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Follow the Microsoft Manual of Style to resolve style issues that are not covered by the Netcracker Style Guide. The Microsoft Manual of Style also contains useful advice on usability and a usage dictionary containing common technical terms and words that frequently present problems.
[image: ] Microsoft Manual of Style, 4th Edition

	Note
The Netcracker Style Guide takes precedence when there are conflicting guidelines.


[bookmark: scroll-bookmark-5]Useful Materials
[image: ] IEEE Standard for Software User Documentation

	Note
For UI Style Guide, please refer to UI Style Guide.





[bookmark: scroll-bookmark-6]Design Documentation - Product/Solution

	Product Business Analysis Message
[bookmark: scroll-bookmark-7]Dear Developer and Analyst,
You are starting to develop design documentation for a product component. Please carefully read design documentation content, formatting, and style requirements found in this section. Please be aware that the design documentation must comply with these requirements in order to successfully pass a compliancy check as part of the product component release procedure.
This section is intended for the specialists developing product analysis and design documentation within the scope of product projects, product change requests, product support, and other activities related to the Netcracker out-of-the-box product. These are product component managers, business and system analysts, system engineers, developers, and any other specialists involved in documentation updates. You will find here rules and recommendations on filling out and formatting documents of the following types:
· Business Use Cases
· System Requirements Specification
· Use Cases
· User Interface Specification
· Automated Functions Specification
· Information Models
· Architecture Specification
· Functional Design Specification
· Data Model Specification




	Сообщение от Product BA
[bookmark: scroll-bookmark-8]Уважаемый разработчик и аналитик,
Обратите внимание!
· В 2014 году направлением Research & Development инициирована программа приведения дизайн документации к единым стандартам качества.
· Программа запущена по результатам фидбеков с внедрений, команды которых часто используют продуктовые спецификации как основу для своих кастомных спецификаций.
· Стандарт является не рекомендацией, но требованием.
· Требования представлены инженерным бизнес-анализом. При формировании требований, в том числе, применены стандарты Technical Writing в части оформления текста и языка изложения.
· Требования являются постоянными.
Просим Вас внимательно ознакомиться с требованиями к структуре, контенту, оформлению и языку дизайн документации, изложенными в данном разделе. Процесс выдачи продуктового компонента в релиз также включает и этап валидации дизайн документации на соответствие данным требованиям.
Требования применимы к следующим типам документов:
· Business Use Cases
· System Requirements Specification
· Use Cases
· User Interface Specification
· Automated Functions Specification
· Information Models
· Architecture Specification
· Functional Design Specification
· Data Model Specification




[bookmark: scroll-bookmark-9]Documentation Validation Checklist
https://bass.netcracker.com/pages/viewpage.action?pageId=260643136

	Guideline
You must validate your document before submitting it for BA review OR to the customer.



	Mandatory sections and contents checks
  Check 1. The Front Matter is consistent with the in-house Netcracker standards as stated by the Brand Management Group guidelines:
1. The project name and the document name are stated correctly. The document name is composed according to the project (or product) naming rules.
2. The document version is correct and updated from the document properties. For information about working with document properties, see Working with File Properties and Fields.
3. The year is pointed out correctly.
4. The customer name is stated correctly.
5. The customer logo is included
	The customer name and the customer logo are pointed out in solution documentation only.


  Check 2. The headers and footers are accurate and contain:
· company logo
· project name
· document name
· current year
· confidentiality data
· customer logo
	The customer logo shall be included for solution documentation only.


  Check 3. The Revision History section is removed before finalizing the document. See Revision History Section.
	The guideline is applied only to the last edition of a document before delivering it to the customer.


  Check 4. The document Table of Contents (TOC) starts from a new page and is updated. For information about working with TOC, see Working with Table of Contents (TOC).
  Check 5. The Distribution List section is included.
  Check 6. The Referenced Documents section is included. See Referenced Documents Section.
  Check 7. The Introduction section is self-sufficient and clear
1. The document purpose is stated clearly.
2. The document audience is stated clearly.
3. Document scope can be described as well.
  Check 8. The Glossary of Terms section is included. See Terms and Definitions.



	Corporate in-house styles consistency checks
  Check 9. A document is based on a corporate template. For information about working with document templates,see Re-Connecting Word Templates.
· The storage of the solution design documentation templates is located on the Solution Delivery Methodology Group Portal.
[bookmark: scroll-bookmark-16]
· The storage of the product design documentation templates is located on SharePoint in the Product Documentation Templates folder.
  Check 10. The styles are checked and applied through a document. See Styles.
There should be no cloned styles, such as Heading 1 and Heading 1 + Before: 3 pt After: 3 pt.
To remove cloned styles:
1. Open the Styles pane in MS Word.
2. Visually scan through the styles.
3. If two duplicating styles are found, right- click the one that should be removed.
4. Click Select All () Instances. All the instances of the incorrect style are highlighted.
5. Click the correct style to be applied to the selection. The wrong style is gone.
  Check 11. The document is consistent with the brand templates.
The document styles are based on the styles designed by the Brand Management Group for using in corporate documentation.
The brand templates are located on the Brand Management Group page.
When checking conformity to the template, make sure that the following characteristics match the template requirements for both the headings, footers, and the document text:
· style name
· font name
· font size
· font color
  Check 12. Every section must have opening text. There must be no sections starting with subsections' headings, or tables, or figures. See Document Flow.
  Check 13. Acronyms are spelled out completely in the first instance. See Acronyms and Abbreviations.
Make sure there is no abbreviation NC for Netcracker in the text. Use Netcracker instead.

  Check 14. Netcracker name is capitalized correctly through the document (vs. to NetCracker). “C” is capital in legal documents ONLY.
  Check 15. There is no "PDT" acronym through the document. If any exist, replace it with the "TW" acronym.
  Check 16. Product names and terms are used consistently throughout the document (for example, proper nouns capitalized).



	Finalizing checks
[bookmark: scroll-bookmark-19]
  Check 17. No comments neither track changes left in the document
When finalizing a document make sure that all the changes in the document are accepted, all the comments are removed, and the Track Changes option is turned off.
1. To turn off the Track Changes option, on the Review tab, in the Tracking pane, view the Track Changes icon. If it is turned on, it is highlighted. Click it to turn it off.
2. To accept all the changes on a document, on the Review tab, in the Changes pane, click the down arrow under the Accept icon to expand the accept options list and click Accept All Changes in Document.
3. To remove all the comments from a document, on the Review tab, in the Comments pane, click the down arrow under the Delete icon to expand the delete options list and click Delete All Comments in Document.
  Check 18. The document flow and structure are logical for the audience to follow.
  Check 19. Capitalization of all titles is validated. See Headings Capitalization.
Check the capitalization of all titles
1. Use the Table of Contents or the MS Word Navigation pane to locate improperly capitalized headings. See Working with Table of Contents (TOC).
2. Use the Table of Figures (TOF) and the Table of Tables (TOT) to find improperly capitalized table and figure captions. Delete the TOF and TOT after the check. See Working with Table of Figures (TOF) and Table of Tables (TOT).
  Check 20. The document text is capitalized as stated in the Style Guide. See Capitalization.
  Check 21. The Tables and Figures captions are correctly fashioned. See Captions. regulations. For information about working with captions in MS Word, see Working with Captions.
1. Captions comply to the table/figure
2. Captions are numbered
3. Caption's number and text are separated by period and space
4. Caption text has no period at the end
5. Captions are formatted with Caption style
6. Captions are left-aligned for the tables.
7. Captions are centered for the figures.
8. A text preceding a table or a figure concerns to that figure or table.
9. The first table rows of all of the tables are repeated on each page. To make the first table row repeat on each page:
a. Select a table.
b. Right-click on the table top row and select Table Properties.
c. On the Row tab select the checkbox Repeat as header row at the top of each page.
d. Click OK.
  Check 22. The Tables and Figures captions are correctly numbered. See Tables and Figures.
  Check 23. All the captions are on the same page with a table or figure. For information about how to avoid breaking captions apart from figures or tables, see Working with the Keep with Next Option.
	When you update document fields or modify text, captions may be detached from figures and tables. Scan the document to verify that they all are together.


  Check 24. Text and screen shots are accurate and contain only required information. See Screen Snapshot Contents and Size.
  Check 25. Spellcheck and grammar check of the whole document is complete. To run spellcheck, click F7.
  Check 26. No double spaces left in the text.
Check that there are no double spaces between words.
To check the text for double spaces, enable Show paragraph marks and other hidden formatting symbols option in MS Word ribbon on the Home tab, in the Paragraph pane.
When the option is enabled, the MS Word underlines them with a green wavy line.
  Check 27. Make sure there is no placeholders left in the document. All the placeholders must be replaced with the relevant text.
To verify there is no placeholders left:
1. Open the Styles pane in MS Word.
2. Right-click the name of the placeholder style.
3. Click Select All ()Instances. All the instances of the placeholder style are highlighted if remained.
4. Locate them and remove or replace with correct text.
  Check 28. All the fields are updated and the references are correct.
To update the fields, press CTRL+A and then F9. Update the entire Table of Contents (TOC), not just the page numbers.
1. All the internal references to the document headings, captions, bookmarks, numbered items, and others, are tested and work.
2. All the references to external documents are tested and work.
3. All the hyperlinks to the external resources are tested and work.
4. All the hyperlinks to the embedded documents are tested and work.
After the fields are updated, search the document for the Error! Reference not found messages. If any exist, correct the references, update all the fields repeatedly, and check for the error message again.


[bookmark: scroll-bookmark-28]Netcracker UI Elements
https://bass.netcracker.com/pages/viewpage.action?pageId=246383177

	Note
All names of the Netcracker 9.3 (Harvard) interface elements in design documents, such as Netcracker-developer-facing names, are defined by the Harvard UI manual of style requirements.
The UI manual of style is supported by the UI Design Group.


[bookmark: scroll-bookmark-29]Structure Requirements
[bookmark: scroll-bookmark-11]Revision History Section

	Guideline 1
Design document must have a "Revision History" section.
Example1:
[bookmark: scroll-bookmark-30]Revision History
	Name
	Component Version
	Revision Date
	Revision Number
	Description of Changes

	Authorname
	x.x.x.x
	DD-Month-YYYY
	1
	First draft

	Editor 1 name
	x.x.x.x
	DD-Month-YYYY
	2
	The following requirements were added according to the link to project project: link to activity.

	Editor 2 name
	x.x.x.x
	DD-Month-YYYY
	3
	Section link to the section was added. Optionally: brief description of the section.


___________________________________________________________
1 The table formatting is a sample. Formatting can vary, i.e., for project design documentation, the date format shall comply with the customer home country standards.



	Guideline 2
Revision author and date information must be specified.



	Guideline 3
All the changes in the document must be stated clearly. It is recommended to insert cross-references to the sections changed.



	Guideline 4
The activity the changes belong to should be pointed out. It is recommended to specify the activity code in the table.



	Guideline 5
If references to external documents are required, it is recommended to insert the references to folders that contain the relevant documents rather than directly to files.



	Guideline 6
Before the document delivery, remove all the versions of the document from the Revision History table except for the final version.


[bookmark: scroll-bookmark-13]Referenced Documents Section

	Guideline 1
Every design document must have a Referenced Documents section. Example:
[bookmark: scroll-bookmark-31]Referenced Documents 
	Reference Number
	Document Name
	Description

	[1]
	ABCDE1.Fulfillment.Improvements.Part_1
	Description 1...

	[2]
	ABCDE1.Fulfillment.Improvements.Part_2
	Description 2...

	[3]
	ABCDE2.Fulfillment.Improvements
	Description 3...

	[4]
	ABCDE3.Fulfillment.Improvements
	Description 4...

	...
	
	






	Guideline 2
The Reference Number should be a bookmark that can be referenced to from the document text.
The Reference Number should be placed in square brackets.



	Guideline 3
The Document Name should be a link to the document or the folder where the document is stored.



	Guideline 4
The Description column should contain brief description of the component referred.


[bookmark: scroll-bookmark-14]Terms and Definitions Section

	Guideline 1
Every design document must have a Terms and Definitions section. Example:
[bookmark: scroll-bookmark-32]Terms and Definitions
	Term
	Definition

	
	






	Guideline 2
This section must list all the key terms used in the document. Only terms from this list can be used in the document.



	Guideline 3
This section must list any non-industry-standard abbreviations used in the document. Industry-standard computing terms, for example, UI, do not need to be included.



	Guideline 4
The table must contain 5 or more items.


[bookmark: scroll-bookmark-33]Table of Icons

	Recommendation
It is recommended to insert a table of icons and buttons in the beginning of the document or proper sections with the images and purpose of the elements.


[bookmark: scroll-bookmark-34]Empty Data Sections

	Guideline
Do not delete empty data sections—sections found in the template, but having no content in the actual document. In this case, put "There is no applicable content for this section." as section text instead of deleteing the section.
Example 1: A component has no entities and uses entities that belong to other components. Then the object requirements do not apply to that component.
Correct
[bookmark: scroll-bookmark-35]Object Requirements
There is no applicable content for this section.

Incorrect
[bookmark: scroll-bookmark-36]Object Requirements

Example 2: A component has no reports and searches.
Correct
[bookmark: scroll-bookmark-37]Reports and Searches
There is no applicable content for this section.

Incorrect
[bookmark: scroll-bookmark-38]Reports and Searches



[bookmark: scroll-bookmark-39]Content Requirements
[bookmark: scroll-bookmark-40]Document Flow

	Guideline 1
Any section or subsection must contain at least one paragraph with some text.



	Guideline 2
There must be no sections containing just an image or a table.



	Guideline 3
There must be no sections containing just subsections.



	Guideline 4
A section must not start with phrases like The table below contains or The following figure demonstrates.
The first sentence of a section must give conceptual information about the subject of the section.


[bookmark: scroll-bookmark-25]Tables

	Guideline 1
Each table must be formatted as designed in the document template, including a table heading row (column) and cell text styles.
Do not apply custom formatting.



	Guideline 2
Do not change a table width manually, if it is not otherwise implied by the corporate template.



	Guideline 3
Each table in a design document must be numbered. See Captions for numbering rules. See Working with Captions for information on how to work witt captions in MS Word.



	Guideline 4
Each table requires an introductory paragraph with a brief description of its contents.



	Guideline 5
When there is a series of similar data type tables going in chain, say The following tables specify <description> before the chain and place one empty paragraph between each table.



	Guideline 6
The Repeat as header row at the top of each page flag must be on.
If no table cell is longer than 5 lines of text, the Allow row to break across pages flag must be off.

	Hint
To remove the "Allow row to break across pages" flag:
1. Select the entire table by clicking [image: ] next to the top left corner of the table.
2. Right-click the mouse.
3. Select Table Properties.
4. Click the Row tab.
5. Clear the Allow row to break across pages check box. If the cursor is placed in the first row and the check box is disabled, click it and remove the flag.
To set the "Repeat as header row at the top of each page" flag:
1. Place the cursor into the first row (any cell).
2. Right-click the mouse.
3. Select Table Properties.
4. Click the Row tab.
5. Select the Repeat as header row at the top of each page check box.
[image: ]











[bookmark: scroll-bookmark-26]Figures

	Guideline 1
· Use figures only to demonstrate clearly the features they illustrate.
· Do not insert a screen snapshot of an entire Web page simply to demonstrate a small pop-up dialog that would be indistinguishable.
· Crop the excessive area of a screen snapshot.




	Guideline 2
Never insert screen snapshots disclosing confidential corporate data like:
· Customer names
· IP addresses
· Server names
· Netcracker user names




	Guideline 3
For demonstrating a drop-down list, expand it before taking a screen snapshot.
If the list is too big, crop part of it before inserting the image in the document.



	Guideline 4
To acquire and insert a UML diagram, use the Enterprise Architect command Main menu > Diagram > Save as Image.



	Guideline 5
To insert a widget popup dialog without the background picture, use the technique described in Screen Snapshot Capture Techniques.


[bookmark: scroll-bookmark-23]Captions

	Guideline 1
Each table or figure must be enumerated and supplied with a caption. See Working with Captions for information on how to work witt captions in MS Word.

Use the Insert captions command of MS Word found in References tab > Insert Caption.



	Guideline 2
A caption must not contain a section number, only the number of the figure or table itself.



	Guideline 3
There must be a dot (.) between the number and the title.
There must be no dot at the end of the caption.
Correct
Figure 1. Component Architecture
Table 5. Home Page Controls
Incorrect
Figure 1 Component Architecture
Table 5. Home Page Controls.



	Guideline 4
Figure and table caption text must be capitalized the same way as headings, see Headings Capitalization.



	Guideline 5
Captions must use the Caption style, which aligns a caption according to the template style.


[bookmark: scroll-bookmark-42]Notes

	Guideline 1
Insert notes sparingly on a page. Otherwise, other text may be interpreted as something unimportant if there are too many notes on the page. Try to limit notes to 1-2 per page.



	Guideline 2
A note is inserted into text only to bring special attention to a point. For example, insert a note when the described feature has a variant or exception under some conditions.
Example:
The condition is: software installed on a client machine, versions of SW, RAM, System type (32-bit or 64-bit), and so on...
Correct
Note: If you run the application on a 32-bit appliance, make sure that ...


[bookmark: scroll-bookmark-43]Language Requirements

	Guideline 1
Writing style:
1. Design documentation should be developed in formal language.
2. Design documentation should be written in third person style.




	Guideline 2
Any analytical document should be written in a clear and concise manner. The document must be understandable for both Netcracker specialists and the customers involved.



	Guideline 3
The same language must be used across the entire design document. The document must appear consistent and seamless if it is developed by team in collaboration.




[bookmark: scroll-bookmark-44]User Interface Conventions

	Note
All names of the Netcracker 9.3 (Harvard) interface elements in design documents, such as Netcracker-developer-facing names, are defined by the Harvard UI manual of style requirements.
The UI manual of style is supported by the UI Design Group.




Interface elements description
This section covers the rules of correct naming of the Netcracker TOMS UI elements and the proper description of the actions that the user performs with them.
When describing action steps, use bold (or style Strong) plus the title case for the menus, menu items, tabs, buttons, and field labels.
This does not mean applying a special style, but just using bold font for the names and capitalizing the names like the titles.
Example: To create new project, on the toolbar click New Project.
In general descriptions of the Interface elements, the title case is used for the whole name of the element.
Example:The New Project button is displayed on the toolbar.
[image: ]
See below the user interface elements names and samples of using them in documentation:

Navigation menu
[image: ]
Example:
The screen can be accessed from the Navigation menu ...
Navigation path string
[image: ]
Example:
The tabs are located under the navigation path string....
Search menu
[image: ]
Example:
The item can be selected from the Search menu...
Operations menu
[image: ]
Example:
The Operations menu displays ...
Tab
[image: ]
Example:
The control is located on the Circuits tab ...
Toolbar
[image: ]
Example:
The control is located on the toolbar ...
Reference selector box
	[image: ]
	[image: ]


Example:
A user should be able to select a group from the reference selector box...
Reference selector pop-up
[image: ]
Example:
Navigating to the Reference Explorer window is performed by clicking "Browse" in the reference selector pop-up ...
Reference Explorer window
[image: ]
Example:
The following groups must be displayed in the Reference Explorer window...
Drop-down list box
[image: ]
Example:
The drop-down list box enables a user to select ...
Edit box
Intended for setting up the text parameters.
[image: ]
Example:
The Description edit box is located on the top ...
Parameter field
Intended for setting string parameters.
[image: ]

Example: The First Name field provides getting ...

Multiple parameter field
The multiple parameters are used to store a number of values for a single multiple parameter,
[image: ]
Examples: The Phone Number multiple parameter field must be implemented with the following input mask: ...
Buttons:
[image: ] Add value
[image: ] Delete value
[image: ] Clear all
Check box
Intended for filling in Boolean parameters.
[image: ]
Example:
The check box to the left (right) of the parameter enables another mode of ...
Date fieldIIntended for filling in date parameters.
[image: ]
Examples:
The date field must be implemented with the "MM/dd/yy" input mask and be provided with two controls as follows:

Buttons:
[image: ] Calendar
[image: ] Delete
Required parameter field
The mandatory fields are marked with a red asterisk.
[image: ]
Example:
The Physical Status drop-down list box is a mandatory field and must be filled in before saving data ...
New Object dialog
[image: ]
Example:
The New Inventory Project dialog enables a user to configure the following parameters ...
Edit dialog

[image: ]
Example:
The inventory project edit dialog shall contain the following ...
In-place editing
The in-place editing button turns on the in-place editing mode.
[image: ]

[image: ]
Example:
A user can perform in-place editing of the ...
Navigation tree
The navigation tree is displayed by clicking the slider button.
[image: ]
Example:
Above the navigation tree, the following buttons are available...
Buttons:
[image: ] Slider
[image: ] Level Up
[image: ] Refresh
[image: ] Level Down






[bookmark: scroll-bookmark-45]Words to Use and Avoid

	Guideline 1
Do not use contractions.
	Incorrect
	Correct

	isn't
	is not

	haven't
	have not

	it's
	it is

	they'll
	they






	Guideline 2
Avoid any words that can bring ambiguity in the requirement statements.
Such words as "several", "improved", and "optimized" should never be used in detailed requirements, only in concepts topics or when describing high-level requirements.
Use of these words can make requirement unverifiable and can result in misunderstanding with the stakeholders.
Incorrect
etc.
and others
and so on
few
and/or
rapid
robust



	Hint
Karl Wiegers' recommended terminology:
	Ambiguous Term
	Ways to Improve

	acceptable, adequate
	Define what constitutes acceptability and how the system can judge this.

	as much as practicable
	Do not leave it up to the developers to determine what is practicable. Make it a to-be-determined item and set a date to find out.

	at least, at a minimum, not more than, not to exceed
	Specify the minimum and maximum acceptable values.

	between
	Define whether the end points are included in the range.

	depends on
	Describe the nature of the dependency. Does another system provide input to this system, must other software be installed before your software can run, or does your system rely on another one to perform some calculations or services?

	efficient
	Define how efficiently the system uses resources, how quickly it performs specific operations, or how easy it is for people to use.

	fast, rapid
	Specify the minimum acceptable speed at which the system performs some action.

	flexible
	Describe the ways in which the system must change in response to changing conditions or business needs.

	improved, better, faster, superior
	Quantify how much better or faster constitutes adequate improvement in a specific functional area.

	including, including but not limited to, and so on, etc., such as
	The list of items should include all possibilities. Otherwise, it can't be used for design or testing.

	maximize, minimize, optimize
	State the maximum and minimum acceptable values of some parameter.

	normally, ideally
	Also describe the system's behavior under abnormal or non-ideal conditions.

	optionally
	Clarify whether this means a system choice, a user choice, or a developer choice.

	reasonable, when necessary, where appropriate
	Explain how to make this judgment.

	robust
	Define how the system is to handle exceptions and respond to unexpected operating conditions.

	seamless, transparent, graceful
	Translate the user's expectations into specific observable product characteristics.





[bookmark: scroll-bookmark-46]Parallel Constructions

	Guideline 1
A sentence or phrase must be consistent across all items in a list, including bulleted and numbered lists, table rows, and glossaries.
All constructions used in parallel with other similar constructions must be the same.
Choose the most appropriate form of construction for each specific case.


Incorrect
	analog
	Analog is a signal directly generated from a stimulus, such as a light striking a camera picture tube

	animation
	Provides visual special effect whereby progressive still images displayed in rapid succession create the illusion of movement


Correct
	analog
	A signal directly generated from a stimulus, such as a light striking a camera picture tube

	animation
	A visual special effect whereby progressive still images displayed in rapid succession create the illusion of movement


Incorrect
This feature lets one do the following:
· Display the profile settings.
· You can edit or delete data that is incorrect or obsolete.
Correct
This feature lets one do the following:
· Display the profile settings.
· Edit data.
· Delete data that is incorrect or obsolete.

Incorrect
Table 5. Settings description
	Password
	This setting enables changing the password.

	Phone number
	The phone number displayed in the client profile as a contact


Correct
Table 5. Settings description
	Password
	The account password

	Phone number
	The phone number displayed in the client profile as a contact



	Guideline 2
For punctuation in tables, follow the Table Punctuation rules.


[bookmark: scroll-bookmark-48]English Capitalization
https://bass.netcracker.com/pages/viewpage.action?pageId=246383187



[bookmark: scroll-bookmark-49]English Punctuation



[bookmark: scroll-bookmark-50]English Grammar and Usage


[bookmark: scroll-bookmark-51]English Prepositions and More
	The list below shows words that are often used incorrectly or are not recommended for use.


	Do Not Use
	Instead Use
	Examples and Conventions

	as shown on the picture
	as shown in the picture
	The Inventory object is presented, as shown in the preceding picture.

	on the workspace
	in the workspace
	The new Event-Start activity is displayed in the workspace.

	in the toolbar, click
	on the toolbar, click
	On the toolbar, click New Project.

	in the menu, click
	on the menu, click
	On the Activation menu, click Activate.

	in the menu, select
	from the menu, select (or choose)
	From the Navigation menu, select Process Management.

	place to
	place in
	Place the file in the folder.

	put to
	put in
	Put the file in the folder.

	on step X
	in step X
	In the following steps below, you will replace the device with cards being moved.

	in the tab
	on the tab
	On the My Profile tab, click Edit.

	on the table
	in the table
	Edit the Name value in the table.

	on the pane
	in the pane
	To expand or collapse the tree, click the button in the navigation tree pane.

	at the status bar
	in the status bar
	An additional type is "Status bar" for messages that are displayed in the status bar of the window.

	on the list
	in the list
	… the option is available in the list …

	in place, inplace
	in-place
	To switch to the in-place editing mode, click …

	aimed at supporting
	aimed to support
	It is a Netcracker Framework component extension aimed to support Oracle Weblogic (WL) Application Server.

	click on the Add button
	click Add (or rarely, "click the Add button", NOT "click Add button"). Skip on and put the if you use the word button.
	To create a new user, click Add.

	drag and drop the object to
	drag the object to
	drag the JPG file to the Image field

	allow
	Avoid this word. Use "can", "enables", "provides", "it is possible to".
	A user can perform an operation ...
A user is enabled to set up the profile settings ...

	it’s
	it is
	Rule: Short forms are disallowed.

	doesn’t
	does not
	Rule: Short forms are disallowed.

	whole
	complete, entire
	The entire set of values …

	ascribe
	assign, specify for
	Assign an alias to the ...
The value specified for the Group parameter …

	authentification
	authentication
	User and device authentication...
Users periodically change their authentication information to meet corporate policy...

	necessary, required
	your (only in steps); see also "Specifying objects."
	To update your password, type the new value in the …

	differing
	different from
	The value that is different from the current one

	edit mode
	editing mode ("in the editing mode")
	In the editing mode, type ...

	drill down
	open, navigate to
	Navigate to the UI Themes from ...

	independent on, irrespective
	regardless of
	Regardless of the object type, the current object belongs to …

	similarly, in a similar way
	likewise
	Likewise, specify the following parameters: …

	correspondent
	corresponding
	... the options corresponding to the mode …

	children types
	child types
	The Residential Customer Account is a child object type of the Customer Account object type.

	it is necessary that you do this
	it is important that you do this
	It is important that you specify the following parameters:

	в отличие от
	unlike
	In-place editing mode enables a user to make changes directly in the table, unlike the ordinary editing mode, supplying a special dialog ...

	web, web page, web interface, web browser
	Web, Web page, Web interface, Web browser
Exceptions: web-centric, webcam, webcast, webmaster, webzine.
	Rule: Do not forget to capitalize the word “Web”.

	internet
	Internet
	Rule: Do not forget to capitalize the word “Internet”.

	sub interface, sub-interface
(-connector, -flow, -type)
	subinterface (subconnector, subflow, subtype)
In general, do not hyphenate words beginning with sub, such as subheading and subsection, unless it is necessary to avoid confusion or sub is followed by a proper noun, as in sub-Saharan.
	Rule: Do not hyphenate words beginning with “sub” unless it is necessary to avoid confusion.

	№
	Skip, replace with words (‘number’), or use ‘#’ if absolutely necessary.
	Rule: Do not use the “№” symbol.

	MS
	Microsoft
	Rule: Do not use an abbreviation of the word “Microsoft."

	optionally (in non-mandatory procedure steps)
	if necessary
	Specify the Work Phone parameter, if necessary.

	colour
	color
	Rule: Use the American spelling.

	modelling
	modeling
	Rule: Use the American spelling.

	zeroes
	zeros
	Rule: Use the American spelling.

	in order to
	to
	Navigate to the Parameters tab to specify …

	using
	by using
	Set up the date by using the Calendar button.

	scheme, schemes
	schema, schemas
	Rule: Use the words schema and schemas.

	variant
	type of, mode OR case, option, revision
	Weblogic Embedded is a type of Weblogic implementation for Netcracker.
Another option of setting up the Name is to enter the in-place editing mode.

	document (as concerning to a network)
	capture, represent
	· Optical distribution frames in Resource Inventory are represented with an object of type ODF.
· The Solution will allow you to capture (not document) the operational status of production network equipment.


	populate the parameters
	fill in the parameter / fill out the parameters, enter the parameter value, specify the parameter value
	Rule: When using the "fill in" / "fill out" constructions in project documentation, consider the language specifics of the customer's country. "Fill out" is the American English usage of the term, whereas "Fill in" is the British English version of it. After deciding which construction to use, make sure that it is consistent through all of the documentation kit.
For information about using the U.S. and U.K terminology, see U.S. Terminology and U.K. Terminology Reference.

	targeted for
	targeted to
	

	e.t.c., etc, et.c.
	in running text: "and so on"
in parentheses: "etc."
	

	i.e.
	in running text: "that is" (put a comma after or set off phase)
in parentheses: "i.e."
	Rule: If "that is" is at the beginning of a sentence, put comma after it.
If "that is" is in the middle of a sentence, do not use a comma after "that is" but use commas to set off the whole phrase. That is, "The vendors, that is Cisco and 3Com, provide routers with multi-protocol capabilities".

	e.g.
	in running text: "for example" (put a comma after or set off phase)
in parentheses: "e.g."

	Rule: If "for example" is at the beginning of a sentence, put comma after it.
If "for example" is in the middle of a sentence, do not use a comma after "for example" but use commas to set off the whole phrase. For example, "Many vendors, for example Cisco and 3Com, provide routers with multi-protocol capabilities".

	grayed, dimmed
	unavailable, disabled
	

	administrating
	administering
	

	enumerates (the tab enumerates parameters)
	displays (the tab displays parameters)
	

	save changes
	save the changes (or save your changes)
	

	situated
	located or skip this word at all
	

	appears, this opens, is opened, is shown when applied to a page, tab, or dialog
	is displayed
	

	context menu, popup menu, dropdown menu
	menu (for ALL menus)
Use the word context ONLY when it is not clear which menu the user should select the command from. Do not use context when you use right-click.
	

	Ok, ok
	OK
	

	distributive
	distribution
	Go to the folder where you unzipped the CLI distribution.

	mandatory, required
	required (parameters)
	Parameters. Applies to design documentation only.

	perform settings
	make settings
	Other settings of the Recent menu, for example, the number of recent objects to display for all users, are made by administrators.

	repeated (в значении "повторный")
	repeat
	The customer personnel can attend repeat training.

	refer to (when referring to Netcracker documentation)
	For more information, see Page Title.
	Style Guide section with guidelines: Internal and External Cross-References.

	see (when referring to external documentation)
	For more information,refer to Oracle Database Installation Guide.
	Style Guide section with guidelines: Internal and External Cross-References.

	Out-of-the box, OOB
	immediately available, preconfigured, standard application, standard application's, by default, default configuration, default setup, default settings
	ASR integration adapter utilizes immediately available Mediation DataFlow configuration to enable interfacing ...


[bookmark: scroll-bookmark-54]References

	Guideline 1
A reference to another section in a document must be formatted as a hyperlinks and should display the title of the referenced section. For information on how to work with cross-refernces, see Working with Cross-References.
Correct
For more details, see "Referenced section name."



	Guideline 2
External documents referenced in the text must be listed in the "References" section. See References Section.
Such documents are included in the documentation package and detail or relate to the current document.
Insert a cross-reference to the referenced documents section if needed.
Correct
For more details, see [2].



	Guideline 3
References to Web resources must be links to the relevant web pages.
A hyperlink must be displayed as readable text, not as a URL.
Correct
For more details, refer to Oracle Documentation.
Incorrect
For more details, refer to http://www.oracle.com/technetwork/indexes/documentation/index.html.




[bookmark: scroll-bookmark-56]Writing Numbers

	Guideline 1
Spell out numbers less than ten, and use numerals for more than 10.
Exception: Always use numbers such as a "1" to refer to a character field, or to the number of positions in a field.



	Guideline 2
Use a no-break space for showing thousands.
Press CTRL+* with the cursor in the text or the Show hidden symbols button on the MS Word ribbon to show the hidden formatting symbols thus making visible the difference between the regular space and the no-break space.
Press CTRL+SHIFT+SPACE to make a no-break space. If you don’t use it, parts of long numbers may suddenly get to another page line.
[image: ]



	Guideline 3
When possible, do not start sentences with numbers.



	Guideline 4
Write out decades and centuries in words.
Correct:
eighties or nineteenth century



	Guideline 5
Write out percents in symbols in ordinary documents (%), and in words "percent" in formal documentation.



	Guideline 6
Write out numbers in words when rounding.
Correct:
about half a million notes



	Guideline 7
When possible, avoid putting several numbers one after another or at least write the fist one in words and the other in figures.
Correct:
eight 19-inch racks








[bookmark: scroll-bookmark-57]Formatting Requirements
[bookmark: scroll-bookmark-58]Boolean Values

	Guideline 1
Use double quotes when "True" and "False" are drop-down list values.
Always capitlize the initial letter.


Correct
Select "True" from the Is Fork drop-down down list box.
Incorrect
Select True from the Is Fork drop-down down list box.


	Guideline 2
Use double quotes when "true" or "false" is referred to as a value entered verbatim.


Correct
If the Offline SCM Compiler is used, set the rdb_strict_mode parameter to "false" in the config.properties file. That is, the following string should be included: set rdb_strict_mode=false
Incorrect
If the Offline SCM Compiler is used, set the rdb_strict_mode parameter to the false value in the config.properties file. That is, the following string should be included: set rdb_strict_mode=false


	Guideline 3
Say TRUE and FALSE when refering to a returned value.


Correct
The following Boolean expression returns TRUE in all cases: TRUE OR x.
Incorrect
The following Boolean expression returns true in all cases: TRUE OR x.


	Guideline 4
Express Boolean values as T (true) or F (false), rather than simply T or F, for example, when you are referring to values of system parameters. Use a nonbreaking space between the letter and the first parenthesis. If, however, you are documenting a system's value or computer text that a user must enter, use the format that the system uses.


[bookmark: scroll-bookmark-59]Code Syntax Format
[bookmark: scroll-bookmark-60]Summary
· In Confluence, all code syntax guidelines, not the actual code samples, should always be formatted using normal Paragraph style with no extra formatting except names of the variables substituted with actual parameters (should be in italics).
· Additionally, use bold for names of commands and keywords.
· Additionally, use italic for names of variables that are replaced with actual values.
Syntax is the order in which the user must type a command-line command or utility name and any arguments and options that follow it. The user must type elements that appear in bold in the syntax line exactly as they appear. Elements that appear in italics are placeholders representing information the user must supply.
Following is a sample syntax line using the form that is standard in Microsoft documentation:
sample {+r | –r} arguments ... [options]
The meaning of each of these elements is as follows.
	Element
	Meaning

	sample
	Specifies the name of the command or utility.

	{ }
	Indicates a set of choices from which the user must choose.

	|
	Separates two mutually exclusive choices in a syntax line. The user types one of these choices, not the symbol.

	arguments
	Specifies a variable name or other information the user must provide—for example, a path and file name.

	…
	Indicates that an argument can be repeated several times in a command line. The user types only the information, not the ellipsis (…).

	[ ]
	Indicates optional items, except in languages in which brackets are part of the syntax. In that case, use double brackets ([[ ]]). The user types only the information within the brackets, not the brackets.


Following are syntax lines for a Visual Basic property (FontSize) and a C library routine (_setfont).
Correct
{[form.] [control.]|Printer.}FontSize[=points%]
short far_setfont ( unsigned char far *options );


Follow exactly the standards and conventions of the language or program that you are documenting when writing syntax.
[bookmark: scroll-bookmark-61]Format of Syntax
In general, follow these document conventions for formatting syntax.
	For these elements
	Use

	Keywords, functions, and anything else that must be entered exactly as shown
	bold

	Variables and other placeholders the user must provide
	italic

	Punctuation marks the user does not enter
	regular text


[bookmark: scroll-bookmark-62]Line Breaks in Syntax
Do not hyphenate a line of command syntax. If you must break a line, break it at a character space and do not use a hyphen. Indent the runover line.
Correct
Set database = OpenDataBase(dbname[, reserved[,
read-only[, connect]]])
Incorrect
Set database = OpenDataBase(dbname[, reserved
[, read-only[, connect]]])



[bookmark: scroll-bookmark-63]Formatting Consistency

	Guideline
The document structure must be consistent.
The same heading style must be used across the entire document for the same level of headings, and so on.


Correct
[bookmark: scroll-bookmark-64]Description
[bookmark: scroll-bookmark-65]Description
[bookmark: scroll-bookmark-66]Description

Incorrect
[bookmark: scroll-bookmark-67]Description
[bookmark: scroll-bookmark-68]Description
[bookmark: scroll-bookmark-69]Description

[bookmark: scroll-bookmark-70]Key Name Format
In general, spell key names as they appear in the following list, whether the name appears in text or in a procedure. Use all capitals for key names unless otherwise noted.
Correct
ALT
ALT GR
Application key [Microsoft Natural Keyboard only]
arrow keys [not direction keys, directional keys, or movement keys]
BACKSPACE
BREAK
CAPS LOCK
CLEAR
CTRL
DELETE (Use this to refer to the back delete key on the Macintosh keyboard.)
DOWN ARROW (Use "the" and "key" with the arrow keys except in key combinations or key sequences. Always spell them out. Do not use graphical arrows.)
END
ENTER (On the Macintosh, use only when functionality requires it)
ESC (Always use ESC, not ESCAPE or Escape, especially on the Macintosh.)
F1–F12
HOME
INSERT
LEFT ARROW (Use "the" and "key" with the arrow keys, except in key combinations or key sequences.)
NUM LOCK
PAGE DOWN
PAGE UP
PAUSE
PRINT SCREEN
RESET
RIGHT ARROW (Use "the" and "key" with the arrow keys, except in key combinations or key sequences.)
SCROLL LOCK
SELECT
SHIFT
SPACEBAR (Precede with "the", except in procedures, key combinations, or key sequences.)
SYS RQ
TAB (Use "the" and "key", except in key combinations or key sequences.)
UP ARROW (Use "the" and "key" with the arrow keys, except in key combinations or key sequences.)
Windows logo key [Microsoft Natural Keyboard only]
Spell key names that do not appear in this list as they appear on the keyboard.
When telling a user to "press" a key, format the key name in all caps. When telling a user to "type" a key, use lowercase bold, unless an uppercase letter is required.
Correct
Press Y.
Type y.
Note: Format punctuation according to the intended use. If the user must type the punctuation, use bold. If not, use regular.
At first mention, you can use "the" and "key" with the key name if necessary for clarity—for example, "the F1 key." For all subsequent references, refer to the key only by its name—for example, "press F1."
For the arrow keys and the TAB key, list only the key name in key combinations without "the" and "key."
Correct
To move the insertion point, use the LEFT ARROW key.
To extend the selection, press SHIFT+LEFT ARROW.

[bookmark: scroll-bookmark-71]Special Character Name Format
Because these keys could be confused with an action (such as +) or be difficult to see, always spell out the following special character names: PLUS SIGN, MINUS SIGN, HYPHEN, PERIOD, and COMMA.
Correct
SHIFT+PLUS SIGN
Press ALT, HYPHEN, C
Press COMMA
Press COMMAND+PERIOD
Type an em dash
Press the PLUS SIGN (+)
Incorrect
SHIFT+ +
SHIFT+ -
Press +.
You can add the symbol in parentheses after the special character name—for example, PLUS SIGN (+). Use discretion in adding symbols, however. it may not be necessary for commonly used symbols such as a PERIOD (.).
[bookmark: scroll-bookmark-17]Styles

	Guideline 1
Design documents must be based on branded design document templates.
· Corporate templates for Product Documentation are stored on the SPS3 SharePoint (the full link is https://sps3.netcracker.com/corporate/ProductDocumentation/Product Documentation/Templates). The path to the repository on the SPS3 SharePoint is Corporate > Product Documentation > Regulating Documentation > Templates
· Corporate templates for Solution Delivery Documentation are available on the SDMG Templates page and can be accessed from the Solution Delivery Methodology Group Home page.
When starting a document, do the following:
1. Navigate to the templates repository.
2. Download the template for your document type.
3. Create the new document based on the downloaded template.




	Hint
To know how to check what template is applied to a document and how to re-connect a template to a document if by some reason the template was unlinked, see Re-Connecting Word Templates.



	Guideline 2
All text must be formatted using only the template styles.



	Guideline 3
Do not modify template styles or create new styles.



	Hint
Open the Styles pane in MS Word to check if MS Word clones corporate template styles. This will let you get rid of cloned styles as early as possible.



	Guideline 4
Do not put empty paragraphs in text. Template paragraph and heading styles are designed to have correct spacing before and after each element.








[bookmark: scroll-bookmark-72]Word Hints
This section is designed to describe briefly the MS Word featuers that are most commonly used in the product documentation.
The subsections describing the features will help the documentation authors to avoid issues when working with an MS Word document.
[bookmark: scroll-bookmark-10]Working with File Properties and Fields
Such parts of any document as the project name, document type, component version and other, are set as the file properties and inserted in the document as fields.
This section provides information on hwo to work with the document properties and to use them in fields in a document.
You will know how to :
· set summary document properties
· set custom document properties
· add a new document property
· update all the fields
· view a field code
· edit a field
The first thing to be done when starting a new document is to set the file properties and to make sure that the fields that reference to the properties are correct.
	[bookmark: scroll-bookmark-73]To set summary document properties


· In MS Word, on the ribbon, click the File tab.
[image: ]
· On the right pane, expand the Properties options by clicking the down arrow and select Advanced Properties.
· On the Summary tab, enter the document title that is to be displayed on the front matter of a document.
[image: ]
· On the Custom tab of the Properties dialog, specify the document type that will also be displayed on the front matter, the component version if required and the other custom properties.
	[bookmark: scroll-bookmark-74]To set custom document properties



· Click the Custom tab.
· Click the property name in the Properties list, and type the new value in the Value box.
[image: ]
· Press the ENTER key and select the next property to change.
· After you completed working with the properties, click OK.
	[bookmark: scroll-bookmark-75]To add a new document property


· On the Custom tab of the Properties dialog, in the Name field either type a new property name or select from the predefined values in the list below the Name box.
· Select the type of the property if necessary. The default value is "Text".
· Enter the value of the new property in the Value text box.
· The button Add is activated.
· Click Add.
[image: ]
· After completing configuring the document properties, click OK.
· When the properties are configured, update the fields through the document to make sure the properties are set correctly.
	[bookmark: scroll-bookmark-76]To update all the fields


· select all the document by clicking CTRL+A and then press F9.
The table of contents, which is a field as well, must be updated entirely.
	The fields inserted in headers and footers, are not updated with the whole document. To update the fields in the headers and footers, double click the header or footer area, select the contents and click F9.


Usually, the corporate templates contain the preconfigured fields which refer to the document properties, thus it is enough to set the properties values and update the fields.
If something goes wrong, you can check with the field code.
	[bookmark: scroll-bookmark-77]To view a field code


· Point your cursor to the field.
· Right-click the field
· From the contextual menu, select Toggle Field Codes.
[image: ]
The field code is displayed, which provides understanding of what document property value goes in this field (if document property used).
For example, on the picture below it is visualized that the field type is DOCPROPERTY, and the property which value is displayed, is DocType.
[image: ]
	[bookmark: scroll-bookmark-78]To edit a field


· Right clicki the field.
· From the contextual menu,select Edit Field option
· If you need to refer to another document property, select it from the Field dialog.
[image: ]

If something is incorrect with the property value, you can correct the issue in the document properties, see To set summary document properties and To set custom document properties
	[bookmark: scroll-bookmark-80]To insert a new field with a document property


· In MS Word, on the ribbon, click the Insert tab.
· In the Text panel, expand the Quick Parts menu and select Field.
[image: ]
· From the categories drop-down list, select "Document Information."
· From the Field names list, select "DocProperty."
· From the Property list, select the property which value you need to insert.
[image: ]
· Click OK
[bookmark: scroll-bookmark-81]
[bookmark: scroll-bookmark-12]Working with Table of Contents (TOC)
Table of Contents (TOC) is required for all the product and project documents providing structured information. TOC enables seeing parts of documents in the order they appear. This section addresses creating, modifying, and updating (re-building)TOC.
You will know how to:
· Create TOC from the Reference tab
· Create TOC as field from Insert tab
· Edit TOC (re-configure, not update) including:
· Editing TOC Options
· Editing formatting of TOC levels
· Update TOC
In MS Word Toc is inserted as a field containing links to the headings' positions. Commonly, the product documents provide TOC configured in accordance with the corporate design guidelines, but the documentation authors are able to reconfigure TOC if needed or if it is damaged by some reasons.
TOC configuration enables to manage:
· Styles which instances build the table of contents
· Appearance of the table of contents
· The level of headings hierarchy
· others
Table of Contents in inserted in the beginning of a document after the standard parts as the front matter, confidentiality data, and so on, before the Introduction section.
[image: ]
MS Word template Normal.dotm provides a number of built-in styles which instances go in TOC. These are Headings Heading 1, Heading 2, etc…
When configuring TOC, it is possible to add other styles in TOC. For example, if you need to include Appendices titles be included, you can create a special style for these titles and add it to the list of styles for building TOC.
Each time before saving document you have to update TOC to re-build the links to the document sections that is updating the renamed sections' names and numbers of the pages the sections start on, as well as adding links to new sections and removing links to deleted sections.
	[bookmark: scroll-bookmark-88]Create TOC


[bookmark: scroll-bookmark-82][bookmark: scroll-bookmark-89]Create TOC from the Reference tab
To create TOC in an MS Word 2010 document:
· Click on the position in the document the TOC will start with.
· On the Ribbon, click the Reference tab.
· In the Table of Contents group, expand the TOC options list by clicking the down arrow on the Table of Contents button.
[image: ]
You can select the TOC appearance from the list of different TOC views, otherwise click Insert Table of Contents.
	Only one table of contents can be inserted in a document. If a document contains TOC, the Insert Table of Contents button is disabled.


The configure Table of Contents dialog is displayed. The default TOC settings are displayed in the dialog.
[image: ]
· Configure TOC if needed and click OK. The TOC parameters are described below, see Editing TOC Options and Editing formatting of TOC levels.
[bookmark: scroll-bookmark-83][bookmark: scroll-bookmark-90]Create TOC as field from Insert tab
Another way to create TOC is to insert it as a field. When editing TOC it is also updated as a field.
To insert TOC as field:
· Click on the position in the document the TOC will start with
· On the Ribbon, click the Insert tab,
In the Text group, expand the Quick Parts options list by clicking the down arrow on the Quick Parts button.
[image: ]
The Field dialog is displayed. Field dialog enables inserting any kind of fields in a document. Some kinds of the fields can be pre-formatted in the same dialog before being inserted.
[image: ]
· Scroll down the Filed names list to the "TOC" item and click it.
	If table of contents already exists in the document, the TOC item in the list of fields is not available.


· Click OK.
The table of contents with default view is inserted in the text.
	[bookmark: scroll-bookmark-91]Edit TOC (re-configure, not update)


Editing TOC lets you change its appearance, the number of levels, styles which instances go in TOC, whilst TOC update implies rebuilding references to the headings in TOC.
	Do not confuse editing that means reconfiguring of TOC with update TOC that means update field.


To edit TOC:
· Right-click the mouse on any area of TOC and select Edit Field from contextual menu.
[image: ]
The Field dialog is displayed.
· Do one of the folllowing:
Either
· scroll the list of Field names to TOC,
or
· select Index and Tables in Categories list to shorten the Fields Names list and then select TOC from it.
[image: ]

· Click Table of Contents.
The Table of Contents dialog is displayed.
[image: ]
The parameters' names are intuitive.
The Print Preview and Web Preview panes let you see how the parameters' updates affect the appearance of TOC if applied.
[bookmark: scroll-bookmark-85][bookmark: scroll-bookmark-92]Editing TOC Options
Clicking the Options button opens the Table of Contents Options dialog.
The Table of Contents Options dialog enables you specifying the styles that go in TOC and the level at which they appear.
[image: ]
To add a style to TOC, find it in the Available styles: list and type the level of it in the TOC level: cell on the right.
For example, if you need to include the Appendices titles in TOC, you need to:
· Create and apply a particular style to all of the Appendices titles, for example, "Appendix"
· Open the Table of Contents dialog
· Open the Table of Contents Options dialog
· Find the "Appendix" style among the available styles
· Set "1" in TOC level cell
· Save the settings.
The confirmation dialog is displayed prompting to replace the TOC.
[image: ]
If you click OK, the table of contents will be replaced with Appendices titles.
[bookmark: scroll-bookmark-86][bookmark: scroll-bookmark-93]Editing formatting of TOC levels
Clicking the Modify button in the Table of Contents dialog opens the Style dialog.
In the Style dialog the formatting of each level of TOC is performed .
The TOC 1, TOC 2, … correspond to the levels of tabel of contents.

[image: ]
	[bookmark: scroll-bookmark-94]Update TOC


Updating TOC is performed as a standard field update operation.
To update TOC:
· Point the cursor to any area of TOC and right-click the mouse.
· From contextual menu, select Update Field
The Update Table of Contents dialog is displayed.
[image: ]
· Select the necessary option and click Ok.

[bookmark: scroll-bookmark-21]Working with Table of Figures (TOF) and Table of Tables (TOT)
This section addresses how to work with the Table of Figures (TOF) and the Table of Tables (TOT).
You will know how to:
· insert caption for a table or for a figure
· insert TOF or TOT
Table of tables (TOT) and Table of Figures (TOF) may be needed, for example, if you want to see all the tables' and figures' names together in one place.
You can also insert TOT or TOF temporarily, to validate that the tables' and figures' names are consistent and correctly capitalized.
Table of Figures and Table of Tables are build as sets of references to the captions of figures or tables in a document.For information about working with captions, see Inserting Captions.
	Only tables that have captions with the "Table " lead-in are included in the Table of tables.



	Only figures that have captions with the "Figure " lead-in are included in the Table of tables.


	[bookmark: scroll-bookmark-95]To insert caption for a table or for a figure


· Click in the table or the figure.
· On the MS Word ribbon, click References tab.
· On the References tab, in the Captions group, click Insert Caption.
· In the Caption dialog, from the Label drop-down list, select Table for a table, or Figure for a figure.
[image: ]
· Click OK.
Once all the tables in the document have the "Table" captions, you can build the table of tables.
	[bookmark: scroll-bookmark-96]To insert TOT or TOF


· Click where you want the Table of Tables to go.
· On the MS Word ribbon, click References tab.
· On the References tab, in the Captions group, click Insert Table of Figures.
The Table of Figures dialog is opened.
[image: ]
· From the Caption label drop-down list, select "Table" for TOT or "Figure" for TOF.
· Click OK.
[bookmark: scroll-bookmark-24]Working with Captions
Captions are used for inserting inscriptions to the tables and figures. This section addresses using captions in documentation.
You will know how to:
· insert caption
· update caption
· refer to caption
A caption consists of the label and number. You can use the predefined labels like Figure, Table, and Equation, otherwise you can create your own label if you need.
The advantages of using captions are the following:
· Caption can be referred to from any place of the document as many times as it is required.
· Captions' numbers are generated automatically thus providing consistent numbering through the document.
· The "Caption" style provides consistent formatting of the inscriptions to the tables and figures.
	[bookmark: scroll-bookmark-98]To insert caption


· Point the mouse to a position you need a caption to be inserted (e.g., below the picture).
· On the ribbon (MS Word top panel), click the References tab.
[image: ]
· On the References tab, in the Captions group, click Insert Caption.
[image: ]
· In the Caption dialog, select the name of the caption and click OK.
The caption label and number are inserted.
[image: ]
· Type manually the text of the caption.
	[bookmark: scroll-bookmark-99]To update caption


· Point the mouse to a caption to be updated.
· Right-click the mouse.
· From a contextual menu, select Update Field.
· The number of the caption is updated in accordance with the caption order in the document.
	[bookmark: scroll-bookmark-100]To refer to caption


· Point the mouse to a position you need to insert the reference to.
· On the References tab, in the Captions group, click Cross-reference.
[image: ]
The Cross-reference dialog is opened.
· From the Reference type drop-down list, select the type of caption you need to refer to.
· In the For which caption list, select the necessary caption.
[image: ]
· From the Insert reference to drop-down list, select the appearance you need for the reference.
[image: ]
· Click Insert.
[bookmark: scroll-bookmark-55]Working with Cross-References
Cross-references enable quick navigating between parts of a document. this section addresses how to work with cross-references.
You will know how to:
· insert cross-reference
· update cross-reference
Cross references can be inserted in any place of a document and you can refer to the same item as many times as you need.
When you make changes to the document, the cross-reference must be updated. If some pert of a document you refer to is deleted, the error message will replace the reference, like:
[image: ]
You can create cross-references to the following objects:
· Numbered item
· Heading
· Bookmarked text
· Footnote
· Endnote
· Figure / Table / Equation – items having the appropriate captions.
	[bookmark: scroll-bookmark-101]To insert cross-reference


· On the MS Word ribbon, click the References tab.
[image: ]
· In the Captions group, click Cross-reference.
· The cross-reference dialog is opened.
[image: ]
· From the Reference type drop-down list, select the type of the item you need to refer to.
The reference type can be as follows:
· 
· Heading
· Bookmark
· 
· Footnote
· Endnote
· 
· Equation
· Figure
· 
· Table

· Insert Reference to drop- down list is contextual. It depends on the Reference type value and defines the appearance of the cross-reference.
[image: ]
· In the "For which " list, select the item you want to refer to.
· Click Insert.
	[bookmark: scroll-bookmark-102]To update cross-reference


The references are updated like the other fields.
· To update a single field, point the cursor to the field and press F9
· To update all fields in a document, click CTRL + A to select all text and then press F9 .
[bookmark: scroll-bookmark-27]Working with the Keep with Next Option
Keep with next option is used to prevent splitting to different pages the paragraphs that must go together.
This section addresses working with the "Keep with next" option.
You will know how to:
· set the "Keep with next" option for paragraph
· apply the "Keep with next" option to style
The situations when paragraphs must be "sticked together" can be the following:
· The table name and the table
· An image and the image caption
· etc…
Setting "Keep with next" option is recommended in the following cases:
· Headings
· Image – to keep image always together with the caption
· Table captions – to keep table names with tables
· Introduction to procedure
Example:
To run the report:
1. Navigate to Reports folder
2. From the Reports table, select…
3. Introduction to a list
Example:
The Status parameter can have the following values:
· New
· Activated
· Suspended
…
It is also recommended to apply the "Keep with next" option to paragraphs preceding images and tables.
	[bookmark: scroll-bookmark-103]To set the "Keep with next" option for paragraph


· Point the cursor to the paragraph that must always be together with the next one, and right-click the mouse.
· From the contextual menu, select Paragraph
· Click the Line and Page Breaks tab.
· Select the Keep with next check box.
[image: ]
· Click OK.
You can apply the "Keep with next" option to a style. For example, all the heading styles have this option toggled, or the style used for graphics is also set as "keep with next" to be never torn apart with the caption below.
	[bookmark: scroll-bookmark-104]To apply the "Keep with next" option to style


· In MS Word, on the ribbon, click the Home tab.
· In the Styles group, click the left-down arrow button to open the Styles pane.
[image: ]
· In the Styles pane, select the necessary style and right-click on it.
· From the contextual menu, select Modify.
· The Modify Style dialog is opened.
· Click the Paragraph button to expand the menu.
[image: ]
· The Paragraph dialog is displayed.
· On the Line and Page Breaks tab, select Keep with next check box.
· Save the updates.


[bookmark: scroll-bookmark-15]Re-Connecting Word Templates
A template is a file used as a basis for the new files created in MS Word. Corporate templates design is created by Brand Management Group and is part of Netcracker Brand Book.
Netcracker templates have standard parts, like front matter, confidentiality information part, headers and footers, TOC, etc... The templates also specify the colors, margins, and other parameters of a document.
All the corporate documents must be consistent with the corporate templates of proper document type.
This section addresses fixing the situation when a template applied to a document is disconnected accidently.
You will now how to re-connect the template backl to a document.
	To link a template to the opened document


· In MS Word, on the ribbon, click the File tab.
· On the left pane, click Options.
[image: ]
· In the Word Options dialog, in the left vertical pane, click Add-Ins.
[image: ]
· In the Manage drop-down list, select "Templates" and click Go.
The Templates and Add-ins dialog is opened.
· To select a template, click Attach.
[image: ]
· Navigate to the required template using your file browser and select it.
After you located and selected the necessary template, click OK to save the settings.
[bookmark: scroll-bookmark-105]Cross-References Repair

When editing documents in MS Word you may encounter broken cross-references like the one on the screenshot below.
As you can see, the bookmark includes a whole topic along with a screenshot instead of just the name of the required heading.
[image: ]
This page describes the root cause of the problem, how to fix it and how to avoid it in the future.
[bookmark: scroll-bookmark-106]Root Cause
The problem is caused by adding new topics directly from the heading of a subsequent topic. By doing so, you extend the bookmark range and insert the whole content of the newly added topic to it.
Lets consider the following example. We have a heading and a reference to it below the heading (in grey):
[image: ]
Suppose you need to add a new chapter just above Connector specifications. The most intuitive (but ultimately wrong) way to do this is to position you cursor before the beginning of the heading text like this:
[image: ]
And then press ENTER. This would create a new heading where you can add a title and content like this:
[image: ]
So far so good. But the problem is, there was a hidden bookmark set on the heading Connector specifications. When you expanded the heading to create the new chapter, you expanded the bookmark as well. Now it will include New heading, Connector specifications and everything in between including screenshots and tables. For now, it is not visible because the field with the cross-reference is not yet updated. But when you update it, the result will be following:
[image: ]
Due to Word's insidious nature, the problem may remain undetected and will manifest only when pdf or online help versions of the document are generated. Make sure to always update all fields and check the document content before you finalize the document and upload it to SVN! Setting Field shafing to "Always" also really helps. (File > Options > Advanced category > Show document content group > Field shading)
[bookmark: scroll-bookmark-107]Avoiding the Problem
	Never add a new paragraph by placing the cursor before the beginning of the text and pressing ENTER. That is, never add a new paragraph before the current paragraph, only add new paragraphs after the current paragraph.
Never use New Heading Before feature on MS Word Navigation pane. Use only New Heading After. (Yes, New Heading Before also causes this problem, Word is such a Word [image: ]).



[bookmark: scroll-bookmark-108]Fixing the Problem
You can fix the problem using one of the two ways:
· Delete the field with the cross-reference, and then insert a new one with the reference to the same heading. This will create a new, correct hidden bookmark. The previous hidden bookmark will remain in the document. But since it is not referenced anywhere, it will not cause problems. Note that you would need to replace all references to this heading in the document!
· Select all the newly added text that should not be included in the bookmark and cut it. Add a new paragraph in a proper way, and then paste the text. This would remove the unwanted text from the bookmark and it will be fixed. You do not need to fix the fields with cross-references this way.


[bookmark: scroll-bookmark-109]User Documentation
This section of the Netcracker Style Guide is intended for the technical writers developing the end-user documentation.
[bookmark: scroll-bookmark-110]Business Logic and UI Abstraction Layers
[bookmark: scroll-bookmark-111] 
https://bass.netcracker.com/pages/viewpage.action?pageId=249206095
[bookmark: scroll-bookmark-112]Abstraction Layers

	Guideline 1
Two abstraction layers are distinguished in user documentation:
· Business logic layer
· Presentation layer (UI)
The presentation layer focuses on user interface (UI) design, current names, color, shapes of buttons, tabs, names, and menu items. In other words, the presentation layer how the access to the system functions, including screen snapshots that illustrate the UI, is realized in the user interface.
The business logic layer includes functions and functional features in the system that remain unchanged, regardless of the UI layer and graphics illustrating the processes, schemes, and structures. Functions and function logic are changed less frequently than their design in the UI.



	Guideline 2
Documentation should describe how to solve user problems at the level of buiness logic, but not at presentation level:
· It is necessary to prescind how a specific function is realized in the UI.
· The presentation layer should be described in specialized books, chapters, or topics.
[bookmark: scroll-bookmark-114]Example 1. User Problem – Necessary Retention Type is Absent*
* Retention – A way to retain loyal customers through promises.
Configuration Guide. The types of retention are presented by the list values of the Case Type attribute. There is strict binding to the interface, and a tendency to the representation layer. Overloading a reader, for which this is probably not the first configuration task, by excessive and unnecessary details of the UI Admin Tool.
Before
[image: ]
Problems:
1. Screen snapshots are made on the current interface. Any change of interface elements or page structure will require changing screen snapshots.
2. Icons are used in the text.
3. The system function is described (navigation to the object type from the instance) as realized in the interface (the Others menu).
4. There are names of windows, a panel, edit fields, and buttons in the text that can be changed.
5. There is duplicate content of object types, attributes, and the Schemas Administrator's Guide.
Solution:
· Delete the screen snapshots.
· Change the detailed description of the action sequence when creating an attribute list value to the following functional description:
· Use the Go to Object Type function to move to the object type from the object type instance.
· Select the attribute value that should be added.
· Make sure the attribute is of the List type.
· Add a new value.
· Give references to object typoes, attributes, and the Schemas Administrator's Guide with the detailed description of attribute creation process.
After
[image: ]
[bookmark: scroll-bookmark-115]Example 2. User Problem – How to open a report in Excel?
From the Netcracker Reports User Guide: The underlined paragraph 6, "Excel 2003" lines, and screen snapshots show a tendency to describing presentation layer.
[image: ]
Problems:
1. Excel 2003. Simple changing of Excel 2003 to 2011 (or deleting the year) would require changes in 3 places in the text and 1 screen snapshot.
2. Web browser. The real behavior in all types of browsers, including Mozilla, Chrome, Safari, and IE, has not been tested. Therefore, to describe this presentation layer in detal potentially means extra effort for mandatory documentation updates in case of new browser versions and behavior.
Solution:
· Rewrite the text. Provide a functional description of the feature and capabilities.
· Delete the screen snapshot because it is excessive and unnecessary.
· Exclude the detailed description of steps in the interface.
· Reduce the sequence of actions in the interface to minimal sufficient information so that a user can understand where the necessary function is located.





[bookmark: scroll-bookmark-113]User Problem Centric
https://bass.netcracker.com/pages/viewpage.action?pageId=249206401

	Rule 1
Good documentation is user problem centric.
The documentation should tell a potential user how to solve a specific task, or answer a specific, practical how-to question.


A simplified example of this type of documentation is Frequently Asked Questions.
An example of the approach:
Do not focus on the list of all possible values of a specific parameter, as the design specification is intended for this. Give a link to the reference topic at the end of the guide. Give the user an opportunity to open the guide, look through the Table of Contents, use the Search function, or find the appropriate task in a title, and get a prompt on the parameter value to be specified in the process of the task solution.
To create the task list, use the training materials stored at SPS3, use cases, documentation, and business analyst advice, and study the Netcracker Sales, Product Marketing, and Product Management brochures.


	Rule 2
Describe tasks of all levels in the documentation. Besides the step-by-step guidance through the system interface, include the tasks of the higher level.
Detailed UI steps should not be the the only description method of the task resolution in the documentation.



	Rule 3
Do not take the content from a Functional Design Specification and fill it with screen snapshots.



	Rule 4
Use at most one user interface screen snapshot for 3 pages of text. Graphics can be used more frequently, if necessary.


[bookmark: scroll-bookmark-116]Document Conventions

	Read This First
http://www.prismnet.com/~hcexres/textbook/high.html


[bookmark: scroll-bookmark-117]Highlighting Scheme
	Item
	Highlighting Style
	Examples

	Parameter names as the object's properties (do not confuse with parameter field labels on screen)*
	Cap style on screen (how you see words capitalized right on the screen).
The first instance of a parameter name can be optionally italicized. The next instances are never emphasize.
N.B.! The guideline is usually applied to narrative text.
	First instance of parameter name in a document:
The Status parameter specifies the state of an account's lifecycle.
Next instance of parameter name in a document:

The Status parameter can take the values as listed below.


	Field labels
	Cap style on screen; bold
N.B.! The guideline is usually applied to step-by-step instructions for users working with UI.
	· In the Name edit box, type the name of the process.
· From the Rescheduling Strategy drop-down list box, select the necessary value.


	Field group labels
	Cap style on screen
	In the Common Parameters group, specify the value you need in the corresponding field.

	Dialogs (boxes)
	Cap style on screen; regular body text
	The New Site dialog is displayed.

	UI tables, UI table columns, widget sections
	Cap style on screen; bold
	The Report table
The Description parameter
The Site column

	Attribute schemas
	Cap style on screen; regular body text
	The Designer attribute schema is inherited from the attribute schema Root.

	Objects
	Cap style on screen; regular body text
	Open DHL Inventory project.
Open Cisco Switch A device to configure its ports.

	Objects, when referred to as link
	Cap style on screen; regular body text; quotes
	Click "Site A."

	Variable in object hyperlink
	Cap style on screen; regular body text
	Click CLLI "site A" site.

	Drop-down list values
	Cap style on screen; regular body text; quotes
	Select "New" from the Status drop-down list box.

	Hyperlink, when underlined
	Cap style on screen; regular body text; quotes
	In the quick links area, click "Export to PDF."

	The "Browse..." item in pop-op
	Cap style on screen; regular body text; quotes
	in the reference selector pop-up click "Browse."

	Navigation path when used as a browsing path
	Initial caps, bold
	Open the users and groups management tool. Browsing path is Navigation > Administrative Tool > Users and Groups.

	Breadcrumb hyperlink (single part of the navigation path string)
	Cap style on screen; regular body text; quotes
	· On the navigation path click "Circuits."
· Verify that the navigation path in the Reference Explorer windows displays "Inventory > Inventory Project > Cisco Switch A345B17."


	Object types, attributes (not parameters)
	Courier New; 1-point size smaller than body font. Monospace in Confluence.
	· Device object type
· The CLLI Code attibute can be found in the Designer attribute schema.


	Names of icons
	Cap style on screen; bold
	

	Buttons (or functional equivalent if not so labeled)
	Cap style on screen; bold
	Click New Site.

	Menus, menu commands, tabs
	Cap style on screen; bold
	· From the Navigation menu, select Inventory.
· Click the Circuits tab.


	Commands entered verbatim with no parameters or flags
	Bold
	Use the move command

	Text entered or displayed
	Courier New; 1-point size smaller than body font. Monospace in Confluence.
	In the Name edit box, type Show task header.

	XML tags
	Regular body text, angle brackets
	Normally, WorkManager name is specified inside <dispatch-policy> tag under <weblogic-enterprise-bean> tag in the weblogic-ejb-jar.xml descriptor.

	API, Java-code, XML, SQL variables shown in text (do not mix with names of object parameters – see the next row!)
	Italics; regular body text
	where accID is the account ID

	Object parameters
	Cap style on screen; regular body text
	Specify the custAccountID parameter value.

	Programming code
	Courier New; 1-point size smaller than body font; Monospace in Confluence, regular body text
	if i!=0 then { i++; }

	Labels on hardware
	Courier New; 1-point size smaller than body font; Monospace in Confluence, bold
	The serial number on the back of your device is shown as S/N xxxxxx.

	Database table names
	All caps; regular body text
	This key is stored in the NC_DIRECTORY table.

	Database table column names
	All caps; regular body text; table name included
	The values in the NC_WFRELATIONS.TYPE table column

	System file names, path/directory names, extension
	Bold
	The default logging level is set in the $NETCRACKER_HOME/nclog.properties file.

	Exact file name as it should be created
	Bold
	Create adapter_log.txt file.

	Java properties, classes, etc.
	Cap style as in code; regular body text
	By default, the com.netcracker.ejb.wf.engine.framework.DefaultEventDispatcher class is specified.




[bookmark: scroll-bookmark-118]Examples: Use of Italic and Bold
	Correct
	Incorrect

	For more information, refer to Netcracker Resource Inventory User Guide, "Textual User Interface."
	For more information, refer to Netcracker Resource Inventory, "Textual User Interface. User Guide."

	…refer to Netcracker Resource Inventory. (book title, see Cross-References)
…you should never click… (emphasis)
…the command:create command… (keyword or literal name)
…the objectName variable… (name of a variable)
…the attrID value… (name of a value used only for descriptive purposes in the document)
…NN is the number of channels…
	


[bookmark: scroll-bookmark-120]User Text

	Guideline 1
Use code style for text entered by user. Do not use double quotation marks for text entered by user.
Incorrect
In the Name edit box, type "Show task header."
Correct
In the Name edit box, type Show task header.



	Guideline 2
Use code style for example text to signal that an example rather than a required entry is being shown. Do not use double quotation marks for example text.
Incorrect
For example, if you want to copy a file, type "copy yourfile.txt myfile.txt." A file called "myfile.txt" will be created, and its contents will be the same as "yourfile.txt."
Correct
For example, if you want to copy a file, type copy ourfile.txt myfile.txt. A file called myfile.txt will be created, and its contents will be the same as yourfile.txt.
Notes:
1. If you show users how to enter a command including example text, do not bold the command that occurs in the example text.
Correct
Use the mv comand to change the name of location of a file: mv thisfile.txt thatfile.txt.
2. If you show users how to enter a command including example text, and include variables in the example text, use italics on the variables.
Correct
Use the mv comand to change the name of the location of a file: mv my_file.txt your_file.txt.



	Guideline 3
Use Monospace style for displayed text such as warnings or status codes or error messages. Do not use double quotation marks for displayed text.
Incorrect
If the directory does not exist, the system responds with "No such file or directory."
As the computer boots up, the digital read-out window displays "8888."
Correct
If the directory does not exist, the system responds with No such file or directory.
As the computer boots up, the digital read-out window displays 8888.



	Guideline 4
[bookmark: scroll-bookmark-121]Use code blocks for code samples when code is stored in a file
Correct
	#check for mean hackers
   if ($address1 eq "" & $address2 eq "")
   {
       &wicked_address (500, "Search Error", "Please enter a name.");
   } 
       elsif ($address1 =~ /[;<>&\*`\|]/ | $address2 =~ /[;<>&\*`\|]/) 
   { 
       &wicked_address (500, "Search Error", "Malformed e-mail address.
       Please do not destroy our poor, humble, one-vitual-room schoolhouse!."); 
   }



For more information of formatting code and computer terminal (console) text see Syntax, Code Samples, Console Text.



	Guideline 5
[bookmark: scroll-bookmark-123]Bolded Quotes, Colon, and Exclamation
If you use bold formatting for something inside quotation marks or followed by a colon, format the quotation marks or the colon in bold as well.
Correct
Parameter: (the colon is in bold)
…text "Text"… (the quotation marks are in bold)


[bookmark: scroll-bookmark-124]Document Naming Conventions
Ensure that the names of guides follow the document naming conventions.
The most common types of guides are as follows:
· User Guide
· Administrator Guide
· Developer Guide
· Installation Guide
· Maintenance Guide
· Troubleshooting Guide
All guides should have the word "Guide" appended to the end of the document name.
[bookmark: scroll-bookmark-125]Quick Phrase Reference
	This section lists phrases for the most widespread tasks. Use these phrases in your documents.



Creating Objects

	Case 1
the object-creating dialog contains the [image: ] button, use the following phrase to describe the functionality provided with the button:
1. …
2. In the Name edit box, type the name for the new […].
Note To create several [...] at the same time or name them by using a naming convention, click [image: ] and specify values in the Number, Delimiter, Length, Start From, and Naming Convention edit boxes. For more information on creating several objects simultaneously, refer to Netcracker User's Guide, "Text Navigation Mode."
3. ...




	Case 2
If an object-create button on the toolbar is supposed to launch creating objects of different types, e.g., different kinds of circuits, then use the following textual construction with a screenshot:
Example:
On the toolbar, expand Create Circuit and then click Create MPLS Tunnel.
[image: ]
It is sufficient to illustrate such kind of action with one screenshot per document.
The screenshot must be of minimal size; only the button and the expanded list (or part of it) are to be captured. If the list is too big, crop part of it before inserting the image in the document.
The screenshot must comply with the common requirements to the figures as stated in Illustrations.


Check boxes and Other Selections
Select the check box. Clear the check box.
Select the check box to the left of the Cisco 1534 device.
Clear the check box to the left of the Cisco 1534 device.
Select the DTM2 card. (not radio button)
Pages - Displaying/Reloading/Redisplaying
… the page is redisplayed.
... the page reloads.
... the page is updated.
Menus
From the Navigation menu, select Administrative Tools.
On the Navigation menu, point to Administrative tools, and then click Types & Schemas.
On the Operations menu, click History.
From the Operations menu, select History.
In the workspace, right-click on the device, and then select Properties from the menu.
Click Search on the menu bar.
Click Help on the menu bar.
Use select to activate a menu item or an option. Menu items should be separated by single > symbols, with a space before and after each symbol. For example:
· 
· Acceptable: Select File > Import.
Drop-down List Boxes
From the Interface drop-down list box, select "DS1".
From the Type drop-down list box, select "MW Radio Unit" located in the Wireless Devices group of device types. To expand the group, click "+".
Use select to activate a drop-down list.
· Acceptable: Select Cellsite/Cellface definitions from the drop-down list.
· Not acceptable: Select the Cellsite/Cellface definitions item from the drop-down list.
Fields and Edit Boxes
In the Name edit box, type…
In the Parameter field, specify…
In the Font combo box, specify…
Permissions
If you define List permission …
… to allow or deny List permission, click the appropriate check box.
Defining permissions …
The user is denied the permission.
To define permissions for objects …
Reference Explorer
Use the following phrase to describe the appearance of the Reference Explorer window:
The Reference Explorer window is displayed.
Reference Selector Pop-Up
Use the following phrase to describe specifying the value of a reference parameter by using the Reference Selector:
1. …
2. In the <…> field, specify […] by using the reference pop-up selector or Reference Explorer.
For information about the reference pop-up selector and Reference Explorer, refer to Netcracker User's Guide, "Text Navigation Mode."
3. ...
If several steps in the topic require the Reference Selector usage, the phrase should be specified only once after the first mentioning of the Reference Selector in the topic.
In-Place Editing
Use the following phrase to describe how to begin editing values in-place:
Point to the cell and click the displayed [image: ] button.
Note Make sure to replace this button icon with the actual button icon from the interface, if they are not the same.
Specifying Objects
Object to add/edit/modify/…
Object to be added/edited/modified/…
Object you want to modify/add/edit/…
Use the same form with plurals:
Objects to add/edit/modify/…
Navigating to Objects
Navigate to Navigation > Administrative Tool > Users and Groups.
	In this example, the navigation path should be interpreted as simply a browsing path, and is bolded. When referring to a breadcrumb hyperlink, it should be put within quotes. Examples:
Open the users and groups management tool (browsing path Navigation > Administrative Tool > Users and Groups).
Click "Device 1" on the navigation path.
Check that the navigation path in the Reference Explorer windows displays "Inventory > Sample Project > Site 1 > Device 1."


Date Format
Use the following notation: day (dd), month (MM), year (yyyy), hours (hh) and minutes (mm).
…the standard US format of MM/dd/yy.
Enter the date (MM/dd/yyyy) for which you want to search or select a date from the calendar.
date in dd/MM/yyyy format.
[bookmark: scroll-bookmark-127]On-Screen Instructions Wording
The following phrases should be used when referring to on-screen instructions:
· Use click to activate a button, rather than click on. The button name does not require the word button as a qualifier. For example:
· Acceptable: Click OK or press ENTER to continue.
· Not acceptable: Click on the OK button or press the ENTER key to continue.
· Use the forms: On the Bookmarks tab, select Generate PDF Bookmarks. and On the Links tab, clear Create Named Destinations for All Paragraphs.

· Option buttons should be clicked. The term radio button should not be used.

· A menu button (a down arrow after the button name, found primarily in Rating and Billing user interfaces) should be clicked. For example:
· Click Subscription functions, and select Configure services.
· Typically, Web-based user interfaces have a navigation pane on the left. This should be referred to as a hierarchical tree. The structure within the tree should be called a menu, and the items within the tree should be referred to as menu items. Menus/menu items are selected. Root node and nodes are also acceptable terms for the items within a menu.

· The following forms should be used to indicate a selection:
· Start Customer Account Maintenance.
· Click the Payments tab.
· Browse to the *X:* drive.
· Click the Account Payments subtab.
· The following forms should be used to indicate actions:
· Close (not Exit) a window.
· Exit a user interface or system process.
· Items should be referred to as being:
· on the taskbar
· on a window; on a page
· on a tab or subtab
· in a dialog
· in a table
· in a view
· on a toolbar.
· under a group box. In this case, specify the group box name and omit the words group box. For example, … under Product Details, enter …

· 
· in/into the system
	The list below shows words that are often used incorrectly or are not recommended for use.


	Do Not Use
	Instead Use
	Examples and Conventions

	as shown on the picture
	as shown in the picture
	The Inventory object is presented, as shown in the preceding picture.

	on the workspace
	in the workspace
	The new Event-Start activity is displayed in the workspace.

	in the toolbar, click
	on the toolbar, click
	On the toolbar, click New Project.

	in the menu, click
	on the menu, click
	On the Activation menu, click Activate.

	in the menu, select
	from the menu, select (or choose)
	From the Navigation menu, select Process Management.

	place to
	place in
	Place the file in the folder.

	put to
	put in
	Put the file in the folder.

	on step X
	in step X
	In the following steps below, you will replace the device with cards being moved.

	in the tab
	on the tab
	On the My Profile tab, click Edit.

	on the table
	in the table
	Edit the Name value in the table.

	on the pane
	in the pane
	To expand or collapse the tree, click the button in the navigation tree pane.

	at the status bar
	in the status bar
	An additional type is "Status bar" for messages that are displayed in the status bar of the window.

	on the list
	in the list
	… the option is available in the list …

	in place, inplace
	in-place
	To switch to the in-place editing mode, click …

	aimed to support
	aimed at supporting
	It is a Netcracker Framework component extension aimed at supporting Oracle Weblogic (WL) Application Server.

	click on the Add button
	click Add (or rarely, "click the Add button", NOT "click Add button"). Skip on and put the if you use the word button.
	To create a new user, click Add.

	drag and drop the object to
	drag the object to
	drag the JPG file to the Image field

	allow
	Avoid this word. Use "can", "enables", "provides", "it is possible to".
	A user can perform an operation ...
A user is enabled to set up the profile settings ...

	it’s
	it is
	Rule: Short forms are disallowed.

	doesn’t
	does not
	Rule: Short forms are disallowed.

	whole
	complete, entire
	The entire set of values …

	ascribe
	assign, specify for
	Assign an alias to the ...
The value specified for the Group parameter …

	necessary, required
	your (only in steps); see also "Specifying objects."
	To update your password, type the new value in the …

	differing
	different from
	The value that is different from the current one

	edit mode
	editing mode ("in the editing mode")
	In the editing mode, type ...

	drill down
	open, navigate to
	Navigate to the UI Themes from ...

	independent on, irrespective
	regardless of
	Regardless of the object type, the current object belongs to …

	similarly, in a similar way
	likewise
	Likewise, specify the following parameters: …

	correspondent
	corresponding
	... the options corresponding to the mode …

	children types
	child types
	The Residential Customer Account is a child object type of the Customer Account object type.

	it is necessary that you do this
	it is important that you do this
	It is important that you specify the following parameters:

	в отличие от
	unlike
	In-place editing mode enables a user to make changes directly in the table, unlike the ordinary editing mode, supplying a special dialog ...

	web, web page, web interface, web browser
	Web, Web page, Web interface, Web browser
Exceptions: web-centric, webcam, webcast, webmaster, webzine.
	Rule: Do not forget to capitalize the word “Web”.

	internet
	Internet
	Rule: Do not forget to capitalize the word “Internet”.

	sub interface, sub-interface
(-connector, -flow, -type)
	subinterface (subconnector, subflow, subtype)
In general, do not hyphenate words beginning with sub, such as subheading and subsection, unless it is necessary to avoid confusion or sub is followed by a proper noun, as in sub-Saharan.
	Rule: Do not hyphenate words beginning with “sub” unless it is necessary to avoid confusion.

	№
	Skip, replace with words (‘number’), or use ‘#’ if absolutely necessary.
	Rule: Do not use the “№” symbol.

	MS
	Microsoft
	Rule: Do not use an abbreviation of the word “Microsoft."

	optionally (in non-mandatory procedure steps)
	if necessary
	Specify the Work Phone parameter, if necessary.

	colour
	color
	Rule: Use the American spelling.

	modelling
	modeling
	Rule: Use the American spelling.

	zeroes
	zeros
	Rule: Use the American spelling.

	in order to
	to
	Navigate to the Parameters tab to specify …

	using
	by using
	Set up the date by using the Calendar button.

	scheme, schemes
	schema, schemas
	Rule: Use the words schema and schemas.

	variant
	type of, mode OR case, option, revision
	Weblogic Embedded is a type of Weblogic implementation for Netcracker.
Another option of setting up the Name is to enter the in-place editing mode.

	document (as concerning to a network)
	capture, represent
	· Optical distribution frames in Resource Inventory are represented with an object of type ODF.
· The Solution will allow you to capture (not document) the operational status of production network equipment.


	populate the parameters
	fill in the parameter / fill out the parameters, enter the parameter value, specify the parameter value
	Rule: When using the "fill in" / "fill out" constructions in project documentation, consider the language specifics of the customer's country. "Fill out" is the American English usage of the term, whereas "Fill in" is the British English version of it. After deciding which construction to use, make sure that it is consistent through all of the documentation kit.

	targeted for
	targeted to
	

	e.t.c., etc, et.c.
	in running text: "and so on"
in parentheses: "etc."
	

	i.e.
	in running text: "that is" (put a comma after or set off phase)
in parentheses: "i.e."
	Rule: If "that is" is at the beginning of a sentence, put comma after it.
If "that is" is in the middle of a sentence, do not use a comma after "that is" but use commas to set off the whole phrase. That is, "The vendors, that is Cisco and 3Com, provide routers with multi-protocol capabilities".

	e.g.
	in running text: "for example" (put a comma after or set off phase)
in parentheses: "e.g."

	Rule: If "for example" is at the beginning of a sentence, put comma after it.
If "for example" is in the middle of a sentence, do not use a comma after "for example" but use commas to set off the whole phrase. For example, "Many vendors, for example Cisco and 3Com, provide routers with multi-protocol capabilities".

	grayed, dimmed
	unavailable, disabled
	

	administrating
	administering
	

	enumerates (the tab enumerates parameters)
	displays (the tab displays parameters)
	

	save changes
	save the changes (or save your changes)
	

	situated
	located or skip this word at all
	

	appears, this opens, is opened, is shown when applied to a page, tab, or dialog
	is displayed
	

	context menu, popup menu, dropdown menu
	menu (for ALL menus)
Use the word context ONLY when it is not clear which menu the user should select the command from. Do not use context when you use right-click.
	

	Ok, ok
	OK
	

	distributive
	distribution
	Go to the folder where you unzipped the CLI distribution.

	mandatory, required
	required (parameters)
	Parameters. Applies to design documentation only.

	perform settings
	make settings
	Other settings of the Recent menu, for example, the number of recent objects to display for all users, are made by administrators.

	repeated (в значении "повторный")
	repeat
	The customer personnel can attend repeat training.

	see, refer to
	look for the guideline in See or Refer To
	


[bookmark: scroll-bookmark-128]On-Screen Items Usage in Instructions
The following standards should be used when referring to on-screen instructions.
	Item
	Usage

	Check boxes
	You select or clear a check box. A check box is referred to as selected or cleared. Check box names are shown in bold font. For example, On the Bookmarks tab, select Generate PDF Bookmarks, or On the Bookmarks tab, select the Generate PDF Bookmarks check box.

	Click
	Use click to activate a button, not click on. The button name does not require button as a qualifier. Acceptable: Click OK to continue. Not acceptable: Click the OK button to continue.

	Combo boxes
	A combo box is a dialog option that is a text box with an attached drop-down list. Combo box names are shown in bold font. See also drop-down list.

	Cursor Pointer
	Use cursor to indicate the I-shaped icon. Use pointer to indicate the arrow icon.

	Dialog
	A dialog contains command buttons and various options through which a user enters information or performs a further task. Refer to a dialog, not to a dialog box. Items are in a box. Dialog names are shown in normal font, not bold. See also message box.

	Drives
	You browse to a drive, as in Browse to the *X:* drive. Drives are shown in bold font.

	Drop-down lists
	Drop-down list names are shown in bold font.

	Group boxes
	The term group box should not be used. Use panel instead – see panel for details.

	Keystrokes
	Use press to indicate the use of a key on the keyboard. The key name does not require key as a qualifier. Key names are shown in uppercase. Use + to indicate the use of multiple keys, for example, CTRL+ALT+DEL. Acceptable: Press ENTER to continue. Not acceptable: Press the ENTER key to continue.

	List boxes
	A list box is dialog option, with an up-and-down scroll bar, containing a list of items the user can select. List box names are shown in bold font.

	Menu bars
	Items are on a menu bar. Menu bar names are shown in bold font.

	Menu buttons
	A menu button is a down arrow after the button name, found primarily in Rating and Billing Manager user interfaces. You click a menu button. Menu button names are shown in bold font. For example, Click Subscription functions, and select Configure services.

	Menu items
	You select a menu item, option, or drop-down list. Chains of menu selections should be separated by single > symbols, with a space before and after each symbol. Menu items are shown in bold font. Acceptable: Select File > Import, or Select Cellsite/Cellface definitions from the drop-down list. Not acceptable: Select the Cellsite/Cellface definitions item from the drop-down list.

	Menus
	Menu names and items within menus are shown in bold font. A menu that is displayed by right-clicking is a pop-up menu (see definition).

	Message boxes
	A message box is a secondary window that presents a user with an informational, warning, or error message. Message box names are shown in normal font.

	Option buttons
	Do not use the term radio button. You click an option button. Option button names are shown in bold font. For example, Click Tax Inclusive, or Click the Tax Inclusive option button.

	Pages
	Items are on a page.

	Panels
	Items are in a panel. Do not use group box. Panel names are shown in bold font. Refer to items as being either in the Panelname panel or under Panelname.

	Pop-up menus
	A pop-up menu is a menu that is displayed by right-clicking. Pop-up menu names are shown in bold font.

	System
	Items are in the system, or are entered into the system.

	System processes
	You start or exit a system process.. System process names must be expressed in full, not using acronyms. System process names are shown in normal font. The words system process are not required. For example, Start the Active Rating Engine.

	Tabs and subtabs
	Do not use tab page. A tab within a tab is a subtab. Items are on a tab or subtab. Tab and subtab names are shown in bold font. You click a tab or subtab to select it, as in Click the Payments tab.

	Tables
	Items are in a table. Database table names and column names are shown in uppercase.

	Taskbar
	Items are on the taskbar.

	User interfaces
	You start or exit a user interface, as in Start Customer Account Maintenance. User interface names are shown in normal font. The words user interface are not required. Do not use the abbreviation UI.

	Views
	Items are in a view. You select a view to open it. View names are shown in bold font.

	Web-based user interfaces
	Typically, these have a navigation pane on the left. This should be referred to as a hierarchical tree. The structure within the tree should be called a menu, and the items within the tree should be referred to as menu items. You select menus/menu items. Root node and nodes are also acceptable terms for the items within a menu.

	Windows
	Items are on a window. You open a window and close a window. Refer to an active/inactive window, not an enabled/disabled window. Window names are in normal font.


[bookmark: scroll-bookmark-129]Netcracker Dictionary
[bookmark: scroll-bookmark-130]Avoid

	Gudieline 1
Do not use the wording "the system." The phrasing can be replaced either with another actor, or with indefinite expression.
Incorrect
The system allows to implement a set of prefigured sales process stages and actions which support the means of measuring and evaluating the current sales processes handled by each sales agent.
Correct
A set of prefigured sales process stages and actions supports the means of measuring and evaluating the current sales processes handled by each sales agent.
Incorrect
The system provides a user with the ability to a activate or deactivate the notification profile.
Correct
Notification profile can be activated or deactivated.



	Gudieline 2
Do not refer to the other Netcracker versions (previous, current, next, or future) in a document text. An exception to this rule is if you need to refer to a previous release of the product in release notes or an upgrade guide.



	Gudieline 3
Do not use the words "module" and "component" in user documentation.
For the word "component" the rule can be ignored when talking about system troubleshooting or maintenance tasks administrator's and developer's documentation..

	Never use phrasing like Retentions Management is the component of Netcracker Customer Problem Management module. Never mention a component membership in a module. Netcracker components can migrate between modules.






	Gudieline 4
Do not use the word "customer." Avoid it, or specify that this is Netcracker customers you are referring to, for example "that Netcracker can provide to its customers." Otherwise our clients may think you mean their customers.


[bookmark: scroll-bookmark-131]Replace
	Do not use
	Instead use

	Administrator
	administrator (use lower case as in common nouns)

	applet (when meaning the Network Configurator)
	the Network Configurator

	applet (when meaning the Workflow Configurator)
	the Workflow Configurator

	attribute schemas tree
	Attribute Schemas tree

	behaviour
	behavior

	catalogue
	catalog

	define grant
	specify grant (grants are always specified)

	demo
	demonstration

	info
	information

	generative attribute, generating attribute
	rendering attibute, attribute rendering smth, attribute that makes the application render smth, ...

	List grant, Read grant …
	List permission, Read permission …

	log into, log in, log to
	log on to

	log out
	log off the

	multilanguage
	multilingual, multi language

	Network Inventory
	Resource Inventory

	Network Configurator applet/window, Netcracker Configurator
	the Network Configurator

	OOB, out of the box, out-of-the-box
	immediately available, preconfigured, Netcracker preconfigured, standard application, standard application's, by default, default configuration, default setup, default settings

	objects hierarchy
	object hierarchy

	object types tree, object type tree
	Object Type tree

	reference explorer
	the Reference Explorer window

	reference selector pop-up
	the reference selector pop-up

	OSS engine
	Netcracker Framework

	Product (when referring to NC TOMS Suite products—Order Management, Service Inventory, and so on)
	Module

	specify permission
	define permission (permissions are always defined or granted)

	stored in the table
	The rule is applicable for UI widgets only, not for DB tables!



	listed in the table

	System Administrator
	system administrator (use lower case)

	Text Navigation mode, textual navigation mode
	the text navigation mode (or, rarely, browser mode)

	The Netcracker
	Netcracker

	user desktop, User desktop
	User Desktop

	Workflow Configurator applet/window, Workflow Configurator
	the Workflow Configurator

	Wifi, wifi, Wi-fi, wi-fi
	Wi-Fi
Use this form regardless of where the word appears in a sentence.


[bookmark: scroll-bookmark-132]Netcracker User Interface


[bookmark: scroll-bookmark-133]UI 9.3 Quick Reference

	Note
This page provides customer-facing names of the Netcracker UI elements. For Netcracker developer-facing names of UI elements, refer to the Harvard document.


The Netcracker TOMS user interface comprises graphical elements that are demonstrated in the figures below.
[bookmark: scroll-bookmark-134]1. User Interface Layout
[image: ]
[bookmark: scroll-bookmark-135]2. Standard Parameters Tab Layout
[image: ]
[bookmark: scroll-bookmark-136]3. Navigation Tree
[image: ]

[bookmark: scroll-bookmark-137]4. Orchestrator
[image: ]

[image: ]

[bookmark: scroll-bookmark-138]5. Network Configurator Interface Elements
[image: ]




[bookmark: scroll-bookmark-139]UI 9.3 Elements Names

	Note
This page provides customer-facing names of the Netcracker UI elements. For Netcracker developer-facing names of UI elements, refer to the Harvard document.



	Harvard vs. Cambridge
[bookmark: scroll-bookmark-140]The Harvard theme (this theme) is associated with Netcracker 9.0 and 9.3 BSS domain products. The Harvard theme is a vertical layout of tabs on the left side of a page.
[bookmark: scroll-bookmark-141]The Cambridge theme is associated with Netcracker 9.0 and 9.3 OSS domain products. The Cambridge theme is a horizontal layout of tabs on top of a page.
For information about the NetCracke modules classification, see Which UI Theme to Use .



	Important!
· [bookmark: scroll-bookmark-143]Do not mix different themes in one document.
· [bookmark: scroll-bookmark-144]Do not describe the two ways – Harvard and Cambridge – of performing the same operation in one document. Decide which Netcracker release your document relates to and use the proper wording.



[bookmark: scroll-bookmark-145]
[bookmark: scroll-bookmark-146]Quick Navigation: Check box Edit box Drop-down list box Section Table Parameter field Multiple parameter field Date field Navigation menu Quick create menu Search menu Others menu Tabs panel Navigation path Tab Toolbar Reference selector box Reference selector pop-up Reference Explorer window New object dialog Edit dialog In-place editing Navigation tree Required parameter field Account profile Panel Table Scheduler toolbar Scheduled tasks toolbar Tasks pane Processes pane Task list Gantt chart

[bookmark: scroll-bookmark-147]Check box
[image: ]




Intended for setting Boolean parameters.
Example: Select the check box next to the Business Order Entry Inventory project.
[bookmark: scroll-bookmark-148]Edit box
[image: ]


Example: In the Description edit box, type Here is a description of the...
[bookmark: scroll-bookmark-149]Drop-down list box

[image: ]


Example: From the Status drop-down list box, select "Planned."
[bookmark: scroll-bookmark-150]Parameter field
[image: ]


Intended for setting string parameters.
Example: In the First Name parameter field, type Garry.
[bookmark: scroll-bookmark-151]Multiple parameter field
[image: ]





The multiple parameters are used to store several values for a single multiple parameter. Examples:
· To add a phone number to the Phone Number multiple parameter field, enter the phone number according to the input mask, and click Add value.


· To delete a phone number, click the item to be deleted in the Phone Number multiple parameter field, and click Delete value.


· To delete all the values from the Phone Number multiple parameter field, click Clear all.
Buttons:
[image: ] Add value
[image: ] Delete value
[image: ] Clear all


[bookmark: scroll-bookmark-152]Date field
[image: ]

Intended for specifying the date parameters. Example:
The Warranty Start Date field format is MM/dd/yyyy. Use the Calendar button to quickly select a date.
Buttons:
[image: ] Calendar
[image: ] Delete

[bookmark: scroll-bookmark-153]Navigation menu
Figure 1 Navigation Menu
[image: ]

Examples:
· From the Navigation menu, select ...
· Inventory can be found in the Navigation menu.
· On the Navigation menu, click Sales Management.
[bookmark: scroll-bookmark-154]Recent menu
Use the same rules as applied to the Naviagion menu.


Example:
The Netcracker application enables users to configure the Recent menu by specifying the types of objects to be tracked in the menu as recently visited. Other settings for the Recent menu, for example, the number of recent objects to display for all users, are specified by administrators
[bookmark: scroll-bookmark-155]Quick Create menu
[image: ]


Examples:
· From the Quick Create menu, select ...
· Opportunity can be found in the Quick Create menu.
· On the Quick Create menu, click Opportunity.
[bookmark: scroll-bookmark-156]Search menu
[image: ]


Examples:
· From the Search menu, select ...
· In the Search menu box, type the CLLI number to quickly find a site by CLLI. (note box)
· On the Search menu, click Generic Search.
[bookmark: scroll-bookmark-157]Others menu
[image: ]


Examples:
· From the Others menu, select ...
· On the Others menu, click Reports.
· Reports can be found in the Others menu.
[bookmark: scroll-bookmark-158]Tabs panel
[image: ]

Configurable buttons on the tabs panel in the Harvard (9.3) theme are displayed as links in the quick links area in the Cambrige (9.0) theme. Examples:
[bookmark: scroll-bookmark-159]Harvard (this theme):
· On the tabs panel, click Change Owner.
· The Put on Hold button can be found on the tabs panel.
· Click Cancel on the tabs panel.
[bookmark: scroll-bookmark-160]Cambridge:
· In the quick links area, click "Change Owner."
· Click "Put on Hold" in the quick links area.


	Important!
· Do not mix different themes in one document.
· Do not describe the two ways – Harvard and Cambridge – of performing the same operation in one document. Decide which theme your document relates to and use the proper wording.



[bookmark: scroll-bookmark-161]Navigation path
[image: ]



Example: On the navigation path, click "Inventory."
[bookmark: scroll-bookmark-162]Tab
[image: ]


Example: Click the Circuits tab.
[bookmark: scroll-bookmark-163]Toolbar
[image: ]


Example: On the toolbar, click New Site.
[bookmark: scroll-bookmark-164]Pop-up dialog
[image: ]

Example: In the New Lead pop-up dialog, fill in the Name parameter field and click Create.
Note! Never describe the Cancel button, or "cancel" link, as they are self explanatory.
[bookmark: scroll-bookmark-165]Reference selector box
	[image: ]



	[image: ]



Examples:
· In the reference selector box, start typing the name of the object you need to insert as a value. You will be prompted a list of values beginning with the symbols you type. Select the necessary one.
· To expand the total list of the referred objects in the reference selector box, click Alt.
[bookmark: scroll-bookmark-166]Reference selector pop-up
[image: ]

The reference selector allows users to select the object to be referred to by:
· Choosing the needed object from the list of objects
· Searching for the needed object by its name
· Setting the reference to this object via the Reference Explorer window
Examples:
· In the reference selector pop-up, type the necessary value.
· To find the necessary value, place the cursor in the reference selector pop-up and click "Browse." The Reference Explorer window is displayed.
[bookmark: scroll-bookmark-167]Reference Explorer window
[image: ]


Example: In the Reference Explorer window, select the items you need, and click Select.
[bookmark: scroll-bookmark-168]New object dialog
[image: ]


Example: In the New Inventory Project dialog, fill in the parameters ...
[bookmark: scroll-bookmark-169]Edit dialog
[image: ]


Example: In the Edit Circuit Folder dialog, update the parameters ...
[bookmark: scroll-bookmark-170]In-place editing
[image: ]

The in-place editing button turns on the in-place editing mode.
Example: In the in-place editing mode, update the parameter value.
[bookmark: scroll-bookmark-171]Navigation tree
[image: ]


The navigation tree is displayed by clicking the slider button.
Example: On the navigation tree, navigate to ...
Buttons:
[image: ] Slider
[image: ] Level Up
[image: ] Refresh
[image: ] Level Down

[bookmark: scroll-bookmark-172]Required parameter field
[image: ]


The mandatory fields are marked with a red asterisk.
Note! Do not use the words "mandatory" or "required."
Example: From the Physical Status drop-down list box, select "..."

[bookmark: scroll-bookmark-173]Account profile
[image: ]


Use "account profile" for a Netcracker widget for vizualizing a user avatar and profile information. Do not use the word "widget" itself.
Example:
· In the Residential Customer account profile, locate and change the user picture.
[bookmark: scroll-bookmark-174]Panel
[image: ]

Use "panel" for a Netcracker widget vizualizing panel. Do not use the word "widget" itself.
Example:
· Click Search on the Marketing Campaign Search panel.
[bookmark: scroll-bookmark-175]Table
[image: ]
Use "table" for a Netcracker widget vizualizing table. Do not use the word "widget" itself.
Examples:
· In the Marketing Campaign table, select the check box for Global Awareness Marketing Campaign.
· Navigate to the Marketing Campaign table and click New Marketing Campaign on the toolbar.
[bookmark: scroll-bookmark-176]Scheduler toolbar
[image: ]


Examples:
· On the Scheduler toolbar, click Refresh to refresh the window display.
· Use the Display Attribute Customization button to configure which task parameters are shown in the Gantt Chart view.

[bookmark: scroll-bookmark-177]Scheduled tasks toolbar
[image: ]

Example:
· Select a task in the Task list or on the gantt chart before you use the create, copy, delete, link or sort buttons on the sheduled tasks toolbar .


[bookmark: scroll-bookmark-178]Tasks pane
[image: ]
[bookmark: scroll-bookmark-179]Processes pane
[image: ]


Examples:
· Click the Tasks pane to display all task templates found in the Process Orchestration Templates, grouped by folders.
· Click the Processes pane to display all process templates found in the Process Orchestration Templates, grouped by folders.


[bookmark: scroll-bookmark-180]Task list
[image: ]

Examples:
· In the task list, click the task to edit.
· In the task list, double-click on the task to open the Update Task window.

[bookmark: scroll-bookmark-181]Gantt chart
[image: ]

Example:
· On the gantt chart, click a task to view the process or process template's current schedule formed by tasks, their dates, durations, and dependencies.

[bookmark: scroll-bookmark-182]UI 9.0 Quick Reference
The Netcracker TOMS user interface comprises graphical elements that are demonstrated in the figures below.
[bookmark: scroll-bookmark-183]1. User Interface Layout
[image: ]
[bookmark: scroll-bookmark-184]2. Standard Parameters Tab Layout

[image: ]
[bookmark: scroll-bookmark-185]3. Navigation Tree
[image: ]

[bookmark: scroll-bookmark-186]4. Network Configurator Interface Elements
[image: ]
[bookmark: scroll-bookmark-187]UI 9.0 Elements Names

	Harvard vs. Cambridge
The Cambridge theme (this theme) is associated with Netcracker 9.0 and 9.3 OSS domain products. The Cambridge theme is a horizontal layout of tabs on top of a page.
The Harvard theme is associated with Netcracker 9.0 and 9.3 BSS domain products. The Harvard theme is a vertical layout of tabs on the left side of a page.



	Important!
· Do not mix different themes in one document.
· Do not describe the two ways – Harvard and Cambridge – of performing the same operation in one document. Decide which Netcracker release your document relates to and use the proper wording.




Navigation menu
[image: ]
Examples:
1. From the Navigation menu, select ...
2. Inventory can be found in the Navigation menu.
3. On the Navigation menu, click Activation.

Navigation path string
[image: ]
Example: On the navigation path string, click "Inventory."
Search menu
[image: ]
Examples:
1. From the Search menu, select ...
2. On the Search menu, type the name of the ...
3. On the Search menu, click Generic Search.

Operations menu
[image: ]
Examples:
1. From the Operations menu, select ...
2. On the Operations menu, click Reports.
3. Reports can be found on the Operations menu.

Tab
[image: ]
Example: Click the Circuits tab.
Toolbar
[image: ]
Example: On the toolbar, click New Site.
Reference selector box
	[image: ]
	[image: ]


Examples:
1. In the reference selector box, start typing the name of the object you need to insert as a value. You will be prompted a list of values beginning with the symbols you type. Select the necessary one.
2. To expand the total list of the referred objects in the reference selector box, click Alt.
Reference selector pop-up
The reference selector allows users to select the object to be referred to by:
· Choosing the needed object from the list of objects
· Searching for the needed object by its name
· Setting the reference to this object via the Reference Explorer window
[image: ]
Example:
1. In the reference selector pop-up, type the necessary value.
2. To find the necessary value, place the cursor in the reference selector pop-up and click "Browse." The Reference Explorer window is displayed.
Reference Explorer window
[image: ]
Example: In the Reference Explorer window, select the items you need, and click Select.
Drop-down list box
[image: ]
Example: From the Status drop-down list box, select "New."

Edit box
Intended for setting up the text parameters.
[image: ]
Example: In the Description edit box, type Here is a description of the...
Parameter field
Intended for setting the string parameters.
[image: ]

Example: In the First Name parameter field, type Natalia.
Multiple parameter field
The multiple parameters are used to store several values for a single multiple parameter,
[image: ]
Examples:
To add a phone number to the Phone Number multiple parameter field, enter the phone number according to the input mask, and click Add value. 
To delete a phone number, click the item to be deleted in the Phone Number multiple parameter field, and click Delete value.
To delete all the values from the Phone Number multiple parameter field, click Clear all.

Buttons:
[image: ] Add value
[image: ] Delete value
[image: ] Clear all
Check box
Intended for setting Boolean parameters.
[image: ]
Example: Select the check box to the left (right) of Empty Proj.
Date fieldIntended for filling in the date parameters.
[image: ]
Examples:
1. To set up a date, do one of the following:
a. Click Calendar to the right of the date field, and select and click a date in the calendar.
b. Type the date in the date fields according to the MM/dd/yy mask.

2. To clear the date, click Delete to the right of the date fileld.
Buttons:
[image: ] Calendar
[image: ] Delete
Required parameter field
The mandatory fields are marked with a red asterisk.
[image: ]
Example: From the Physical Status drop-down list box, select "..."
Note! Do not use the words "mandatory" or "required."
New Object dialog
[image: ]
Example: In the New Inventory Project dialog, fill in the parameters ...
Edit dialog
[image: ]
Example: In the Edit Mobile Core Sample Project dialog, update the parameters ...
In-place editing
The in-place editing button turns on the in-place editing mode.
[image: ]

[image: ]
Example: In the in-place editing mode, update the parameter value.
Navigation tree
The navigation tree is displayed by clicking the slider button.
[image: ]
Example: In the navigation tree, navigate to ...
Buttons:
[image: ] Slider
[image: ] Level Up
[image: ] Refresh
[image: ] Level Down


[bookmark: scroll-bookmark-142]Which UI Theme to Use
The section below contains information on the Netcracker modules' classification.
[bookmark: scroll-bookmark-188]Business Support Systems (Harvard tabs on the side)
[bookmark: scroll-bookmark-189]Operations Support Systems (Cambridge tabs on top)
Customer Management
· Customer Self-Service
· Customer Information Management
· Customer Order Management
· Customer Billing Management
· Customer Problem Management
· Customer SLA/QoS Management
Service Fulfillment & Assurance
· Service Information Management
· Service Order Management
· Service Inventory
· Service Activation
· Service Problem Management
· Service Quality Management
Partner & Channel Management
· Partner Management
· Marketing & Sales Management
· Analytics & Decisioning
IT Platform
· Service Delivery Platform
· SaaS/PaaS/DaaS/IaaS
· M2M Cloud
Product Management
· Product Information Management
· Product Lifecycle Management
Network Management
· Fault Management
· Performance Management
· NMS/EMS
Revenue Management
· Online Rating &Charging
· Active Mediation
Network Platforms
· Policy Management
· Policy Enforcement
· Media Optimization
Enterprise Management
· Workforce Management
· HR Management
· Asset Management
· Financial Analytics
· Administrative Services
· Knowledge Management
Resource Management
· Network Planning & Design
· Configuration Management
· Resource Activation
· Resource Inventory
· Discovery & Reconciliation
· Outside Plant
End-User Devices
· Device Management
· Home Network

[bookmark: scroll-bookmark-190]Miscellaneous Tips

	Guideline 1
Write in complete sentences. A complete sentence includes a subject and a verb, and expresses a complete thought.



	Guideline 2
Always use a single space between sentences. There must be no double-spaces in documentation.



	Guideline 3
Do not use an extra paragraph return to separate paragraphs, since paragraph styles include the necessary spacing.



	Guideline 4
Use a participle ( -ing verb phrase) only for second and third-level headings, for example, Adding Caption Codes. Do not use a participle in first-level headings, for example: Caption Codes.



	Guideline 5
Never use (s) within parentheses. To indicate one or more, you should use a plural form, for example, The windows open.



	Guideline 6
Make language as simple as possible. For example, it may be best to use incorrectly rather than erroneously.



	Guideline 7
Use terms included in the Glossary, rather than synonyms.



	Guideline 8
Avoid the use of compound verbs, as these can be difficult to translate into other languages. For example, use configure rather than set up.






[bookmark: scroll-bookmark-191]RBM/CM Document Structure
The structure of documents is defined in this section.
[bookmark: scroll-bookmark-192]Order Within Documents
Each document must conform to a standard layout, controlled by templates and master pages. Some layouts are common to all documents, while some are specific to Help documentation or HTML-based interactives. See the Online Help folder on this site for a full account of the differences between Rating and Billing Manager Help projects and product documentation.

The basic shared document structure is as follows:
· A title page
· A page of legal information, including disclaimers, the copyright notice, and trademark information
· A table of contents
· A table of figures (where appropriate)
· A table of tables (where appropriate)
· About This Document information
· Overview
· The main body of the document
· Appendixes (where appropriate)
	
	


[bookmark: scroll-bookmark-193]Leader Pages
Each document should have the following leader pages:
· Front cover page
· Inside cover page
· Table of contents pages
· Table of figures pages
These should only appear if the document contains captioned graphics or screen snapshots.
· Table of tables pages
These should only appear if the document contains captioned tables.
· About This Document pages
[bookmark: scroll-bookmark-194]Cover Pages
To create the front cover and inside front cover, you should use the cover template and customize it according to your needs.
[bookmark: scroll-bookmark-195]Front Cover Page
The front cover page should contain the items listed in the following table.
	Description
	FrameMaker Variable

	The logo on the front cover is built into the graphic layer.
	n/a

	The configured name. You must update this variable or delete it.
	Component Name

	The document title – this may extend to a second line.
	Document Name

	The name of the product, for example, Rating and Billing Manager.
	Product Name

	The product release in the form Release X.X.
	Release


[bookmark: scroll-bookmark-196]Inside Cover Page
The inside cover page of the template contains the agreed copyright information, legal disclaimers, and trademarks. The Netcracker copyright message should always appear in the format "Copyright © [1999–201X], Netcracker. All rights reserved."

The FrameMaker style Body1 is used for this text.
[bookmark: scroll-bookmark-197]TOC, TOF, and TOT Pages
Table of Contents, Table of Figures, and Table of Tables pages must start on an odd page and end on an even page.

In FrameMaker, use the FM10_TOCTemp.fm template for theTable of Contents, the FM10_TOFTemp.fm template for the Table of Figures, and the FM10_TOTTemp.fm template for the Table of Tables.
[bookmark: scroll-bookmark-198]About This Document
All guides contain an About This Document section, which follows immediately after the table of contents, table of figures, and table of tables. This section forms part of the introduction to the document and, as such, is not numbered.
The About This Document information contains the following sections of fixed wording:
· Document Conventions
· Spelling and Terminology
This indicates geographical differences, detailing the use of U.S. spellings and terminology.
In FrameMaker, use the FM10_AboutTemp.fm template for this chapter.
[bookmark: scroll-bookmark-199]Overview
Most guides contain an Overview section as the first item in the main body of the document. This is the first section in the document that uses standard page numbering, rather than Roman numerals, in a pdf document.
The basic structure of the Overview section has the following format:
· Introductory section
This provides general details about the process or interface that the document describes. The first two headings in the Overview section should be:
· Audience - This provides a brief introduction detailing who the document is aimed at.
· Before You Begin - This provides recommendations on what users should review before performing any system functions, and helps the user gain familiarity with the product.
	
	

	Note:
	The sections Audience and Before You Begin should always be included in the Overview. Where relevant, or necessary, additional sections can also be included in the Overview, but this section should not include a detailed (that is, a complete, section-by-section) guide to the entire contents of the document.

	
	


[bookmark: scroll-bookmark-200]Main Body
These pages must start on an odd page and end on an even page.

In FrameMaker, use the FM10_ChapterTemp.fm template.
[bookmark: scroll-bookmark-201]Appendixes
If a document has appendixes, each appendix is added as a separate chapter, with a letter rather than a number as the identifier. Each appendix must start on an odd page and end on an even page.

If you are using FrameMaker, use the FM10_AppendixTemp.fm template.

in FrameMaker, appendixes are identical to the chapters in the main body of the document, except that:
· The title uses the heading style Appendix Title rather than Heading 1, and the number style Appendix No rather than Chapter No.
Lower-level headings (Heading 2, Heading 3, etc.) can be used within appendixes.
[bookmark: scroll-bookmark-202]Content
[bookmark: scroll-bookmark-203]Introductory Sections

	Guideline 1
Never use in the introductory sections of the product documentation the following wording:
· "This document describes ..."
· "This section specifies...",
· "This guide addresses..."
· "This article lays out..."
· "This chapter is dedicated to..."
· and so on.
Once you face such introductory wording, replace it with a sentence describing the subject of the page.
	This guideline is applicable to product components' documents only.






	Guideline 2
Introduction must provide brief summary for a document (a chapter), one thesis per subsection. Further as the text goes, the deep insight on the summary should be given. The introduction should provide guidance on the subject, not on the document.



	Guideline 3
Do not use the word "document."


Example:
Introductory section:
Netcracker Database
Incorrect:
This document describes the structure of the Netcracker Database, its essential tables, and relationships between them.
Correct:

The Netcracker database represents a set of 'flat' object tables. The number of tables in the database is fixed and does not grow with the increase of data or object types in the application. Several core tables support the Entity-Attribute-Value paradigm of the Netcracker application. Altering of the Netcracker database structure is strictly not recommended, nor required.
Next Level section:
Netcracker Database Schema Essentials
Unlike most databases, which store information about each entity (like LOCATION, SHELF, and PORT) in a separate table and use the table columns for the entities' attribute values, Netcracker implements another approach. The Netcracker database includes two major sets of tables. One set of tables is used for storing metadata, that is, the definitions of object types and their attributes. Another set of tables is used for storing the data itself, that is, the objects (entities) and their parameter values. ...



[bookmark: scroll-bookmark-204]Sensitive Data in Code

	Guideline
Never include sensitive data in code samples.
The following data are sensitive:
· Customer names
· IP addresses
· Server names
· Netcracker user names.
Sensitive data also include:
· Geographical addresses, including addresses of the provider's clients and addresses of the provider's locations.
· Different kinds of IDs, like customer PINs, and any other identifiers, including literal, that can contain names of the customers or may allude to the customers' countries or regions.
· Provider services' names and product names, that are specific data, sufficient to identify acustomer.
· Other data that can let individualize customers.



Below is the example of sensitive data in code that cannot be indicated in documentation.
	Important! The following is an example of information that is strictly prohibited for publishing on BASSDEV2:
[image: ]


[bookmark: scroll-bookmark-205]Question:
What should I replace the sensitive data with, when the code developer cannot suggest anything?
[bookmark: scroll-bookmark-206]Answer:
Fictitious, but resembling real, data. Examples:
Server: http://server.example.com, http://example.com
Port: 1234
Number: 1234567890…
Company name: ABC Company
User name: John Doe
Password: password
[bookmark: scroll-bookmark-207]Control Descriptions
If it is necessary to describe not only buttons, but also interface elements of a dialog or table, and if there are many buttons and interface elements to describe, split the description into two tables—one for buttons, and one for other controls (check boxes, fields, edit boxes, and so on). For more information on how to describe buttons using a table, refer to Buttons and Hyperlinks.
However, if there are not enough controls to split their descriptions adequately, or it does not apply for some other reasons, all controls should be described in one table. In this table, in the left column the names of the interface elements are listed, with appropriate formatting. In the right column, the description for buttons conforms to the rules set in "Button descriptions," and for the other controls the type of the element is specified.
Example:
	Control
	Description

	Run Report
	Executes the reconciliation report.

	Is Constant
	This check box specifies whether this value is constant.

	Name
	This edit box contains the name of the object.





[bookmark: scroll-bookmark-209]Editing Parameters

	Guideline 1
Describe editing object parameters only when you need to communicate to the user some additional information that will help the user fill out the parameter or choose an appropriate value. Do not describe editing parameters in general, as this procedure is already covered in Netcracker Framework, "Text Navigation Mode."



	Guideline 2
If you describe editing an object, instruct the user to use the check box on the left and then click Edit on the toolbar.
Correct
Select the check box to the left of the object you want to edit. On the toolbar, click Edit.



	Guideline 3
If an object's parameters can be edited in-place, then this way of editing the parameter should be suggested to the user first.
Always put a note to explain that if the in-place editing feature is turned off for this object, the user must go to the Parameters tab and edit the parameter from there.
For more information on in-place editing, refer to Netcracker Framework, "Text Navigation Mode."
Correct
Point to the cell you want to edit and click the displayed double right arrowhead button.


[bookmark: scroll-bookmark-210]Mandatory Parameters

	Guideline
Do not say "mandatory" or "required" when referencing a parameter, even if it is. Unlike design documentation, in user documentation there is no need to specifically focus on the fact that a parameter is mandatory because a red asterick is used to indicate mandatory and required fields, and this is a commonly recognized way in the industry to indicate them. In addition,any system, including Netcracker, should display an explanatory note if an indicated required parameter is left empty.


[bookmark: scroll-bookmark-211]Notes and Important

	Guideline 1
No topic must start with a Note or Important! block.
To bring the reader’s attention to the text written in the paragraph, use only the Note and Important introductory words, as shown in the below examples. Please note that this and the following yellow blocks on this page are Confluence blocks the way they should appear in documentation written in Confluence. Note that the Note title must be inserted as the block's title and not as regular bold text. To do so, in the editor highlight the macro, then click Edit.

	Note
This is a note.



	Important! (or Caution!)
This is a message of critical importance. This means that if the user fails to pay attention to what is written here, something may go wrong.


For information about formatting notes and the acceptable icons for notes, see RBM and CM Notes - Use of.



	Guideline 2
Do not put either Note or Confluence block macros inside table cells.



	Guideline 3
Follow the approach below when using Confluence block macros.
	Block macro
	Usage
	Correct

		This is {note} macro.



	Note, Caution, Important!
Something that unexperienced user may not know, but will not cause damage to the data or the application.
	
	Note
Text.



	Caution
Text.



	Important!
Text.




		This is {warning} macro.



	Warning.
Something that may cause damage to the data of application.
	
	Warning
Text.




		This is {tip} macro.



	A hint, shorcut, workaround. A faster or easier way to do something.
		Text.




		This is {info} macro.



	Use to highlight individual blocks of text going in a sequence. For example: highlighting guidelines in a manual.
		Text.




		This is {panel} macro.



	Use to put blocks of text on a grey background. Examples of use: a checklist, FAQ.
		Content.









	Guideline 4
Plural of the word "Note" must not be used. Even in case the word "Note" is followed by a bulleted list, the term must be inserted in the singular.

	Note
· This is how you should format a series of related notes. Use the List Bullet style.
· This is how you should format a series of related notes. Use the List Bullet style.








	Guideline 5
Notes' blocks must not be inserted neither in bulleted lists, nor in numbered lists. Notes must always preceed or follow lists.
To correct improperly inserted notes:
1. Consider whether the note text deserves styling as note. In most cases it can be formatted as a regular narrative text. If so, convert the text to narrative style.
2. If it is really needed to attact special attention to wording and it cannot be carried out from the list, use such wording, like:
Note, changing this attribute will also reset the order expiration date.
Important, changing this attribute will also reset the order expiration date!
3. If the note text can be removed from the list, place it before or after the list. Use Confluence's Note block. The example is shown below.

	Note (or Caution!)
Clicking OK will initiate system self-destruction sequence.








	Guideline 6
There can be a maximum 3 items in the Notes bulleted list.
The text below should not be styled as Note. It must be formatted as narrative text.
INCORRECT
Note:
If a report is blocked by the Administrator, the following scenarios can occur:
· The report cannot be scheduled. An error message is displayed to indicate that the report is blocked until a specified time and cannot be scheduled. A scheduled report can be blocked or unblocked from its Settings tab. For more information on blocking and unblocking reports, contact the administrator.
· A scheduled report is not executed on the start date. The system defines a new start date of execution based on the configuration of the report.
· A scheduled report can be edited if the report's Status parameter value is "Open", "Redefined", "Assigned", or "Executing."
· If a scheduled report with the Status parameter value equal to either "Assigned" or "Executing" was edited, its next iteration task is displayed on the ScheduledReports tab with the Redefined status, and the changes made to its parameters apply starting from the next iteration of its execution task.
· The Planned Start Time, Execution Period, and Period Unit parameters of a scheduled report can be edited using in-place editing. For more information on in-place editing, refer to Netcracker User's Guide, "Textual UI."
· A scheduled report can be terminated. If the report Status parameter value is "Open", "Assigned", or "Executing", the entire execution task is terminated. If the report Status parameter value is "Redefined", only the redefined iteration of the execution task is terminated, and the report is executed as it was scheduled before the redefinition. For more information on terminating reports, see "Terminating Reports."
· A scheduled report can be deleted if its Status parameter value is "Open", "Redefined", "Finished", or "Terminated". If the report status is Open, the entire execution task is cancelled. If the report status Redefined, only the redefined iteration of the execution task is cancelled, and the report is executed as it was scheduled before the redefinition.
· When a scheduled report uses a Calculable parameter type, the value of the parameter is recalculated each time the report is executed. For more information on the Calculable parameter type, contact the administrator.



[bookmark: scroll-bookmark-213]Paragraphs and Sentences

	Guideline 1
There should be no empty paragraphs in your text, but always put one empty paragraph after a table.



	Guideline 2
Do not create one paragraph for one sentence.


[bookmark: scroll-bookmark-214]Comment
All sentences about one item being described must be grouped in one paragraph. A sentence can be outside a paragraph only if it talks about a completely different item and there are no other sentences providing information about that item.


	Guideline 3
Try not to write sentences longer than two lines of text. Use short sentences (15 to 20 words per sentence is recommended when possible), simple words, and reuse words and phrases when possible. This also makes it easier for documents to be translated.


[bookmark: scroll-bookmark-215]Comment
Long sentences with several clauses are difficult to understand and maintain. So, to make the ideas expressed clearer in your sentences, try keeping the sentences as simple and short as possible. If a sentence contains more than two clauses, consider breaking it into multiple simpler sentences. Also do not create large paragraphs. For example, consider breaking a paragraph that is a half page long into two or more paragraphs. Paragraphs should be limited to 2 to 3 sentences whenever possible. To shorten paragraphs, also consider using bulleted lists whenever possible for paragraphs containing series of items.
[bookmark: scroll-bookmark-216]References
Editing for Writers, Lois Johnson Rew
Writing Technical Articles, Speeches, and Manuals, Mark Forbes
http://www.unisanet.unisa.edu.au/learn/LearningConnection/?PATH=/Resources/la/Shorter+sentences+for+better+writing/&default=Welcome.htm
http://www.idea.gov.uk/idk/core/page.do?pageId=8302197
http://www.writing-lovers.com/use_short_sentences.html
[bookmark: scroll-bookmark-217] 
[bookmark: scroll-bookmark-218]Specifying Parameters
https://bass.netcracker.com/pages/viewpage.action?pageId=267555619
[bookmark: scroll-bookmark-219]General Guidelines

	Guideline 1
Obvious parameters such as Created By, Modified When, Name, and Description do not require a description.
Incorrect
	Parameter
	Description

	Name
	The customer trouble ticket name. The parameter's value is generated automatically when a trouble ticket is created.

	Description
	The customer trouble ticket description. The parameter is optional and can be specified when a trouble ticket is created and can be edited later.


Correct
The parameters mentioned above are self-explanatory and do not require a description.



	Guideline 2
Some parameters that are particularly intensive or solve a massive task may need a separate section with a title. However, there is no need to mention a parameter name in the title. The title should name the task that is being solved. Users can look through the Table of Contents (TOC) to find a familiar task. They can also search for a certain parameter, including searching a PDF, or even several PDF files. However, the parameter name must be present in the document body, with its spelling on screen faithfully copied.



	Guideline 3
Parameters specified for code must be formatted in tables, whereas parameters specified for the UI must be formatted in paragraphs. For further details, see the sections below.


[bookmark: scroll-bookmark-220]Specifying Parameters for Code


	Guideline 1
When specifying parameters for code, use the table format. Do not use paragraphs to specify parameters for code.
For more details about table view, see Tabular View.
Correct
	Parameter
	Parameter Type
	Parameter Value Type
	Mandatory
	Description

	ticket_id
	Path parameter
	Number
	Yes
	The unique identifier of the trouble ticket in NetCracker.

	work_log_id
	Path parameter
	Number
	Yes
	The unique identifier of the work log in NetCracker.






	Guideline 2
Provide a brief introductory sentence to explain the contents of each table.
Correct
The table below specifies the Remove Trouble Ticket WorkLog input parameters.



	Guideline 3
The names of parameters specified in tables do not require any additional formatting, such as italics or quote marks, since the table column cannot be easily confused with surrounding text.













[bookmark: scroll-bookmark-222]Specifying Parameters for UI


	Guideline 1
When specifying parameters for the UI, use paragraphs formatted as “Body Text”. Do not use tables to specify parameters for the UI.
Correct
The Distribution Channel parameter specifies the source of the sales order (Call Center, Retention, Door-to-Door, and so on). The drop-down list varies depending on user privileges. Also, options may be populated based on user security roles.



	Guideline 2
The description of each parameter must start with a new paragraph. The parameter name must appear in the first part of the paragraph.



	Guideline 3
Always add the word "parameter" directly after the parameter name when describing a parameter.



	Guideline 4
Enclose parameter names that are all lowercase in double quotes.



	Guideline 5
Parameter name – DO NOT CONFUSE WITH PARAMETER LABEL ON SCREEN IN UI! – must be highlighted as follows:
· The first instance of a parameter name is normal text, but can optionally be italicized.
· The next instances are not highlighted.
EXAMPLES:
First instance of parameter name in a document:
The Status parameter specifies the state of an account's lifecycle.
Next instance of parameter name in a document:

The Status parameter can take the values as listed below.
Parameters description:
The Auto-Prolongation Period parameter specifies the number of weeks that are automatically assigned to a Resource Group or Position.
The Auto-Prolongation Job Interval parameter specifies the time period, to which the Auto-Prolongation Period belongs.


[bookmark: scroll-bookmark-223]Standard Operations

	Guideline
Do not describe standard operations, such as deleting or copying objects or projects.


These procedures are always the same and are already described in Netcracker Framework, "Text Navigation Mode." It is enough to mention that these operations are available and to refer to this document. However, if such a procedure is in some way nonstandard, it is necessary to describe it.
The following operations are considered standard:
· Deleting objects or projects
· Editing objects or projects
· Copying objects or projects
· Moving objects or projects
· Exporting objects or projects
· Importing objects or projects
· Saving changes in in-place editing mode
· Discarding changes in in-place editing mode
· Starting the Network Configurator
· Selecting objects using the Reference Explorer
· Selecting objects using the reference pop-up selector
· Releasing objects
· Editing object parameters
For more information on editing parameters, refer to Editing Parameters.
[bookmark: scroll-bookmark-224]Table Captions

	Guideline 1
Each table must have table caption. Use the Insert Caption MS Word command and put a caption above table.
Select the table, and then click Insert Caption on the References tab.


Correct
[image: ]


	Guideline 2
Use the Caption Wide style for wide tables.
Do this as follows:
1. Use the Insert Caption MS Word command to insert a caption.
2. Change the caption style to Caption Wide.





[bookmark: scroll-bookmark-221]Tabular View
https://bass.netcracker.com/pages/viewpage.action?pageId=267554983

	Guideline
Information is divided into two types:
· Information that allows table view
· Information that does not allow table view



[bookmark: scroll-bookmark-225] Table view is allowed
[bookmark: scroll-bookmark-226]1. Keyboards shortcuts
Example: https://confluence.atlassian.com/display/DOC/Keyboard+Shortcuts
[bookmark: scroll-bookmark-227]2. Certain list-style parameter values (drop-down list)

	Correct
	Status
	Meaning

	Assigned to Group
	Ticket is assigned to a group, not to an individual person

	Assigned to User
	Ticket is assigned to a person in a group

	Work in progress
	Ticket assignee has started working on the ticket

	Resolved
	The problem described in the ticket was resolved and the ticket can be closed

	Closed
	Resolution is satisfactory and no further work is required. “Closed” is the terminal status of the ticket lifecycle.





[bookmark: scroll-bookmark-228]2. Menu commands

	Correct
	Menu option
	Hardware action

	Rotate Left
	Rotates the simulator to the left.

	Rotate Right
	Rotates the simulator to the right.

	Shake Gesture
	Simulates shaking the device.

	Home
	Displays the Home screen of the simulated device.

	Lock
	Displays the Lock screen.

	Simulate Memory Warning
	Sends the frontmost app a simulated low-memory warning.
For information on how to handle low-memory situations, see Observing Low-Memory Warnings.

	Toggle In-Call Status Bar
	Toggles the status bar between its normal state and its in-call state.






[bookmark: scroll-bookmark-229]3. Side by side comparison
Example: https://confluence.atlassian.com/display/DOC/Code+Block+Macro

[bookmark: scroll-bookmark-230] Table view is not allowed

[bookmark: scroll-bookmark-231]1. Enumeration of parameters in the Netcracker UI


	Correct
The Password Modified by User When parameter displays the last date the password was modified by a user. The parameter can be found on the Parameters tab of the user's page, in the System group.



	Also correct
[bookmark: scroll-bookmark-232]$hyperlink$
Syntax:
$hyperlink(##link_address_multiple_xpath_expression#link_label_relative_xpath_expression#r)$
If this macro is used, the module creates a cell of the hyperlink type instead of the cell where the macro is defined. Example: $hyperlink(#/doc/link/linkstring#../label#)$. The link "link_address_xpath_expression" XPath expression specifies the reference for the hyperlink. The link "link_label_relative_xpath_expression" XPath expression specifies the label for the hyperlink.




Reason
Description of the parameter meaning, the tasks it solves, what it is responsible for, in what way, what the details and "pitfalls" are, may take up to 15-20 text lines, including both numbered and bulleted lists, and even graphic illustrations as well. Inserting such information, which does not allow table view, into the table imposes artificial limitations on text volume reducing transmitted data quality. At that, if not to reduce information volume , so that the quality doesn’t suffer, the table row will either be broken into two pages, which is unacceptable, or jump to the next page, again creating an invalid blank space on the preceding page. Detailed recommendations for parameters description see in Specifying Parameters.


	Note
Tables are permitted when specifying parameters for code. However, paragraphs must be used when specifying parameters displayed in the UI.


2. Bulleted lists
No table cell can have a bulleted list inside.
[bookmark: scroll-bookmark-233]Formatting of User Documents

	Guideline
You must use only styles defined on the Styles and Formatting pane (see NCPD Template Styles) and the NC Toolbox in your documents.
Do not apply any Microsoft Word manual formatting, including bold and italics. Use the Button and Emphasis styles instead.




[bookmark: scroll-bookmark-234]NCPD Template Styles
The NCPD.dot template contains several styles that you should always use to format the text you write.
Note: For your convenience, a special toolbox called NC Toolbox is available in NCPD, containing all Netcracker styles and functions. For more information, refer to NC Toolbox.
	Style
	Keyboard Shortcut
	Used for

	Title
	
	Document title

	Heading 1
	
	Deprecated. Do not use.

	Heading 2
	ALT+2
	Heading 2

	Heading 3
	ALT+3
	Heading 3

	Heading 4
	ALT+4
	Heading 4

	Body Text
	CTRL+ALT+A
	All regular text

	Body Text Indent
	
	Indented text (use only when nothing else applies)

	Picture and PrintedOnlyPicture
	SHIFT+ALT+P
SHIFT+ALT+R
	The Picture style is for images that go to online help and printed documents. The PrintedOnlyPicture style is for images that go only to printed documents. Generally, you should include in online help only small button images and illustrations that must be present to clarify the material being discussed. Screen snapshots demonstrating user actions or results of these actions should end up only in printed documentation, as we assume that when users perform the actions they can see everything on the screen.

	Caption
	SHIFT+ALT+C
	Image captions

	1 / 1.1 / 1.1.1
	SHIFT+ALT+N
	All sequences of user actions and numbered lists should be formatted first with the Body Text style and then with the style 1 / 1.1 / 1.1.1.

	List Bullet
	SHIFT+ALT+L
	Bulleted list

	List Bullet 2
	SHIFT+ALT+>
	Indented bulleted list

	List
List 2
	SHIFT+ALT+M
SHIFT+ALT+<
	If you need to insert a paragraph inside a list and you want this paragraph to be indented from the left, mark it with the List (or List 2) style.

	Bulleted List
	
	Deprecated. Do not use.

	Table
	SHIFT+ALT+T
	Table with a header row. When you insert a table, first clear the formatting inside the table. As a result, the text in the table cells should be formatted with the Body Text style.
The first row of the table should be repeated as a header row at the top of each page. The rows should not break across pages.

	Table Grid
	SHIFT+ALT+G
	A table without a header row. When you insert a table, first clear the formatting inside the table. As a result, the text in the table cells should be formatted with the Body Text style.
The first row of the table should be repeated as a header row at the top of each page. The rows should not break across pages.

	button
	
	Names of all interface elements, including:
· Buttons
· Tabs
· Menu commands
· Field labels


	Code
	CTRL+SHIFT+C
	Examples of system code that can be entered in edit boxes (for example, the Details edit box for attributes).

	H3
	
	Identical to Heading 3, but does not start a new topic in o-line help. Instead, a mid-level topic is created (looks like a subsection inside a topic). For more information on usage, refer to "H and drop-down topic headings."

	H4
	
	Identical to Heading 4, but does not start a new topic in online help. Instead, a mid-level topic is created (looks like a subsection inside a topic). For more information on usage, refer to "H and drop-down topic headings."

	Heading 3 Drop-down
	ALT+5
	Identical to Heading 3 in the printed version, but in online forms a drop-down section inside a topic. For more information on usage, refer to "H and drop-down topic headings."

	Heading 4 Drop-down
	ALT+6
	Identical to Heading 4 in the printed version, but in online forms a drop-down section inside a topic. For more information on usage, refer to "H and drop-down topic headings."

	PrintedOnlyText
	
	Use to mark blocks of text or single words that should NOT be displayed in on-line help. This text is removed when processed by WebWorks. Try not to use this style.




[bookmark: scroll-bookmark-235]RBM and CM Template Files
To ensure consistency, all documentation must be produced based on specified templates.

A suitable template file should be used to ensure consistency of layout and content for different parts of a document.

The correct use of template files ensures that:
· Chapters always start on an odd-numbered page.
· Page sizes and margins are set correctly.
· Headers are picked up automatically.
· Tables of contents and other tables are generated.
Master templates for Rating and Billing Manager and Collections Manager reside in SVN. To ensure that you always have the latest versions, you should always obtain the templates directly from the Templates folder in the latest Rating and Billing Manager project in SVN. You should not copy the templates to another location and then use copied templates.

Note: There are FrameMaker 7 templates and FrameMaker 10 templates in SVN. This style guide only refers to the FrameMaker 10 documents.
[bookmark: scroll-bookmark-236]FrameMaker
The template files for use with FrameMaker 10 documents are listed below.
	Template File Name
	Description

	FM10_cover.fm
	Front page of the document, which comprises:
· The outside front cover – includes the component name (if any), document title, DRAFT identifier, the release number, and the document version number.
· The inside front cover – includes proprietary information and copyright notices.


	FM10_TOCTemp.fm
	The table of contents

	FM10_TOFTemp.fm
	The table of figures

	FM10_TOTTemp.fm
	The table of tables

	FM10_AboutTemp.fm
	The "About This Document" section

	FM10_ChapterTemp.fm
	Main sections of the document

	FM10_AppendixTemp.fm
	Appendixes to the document


[bookmark: scroll-bookmark-237]HTML Legal Statement
The ls.htm provides the master copy of the legal statement. The legal statement was updated with Netcracker information in July 2012. The ls.htm file is stored here:
https://sharepoint.convergys.com/sites/proddoc/Style%20Board/Forms/AllItems.aspx?RootFolder=%2Fsites%2Fproddoc%2FStyle%20Board%2FTemplates%2FRB%5FCSM%2FLegal%20Statement%20%28new%29
[bookmark: scroll-bookmark-238]Style Sheet
The cascading style sheet (.css), infinys.css, defines how the interactive HTML documents appear. Similar to a template, it specifies attributes such as the font, font size, special text styles and headings, and colors.

The infinys.css file is stored in the latest Rating and Billing Manager project in SVN.
[bookmark: scroll-bookmark-239]Boolean Values (True and False)

	Guideline 1
Use double quotes when "True" and "False" are drop-down list values.
Always capitlize the initial letter.


Correct
Select "True" from the Is Fork drop-down down list box.
Incorrect
Select True from the Is Fork drop-down down list box.


	Guideline 2
Use double quotes when "true" or "false" is referred to as a value entered verbatim.


Correct
If the Offline SCM Compiler is used, set the rdb_strict_mode parameter to "false" in the config.properties file. That is, the following string should be included: set rdb_strict_mode=false
Incorrect
If the Offline SCM Compiler is used, set the rdb_strict_mode parameter to the false value in the config.properties file. That is, the following string should be included: set rdb_strict_mode=false


	Guideline 3
Say TRUE and FALSE when refering to a returned value.


Correct
The following Boolean expression returns TRUE in all cases: TRUE OR x.
Incorrect
The following Boolean expression returns true in all cases: TRUE OR x.


	Guideline 4
Express Boolean values as T (true) or F (false), rather than simply T or F, for example, when you are referring to values of system parameters. Use a nonbreaking space between the letter and the first parenthesis. If, however, you are documenting a system's value or computer text that a user must enter, use the format that the system uses.


[bookmark: scroll-bookmark-208]Buttons and Hyperlinks

	Guideline 1
Do not say the word "button." Just say "Click OK." Do not say "Click the OK button."
Correct
Click OK. (skip "on")
On the toolbar, click Delete.

Incorrect
Click the OK button.



	Guideline 2
Do not use brackets [ and ].
Correct
To find usages of a particular business operation in the current project template, click Find Usages.

Incorrect
To find usages of a particular business operation in the current project template, click [Find Usages].




	Guideline 3
Graphic images of icons can be used in the documentation only if they can not otherwise be represented with a keyboard symbol or do not have a screen label.
· If a key symbol is used to replace the button pictogram, the symbol must be enclosed in double quotes, for example "+" or ">".
· If the symbol is followed by a period, the period should come outside the closing double quote.
Incorrect
Click the [image: ] button.
Correct
Click the "+" button.
Click "+".



	Guideline 4
When referring to a labeled button, specify only the label text.
Incorrect
Click the [image: ] button.
Correct
Click Choose Target.



	Guideline 5
When you describe a set of buttons (for example, on a toolbar) by using a table, you must put the verb describing what the button does in the singular. That is, "adds an object," not "add an object."
	Button
	Description

	Run Report
	Executes the reconciliation report.

	Reconcile
	Starts reconciliation for selected objects and their parameters.

	Analyze
	Applies patterns to the discrepancies list to find integral discrepancies.






	Guideline 6
Differentiate between a button and a hyperlink.
Commands in reference selector pop-ups and boxes, such as "Browse" are hypelinks. Say Click "Browse". Enclose hyperlinks in quotes. Do not use the word "hyperlink."
Sometimes a hyperlink in one theme (Cambridge) may be displayed as a button in another theme (Harvard). Treat them according to the way the control is visualized in the current theme.
For example, the button [image: ] displayed on the tabs panel in the Harvard theme is displayed as New Sales Order in the Cambridge theme's quick links area.



To find usages of a particular business operation in the current project template, click [Find Usages].
[bookmark: scroll-bookmark-240]Code Syntax
[bookmark: scroll-bookmark-241]Summary
· In Confluence, all code syntax guidelines, not the actual code samples, should always be formatted using normal Paragraph style with no extra formatting except names of the variables substituted with actual parameters (should be in italics).
· Additionally, use bold for names of commands and keywords.
· Additionally, use italic for names of variables that are replaced with actual values.
Syntax is the order in which the user must type a command-line command or utility name and any arguments and options that follow it. The user must type elements that appear in bold in the syntax line exactly as they appear. Elements that appear in italics are placeholders representing information the user must supply.
Following is a sample syntax line using the form that is standard in Microsoft documentation:
sample {+r | –r} arguments ... [options]
The meaning of each of these elements is as follows.
	Element
	Meaning

	sample
	Specifies the name of the command or utility.

	{ }
	Indicates a set of choices from which the user must choose.

	|
	Separates two mutually exclusive choices in a syntax line. The user types one of these choices, not the symbol.

	arguments
	Specifies a variable name or other information the user must provide—for example, a path and file name.

	…
	Indicates that an argument can be repeated several times in a command line. The user types only the information, not the ellipsis (…).

	[ ]
	Indicates optional items, except in languages in which brackets are part of the syntax. In that case, use double brackets ([[ ]]). The user types only the information within the brackets, not the brackets.


Following are syntax lines for a Visual Basic property (FontSize) and a C library routine (_setfont).
Correct
{[form.] [control.]|Printer.}FontSize[=points%]
short far_setfont ( unsigned char far *options );


Follow exactly the standards and conventions of the language or program that you are documenting when writing syntax.
[bookmark: scroll-bookmark-242]Format of Syntax
In general, follow these document conventions for formatting syntax.
	For these elements
	Use

	Keywords, functions, and anything else that must be entered exactly as shown
	bold

	Variables and other placeholders the user must provide
	italic

	Punctuation marks the user does not enter
	regular text


[bookmark: scroll-bookmark-243]Line Breaks in Syntax
Do not hyphenate a line of command syntax. If you must break a line, break it at a character space and do not use a hyphen. Indent the runover line.
Correct
Set database = OpenDataBase(dbname[, reserved[,
read-only[, connect]]])
Incorrect
Set database = OpenDataBase(dbname[, reserved
[, read-only[, connect]]])



[bookmark: scroll-bookmark-119]RBM and CM Cross-References
Note that we only use cross-references to topic headings or pictures, not to an arbitrary part of a topic. This can be important if the document is printed.
Important! Do not use cross-references and hyperlinks to other documents. For more information, refer to Cross-references to Another Document.
In FrameMaker, there are two types of cross-referencing styles:
· Internal cross-references (blue x-ref)
· External cross-references (x-ref external nolink)
	
	

	Note:
	URLs must be neither linked nor in blue text. If a URL is linked, remove the link. Change blue (or other color) URL text to black. Use the names/paths style in FrameMaker for the URL.

	
	


[bookmark: scroll-bookmark-245]Footnotes
Footnotes should not be used in regular text but are permitted at the bottom of a table.
[bookmark: scroll-bookmark-246]Cross-Reference Formats
The following table provides the defined cross-reference formats, along with examples. No blue text is used for any cross-references, and no cross-references should be active links. See, Refer to, and other peripheral text is not built into these cross-references.
To avoid redundancy, you must not include the word figure or table in any figure captions or table titles.
	Figure 2 worddavcd56e6f1271edfea363f959f228da2d5.png
[image: ]
	Historically, Rating and Billing Manager guides used figure title and table title cross-reference formats (not numbers) since the guides were also produced in HTML.


[bookmark: scroll-bookmark-247][bookmark: scroll-bookmark-248]Table 6Formats for Internal and External Cross-References
	Cross-Reference Format
	Example (with Surrounding Text)

	"Hdg," pg x
	See "Before You Begin", page x for more information.

	Appdx x, "Appdx Title"
	See Appdx x, "Error Messages" for more information.

	Chp, "Chp Title"
	See Chapter x, "Overview" for more information.

	"Step Intro Title" pg x
	See "To insert a note table:" for more information.

	Step x
	See Step x.

	Figure x
	See Figure x.

	Table x
	See Table x.


[bookmark: scroll-bookmark-244]Cross-Reference to Another Page

	Guideline 1
Follow the markup guidelines set in Working with Links.



	Guideline 2
Important! Do not use references to administrator's documents from user's documents. Otherwise, it might mislead users as you will prompt them to view documents they cannot access. For example, do not refer to the Netcracker Framework, "Search Profiles" document from the Netcracker User's Guide, "Search Function" chapter.
To check if a chapter belongs to user's or administrator's manual, refer to https://doc.netcracker.com/display/DOC/Netcracker+Documentation, Published PDFs section. Netcracker Framework is administrator's manual.


	Never put cross references to Developer Guides, whatever document you are working with.


[bookmark: scroll-bookmark-250]FrameMaker Only
Do not use cross-references and hyperlinks to headings in other documents. It is allowed only if you are positive that the topic you are referring to will never be deprecated and its title will not be changed, and only if this topic is no less than a Heading 2. When it is necessary to refer to information in another document, use general wording like "refer to working with devices in Netcracker Resource Inventory User's Guide, "Network Modeling," where "working with devices" in a common case is not a topic name, but a general description of the necessary text block. It can be a topic name too, but it should not be formatted as such.
The general syntax for any document reference is
Document Title [,"Chapter Title"]
Use italic style for Document Title.
[bookmark: scroll-bookmark-251]Examples
For more information (or any other introductory text), refer to the exporting objects description in Netcracker Administrator's Guide, "Object Types, Attributes, and Schemas."
For more information (or any other introductory text), refer to Netcracker Discovery and Reconciliation User's Guide.
For more information (or any other introductory text), refer to Netcracker Maintenance Guide, "AutoInstaller."
For more information (or any other introductory text), refer to Netcracker Administrator's Guide, "License Key."
For more information (or any other introductory text), refer to Netcracker Maintenance Guide.
See also creating search profiles in Netcracker User's Guide, "Text Navigation Mode."

[bookmark: scroll-bookmark-252]Cross-reference to a Heading
Cross-references to a heading in the same document must comply with one of the following formats:
For more information (or any other introductory text), see "CrossRef."
…described in "CrossRef"… (middle of sentence)
…described in "CrossRef." (end of sentence)
[bookmark: scroll-bookmark-253]Cross-reference to a Dropdown Topic Heading
With Microsoft Word, it is impossible to create a cross-reference to a heading formatted with "H3", "H4", "Heading 3 DropDown", or "Heading 4 DropDown" styles, as they are not considered headings in terms of Word styles. If you want to make a reference to such a topic, it is necessary to use bookmarks.
To make a cross-reference to a dropdown topic heading:
1. Select the heading of the topic to which you want to refer.
[image: ]
Selected heading
2. From the Insert menu/tab, select Bookmark.
The Bookmark dialog is displayed.[image: ]
Bookmark Dialog
3. In the Bookmark name edit box, type the exact name of this topic, replacing spaces with underscores ("_").
[image: ]
Bookmark Dialog with Bookmark Name
4. Click Add.
The bookmark is added.[image: ]
Figure 12. Bookmark in the Heading
5. Navigate to the place in the text from which you want to refer to that topic.
6. On the Insert menu, point to Reference and then click Cross-reference.
The Cross-reference dialog is displayed.
7. From the Reference type drop-down list box, select Bookmark".
[image: ]
Cross-reference Dialog
8. Make sure that in the Insert reference to drop-down list box, "Bookmark text" is selected.
9. Make sure the Insert as hyperlink check box is selected.
10. Click Insert.
The cross-reference to bookmark is inserted.
[image: ]

Inserted Cross-reference to Bookmark

Important! Remember that the cross-reference must comply with the formats specified in "Cross-reference to a heading."
11. Click Close to close the Cross-reference dialog.
[bookmark: scroll-bookmark-254]Step Cross-References
When using the Step cross-reference, follow these standards for wording:
· Use Return to when referring the reader back.
· Use Go to when referring the reader forward (skipping one or more steps).
· Use Continue to the next step (not a cross-reference) when you want the reader to continue to the next step that immediately follows.
[bookmark: scroll-bookmark-255]References to External Resources
In Netcracker documentation, it is allowed to use not only references to internal resources of Netcracker (documentation, sites that belong to Netcracker, and so on), but also references to external resources. When using references to external resources (or external references), follow the rules below:

1. It is allowed to use references to resources of acknowledged non-commercial organizations that develop industrial standards. Examples: IEEE, ISO, W3C, OASIS, TIA, EIA
2. It is allowed to use references to resources of governmental institutions (taking the limitations described below into consideration), for example, FCC.
3. It is not recommended to use references to resources of companies that are already clients of Netcracker or can potentially become Netcracker clients. However:
· It is allowed to refer to resources of such companies if these resources include specifications of industry standards or recommendations that these companies develop exclusively or in cooperation with other companies, for example, documents that are related to the NGOSS program, in which different companies included in the TeleManagement Forum take part, provided that these documents are available for free on resources of the given company only.
4. It is not recommended to use references to resources of companies that provide telecommunications services to third-party clients. However:
· It is allowed to refer to resources of such companies if these resources include specifications of industry standards or recommendations that these companies develop exclusively or in cooperation with other companies, for example, documents that are related to the NGOSS program, in which different companies included in the TeleManagement Forum take part, provided that these documents are available for free on resources of the given company only.
5. It is not recommended to use references to resources of manufacturers of software (including open-source software and software published under licenses like GPL), hardware, and telecommunications equipment. It is allowed to refer to resources of such companies in the following instances:
· When referring to proprietary telecommunications standards, protocols, and interfaces developed by these companies, and there is no other resource from which this information can be quoted legally, for example, information on the proprietary LEAP authentication protocol, which is developed by Cisco.
· When it is desirable to refer to a compatibility table of versions of a company's products and with versions of other companies' products. Such tables are updated frequently, so it is reasonable to refer to the given resource rather than copy its contents, for example, a compatibility table of BEA WebLogic Server and Oracle Database versions.
· When the given company is a developer of specifications on an acknowledged application development language or a language dialect, and it is desirable to refer to such a specification, for example, the Java language (Sun Microsystems) or PL/SQL language (Oracle Corporation).
· When the given company provides an application-running platform that can be used with Netcracker and it is desirable to refer to a specification on this platform, for example, the Java Virtual Machine (Sun Microsystems), JavaScript engine that is built into Microsoft Internet Explorer, or Internet Explorer itself.
6. It is not allowed to use references to news resources.
7. It is not allowed to use references to dictionaries, encyclopedias, and glossaries, including those supported by using wiki-technologies, for example, Wikipedia.
8. It is not allowed to place direct references to downloadable files even if the resource can be referred to according to the rules mentioned above.
Before placing an allowed external reference to a particular resource into a document, make sure this reference is valid. Validity means ensuring that the resource is accessible via this reference and it is the resource you want to refer to.
[bookmark: scroll-bookmark-256]Headers, Footers, and Page Numbering
Templates control the content of the headers and footers, requiring minimal intervention from the author.
[bookmark: scroll-bookmark-257]Page Footers
The FrameMaker templates insert page footers automatically. These contain page numbers and confidentiality wording.
[bookmark: scroll-bookmark-258]Initializing Page and Chapter Numbers in FrameMaker
To ensure that the numbering is correct in FrameMaker documents, use the book view to set the numbering properties as follows:
	TOC Page
	Page: 1 roman (xiv)

	TOF Page
	Page: Continue Numbering…

	TOT Page
	Page: Continue Numbering… Click Restart Paragraph Numbering.

	About This Document
	Page: Continue Numbering…

	Chapter 1
	Page: 1 Numeric (14) Paragraph: Click Restart Paragraph Numbering.

	Chapter 2…
	Page: Continue Numbering… Paragraph: Continue Numbering…

	Appendix A
	Page: Continue Numbering… Paragraph: Continue Numbering…

	Appendix B…
	Page: Continue Numbering… Paragraph: Continue Numbering…


To access these numbering properties:
1. Open your FrameMaker book file, select a file, right-click, and select Numbering from the menu.
2. Click the Page tab.
3. Select the First Page # and Format properties as specified in the preceding text.
4. Click Set.
[bookmark: scroll-bookmark-259]Page Numbering
The numbering on pages is automatic and requires no intervention from the author:
· There are no page numbers on the front or back of the cover page.
· For the table of contents, table of figures, and table of tables, page numbers are in bold, 10 point type Roman numerals, for example, iii. The first page of the table of contents is i, and the numbering for the table of figures and table of tables pages is consecutive from there.
· The "About This Document" chapter continues with Roman numerals, numbered consecutively following the table of tables.
· For the main (numbered) chapters of the document and the appendixes, the first page of the first chapter is 1 and the numbering for the remaining chapters is continuous. A simple page numbering format is used; page numbers do not include the chapter number.
[bookmark: scroll-bookmark-260]Page Headers
Rating and Billing Manager and Collections Manager page headers contain:
· The product name, derived from the Product Name variable.
· The document title, derived from the Document Name variable.
These items are displayed, left-justified, in the headers of even (left) pages.
The chapter/appendix name is picked up from the most recent occurrence of any of the following styles:
· Heading 1
· MTOC Title
· About Title
· Appendix Title
In some chapters, the chapter name is hard-coded into the header.

The chapter/appendix name is displayed, right-justified, in the headers of odd (right) pages. The chapter number or appendix letter, followed by an en dash (with a space before and after the dash), forms a prefix to the chapter/appendix name.

The page header is omitted from all title pages.
[bookmark: scroll-bookmark-261]Help Topics
This section contains the rules concerning topic writing.
A help topic is a complete and independent piece of information given to user. A help topic should be written so that it does not depend on what the user has already read. In a good help system, there are no "previous" or "next" topics. Never use the words "earlier" and "later" in a topic. If there is related information in another topic, this should be mentioned explicitly either at the beginning or at the end of the topic. For example, at the beginning of the "Creating network elements" topic you can write "Prior to creating a network element, create a site that will host this network element." In other words, you can easily set out conditions for a user to know that what is explained in the topic will work only after the user has accomplished some other tasks. Similarly, at the end of the topic you can explain to the user what would be logical to do next. In other words, topics but must be independent and must be linked at the same time.
Never use "above" to refer to what is written in the previous topic and "below" to refer to what is written in the next topic. You can use "above" and "below" only to refer to an adjacent paragraph above or below, respectively.
The text you write should be structured. This means that the descriptive part and the user instruction part should never be mixed. Ideally, they should appear in different topics. However, if you are describing a small task (for example, "Arranging objects in workspace"—simply changing the layout of objects in the Network Configurator workspace), it is acceptable to put the descriptive part at the beginning of the topic and the steps in the middle or at the end.
When you write a topic, you should make sure that it is tailored to a specific Netcracker page, tab, or Network Configurator dialog (or tab as well), so that when this topic is invoked from that place in the system, information presented to the user makes sense and is relevant and meaningful. Likewise, for each Netcracker tab, page, or dialog, documentation should have a corresponding topic that would be appropriate to be shown to the user when he or she clicks Help.
There are three types of topics:
1. Topics describing what the user can do on a tab, page, or dialog
2. Topics describing how the user can do something on a tab, page, or dialog
3. Topics describing what the user can do on a tab, page, or dialog, and how the user can do it.
Important! For each tab, page, or dialog, there should be either a topic of Type 3, or two topics, one of Type 1 and the other of Type 2.
Note that a topic of Type 3 can get too long. If that is the case, break it into two topics (of Type 1 and 2). Generally, a help topic should be no longer than a page.
A topic introducing a tab or page must describe the purpose of all its non-standard controls. Controls are buttons, tabs, menu items, check boxes, edit boxes, and other interface elements that a user can click (or type text into) to make some changes in the system or the database. Standard controls are the ones that are unified across the system, like the Edit or Delete buttons. For standard controls, just add a reference to the topic where they are described. For a list of standard buttons and for a reference example, refer to "Button descriptions."
Use tables to describe controls. For more information on this and for an example of such a table, refer to Buttons and Hyperlinks and Control Descriptions.
Note There must be only one chain of instructions per topic.
[bookmark: scroll-bookmark-262]First Topic
The first topic of the document should be formatted with the H2 style and named "Introduction to Document Title", where the document title is taken from document properties and inserted as a field. This will help us avoid having many topics with the same name in our online help.
For new documents, all this is implemented in the NCPD.dot. You just need to update the field in the topic heading.
[bookmark: scroll-bookmark-263]Creating and Formatting Topics
To start a new topic, you MUST follow these steps:
1. Find a topic, after which you want to insert a new topic.
2. Place the cursor at the very end of the very last paragraph in that topic.
3. Press ENTER to create a new paragraph.
4. Change the style of the new paragraph to Body Text.
5. Type heading text.
6. Change the style of the paragraph to Heading 2, Heading 3 or Heading 4.
Important! Never start a topic by placing the cursor at the beginning of the next topic and pressing ENTER. This will corrupt the bookmark, if there is one inserted for that existing topic (topic that will follow the newly inserted).
The heading title becomes the topic title, which then goes to the table of contents (TOC), and the text under the heading becomes the topic text.
Topic flow must conform to the following standard:
Heading 2
Text – Body Text style
Heading 3
Text – Body Text style
Heading 4
Text – Body Text style
In other words, there should always be a text block between Heading 2 and Heading 3 and between Heading 3 and Heading 4.
[bookmark: scroll-bookmark-264]Topic Headings

	Guideline 1
Topic headings MUST be unique across the entire help system.
To support this, you must make your heading as specific as possible. For example, do NOT call your topic "SQL"; instead, call it "Reconciliation Pattern SQL". In print or in Microsoft Word document, it may appear obvious that this SQL is specifically tailored to reconciliation pattern, but this will not be that obvious when a user incidentally opens this topic in the help system.



	Guideline 2
Avoid long headings.
First three words are the most informative part of the heading, especially in online help. That is, make headings as specific as possible while keeping them as short as possible.



	Guideline 3
Do not name topics after interface elements. Find out what task is solved with this element, and name the topic accordingly.


Incorrect
Integral Report Tab
Create New Device Dialog
Correct
Integral Reports
Creating Devices



	Guideline 4
Use the plural form for all nouns in a heading, except where it's awkward or illogical to do so. For a table of correct plural and singular usage, refer to Plural vs. Singular.



	Guideline 5
Skip articles in headings except when you are referencing a countable entity in singular form and skipping the article would change the heading's meaning.


Correct
Sharing a Perspective (this says: "Information in this topic tells you how to share one (a) specific Perspective entity with other user")
Incorrect
Sharing Perspective ("perspective" is a uncountable concept here, not entity, which changes the entire meaning)



	Guideline 6
Always use Title Case for headings of all levels, including Heading 2, 3 etc. More on capiltalization can be found in Headings Capitalization.




[bookmark: scroll-bookmark-265]H and Dropdown Topic Headings
The "H" heading styles are "H2", "H3" and "H4". If you format your topic heading with one of these styles, it does not become a separate topic in on-line help, but begins a subsection of the corresponding level inside the previous topic. This is usually used for theory, methodology and case-studies—so that all information for one non-practical subject appears on the same page, but also has comprehensible structure in print. In print these styles look exactly like "Heading 2", "Heading 3" and "Heading 4" styles correspondingly.
The "drop-down" heading styles are "Heading 3 DropDown" and "Heading 4 DropDown". These styles are identical to "Heading 3" and "Heading 4" in printed version, but in on-line help they form a drop-down section inside a topic. These sections are useful, for example, when it is necessary to describe several simple operations, which start from the same page, or some not-critically-important parts in theory topics.
[bookmark: scroll-bookmark-266]Topic Structure
Topic structure must conform to the following standard:
Heading
Text – Body Text style
[Picture] – Picture or PrintedOnlyPicture style
[Text] – Body Text style
[…]
Steps – Body Text style + 1 / 1.1 / 1.1.1 style
[Text] – Body Text style
[Picture] – Picture or PrintedOnlyPicture style
[…]
Note Brackets ([ ]) denote a block that can be omitted.
Although a topic can include Note and Important blocks, as described in "Notes and Important", the topic must not start with such a block.
[bookmark: scroll-bookmark-267]Topic Sequence
If a document includes a number of topics on working with certain objects, like "Creating sites", "Editing sites", "Deleting sites", and so on, the topic on creating such objects must be the first one in the sequence of these topics.
[bookmark: scroll-bookmark-126]Illustrations

	Guideline
General rules:
· Before inserting a screen snapshot, decide if there a real need for it.
· Large screen snapshots including a whole browser/application with navigation path and tabs may be used only once in the beginning of a document or its part.
· Crop a screen snapshot to the minimum meaningful content, leaving only important, relevant illustrative information.
· Do not overuse screen snapshots as a means of knowledge transfer. The allowed frequency of a screen snapshot is 1 per every 3 pages of user documentation, or 2 per every 3 pages of training documentation.
More about these rules can be found in Screen Snapshot Contents, Sizing, and Positioning.


Before inserting any screen snapshot into adocument, make sure that it does not contain your name or our customer's name. If it is necessary to create an object that is to be presented in a screen snapshot, choose a neutral name for it, like "Sample object,"\ "Sample device," "Quick start project," "Project #N," "Project N," "Springfield," or "Oakwood" (for cities). It is recommended to avoid the word "test" in sample project and object names.
Do not use the phrase "in the figure below" to precede a figure, except when this figure is included in online help and is formatted with the "Picture" style.
Do not embed vector images (for instance, Visio images) directly into a Word document because these images might be incorrectly transformed to a PDF. Instead, you should insert a bitmap representation of such a vector image.
To insert an image that is originally stored in Visio format into a Word document:
1. In Microsoft Visio, open the image.
2. In Microsoft Visio, on the Edit menu, click Select All.
3. In Microsoft Visio, on the Edit menu, click Copy.
4. In Microsoft Word, open the target document and place the cursor at the point where you want to insert the image.
5. In Microsoft Word, on the Edit menu, click Paste Special, and then select Device Independent Bitmap and click OK.
Graphics/illustrations (screen snapshots, flowcharts, diagrams, and so on) can and should be used only to enhance text where text alone is not a sufficient explanation. More specifically, graphics can be used to:
· Emphasize or reinforce the meaning of data.
· Help readers visualize processes and procedures.
· Simplify concepts.
· Show relationships among our components (diagrams/flowcharts in particular).
· Represent the non-obvious, or more detailed or complex, parts of the user interface.
In using graphics, be careful not to:
· Overwhelm or distract a reader from the text.
· Employ graphics merely as a method for enhancing the look of a document.
· Overuse them; do not use an illustration to convey something obvious or something that can be described sufficiently in text.
· Repeat them needlessly. Do not illustrate each step of a process.
· Capture an entire Web page in a graphics software program if just a partial view of a particular area (such as a specific group box) would be sufficient.
· Include a graphic that is not consistent with or contradicts or conflicts with the text. For example: Do not include a screen snapshot of a window that shows a check box as selected if your text is saying that the check box is cleared.
· If a screen snapshot of a user interface is required in a stepped procedure, as a general rule the screen snapshot should reflect the look of the window or page when it is opened, before any data described in a subsequent procedure is input.
· If data is required in a screen snapshot, ensure that no proprietary data is included in the screen snapshot. Use common sense if you are adding generic data (such as a fictitious customer name or address) in a screen snapshot.
Due to issues with clarity, multicolored three-dimensional representations of system functions should not be used in diagrams. The content of such diagrams should be redrawn using two-dimensional gray scale line drawings, such as those shown below.

Ultimately, as long as the writer has conformed with the guidelines stated here, the decision to use a graphic should reside with the writer who is primarily responsible for the content and knows the content best.

For interactives and Web-based presentations in particular, careful and thoughtful use of a few good graphics is much more effective in terms of page loading speed in a Web browser.
Additional Guidelines for Illustrations

When representing certain concepts, you should use specific shapes for objects. The standard representational shapes are described and shown in the following table.

	Concept/Object
	Description
	Shape

	Bill or dunning notice
	Symbolic icon (page with lines), with text indicating the type
	[image: ]

	Catalog (billing or rating)
	Symbolic icon (book with lines for an existing catalog, without lines for a new catalog)
	[image: ]

	Connections/Interfaces/ Sockets
	Double-headed arrow
	[image: ]

Use line arrows, as shown.Do not use block arrows.

	Database
	Cylinder
	[image: ]

	Database table, with or without column names
	Divided rectangle
	[image: ]

	FilesLog files
	Box with wavy line on bottom
	[image: ]

	Applications
Use for user interfaces and system processes.
	Rectangle, enclosing the application name
Use shading to emphasize a specific application in a flow.
	[image: ]

	Mediation devices, Network devices
	Ellipse, enclosing the device name
	[image: ]

	Flow diagram – step
	Rectangle, enclosing text
	[image: ]

	Flow diagram – decision
	Rhombus, enclosing text
	[image: ]

	Flow diagram – arrows
	Single- or double-headed arrow
	[image: ]

Use single-ended arrows, as shown.Do not use block arrows.


In illustrations of a process, you should normally use line arrows of a thickness that is appropriate to the remainder of the illustration. If you use block arrows, these should have a 50 percent gray filling.

You should aim to be consistent throughout a presentation in the types of arrows used for similar diagrams.
[bookmark: scroll-bookmark-269]Acceptable Graphic Types
The following graphic types are acceptable:
· GIF (for most graphics. Also, most small icons should be saved as GIFs.)
· PNG (acceptable, and especially for color-heavy graphics)
· EPS (acceptable strictly for linear-based flowcharts or diagrams, to ensure optimal print viewing, EPS graphics are created from CorelDRAW)
· EMP (acceptable strictly for linear-based flowcharts or diagrams, to ensure optimal print viewing, EMP graphics are created from Microsoft Visio)
	
	

	Note:
	BMP and JPG file types should never be used.

	
	


[bookmark: scroll-bookmark-270]Anchoring a Figure in FrameMaker
To achieve correct line spacing above graphics and screen snapshots in FrameMaker, precede all figures with a blank line, using the Anchor style. You can then insert an anchored frame by selecting Anchored Frame from the Special menu or by copying the anchored frame on the References page (View > Reference Pages) and pasting it where appropriate. All figures should be left-justified. However, anchored frames should align with the right margin.
[bookmark: scroll-bookmark-271]Figure Captions

	Guideline 1
All figures, diagrams, illustrations, pictures, and screen snapshots must have a caption. Put the caption after the figure.



	Guideline 2
To insert caption, use the Reference -> Insert Caption menu command in Microsoft Word. The figure caption label must be "Figure".



	Guideline 3
Do not put periods at the end of the caption text.


Example:
Figure 2. New Site Dialog

	Guideline 4
Never use dashes in caption text.



	Guideline 5
Include articles in figure captions if applied in the middle of a sentence. Do not start the captions with an article.


Examples:
Figure 4. Upload and Delete Buttons
Figure 5. Properties Tab
Figure 6. Adding an Address
Figure 7. Exporting Project with Operation Progress Shown


	Guideline 6
Never use angle brackets (< >), square brackets ([ ]), or any extra formatting to highlight names of controls in captions.



	Guideline 7
Do not describe the purpose of what is shown in the figure or any actions associated with it. Use only names of controls, titles, and so on.



	Guideline 8
Use tool tips as names of the buttons when your figure should bring the user’s attention to buttons.




	Figure captions with a chapter number (like Figure 3-11) are deprecated. To replace such captions with proper ones automatically, use the RemoveH1FromCaptions macro (CTRL+ALT+U) provided in NCPD.dot.



[bookmark: scroll-bookmark-272]Figure Captions in FrameMaker
In FrameMaker, all figures should be followed by a caption, using either Figure Title and giving a brief description of the figure.

The Figure Title style automatically adds Figure <n> (where n represents a consecutive number) before the text you enter as a title.

For any caption that extends beyond a single line, you must specify exactly where the line break is to occur. To do this, insert a soft return at the break point and a tab marker at the start of the second line. Note that you cannot insert the tab marker by pressing the TAB key, but instead, you must insert a tab marker elsewhere in the text, and then copy and paste it at the beginning of the second line.

Because the Anchor style in FrameMaker has a "keep with next" property attached to it, figures and their captions should never become separated.
	You must refer to each figure at some point in the text, to emphasize the relevance and context of the figure. See Internal and External Cross-References page , for information on references to figures.


[bookmark: scroll-bookmark-273]Google Toolbar
If the Google Toolbar is installed for your Internet Explorer, some edit boxes on Netcracker pages may be displayed with yellow highlighting, which is incorrect.
[image: ]
Highlighting of the Name Edit Box
To avoid making inappropriate screen snapshots do not install Google Toolbar.
[bookmark: scroll-bookmark-274]Highlighting in Screen Snapshots
In general, no additional highlighting should be applied to screen snapshots, specifically:
· No frames for the entire screen snapshot
· No highlighting of any parts of screen snapshots with red boxes. When such highlighting seems crucial for understanding what the screen snapshot is for, it usually means that the screen snapshot is too general or otherwise inaccurate.
If it is absolutely necessary to highlight some point on a screenshot, use the hand-shaped cursor, as shown in the next figure.
Figure 3 8.png
[image: ]
Highlighting with Hand-shaped Cursor
[bookmark: scroll-bookmark-41]Screen Snapshot Capture Techniques
https://bass.netcracker.com/pages/viewpage.action?pageId=250549282
[bookmark: scroll-bookmark-275]Pop-Up Screen Snapshots

	Guideline 1
You should treat any popup dialog as a screen region. Use Snagit or any other snapshot tool to capture the region on the screen.



	Guideline 2
Do NOT capture the border of the pop-up. Confluence will add the border to ANY image automatically.
If you capture the image with the border, there will be two borders around the image: the captured one and the one added by Confluence.



	Guideline 3
In documents it is allowed to insert only screenshots without image croppings in the background.


[bookmark: scroll-bookmark-276]How to Take Screenshot
1. Invoke pop-up in Google Chrome web browser
2. Insert the whole text which is given below into a browser address bar (a script author is Lavr Lyndin)
	javascript: jQuery(".ui-widget-overlay-under").css("background","white");
jQuery(".ui-dialog")[0].style["boxShadow"]="none";
jQuery(".triangle").hide();



	If a code didn't work, check whether a browser captured the word «javascript:» when pasting a code into a browser address bar or not


3. Snap a screen region with a pop-up using a typical Snipping Tool (or SnagIt, etc.)
Result:
[image: ]
	To avoid copying a javascript code into a browser address bar create a button-marker on the "Bookmarks" in Google Chrome web browser using the following way:
1. Right-click on the Bookmarks and select Add Page
2. Specify a new button name in Name field, e.g. "Screenshot".
3. Copy javascript code from the above mentioned example in URL field.











[bookmark: scroll-bookmark-268]Screen Snapshot Contents, Sizing, and Positioning

	Guideline 1
General approach:
· Use a figure only to demonstrate clearly the feature it illustrates.A screen snapshot must indicate the UI elements that are significant with respect to the text contents.
· Do not insert a screen snapshot of an entire Web page to demonstrate a small pop-up dialog, which would be indistinguishable.
· Crop the excessive area of the screen snapshot.
· All illustrations should be left-justified.
· In FrameMaker, graphics are not embedded within the documents. They are held as links to external EPS, GIF, or PNG files.




	Guideline 2
Frequency of screen snapshots:
· There can be a maximum of 1 screen snapshot per every 3 pages of text (2 screen snapshots is allowed for training documentation).
· There can be a maximum of 2 screen snapshots per a document article.




	Guideline 3
When inserting screenshots into the documentation, make sure that all the objects' names are sensible. Using such object names like: "Test customer", "My project", "Company 1", "Alex opportunity" is deprecated. All the object names must be fictitious. The object names must look like true names in production.
Incorrect
Test Residential Customer
Correct
John L. Black
Incorrect
Company 1
Correct
Jackson Sales and Management Llc.



	Guideline 4
Never insert screen snapshots disclosing confidential corporate data like:
· Customer names in product documentation
· IP addresses
· Server names
· Netcracker user names




	Guideline 5
A screen snapshot may contain the navigation path and the tabs only when:
· This is the first illustration of this screen form and it is important to show its place among other tabs.
· There is an identical screen form on another tab referenced in the same document article.
Example
[image: ]



	Guideline 6
A screen snapshot cannot have navigation path or the tabs, except cases explicitly mentioned in Guideline 4.
Correct
Note the Password field in the Business Customer Account section.
[image: ]
Incorrect
Note the Password field in the Business Customer Account section.
[image: ]



	Guideline 7
In Netcracker TOMS documentation, the allowed screen snapshot height to width ratios are: 1:1, 1:2, 2:3, 3:4. A tall picture forces a page beak to be inserted before while leaving a big empty space on the previous page.
Correct
[image: ]
Incorrect
[image: ]


In FrameMaker, be particularly conscious of the size of screen snapshots for Web-based pages. Keep your original image size intact, and resize it only after you import it into your document or application. Do not reduce or resize a graphic in your graphics software program before importing it into your document or application.

Ensure that no white border exists around your original images. The content of the image should fill the entire area that is saved to a file. (Failure to do so in the past has created HTML output with large white gaps between images and the text.)

Try to save graphics (especially graphics that are not color-heavy) using the 256-color palette for optimal HTML color conversion.

In saving your graphics in a graphics software package, always use a 1:1 display ratio to ensure optimal resolution.
· When you import pixel-based (raster) images (such as GIF and PNG file types) into your document/application, try to adhere to a DPI range of from 100 to 200 dpi (depending on the size of the graphic) when resizing within your application in order to satisfy print and online needs. This does not apply to EPS files.
· When you import a line-based (vector) image (such as an EPS file created in Visio), no specification of DPI should be necessary.
Once you have imported a graphic into your document or application, follow these general guidelines:
· Graphics should be resized to 75 percent of the original size.
· The maximum width should never exceed 6.5 inches. Preferably, the width should stay within the 5.5-inch boundary (the text area within a FrameMaker document). Ideally, a typical (average-sized) graphic's width should be roughly between one-half to three-quarters of the 5.5-inch width of the text area. And ideally, a graphic should take up no more than roughly two-thirds of the length of the text area of a page.
· You must also ensure that the aspect ratio is retained.
· Buttons, icons, and very small items should be enlarged to 200 percent of their original size, to ensure legibility.

	Guideline 8
The size of text in the image should be the same size as the document body text or 1 point smaller.
There must be no images with huge characters, for example small alerts stretched to the page width.
Correct
[image: ]
Incorrect
[image: ]



	Guideline 9
To insert a widget pop-up dialog without the background picture, use the technique described in Screen Snapshot Capture Techniques.







[bookmark: scroll-bookmark-277]Screen Snapshot MS Word Style
All images should be formatted with the Picture style, if the image goes to online help and a printed document.
All images should be formatted with the PrintedOnlyPicture style if the image goes only to a printed document.
Generally, you should include in online help only small button images and illustrations that must be present to clarify the material being discussed. Screen snapshots demonstrating user actions or results of these actions should end up only in printed documentation, as we assume that when users perform the actions they can see everything on the screen.
[bookmark: scroll-bookmark-278]Proper Color Scheme
When taking screen snapshots, make sure the Windows Standard color scheme is set for your computer. If you run Windows XP, also make sure the buttons and windows are displayed in the Windows Classic style, and the ClearType option for screen fonts is turned off.
Setting the Color Scheme in Windows XP
To set the proper window and button appearance in Windows XP:
1. Right-click on your desktop.
2. Select Properties from the menu.
The Display Properties dialog appears.
3. Click the Appearance tab.
4. From the Windows and buttons drop-down list box, select "Windows Classic style".
5. Click Effects.
The Effects dialog appears.
6. Make sure the ClearType option is not selected from the Use the following method to smooth edges of screen fonts drop-down list box.
7. Click OK.
The Effects dialog is closed.
8. From the Color scheme (or Scheme) drop-down list box, select "Windows Standard".
9. Click OK.
The windows and buttons are now displayed in the appropriate style and colors.
Setting the Color Scheme in Windows 7
To set the proper window and button appearance in Windows 7:
1. Right-click on your desktop.
2. Select Personalize from the context menu.
The Personalization page of the Control Panel is displayed.
3. In the Basic and High Contrast Themes group, click "Windows 7 Basic".
The theme is applied.
4. Close the Control Panel window.
The windows and buttons are now displayed in the appropriate style and colors.
[bookmark: scroll-bookmark-279]Use of Color
If you are creating an original graphic (such as a flowchart or a diagram), remember that logic, clarity, and meaning should always drive your design. Keep your design as simple and straightforward as possible. You should have a peer or someone who represents your audience review your materials once they are created. Only include layout elements and text that support the message. Remember that the design is intended to help clarify and support the content.

Also, follow these guidelines:
· Use a transparent background when creating your graphics.
· Use black/white (grayscale) as the primary color values.
· Use drop shadows only as needed to draw attention to boxes or images.
· Use Arial 9-point bold type for callouts or text. Use text as needed to help clarify the design, but do not overwhelm a graphic with too much verbiage. Use the case that is appropriate for the content of the callout or other text.
· Use other colors effectively to highlight or contrast data as needed.TIPS: Try to stay within the colors in the standard Web-based "safe" 256-color palette.Try saving your image as an HTML file and opening it in a Web browser to determine how the Web-based version will look.
· Consult an editor or another author if you are in doubt about color selections for graphics.
· Maintain consistency in the use of ruling line thicknesses, types of arrows used, fill patterns, and spatial relationships to text and other graphic elements. If you use fill patterns, ensure that they can be differentiated easily on screen and in print.
· Avoid overwhelming an image with too much color.
· Avoid using background images containing graphic patterns that may compete with or distract from the information being presented in the flowchart or diagram.
See the Naming Conventions topic for information on the naming conventions that should be used when saving illustrations.

[bookmark: scroll-bookmark-280]Visited Links
In screen snapshots, there should be no visited links represented in a color that is different from other links. You can clear the list of visited links by clearing the Web browser history and reloading the page.
To remove visited links from a page:
1. In Internet Explorer, from the Tools menu, select Internet Options.
The Internet Options dialog box is displayed.
2. On the General tab, in the History group, click Clear History.
3. In the displayed warning message, click Yes.
The browser history is removed.
4. In the Internet Options dialog box, click OK to close the dialog.
5. Refresh the page.
All links are displayed as unvisited.
Note: If you use Windows 7, press ALT to display the menu bar.
[bookmark: scroll-bookmark-281]Key Names
In general, spell key names as they appear in the following list, whether the name appears in text or in a procedure. Use all capitals for key names unless otherwise noted.
Correct
ALT
ALT GR
Application key [Microsoft Natural Keyboard only]
arrow keys [not direction keys, directional keys, or movement keys]
BACKSPACE
BREAK
CAPS LOCK
CLEAR
CTRL
DELETE (Use this to refer to the back delete key on the Macintosh keyboard.)
DOWN ARROW (Use "the" and "key" with the arrow keys except in key combinations or key sequences. Always spell them out. Do not use graphical arrows.)
END
ENTER (On the Macintosh, use only when functionality requires it)
ESC (Always use ESC, not ESCAPE or Escape, especially on the Macintosh.)
F1–F12
HOME
INSERT
LEFT ARROW (Use "the" and "key" with the arrow keys, except in key combinations or key sequences.)
NUM LOCK
PAGE DOWN
PAGE UP
PAUSE
PRINT SCREEN
RESET
RIGHT ARROW (Use "the" and "key" with the arrow keys, except in key combinations or key sequences.)
SCROLL LOCK
SELECT
SHIFT
SPACEBAR (Precede with "the", except in procedures, key combinations, or key sequences.)
SYS RQ
TAB (Use "the" and "key", except in key combinations or key sequences.)
UP ARROW (Use "the" and "key" with the arrow keys, except in key combinations or key sequences.)
Windows logo key [Microsoft Natural Keyboard only]
Spell key names that do not appear in this list as they appear on the keyboard.
When telling a user to "press" a key, format the key name in all caps. When telling a user to "type" a key, use lowercase bold, unless an uppercase letter is required.
Correct
Press Y.
Type y.
Note: Format punctuation according to the intended use. If the user must type the punctuation, use bold. If not, use regular.
At first mention, you can use "the" and "key" with the key name if necessary for clarity—for example, "the F1 key." For all subsequent references, refer to the key only by its name—for example, "press F1."
For the arrow keys and the TAB key, list only the key name in key combinations without "the" and "key."
Correct
To move the insertion point, use the LEFT ARROW key.
To extend the selection, press SHIFT+LEFT ARROW.

[bookmark: scroll-bookmark-282]Special Character Names
Because these keys could be confused with an action (such as +) or be difficult to see, always spell out the following special character names: PLUS SIGN, MINUS SIGN, HYPHEN, PERIOD, and COMMA.
Correct
SHIFT+PLUS SIGN
Press ALT, HYPHEN, C
Press COMMA
Press COMMAND+PERIOD
Type an em dash
Press the PLUS SIGN (+)
Incorrect
SHIFT+ +
SHIFT+ -
Press +.
You can add the symbol in parentheses after the special character name—for example, PLUS SIGN (+). Use discretion in adding symbols, however. it may not be necessary for commonly used symbols such as a PERIOD (.).
[bookmark: scroll-bookmark-283]Narrative Text vs. Lists
Narrative text shall never be formatted as list. List formatting can be applied only for simple text with no more than one phrase per item. Lists can contain text only, no code samples, neither figures, and so on. A sequence of user's actions is not an exclusion. Using list as a structural base for text and styling text as list items is unallowable. Structural base of text for readers is always paragraph.
INCORRECT:
https://doc.netcracker.com/pages/viewpage.action?pageId=21401770#OfflineMode-OfflineManifest
CORRECT:
https://doc.netcracker.com/display/MobileClientFRW009003003003/Offline+Mode#OfflineMode-OfflineManifest
[bookmark: scroll-bookmark-284]Step-by-Step Lists

In this topic, all rules concerning steps and step results are presented:

	Guideline 1
Bulleted lists can have only one level. Nested bulleted lists are deprecated.
Correct
· Item1
· Item2
· Item3
Incorrect:
· Item1
· Item2
· Subitem1
· Subitem2
· 
· Subitem3
· Item3




	Guideline 2
Numbered lists can have only one level . Nested numbered lists are deprecated.
Do not use constructions containing the phrase "Do one of the following" in step-by-step lists. If an operation can be performed by different means, specify the best method in the instruction, and add secondary methods as a note if needed: "…Note, there is also another method of doing it...".
For example, the best method to get to My Desktop is to click your user name on the top right. Less clicks – the better the method.
Correct:
1. Item1
2. To set the timeout period, in the Table X, click the appropiate value in the Timeout column. Note, that setting timeout period can be also performed on the System tab of the object page in the edititng mode.
3. Item3
Incorrect:
1. Item1
2. In order to set the timeout period, do one of the following:
· Subitem1
· Subitem2
· Subitem3
3. Item3




	Guideline 3
Each step must always start from setting the place of the action as introductory part if any. Then, the introductory part must be followed by a comma and the action itself.
On the navigation path string, click "Cables."
In the Name edit box, type My Project
Simple sentences do not require introduction.
Click OK.




	Guideline 4
Always start steps from the top level of user actions, such as clicking something on the Navigation menu or navigating to objects in the Network Configurator.
On the Navigation menu, click Data Mapping.
In the Network Configurator, navigate to…



	Guideline 5
Starting from Netcracker 7.2, the order of tabs displayed on an object's page can be changed. So, if the page you informed the reader about includes more than one tab, always explicitly specify a step about clicking the target tab even if this tab is opened on the page by default. This ensures that the reader gets to the tab you want him or her to open.
In the example below, the Countries tab is the default tab of inventory project's top site's page.
2. Click your inventory project.
3. Click the Countries tab.



	Guideline 6
When you want the user to open a specific object and then immediately navigate to one of its tabs, join these actions into one step, as written in the example below. The only exception is when you want to illustrate the fact of opening an object with a screen snapshot. Then, insert the screen snapshot, and in the following step, tell the user to click the appropriate tab.
In the Data Mapping Projects table, click the name of your data mapping project, and then click the Parameters tab.



	Guideline 7
Avoid interrupting steps with conceptual content. Try to put all conceptual content before steps, where possible.



	Guideline 8
Although many operations with objects (like deletions) let the user select several objects at once, in the procedure, describe the course of action for one object.
5. Select the check box for the session you want to stop.
However, if but only if you are describing a specifically bulk operation, like, for example, editing several circuits, you can write the instruction as follows:
Correct
Select the check boxes for the sessions you want to stop.
Incorrect
Select the check box(es) for the session(s) you want to stop.



	Guideline 9
Do not begin steps with "To do something". All steps must be strictly imperative.



	Guideline 10
For optional steps, do not place "Optionally" at the beginning of a step. Instead, begin it with "If necessary". Also, if steps contain one or more complex steps (subprocedures) that may be omitted, make sure to state this in the main topic text before the steps begin so that it is easier for the user to skip the unnecessary actions.



	Guideline 11
If some steps can or should be repeated, for example, adding several similar objects, then in the steps it should be specified which steps are to be repeated. Format the step numbers as cross-references, to simplify future support of such links.



	Guideline 12
Capitalize each step reference, for example, "Repeat Step 2", not "Repeat step 2".



	Guideline 13
Do not make separate steps telling how to cancel something in the same procedure where this thing is initiated.
Correct
1. On the Navigation menu, click Data Mapping. The Data Mapping Projects page is displayed. (Put the step result in the same paragraph)
2. In the Data Mapping Projects table, click the name of your data mapping project, and then click the Parameters tab.
3. …
4. If necessary, in the Name edit box, type a new name.
5. ...
6. ...
7. ...
8. To add more IP addresses for the device, repeat Steps 5-7 .
Incorrect
8. To add more IP addresses, repeat Steps 5-7.
9. Click Cancel to terminate adding addresses.



	Guideline 14
Minimize the number of steps used in step-by-step procedures where possible. Twenty steps might occasionally be necessary for a complex administrator task, but tasks in user guides should be broken up into smaller subtasks if necessary.



For information on steps formatting, refer to Steps Structure.
[bookmark: scroll-bookmark-286]Step-by-Step Opening

	Guideline
If a paragraph contains something like "To open…" and ends with a colon, always format this paragraph with the "Keep with next" option.
Do not use the Microsoft Word 'Paragraph tool for this, as it can lead to errors when applied to the "List" style.
Use the built-in custom button found in the NCPD template toobox.


[bookmark: scroll-bookmark-285]Steps Structure
If there is more than one instruction, all user instructions must be formatted as a numbered list. If there is just one instruction, it should be formatted as a bulleted list that consists of only one bulleted item.
Note: Avoid interrupting steps with conceptual content. Try to put all conceptual content before steps, where possible.
If there is only one step or instruction, it should conform to the following standard:
Goal line (for example, "To delete a device:"):
· Instruction (for example, "Click Delete")
Example:
To open a project:
· In the project table, click the name of the project.
If there is more than one step in the chain of instructions given to the user, steps must conform to the following standard:
Goal line (for example, "To create a device:"):
1. Instruction 1. [Brief description of step results]
2. Instruction 2 .[Brief description of step results]

Note: Brackets ([ ]) denote a block that can be omitted.
[bookmark: scroll-bookmark-287]Subprocedures in Steps

	Guideline
Subprocedures in steps are deprecated.


[bookmark: scroll-bookmark-288]Styles and Formatting
This section details the styles and formatting that are common to all documentation.

In order to ensure stylistic consistency throughout a document, predefined styles should always be used in preference to ad hoc paragraph formatting.
Developers should, therefore, not use non-standard formatting, that is, they must not:
· Create their own styles.
· Override existing styles.
· Use untagged character styles.
· Insert manual page breaks.
All currently-approved styles for RBM/ICOMS/CM documentation can be found in the relevant FrameMaker templates. For a full list of styles, see the templates.

For general guidelines on hyphenation and capitalization of Netcracker TOMS terminology, see the Preferred Terms and Treatments topic.
[bookmark: scroll-bookmark-289]Captions for Figures and Tables
The following FrameMaker styles are available for figure and table captions:
	Figure Title
	For figure captions (caption immediately following a figure)

	
	

	Table Title
	For table captions requiring a title (caption immediately preceding a table)

	Table Title [image: ]
	For table captions in the About This Document chapter only (caption immediately preceding a table)

	
	


[bookmark: scroll-bookmark-290]Character Styles
Character styles should be used to highlight particular words or phrases in the text. The FrameMaker character styles are as follows.
	Default Font
	This default style is used to apply regular text.
This style eliminates all formatting, leaving the default attributes as defined in the Paragraph Designer for that selection.

	bold
	General bold style for drawing attention to a particular word/phrase and for variables and permissions.

	callout
	Used with a simple pointer line with no arrowhead (width=0.5) to identify elements in certain graphics.
Use the case that is appropriate for the content of the callout.
Note: Callouts are generally not to be used but are allowed if the window or page being illustrated is particularly complex (to identify the sections of the window/page, or to point out a specific area of focus).

	Component
	For names of window components such as command buttons, option buttons, text boxes, check boxes, drop-down lists, group boxes/panels, and menu options.

	computer text
	See the On-Screen Text and Structures topic.

	Emphasis
	For applying italics to words that you want to emphasize, and terms that are being defined.

	keys
	For applying an all-uppercase style for key names and key combinations.

	names/paths
	Used specifically to make file names, directory names/paths, file suffixes, script names, and server names bold. URLs should also have this style, and no link.

	page no
	For the page number within the footer.

	strikethrough
	For text with a line through it, to indicate removed parameters, and so on.

	subscript
	For subscript characters, as in AAAsub.

	superscript
	For superscript characters, as in AAAsuper.

	Wingdings
	For defining certain bullet styles in FrameMaker.

	x-ref external nolink
	For unlinked cross-references to documents that are not in the same documentation set (applies italic type but no blue).


[bookmark: scroll-bookmark-291]Framemaker Styles for Specific Items
To achieve common styling across all documentation, the list in the following shows items that require specific FrameMaker styles, indicating the style that should be used and providing an example for each one.

Note: If a stylized (for example, bolded) text item immediately precedes a mark of punctuation, such as a comma or a period, do not apply the style to the punctuation mark. (This is contrary to the regular usage outlined in industry style guides.)
	Items
	Style
	Example

	Button names
	Component
	Click Save to save the entries.Click OK to open the Add Product dialog.

	Chapter (section) titles in cross-references
	Body, in quotation marks
	See "Tax Sets and Tax Codes" for more information.

	Check box names
	Component
	Select Tax inclusive.

	Class names
	Body (with appropriate capitalization)
	… the StreetTypeCode constant class …… the public class MyContact …… the SecurityFilter class …

	Computer input and output text (individual words)
	computer text (character style)
	Enter PPM as the application server name.

	Computer input and output text (single line or first line of a block)
	Computer Text
	This achieves a non-proportionally spaced font, suitably spaced from the text above.

	Computer input and output text (all except the first line of a block)
	Computer Text Close
	This achieves a non-proportionally spaced font with no spacing above.

	Database column names
	Body (type in uppercase)
	… the CURRENCY column in the COSTEDEVENT table.

	Database table names
	Body (type in uppercase)
	The event is added to the COSTEDEVENT table.

	Dialog, message box, and window or page names
	Body
	Open the Add Customer dialog.The Confirm window opens.

	Directory names
	names/paths
	The file is saved in the temp directory.

	Directory paths
	names/paths
	Paths relating to Windows use a backslash symbol, and those relating to UNIX use a forward slash.
For example:
· Windows: C:\trainX\bill\test
· UNIX: ../trainX/bill/test


	Drop-down list names
	Component
	… the Customer Type drop-down list.

	Drop-down list items
	Body (capitalization to match the system)
	Select Private customer from the Customer Type drop-down list.

	Field names
	Component
	In the Name text box (field), enter …

	Figure numbers and table numbers
	Bold (for the word Figure or Title and the figure or table number only)
	Figure 10 The Rating Process Table
Table 7 List of System Parameters

	Figure numbers and table numbers (for HTML conversion)
	Bold (for the word Figure orTitle and the en dash that follows only)
	Figure – The Rating Process Table
Table – List of System Parameters

	File names
	names/paths
	This can be found in the install.ini file.

	File suffixes (used alone)
	names/paths
	This lists all the .dot files.

	File types
	Body
	… a file of type FileType …

	Function names
	Body (with appropriate capitalization)
	… the Oracle Autoextend function …

	Group box names
	Component
	Use Under, followed by the group box name. Do not include the words group box.
Under Product Details in the Add Product dialog, enter…

	Job types
	Body
	… a job of type JobType …

	Keystrokes
	keys `(all uppercase)
	To save your entry, press ENTER.To move back a field, press SHIFT+TAB.

	Menu options
	Component
	When you select Save from the File menu, the file …

	Menu paths
	Component
	Select File > Save.

	Menu titles
	Component
	View the File menu.

	Method names
	Body (with appropriate capitalization)
	… the rawNETypeQuery method …… the applyUpdate method …

	Object names
	Body (with appropriate capitalization)
	The ServiceOrders object supports the Requeue method.

	Option button names
	Component
	Click Tax inclusive.

	Parameters within a procedure
	Body
	… where account_id is set to null …

	Paths
	names/paths
	Save the file in the /opt/oracle/ directory.
Variables must not be used to stipulate paths.

	Permissions/User IDs
	Bold
	As in sudo permission or root permission.Use root as the user ID.

	Read-only values for fields
	Body (capitalization to match the system)
	The Status is Active.

	Roles
	Body (with appropriate capitalization)
	The role is named [schema]_role.

	Script names
	names/paths
	The setup.environment script …

	Server names
	names/paths
	Documentation is stored on the CDCFQ001 server.

	Stored procedure names
	Body
	… the storedProcedureName stored procedure …

	System messages
	Body (with quotation marks)
	The message states: "Are you sure you want to delete this record?"

	System parameter names
	Body
	… the SYSdateValue system parameter …

	Tab and subtab names
	Component
	View the Address Details subtab on the Customer Details tab.

	Table names
	Body (type in uppercase)
	Inspect the TABLENAME table.

	Terms being defined in regular body text
	Emphasis
	An account hierarchy is a …

	Titles of books, guides, and so on
	Emphasis
	Refer to the Glossary for details.

	Toolbar names
	Component
	… the Formatting toolbar …

	User interface and system process names
	Body (initial capitalization for all key words)
	Billing Catalog Maintenance is used to …,The Task Master is designed to …

	Utilities
	Body (with appropriate capitalization)
	… the genksms utility is in $ORACLE_home/bin.

	Values entered as part of an exercise
	computer text (character style)
	Enter Jones as the Surname.This may also be presented in an invisible table format.

	Variables
	Bold (type in uppercase)
	The $APP_DOMAIN variable …

	View names
	Component
	The Tax view of System Configuration …

	Web page names
	
	See Dialog, message box, and window or page names.

	Window names
	
	See Dialog, message box, and window or page names.


[bookmark: scroll-bookmark-292]General Text
In FrameMaker, the Body style should be used as the default style for regular text.
[bookmark: scroll-bookmark-293]Hanging Text
Hanging text can be used to provide a list of field names and their descriptions. However, bullets and stub lists are generally preferred. If hanging text is needed, use an invisible table to indent the body of the descriptive text. For example:
	Field name
	Description of the field, description of the field, description of the field, description of the field…
Further paragraph…


FrameMaker includes a standard invisible table that can be inserted as required. If necessary, the column widths in this table can be altered, as long as the overall effect is consistent (that is, there are no noticeable differences in the position of text where more than one invisible table appears on a page). The left column should not, however, exceed 50 percent of the table's width. For example:
	Acceptable example of an invisible table
	This is an example of the acceptable use of an invisible table as hanging text.
	

	Unacceptable example of an invisible table
	
	This is an example of the unacceptable use of an invisible table as hanging text.


There are no specific styles for bulleted text and so on within an invisible table. These forms are achieved by using standard text styles within the invisible table. In other words, do not use table text styles for invisible tables, use regular body text styles.
[bookmark: scroll-bookmark-294]Headings
Headings in RBM and CM documentation should have the following styles. This list reflects only the styles that are common to all documentation:
	About Title
	Heading for the "About This Document" section

	Heading 1
	Main heading (chapter or section title)

	Heading 2
	Level 2 heading

	Heading 3
	Level 3 heading

	Heading 4
	Heading within a subsection (that is, a heading of lesser importance than a Heading 3)

	Heading 5
	Heading within a subsection (that is, a heading of lesser importance than a Heading 4)

	Heading 6
	Heading within a subsection (that is, a heading of lesser importance than a Heading 5)

	Appendix Title
	Appendix heading

	MTOC Title
	TOC, TOF, and TOT title

	Example
	Heading for a large standalone example.
Unless the text of the example is followed by a heading, a spacing line (using the Example End style) must be placed after the example and before the next paragraph of text to delimit clearly where the example ends and the main text is resumed.


[bookmark: scroll-bookmark-295]Layout and Styles
To ensure stylistic consistency throughout a document, predefined styles must always be used instead of ad hoc paragraph formatting.
The use of correct styles should prevent most problems with widows and orphans, and other layout peculiarities.
[bookmark: scroll-bookmark-296]Applying Character Styles
In FrameMaker, where proportional font styles must be applied to words or phrases in text, the spaces preceding and following the word or phrase should not have the style applied, for example, "the File menu." The Body style, not the bold style, should be used before and after the word File. This preserves regular spacing throughout the document.
	
	

	Note:
	A proportional font is a font such as Arial in which different characters have different pitches (widths). Proportional fonts are also called proportional-pitch fonts. (In other words, these are not monospaced fonts.)

The opposite of a proportional font is a fixed-pitch, or non-proportional, font. Andale Mono is an example of a non-proportional font.

	
	


Where non-proportional fonts are in use, for example, "Enter PPM as the application server name," the spaces before and after the text that appears in the non-proportional font should have the same style applied.
[bookmark: scroll-bookmark-297]Leadins
To ensure at a page break that a specific piece of text is kept with the line that follows it, several leadin styles are available in FrameMaker. These must be used when introducing a numbered list, bulleted list, or hanging text (invisible table). For example:

This is a leadin to a bulleted list and incorporates the "keep with next" property:
· Option 1
· Option 2
· Option 3
The following styles are provided in FrameMaker:
	Body Leadin
	For use in normal Body text

	Bullet Leadin
	For use in place of the Bullet style, for example, to introduce a list in Bullet2

	Bullet2 Leadin
	For use in place of the Bullet2 style, for example, to introduce a list in Bullet3

	Bullet3 Leadin
	For use before a Steps bullet2 indent

	Step Intro
	Infinitive phrase to introduce a list of Steps

	Steps Leadin
	For use in place of the Steps style, for example, to introduce a bulleted point within a step, in Steps bullet

	Steps indent Leadin
	For use under a Bullet and leading to a Bullet2, or under a step and leading to a Steps bullet

	Steps bullet Leadin
	For use in place of the Steps bullet style and leading to a Steps bullet indent.

	Steps bullet indent Leadin
	For use under a Bullet2 and leading to a Bullet3, or under a Steps bullet and leading to a Steps bullet2

	Steps bullet2 Leadin
	For use in place of the Steps bullet2 style and leading to a Steps bullet2 indent.


[bookmark: scroll-bookmark-298]Lists

	Guideline 1
Do not use lists inside tables.



	Guideline 2
Lists can be bulleted or numbered. In both cases they must be preceded by a leadin style in FrameMaker (see the Leadins topic).



	Guideline 3
Bulleted lists do not imply any logical progression between the points listed, but they should be used to allow relevant points to be grouped, for example, when breaking up points in a paragraph.



	Guideline 4
Numbered lists should be used only when ordering is implied, that is when items further down the list occur later, or are smaller or less important.




[bookmark: scroll-bookmark-299]Bulleted Lists
Whenever possible, bulleted lists should be used in preference to numbered lists. Bulleted lists should also be used to break up blocks of text containing important points. The use of bullet points makes it easier to locate and view important points within a topic and aids user comprehension.

For first-level bullets:
	Bullet
	Used as a general list style

	Steps indent
	Used wherever additional explanation is required for a bullet entry, or an example must be provided. In other words, wherever it is appropriate to start a new paragraph explaining a list point that is not itself a new point.

Steps indent is correctly indented for use with numbered and bulleted lists.


For listing additional points within a bulleted list:
	Bullet2
	Second-level bullet

	Bullet3
	Third-level bullet

	Steps bullet indent
	To add extra paragraphs to Bullet2

	Steps bullet2 indent
	To add extra paragraphs to Bullet3


For example:

Leadin:
· Bullet
Steps indent
· Bullet Leadin:
· Bullet2
Steps bullet indent
· Bullet2 Leadin:
· Bullet3
Steps bullet2 indent

In stub lists (lists where each bulleted item begins with a run-in title), the appropriate level of bullet style should be used. The stub title should be in bold text and should end with a period. There should be a single space between the period and the remaining wording in the bullet. This example is taken from a Help topic:
· Operator-defined attributes. The actual label will vary, according to client needs. Select the attribute from the drop-down list. There may be several operator-defined attributes defined for the customer.
[bookmark: scroll-bookmark-300]List Punctuation and Capitalization
The following rules relate to the setting out and punctuation of numbered lists and bulleted lists:
· Items in a list should start with a capital letter.
The only exception is where, for example, a stored procedure (such as rejectCatalog) is listed.
· Any item that is a complete sentence should end with a period.
· Any item that is a fragment that completes the thought in the stem of a list should end with a period.
· Otherwise, items in a bulleted or numbered list should not end with a period.
· If there is any doubt when creating a bulleted list, the overall effect must be consistent – it is not acceptable to have periods inconsistently applied within the same bulleted list.
· If two (or more) bullet points detail a choice of options or consequences, the following format should be used, with leadin text making it clear that a number of options are being presented:
The appearance of this message means that one of the following occurs:
· Option A
· Option B
[bookmark: scroll-bookmark-301]Numbered Lists
In FrameMaker, a leadin line using the StepIntro style should precede numbered lists that describe sequential steps in a process or an exercise. Otherwise, a numbered list may be preceded by a leadin as for a normal bulleted list, using Body Leadin style.

The presence of a leadin line in a StepIntro style above a numbered list resets the numbering so that it starts from 1.

For numbered items in a list:
	Steps
	Used for step-by-step instructions and for any other numbered lists.

	Steps (n=1)
	Same as Steps, except used only if you have an unusual circumstance and need to force numbering to begin at 1 again.

	Steps indent
	Used to indicate a system result that follows a step. Also used wherever additional explanation is required for a numbered item or an example must be provided under a step.
In other words, Steps indent is used wherever it is appropriate to start a new paragraph that is not itself a new point and that expands on a numbered item.

Steps indent is correctly indented for use with both numbered and bulleted lists.


For additional points within a numbered list:
	Steps bullet
	First-level bullet within a numbered item, following Steps

	Steps bullet2
	Second-level bullet within a numbered item, following Steps bullet

	Steps bullet indent
	To add extra paragraphs to Steps bullet

	Steps bullet2 indent
	To add extra paragraphs to Steps bullet2

	Substep (alpha)
	Used when you need to present substeps in an ordered hierarchy instead of using sub-bullets. This style can also be used in a bulleted list.

	Substep (alpha=A)
	Same as Substep (alpha), except used onlyy if you need to force lettering to begin at A again.


For example, the following styles should be used:
StepIntro:
1. Steps
2. Steps
Steps indent.
Steps indent leadin:
· Steps bullet

1. Substep (alpha)
Steps bullet indent
Steps bullet indent leadin:
· Steps bullet2
Steps bullet2 indent
[bookmark: scroll-bookmark-302]Numbered Lists with a Single Entry
It may be necessary at times to describe a process using a StepIntro leadin, where there is only a single step. In such a case, the leadin should use the StepIntro style, but the single step should use the Bullet style, rather than using the Steps style and being numbered 1.
[bookmark: scroll-bookmark-303]Long Names in Tables
Many of the data tables, columns, procedures, or parameters referred to in the documentation have long names. Where these names appear in a table, you should not use soft returns to force a break at the end of a line.

For example:
	CURRENT_DEBT_
PAYMENTS
	Example of a term with a manual soft return to enforce a sensible break in the long name. This term does not appear in a keyword search of the finished PDF.

	CURRENT_DEBT_P
AYMENTS
	Example of the same term without a soft return. Although the spacing enforces a break at an awkward position, the term appears in a keyword search of the finished PDF.


[bookmark: scroll-bookmark-304]On-Screen Text and Structures
In some documents, examples of text to be either input or output are required. The FrameMaker styles required for this are as follows:
	computer text
	
	Character style – for single words or phrases in text to be input or output
	

	Computer Text and Computer Text Close
	
	Paragraph styles – for large sections of text to be input or output (for example, for blocks of code in appendixes), and for procedure definitions (particularly in stored procedures documents)

Computer Text is the style used for the first line of computer text in documentation.

Computer Text Close is used for all subsequent lines of computer text.

Computer Text Close ensures single line spacing for multiple rows of computer text.

Both computer text styles have tabs configured at 0.2-inch intervals to assist with alignment. Text in either of these paragraph styles can be indented using tabs, but there must be no spaces between or after the tabs.
	

	
	
	
	


[bookmark: scroll-bookmark-305]Page Headers and Footers
The templates apply styles within page headers and footers automatically. However, the FrameMaker ones are listed here for reference:
	Header
	Headers, that is, the name of the document (even pages) and the chapter number – chapter name (odd pages)

	Footer
	Footers, that is, the page number and proprietary information.


[bookmark: scroll-bookmark-212]RBM and CM Notes - Use of
Notes are often seen as the most important part of a document, since casual readers are more likely to read notes than body text. They should, consequently, be used with care to emphasize the most important points in the text – for example, any significant performance limitations, particular requirements, or obscure functions.


	Guideline 1
Insert notes sparingly on a page. Otherwise, other text may be interpreted as something unimportant if there are too many notes on the page. Try to limit notes to 1-2 per page.



	Guideline 2
A note is inserted into text only to bring special attention to a point. For example, insert a note when the described feature has a variant or exception under some conditions.
Example:
The condition is: software installed on a client machine, versions of SW, RAM, System type (32-bit or 64-bit), and so on...
Correct
Note: If you run the application on a 32-bit appliance, make sure that ...


In FrameMaker, three different note types are available. Each one is inserted as a table, containing three rows and two columns. The top and bottom rows are included as spacers and must not contain any text.

The first column automatically contains an icon that shows the type of note. The text of the note should be typed in the second column.

The standard styles for body text, bullets, and so on, are used within notes.

	Guideline 3
Consecutive notes of the same type should be avoided, where possible, particularly if the text of such consecutive notes can be combined within a single note, under a single icon. Consecutive notes of different types may be used (for example, a warning note followed by an information note).


Each of the note types described in the following sections also has a corresponding indented version, for use specifically within stepped procedures.

Three types of notes are available for use across all documentation sets:

Information note:
	
	

	[image: ]
	An information note helps you to select options, make decisions, or understand the indirect results of a particular action.

	
	


Warning note:
	
	

	[image: ]
	A warning note tells you that an action could result in undesirable changes or consequences.

	
	


Critical note:
	
	

	[image: ]
	A critical note tells you that an action could cause the system to lose all or part of its data or to shut down. The audit trail may also be broken.

	
	


[bookmark: scroll-bookmark-306]Tables of Contents, Figures, and Tables
The templates apply styles within the table of contents, table of figures, and table of tables automatically. However, they are listed here for reference.
The following styles generate the front-matter tables in FrameMaker.
	About TitleTOC
	The "About This Document" entry in the table of contents uses this style automatically.

	Heading 1TOCHeading 2TOCHeading 3TOC
	The table of contents uses these styles automatically.

	Appendix TitleTOC
	Appendix titles in the table of contents use this style automatically.

	Figure TitleLOF
	The table of figures uses this style automatically.

	Table TitleLOT
	The table of tables uses this style automatically.

	Table Title (i)LOT
	The table of tables uses this style automatically for entries derived from tables in the "About This Document" chapter.

	MTOC Title
	Titles of the table of contents, table of figures, and table of tables titles use this style (so they are not included in the TOC).


[bookmark: scroll-bookmark-307]Table Styles
The following FrameMaker styles are available when creating tables:
	CellHeading
	For the table heading and, if a matrix is being used, for the initial column

	CellBody
	Main style within the body of a table

	CellFootnote
	Footnote text in the footing row of a table

	CellFootnote Numbered
	Numbered footnote text in the footing row of a table

	CellBody Note
	Note within a table cell

	CellBody Indent
	For items indented under Cell bullets

	Cell bullet
	First level bullet within a table cell

	Cell bullet2
	Second level bullet within a table cell, following Cell bullet

	CellBodyRightJustify
	For table text that must be flush right


The styles CellHeading and CellBody are applied automatically when a table is inserted.

When notes (such as information, warning, and critical notes) are inserted in a document, they are formatted as tables, although the note text uses the regular Body style. For more information on note tables, see the "Notes, Use of" topic..
[bookmark: scroll-bookmark-308]Title Page
In FrameMaker, the title page should contain items that use each of the following styles:
	ComponentName
	The name of the component. This is usually not applicable.

	DocumentName
	The name of the document.

	ProductName
	The name of the product. For example, Rating and Billing Manager.

	Release
	Software release number

	Body1
	Copyright and trademark verbiage, on the inside cover


These lines appear on guide covers, regardless of whether information appears in them.
[bookmark: scroll-bookmark-309]Table Formatting in FrameMaker

Several table formats are defined in the FrameMaker templates. Some of these are designed for a specific purpose – they already have the correct number of columns set to the appropriate widths. Others are for general use and can have extra columns added, can be resized, and so on.

Tables are made up of columns and rows, with an intersection between the two referred to as a field.
	
	

	Note:
	You must refer to each table at some point in the text, to emphasize the relevance and context of the table. See the Cross-References topics for guidelines.

	
	


[bookmark: scroll-bookmark-310]General-Purpose Tables
The following general-purpose tables are common across all Rating and Billing Manager and Collections Manager documentation sets:
	2+ col (FrameMaker)
	Two-column table. A table caption is included above the table when this table is inserted.
Column widths may be adjusted, and columns and rows may be added as required.

	2-col If/Then (FrameMaker)
	Two-column table indented 0.25 inches from the left margin.The left column is headed If… and the right column is headed Then…. There is no caption.
Column widths may be adjusted and rows added as required.

	Invisible Table
	Two-column table with invisible borders that uses normal text styles to provide the effect of hanging text.
Column widths may be adjusted and rows may be added as required (with the proviso that the table must remain the full width of the text area on the page). See the Hanging Text topic for more information.

	Invisible Table Indent
	Same as above, but indented 0.25 inches from the left margin.


Text within all tables except invisible tables is set to 1 point smaller than the standard text size (that is, to 9 point). Specific text styles achieve this format, and these styles are included when a table is inserted.

Invisible tables use standard text styles to achieve the effect of hanging text.
	
	

	Note:
	Note tables. Various styles of notes can also be inserted in documents as tables. For more on these, see the Notes topic.

	
	


[bookmark: scroll-bookmark-311]Table Caption Formatting
In FrameMaker, all tables derived from Table2col or 2+ col are preceded by a caption (using the Table Title style) that should give a brief description of the table. The caption is included when a Table2col or 2+ col table is inserted and includes the bolded text Table <x> (for numbered tables), followed by a space, after which you should enter the text of the table caption.

The Table Title style has "keep with next" selected, so captions and tables should never become separated.
[bookmark: scroll-bookmark-312]Lengthy Table Captions
In FrameMaker, for any caption that extends beyond a single line, you must specify exactly where the line break occurs. Similarly, if a one-line caption does not leave sufficient space for the word "(continued)" to be included, you must specify the line break.

To do this, insert a soft return at the break point and a tab marker at the start of the second line. Note that you cannot insert the tab marker by pressing the TAB key, but instead, you must insert a tab marker elsewhere in the text, and then copy and paste it at the beginning of the second line.
[bookmark: scroll-bookmark-313]Table Captions and New Pages
When a table extends to a new page the table caption is repeated at the top of the new page.

The word (continued) is also required on the continuation caption. To achieve this in FrameMaker, whenever a table caption is created, place the cursor at the end of the table title, click Special > Variable, and select the Table Continuation variable.
[bookmark: scroll-bookmark-314]Table Cells
FrameMaker tables are configured so that table cells cannot split over a page. Therefore, cells must be kept reasonably small and, where necessary, the contents may have to be split between two or more cells.
[bookmark: scroll-bookmark-315]Cell Headings
In FrameMaker, table headings use the CellHeading style. In cell headings, all keywords should be capitalized, including any keywords that are inside parentheses.
[bookmark: scroll-bookmark-316]Table Footnotes
A footnote cell can be added to any table, if required. This cell extends across the full width of the table and enlarges on entries in the headings or cells of the table.

If a table requires only a single footnote, an asterisk should follow the relevant text in the table cell, and an asterisk should precede the explanation text in the footnote. This characteristic is built into the CellFootnote style in FrameMaker.
If a table requires more than one footnote, a number in superscript style should follow the relevant text in the table cell, and the corresponding number in normal body text should precede the explanation text in the footnote. This characteristic is built into the CellFootnote Numbered style.
[bookmark: scroll-bookmark-317]Table Formatting in MS Word
NCPD.dot provides two styles for formatting tables: Table for tables with a header row, and Table Grid for tables without a header row. The first row of a table should be repeated as a header row at the top of each page. The rows should not break across pages. A table should always be followed by an empty paragraph.

	Guideline 1
When inserting a table, first clear the formatting inside the table. Then, the text in the table is formatted with the Body Text style. After that you can apply styles, such as List Bullet, List, numbered list, and so on.


The Body Text style implies justified text alignment. In some cases. This may cause the spaces in the text to be stretched too widely to fill the cell, like in the following table.
[image: ]
Such issues should be fixed individually by placing a non-breaking space (CTRL+SHIFT+SPACE) instead of a stretched space.
[image: ]

	Guideline 2
Tables with the same number of columns placed close to each other must have equal column widths.
Similar tables (for example, for describing buttons) with the same number of columns should have equal column widths, even if they are placed in different document sections.


Note: For information about punctuation in tables, refer to Table Punctuation.
[bookmark: scroll-bookmark-318]User Interface Elements
This section covers the rules of correct naming of the Netcracker TOMS UI elements and the proper description of the action that the user performs with them.

	Guideline 1
Use the NCPD template Strong style to emphasize menus, menu commands, buttons, tabs, parameter field screen labels, field group screen labels, UI table screen labels, UI table columns, UI widget screen labels. If the Strong style is unavailable in your document template, then use bold font.
Do not bold page names and dialog names.


Example:
Click New Project on the toolbar to create a new project.

	Guideline 2
In plain text put the UI element name exactly as it appears on the browser page.


Example:
The New Project button is displayed on the toolbar.
Illustration
[image: ]


	Guideline 3
Menus, menu commands, tabs, and buttons should be formatted in bold characters when they are referenced in step-by-step instructions and in narrative text.
Do not put angle brackets (< and >) around names of the following:
· Buttons
· Edit boxes, text boxes, check boxes, and drop-down list boxes
· Titles of pages
Correct
Click the Report Folders tab.
Incorrect
Click the <Report Folders> tab.



	Guideline 4
If the name of an interface element contains ellipses, angle brackets, or other non-letter characters, do not include them when referring to the element in your text.


[bookmark: scroll-bookmark-319]Example
Figure 4 screen_SG_04.png
[image: ]
Correct
The Browse button
Incorrect
The Browse… button
However, if there is a hyphen in the name of an element, replace it with an em-dash. To refer to a button, the name of which consists of non-letter characters only, use its tooltip (if available) and its picture. For buttons with no tooltip, use the picture only.

	Guideline 5
Never use graphical representations of buttons. Different Netcracker themes may use different icons, plus the icon&apos;s theme you use may quickly become obsolete.
It is allowed to use the words "the" and "button" when a button does not have a caption.
Correct
Click the Next button.
Incorrect
Click [image: ]







[bookmark: scroll-bookmark-320]Language
[bookmark: scroll-bookmark-321]Quick Word Reference
	The list below shows words that are often used incorrectly or are not recommended for use.


	Do Not Use
	Instead Use
	Examples and Conventions

	as shown on the picture
	as shown in the picture
	The Inventory object is presented, as shown in the preceding picture.

	on the workspace
	in the workspace
	The new Event-Start activity is displayed in the workspace.

	in the toolbar, click
	on the toolbar, click
	On the toolbar, click New Project.

	in the menu, click
	on the menu, click
	On the Activation menu, click Activate.

	in the menu, select
	from the menu, select (or choose)
	From the Navigation menu, select Process Management.

	place to
	place in
	Place the file in the folder.

	put to
	put in
	Put the file in the folder.

	on step X
	in step X
	In the following steps below, you will replace the device with cards being moved.

	in the tab
	on the tab
	On the My Profile tab, click Edit.

	on the table
	in the table
	Edit the Name value in the table.

	on the pane
	in the pane
	To expand or collapse the tree, click the button in the navigation tree pane.

	at the status bar
	in the status bar
	An additional type is "Status bar" for messages that are displayed in the status bar of the window.

	on the list
	in the list
	… the option is available in the list …

	in place, inplace
	in-place
	To switch to the in-place editing mode, click …

	aimed at supporting
	aimed to support
	It is a Netcracker Framework component extension aimed to support Oracle Weblogic (WL) Application Server.

	click on the Add button
	click Add (or rarely, "click the Add button", NOT "click Add button"). Skip on and put the if you use the word button.
	To create a new user, click Add.

	drag and drop the object to
	drag the object to
	drag the JPG file to the Image field

	allow
	Avoid this word. Use "can", "enables", "provides", "it is possible to".
	A user can perform an operation ...
A user is enabled to set up the profile settings ...

	it’s
	it is
	Rule: Short forms are disallowed.

	doesn’t
	does not
	Rule: Short forms are disallowed.

	whole
	complete, entire
	The entire set of values …

	ascribe
	assign, specify for
	Assign an alias to the ...
The value specified for the Group parameter …

	authentification
	authentication
	User and device authentication...
Users periodically change their authentication information to meet corporate policy...

	necessary, required
	your (only in steps); see also "Specifying objects."
	To update your password, type the new value in the …

	differing
	different from
	The value that is different from the current one

	edit mode
	editing mode ("in the editing mode")
	In the editing mode, type ...

	drill down
	open, navigate to
	Navigate to the UI Themes from ...

	independent on, irrespective
	regardless of
	Regardless of the object type, the current object belongs to …

	similarly, in a similar way
	likewise
	Likewise, specify the following parameters: …

	correspondent
	corresponding
	... the options corresponding to the mode …

	children types
	child types
	The Residential Customer Account is a child object type of the Customer Account object type.

	it is necessary that you do this
	it is important that you do this
	It is important that you specify the following parameters:

	в отличие от
	unlike
	In-place editing mode enables a user to make changes directly in the table, unlike the ordinary editing mode, supplying a special dialog ...

	web, web page, web interface, web browser
	Web, Web page, Web interface, Web browser
Exceptions: web-centric, webcam, webcast, webmaster, webzine.
	Rule: Do not forget to capitalize the word “Web”.

	internet
	Internet
	Rule: Do not forget to capitalize the word “Internet”.

	sub interface, sub-interface
(-connector, -flow, -type)
	subinterface (subconnector, subflow, subtype)
In general, do not hyphenate words beginning with sub, such as subheading and subsection, unless it is necessary to avoid confusion or sub is followed by a proper noun, as in sub-Saharan.
	Rule: Do not hyphenate words beginning with “sub” unless it is necessary to avoid confusion.

	№
	Skip, replace with words (‘number’), or use ‘#’ if absolutely necessary.
	Rule: Do not use the “№” symbol.

	MS
	Microsoft
	Rule: Do not use an abbreviation of the word “Microsoft."

	optionally (in non-mandatory procedure steps)
	if necessary
	Specify the Work Phone parameter, if necessary.

	colour
	color
	Rule: Use the American spelling.

	modelling
	modeling
	Rule: Use the American spelling.

	zeroes
	zeros
	Rule: Use the American spelling.

	in order to
	to
	Navigate to the Parameters tab to specify …

	using
	by using
	Set up the date by using the Calendar button.

	scheme, schemes
	schema, schemas
	Rule: Use the words schema and schemas.

	variant
	type of, mode OR case, option, revision
	Weblogic Embedded is a type of Weblogic implementation for Netcracker.
Another option of setting up the Name is to enter the in-place editing mode.

	document (as concerning to a network)
	capture, represent
	· Optical distribution frames in Resource Inventory are represented with an object of type ODF.
· The Solution will allow you to capture (not document) the operational status of production network equipment.


	populate the parameters
	fill in the parameter / fill out the parameters, enter the parameter value, specify the parameter value
	Rule: When using the "fill in" / "fill out" constructions in project documentation, consider the language specifics of the customer's country. "Fill out" is the American English usage of the term, whereas "Fill in" is the British English version of it. After deciding which construction to use, make sure that it is consistent through all of the documentation kit.
For information about using the U.S. and U.K terminology, see U.S. Terminology and U.K. Terminology Reference.

	targeted for
	targeted to
	

	e.t.c., etc, et.c.
	in running text: "and so on"
in parentheses: "etc."
	

	i.e.
	in running text: "that is" (put a comma after or set off phase)
in parentheses: "i.e."
	Rule: If "that is" is at the beginning of a sentence, put comma after it.
If "that is" is in the middle of a sentence, do not use a comma after "that is" but use commas to set off the whole phrase. That is, "The vendors, that is Cisco and 3Com, provide routers with multi-protocol capabilities".

	e.g.
	in running text: "for example" (put a comma after or set off phase)
in parentheses: "e.g."

	Rule: If "for example" is at the beginning of a sentence, put comma after it.
If "for example" is in the middle of a sentence, do not use a comma after "for example" but use commas to set off the whole phrase. For example, "Many vendors, for example Cisco and 3Com, provide routers with multi-protocol capabilities".

	grayed, dimmed
	unavailable, disabled
	

	administrating
	administering
	

	enumerates (the tab enumerates parameters)
	displays (the tab displays parameters)
	

	save changes
	save the changes (or save your changes)
	

	situated
	located or skip this word at all
	

	appears, this opens, is opened, is shown when applied to a page, tab, or dialog
	is displayed
	

	context menu, popup menu, dropdown menu
	menu (for ALL menus)
Use the word context ONLY when it is not clear which menu the user should select the command from. Do not use context when you use right-click.
	

	Ok, ok
	OK
	

	distributive
	distribution
	Go to the folder where you unzipped the CLI distribution.

	mandatory, required
	required (parameters)
	Parameters. Applies to design documentation only.

	perform settings
	make settings
	Other settings of the Recent menu, for example, the number of recent objects to display for all users, are made by administrators.

	repeated (в значении "повторный")
	repeat
	The customer personnel can attend repeat training.

	refer to (when referring to Netcracker documentation)
	For more information, see Page Title.
	Style Guide section with guidelines: Internal and External Cross-References.

	see (when referring to external documentation)
	For more information,refer to Oracle Database Installation Guide.
	Style Guide section with guidelines: Internal and External Cross-References.

	Out-of-the box, OOB
	immediately available, preconfigured, standard application, standard application's, by default, default configuration, default setup, default settings
	ASR integration adapter utilizes immediately available Mediation DataFlow configuration to enable interfacing ...


[bookmark: scroll-bookmark-322]Developer vs. User Terms

	Note
This page is applicable to TOMS only.



	Guideline 1
Distinguish between developer terms and user terms.
Developer terms are used in Developer Guides, API Integration Guides, and design specifications.



This table shows the difference between the terms and how they correspond to each other.
	Developer Term
	User Term

	Attribute
	Parameter

	Object type
	The name of the object instantiated from this object type. For example, circuit, not object of the Circuit object type

	Operation
	Toolbar button (sometimes)

	Attribute schema
	Do not use because users have no access to attribute schemas.

	Command
	Command

	Product Component
	Try not to use, except when you need to add a note that a function is only available with a specific product component installed.



	Note
Avoid the use of developer terms in user documentation, and vice versa. If you must use a developer term in user documentation, describe what it means upon the first occurrence



	Guideline 2
In User Guides, do not use wording like Objects of Circuit type. Write just circuit. No highlighting is applied to the objects' names.
The same holds true for lists.

	Note
This rule is applicable to User Guides only.


INCORRECT
Note: Not all the parameters values are copied. In the case of copying, the default values are specified for the "Physical Status", "Logical Status", "Assignment Status", and "Plugged Into" parameters for the objects of the following types: "Building", "Customer Location", "Network Element", "Rack", "Device", "Slot", "Card", "Port", "Device Connector", "Port Connector", "Circuit", "Circuit Channel", "Circuit Path Element", "Cable", and "Cable Connector."
CORRECT
Note: Not all the parameters values are copied. In the case of copying, the default values are specified for the Physical Status, Logical Status, Assignment Status, and Plugged Into parameters for the buildings, customer locations, network elements, racks, devices, slots, cards, ports, device connectors, port connectors, circuits, circuit channels, circuit path elements, cables, and cable connectors.


[bookmark: scroll-bookmark-323]Future Tense

	Guideline
Avoid future tense in most cases. Present tense is more direct and concise.


[bookmark: scroll-bookmark-324]Example 1
Incorrect
In the Process Scheduler, you must save changes made before leaving the Scheduler tab. Otherwise, all the changes will be lost after leaving the tab.
Correct
In the Process Scheduler, you must save changes made before leaving the Scheduler tab. Otherwise, all the changes are lost after leaving the tab.
[bookmark: scroll-bookmark-325]Example 2
Incorrect
After all included in the process tasks are executed, their statuses will change to Completed and the process will be terminated with the Error status. Included tasks that depend on the tasks with the Error status will not be executed and will have Not Started status.
Correct
After all included in the process tasks are executed, their statuses change to Completed and the process is terminated with the Error status. Included tasks that depend on the tasks with the Error status are not executed and have Not Started status.
[bookmark: scroll-bookmark-326]Example 3
Incorrect
In this case, the system will calculate the expected end date of the process taking into account the previously specified start date of the process and the duration of each task in the process.
Correct
In this case, the system calculates the expected end date of the process taking into account the previously specified start date of the process and the duration of each task in the process.


[bookmark: scroll-bookmark-327]Grammar and Usage
In this section, advice on general English language usage is presented.
[bookmark: scroll-bookmark-22]Capitalization
[bookmark: scroll-bookmark-328]Bulleted List Items

	Guideline 1
Bulleted list items should always have the first word capitalized, unless it is a system word, such as a variable name, for example, custAcct variable.


Corrrect
· custAcct variable

· Template type
Incorrect
· template type

· CustAcct variable



	Guideline 2
The first word after a stub of a list item should normally be capitalized.
Stubs are the part preceding an em dash or a period. Often the stubs are bolded. Do not bold the em dash.


Corrrect
· Customer Account—The customer account.
· Width—Specifies the device width in inches.
Incorrect
· Customer Account—the customer account.
· "Width"—specifies the device width in inches.

[bookmark: scroll-bookmark-329]Capitalize

	Guideline 1
In design documentation, capitalize the names of Netcracker object types.



	Guideline 2
In user documentation capitalize:
· Headings (see also Headings Capitalization)
· Figure captions
· Table captions
Capitalize Netcracker system names such as the following because they are proper nouns naming a specific, important thing in the system:
· Names of specific product components (for example, Inventory, Device Library, Auto Design & Assign)
· Template types (for example, Product template)
· Catalogs
· Tools in the Network Configurator (for example, Hand tool, Circuit tool)
· Activities in the Workflow (for example, Manual Start activity, End activity)
· Event listeners (for example, Object Naming listener)
· Titles of specific screens and user interfaces
· Book titles (for example, Netcracker Framework)



Examples
Correct
The Business Order Entry component transfers all required information.
Incorrect
The business order entry component transfers all required information.

Correct
Enter a description in the Description field.
Incorrect
Enter a description in the description field on the screen.


Correct
Offerings are stored in the Business Offering catalog in the system. (catalog with a lowercase "c", as it is a common noun)
Incorrect
Offerings are stored in the business offering catalog in the system. (application with a lowercase "a")

Correct
The Business Order Entry application allows you to enter and add sales orders.
The application allows you to enter and add sales orders.
Incorrect
The System allows you to enter and add Sales Orders.
The Application allows you to enter and add Sales Orders.

[bookmark: scroll-bookmark-330]Captions of Figures and Tables
All key words should be capitalized.
Note: If a window or page title or a field name is part of a caption, key words should have initial capitals, as for all captions.
Prepositions of five letters or fewer should not be capitalized.
[bookmark: scroll-bookmark-331]Common Terms in Object Names

	Guideline
Do not capitalize common terms when they are part of an object name, even if they are capitalized on the screen.
Do not duplicate a capitalized common term with a non-capitalized one.
Do not put quotes around an object name.
Following are examples of common nouns that do not require capitalization:
project
folder
configuration
table set
adapter


	Incorrect
	Correct

	The “Start Configurations Folder” folder
	The Start Configurations folder

	The "Copy Version Catalog Configuration" DataFlow configuration
	The Copy Version Catalog data flow configuration

	The “DataFlow Project” document project
	The DataFlow project ("document" and "project" are excessive here)

	The DataFlow Project document project
	The DataFlow project

	The “RBM IDB Table Set"
	The RBM IDB table set

	The “RBM Synchronization Adapter" reconciliation adapter
	The RBM Synchronization adapter

	The “RBM Task Templates" task template folder
	The RBM Task Templates folder

	
	




[bookmark: scroll-bookmark-332]Terms Capitalization (RBM and Collections Manager Documentation)
This list provides guidelines regarding the capitalization of specific terms in Rating and Billing Manager and Collections Manager documentation.
	Item
	Guideline

	Appendix
	Capitalized only when used together with a specific appendix number, as in Appendix A.

	ASCII
	Fully capitalized. This is an acronym for American Standard Code for Information Interchange.

	Boolean
	Capital B, as it derives from a proper name.

	Chapter
	Capitalized when used together with a specific chapter number, as in Chapter 2.

	dunning notice
	Lowercase d, as dunning is not a proper noun.

	Ethernet Fast Ethernet
	Capitalized as shown. These are proper names for standards created by Xerox Corporation.

	Help
	When referring to online Help, the word Help should be capitalized, and the word online should be omitted.

	i18n
	Never use this abbreviation as a substitute for the word internationalization.

	ID, IDs
	May be used as an abbreviation for identifier, but must be capitalized.

	the Internet
	Capitalized as shown.

	an intranet
	Lowercase as shown.

	Java Enterprise JavaBeans Javadoc
	Capitalized as shown, as they are trademarks.

	L10n
	Never use this abbreviation as a substitute for the word localization.

	Memory size
	The word bytes should always be lowercase and written in full. Larger denominations may appear in abbreviated format, with both letters capitalized. For example, kilobyte becomes KB, megabyte becomes MB, gigabyte becomes GB, and so on. Any associated value should be separated by a nonbreaking space, for example: 2 MB.

	null as a value
	All lowercase, except where conventional grammatical rules apply.

	OID
	object ID; spelled-out form does not require a capital O.

	Oracle
	Capitalized as shown.

	PDF
	Fully capitalized.

	Perl
	Capital P, but not fully capitalized (even though it is an acronym).

	procSitter
	Capitalized as shown.

	stdin, stdout
	Standard input, standard output (UNIX terms).

	Step
	Capitalized when used together with a specific step number, as in Step 2.

	system administrator database administrator ...and so on
	Lowercase, except where conventional grammatical rules apply. It is acceptable, after spelling out the term at its first instance, to use the acronym (SA, DBA) in subsequent instances.

	UNIX
	end user

	the World Wide Web (WWW) the Web a Web page a Web site a Web browser
	Capitalized as shown.

	ZIP code
	Capitalized as shown, as ZIP is an acronym for Zoning Improvement Plan.



	


[bookmark: scroll-bookmark-333]Data Samples

	Guideline 1
The NetCarcker UI buttons, tabs, panes, field names, and Web pages must be capitalized exactly as they appear in the Web browser. See also User Interface Elements.


[bookmark: scroll-bookmark-334]Example
The Web page title is "Account collections."
Correct
The Account collections page is displayed.
Incorrect
The Accounts Collections page is displayed.


	Guideline 2
Names of object instances are capitalized exactly as they appear in the interface and are enclosed in double quotes.


Examples
Correct
the "Quick Start" project
the "Alberta" site
the "Cisco 1530" device
the "SDH Circuits" folder
the "Ethernet Circuit" template
[bookmark: scroll-bookmark-335]Do Not Capitalize

	Guideline
Do not capitalize data entities unless you are specifically referring to a label on a screen.
Do not confuse proper nouns with the names of instances of objects created in the Netcracker database.
	This guideline is applicable to user documentation only! Design documentation requires emphasis of the data entities by means of captilization to draw attention of the audience.





Correct
One of the central entities is a product offering that is a sellable item.
Incorrect
One of the central entities is a Product Offering that is a sellable item.

Correct
The Users: Named Users report is displayed.
Incorrect
The "Users: Named Users" Report is displayed.

Correct
The functionality can be accessed from the user interface. ("user interface" is a common noun)
In the New Inventory Project dialog, fill in the parameters... (New Inventory Project is written exactly as in the UI, "dialog" is a common noun)
The Users: Named Users report is displayed. ("Users: Named Users" is a report name, "report" is a common noun)
Click the Netcracker logo in the upper left corner of the page to navigate to the list of projects. ("projects" is a common noun)

	Correct
	Incorrect

	…an object type…
…an attribute…
…an MW radio link…
…an inventory project…
…open an inventory project…
	…an Object type…
…an Attribute…
…an MW Radio Link…
…an Inventory project…
…open your Inventory Project…



[bookmark: scroll-bookmark-336]Document (Guide) and Help Titles
Capitalize all key words.
Examples: Rating and Billing Manager Product and Catalog Concepts, Rating and Billing Manager Accounts Receivable Help,
[bookmark: scroll-bookmark-337]Field Names in UIs
Match the capitalization with its appearance in the user interface. In some systems, only the first letter of the first word has an initial capital, and in other systems, the names are in title case (key terms begin with capital letters).
[bookmark: scroll-bookmark-20]Headings Capitalization

	Tip: Online Capitalization Check
TitleCap is a convenient too to check capitalization online: http://titlecapitalization.com/.
Works in Google Chrome!
Note: The output from TitleCap is generally reliable, but it is always a good idea to check it against the guidelines below. One common error is the incorrect capitalization of the verb to be. Since "to" is part of the verb in this case and not a preposition, it should be capitalized.
CORRECT
Determining Which Pod Is Considered To Be Master by Patroni
INCORRECT
Determining Which Pod Is Considered to Be Master by Patroni


The following are the rules for capitalizing words in the titles of the document sections (up to level 6), tables, and figures.

	Guideline 1
Capitalize
· Capitalize in titles the following parts of speech:
· Nouns (man, bus, book)
· Adjectives, including "this" and "that" (examples: angry, lovely, small)
· Verbs, including "is," "are," and other forms of "be" (examples: run, eat, sleep)
· Adverbs, including "then" and "when" (examples: slowly, quickly, quietly)
· Pronouns, including "its" (he, she, it)
· Prepositions that are part of a verb phrase (example: "Backing Up Your Disk")
· Subordinating conjunctions (examples: because, that)
· Capitalize the first and last words, regardless of their parts of speech (example: "The Text to Look For") (example: "Using a Site-Specific Installation Program; Initiating Self-checking Procedures").
· Always capitalize the second part of a hyphenated compound if it is the last word of a heading or title (example: "Installing an Add-In").
· Capitalize the second element of a hyphenated compound word unless the first element is a prefix.
· Capitalize all key words (example: "Setting Debt Age Bands" rather than "Setting debt age bands").
· Capitalize all key words window titles or Web page titles or Dialog titles when they are part of a heading.




	Guideline 2
Do Not Capitalize
· Articles: a, an, the
· Coordinating Conjunctions: and, but, or, for, nor, and so on.
· Prepositions (fewer than five letters): on, at, to, from, by, and so on.




	Hint
When in doubt and you do not have a reference guide in front of you, here is one general rule to remember recommended by The U.S. Government Printing Office Style Manual:
"Capitalize all words in titles of publications and documents, except a, an, the, at, by, for, in, of, on, to, up, and, as, but, it, or, and nor."



	Guideline 3
Capitalize the file names in headings.
INCORRECT
· Configuring config.properties file
· install.tar.gz target
· install.tar.gz Target
CORRECT
· Configuring Config.properties file
· Install.tar.gz Target
· Install.tar.gz Target
	You can use common words in headings instead of file names, e.g.:
instead of
Configuring config.properties file,
write
Configuring Server Parameters.






Do Not Capitalize
· Articles: a, an, the
· Coordinating Conjunctions: and, but, or, for, nor, and so on.
· Prepositions (fewer than five letters): on, at, to, from, by, and so on.
[bookmark: scroll-bookmark-338]Industry-Specific Terms
Do not capitalize these unless they are used as part of a proper noun.
Examples: invoicing company, contracted point of supply, and budget center report; but, the Netcracker Budget Center report states….
Note: Abbreviations or acronyms (for example, ICo, CPS, or BCR) should not be used to abbreviate industry-specific terms such as these.
[bookmark: scroll-bookmark-339]System Elements
Capitalize the names of the following system elements as proper nouns:
· Names of specific product components (for example, Inventory, Device Library, Auto Design & Assign)
· Template types (for example, Product template)
· Catalogs (for example, the Product Catalog)
· Tools in the Network Configurator (for example, Hand tool, Circuit tool, AdminClient tool)
· Activities in the Workflow (for example, Manual Start activity, End activity)
· Event listeners (for example, Object Naming listener)
· Attributes (for example, the Host attribute)
· Elements (for example, the Domain element)
· Procedures (for example, the Remove Jobs procedure)
· Features (for example, the Pending Payment feature)
· Partitions (for example, the Index partition)
· Titles of user interfaces (for example, Customer Service Management user interface)

Note: Do not use the abbreviation "UI" when referring to the title of a user interface.
Note: Capitalize the key words in user interface titles but not the words "user interface."
Note: Capitalize the word "Catalog" when referring to the title of a catalog.

System parameters are case-sensitive and should be capitalized exactly as they are defined,
Examples: EFMLmaxFileSize, CEFSlargeThreshold

Data tables and data table column names (table field names) should always appear in uppercase
Examples: RATED_EVENT_COUNT column or ACCOUNTRATINGSUMMARY table.

[bookmark: scroll-bookmark-340]System Parameters
These should be capitalized exactly as they are defined.
Examples: EFMLmaxFileSize, CEFSlargeThreshold
[bookmark: scroll-bookmark-341]System Processes
Capitalize key words when referring to system processes.
Note: Do not capitalize the words "system process" if you need to use them.
Note: Do not use abbreviations or acronyms when referring to system processes except when you are indicating the executable name.
Examples: Active Rating Engine, Collect Overdue Receivables system process
[bookmark: scroll-bookmark-342]System Tables and Column Names
These should always appear in uppercase.
Examples: RATED_EVENT_COUNT column (field name) or ACCOUNTRATINGSUMMARY table.
Note: Table and column names in user interfaces should be capitalized exactly as they appear in the user interface.
[bookmark: scroll-bookmark-343]User Interface Titles
Capitalize the key words in the title but not the words "user interface."
Example: Customer Service Management user interface
Note: Do not use the abbreviation UI when referring to the title of a user interface.
[bookmark: scroll-bookmark-344]Web Page, Window, and Dialog Titles

	Guideline
Always capitalize the title of a Web page, window, or dialog exactly as it is in the user interface.


[bookmark: scroll-bookmark-345]Example
The Web page title is "Account collections."
Correct
The Account collections page is displayed.
Incorrect
The Accounts Collections page is displayed.

[bookmark: scroll-bookmark-346]Contact Details
Avoid using information such as telephone numbers and e-mail addresses, since these tend to be territory specific. Relevant contact numbers are provided by other means. Ask the user to Contact your local Netcracker representative.
[bookmark: scroll-bookmark-18]Acronyms and Abbreviations


	Guideline 1
For abbreviations and acronyms, the full term should be quoted on the first usage in each chapter, followed by the abbreviation in parentheses. The abbreviation can then be used for subsequent occurrences, as in: …paid to a virtual service provider (VSP). The VSP then pays…
An exception to this rule is if the abbreviation or acronym is an industry-standard term and is commonly understood by the audience of the document, for example, common computing terms as HTTP, PC, UI, and XML.




	Guideline 2
If the term is a proper noun, use initial capital letters for the spelled-out version. If the term is generic, (for example, user interface) use lowercase.




	Guideline 3
Industry-standard acronyms can be used in section headings, but the heading should not include the spelled-out meaning. If necessary, this should be included in the text immediately following the heading.




	Guideline 4
Plurals of acronyms use a lowercase s and no apostrophe (for example, VSPs, PCs).




	Guideline 5
Do not use the abbreviation NC for Netcracker in the acronyms table or any of the text. Use Netcracker instead.




	Guideline 6
Avoid the use of abbreviations of the Netcracker modules within the text unless they are part of marketed company names. Refer to the Products drop-down menu of the Netcracker corporate Web site (http://www.Netcracker.com/) to determine whether an ampersand is part of a marketed name.



	Guideline 7
TOMS component names, user interfaces, and system processes should not be abbreviated unless they are branded that way. See the User Interfaces and System Processes topic for more information. Refer to the Products drop-down menu of the Netcracker corporate Web site (http://www.Netcracker.com/) to determine whether a name is abbreviated as a branded name.



	Guideline 8
All acronyms and key terms should also be included in the Glossary.


[bookmark: scroll-bookmark-348]Using Articles

	Guideline 1
Do not put articles before word combinations like "HTML format" or "safe mode".


Correct
In XML format
In safe mode
Incorrect
In the XML format

	Guideline 2
In parallel constructions:
· Repeat a definite article before every item in a series or use it only once if the number of items in a series is more than two. For two items in a series, it is recommended to repeat the article.
· If an indefinite article, that is a or an, is the same for all the items in a series, repeat an indefinite article before every item in a series or use it only once if the number of items in a series is more than two. For two items in a series, it is recommended to repeat the article.
· If an indefinite article differs for the items in a series, then each item in a series must appropriately be preceded by "a" or "an."



Correct
The document deliverables for NetProvision 6.2 include the Administration Guide, the Installation Guide, the User Guide, and the Release Notes.
The document deliverables for NetProvision 6.2 include the Administration Guide, Installation Guide, User Guide, and Release Notes.
Incorrect
The document deliverables for NetProvision 6.2 include the Administration Guide, Installation Guide, User Guide, and the Release Notes.
Correct
A disputable entity can be a specification, a product charge, or a one-time service instance.
A disputable entity can be a specification, product charge, or one-time service instance.
Incorrect
A disputable entity can be a specification, product charge, or a one-time service instance
Correct
A disputable entity can be an event specification, a product charge, or a one-time service instance.
Incorrect
A disputable entity can be an event specification, product charge, or one-time service instance. (The first article must is "an", and the next two articles must be "a". Since the articles are different, they must preceed each item appropriately).




	Guideline 3
For articles used with acronyms, the following rules apply:
· If an acronym is read by spelling all the letters in it, the choice of the indefinite article is determined by the pronunciation of the first letter.
· If an acronym is pronounced as a word, the indefinite article preceding it is determined by the pronunciation of the word.



Correct
A KPI represents a practical result of a certain activity in terms of figures.
A widget graph can be viewed as a PNG image, a JPEG image, or an SVG file.
A LAN switch provides a connection for a node in a company's internal network.
Incorrect
A widget graph can be viewed as a PNG image, a JPEG image, or a SVG file.






[bookmark: scroll-bookmark-349]Definite and Indefinite Articles
[bookmark: scroll-bookmark-350]Basic Principle
· indefinite article = general meaning
· definite article = specific meaning
Examples:•“Events are rated by the Active Rating Engine” = events in general
“The events are rated by the Active Rating Engine” = some specific events that are being described in the given context•“Discounts were applied” = some discounts, but not specific ones
“The discounts that were failed by the Billing Engine” = specific discounts (the ones that failed)•“Technology has enabled rapid change” = abstract noun with general meaning
“the technology for early cell phones was quickly replaced” = a specific technology•“Developers don’t like to take holidays” = developers in general
“The developers here don’t take many holidays” = at this company, in this group, etc
Grammatical rules:
1.“a” is used before a word starting with a consonant (or vowel with consonant sound); “an” is used before a word starting with a vowel
2.“a/an” is used before a singular countable noun, including those used as an example of a class of things
3.“a/an” has no plural form, so is omitted before plural nouns. It is also omitted before uncountable (mass) nouns.\
Examples:
1.“a discount”
“an envelope”2.“the events are placed in an envelope and rated” (singular countable noun)
“the account qualified for a discount” (singular countable noun)
“a rate plan must be configured” (example of a class of things)3.“events are a key concept in RBM” (plural)
“billing is also central to RBM” (mass noun)
Grammatical rules:
1. The form is identical for singular and plural nouns, i.e. “the” is the only form
2. Used when an object or group of objects is unique
3. Used before a noun that is mentioned a 2nd time – this makes it definite
4. Used before a noun with an associated phrase that makes it definite (specific)
Examples:
1.“the event”, “the events”2.“the earth”, “the stars”3.“Mediation sends incoming events for rating. The Active Rating Engine processes the events.”“the discounts that were applied”
“the screen where you add a customer”
“the system process with the lowest latency”
Grammatical rules:
1. Used before superlatives and “first”, “second”, and so on
2. Used with a singular noun to represent a class of things
3. “the” + adjective is used to represent a class of persons
4. Used before certain proper names
Examples:
1.“the best way to rerate events is ...”
“the second event to be processed”
“The only solution is to reboot the machine.”2.“The corporate world is increasingly globalized.”3.“The young are usually better with technology than the old.” (meaning young people and old people in general)4.“the Atlantic”, “the Himalayas”, “the Indian Ocean”
Grammatical rules for when “the” is omitted:
1. Before the names of places (some exceptions) or people
2. Before abstract nouns, except with a particular sense
3. After a possessive noun/adjective
4. Before indefinite plural nouns
5. "the” is either used or omitted before certain other words like “office”, “school”, depending on intended meaning
Examples:
1.“Hyderabad”, “Orlando” … (but “the United States”)2.“technology has enabled rapid change”3.“the user interface’s screens are well-designed”4.“developers don’t like to take holidays”5.“she hasn’t arrived at the office yet” (place of work) but “she was in office for fifteen years” (official/political position)
“He went to school before he was five” (primary use of a school) but “the game was held at the school” (other use)
Grammatical rules:
1. Are uncountable (always singular) and do not take “a/an”
2. Include names of substances considered generally
3. Abstract nouns
4. Other words that are uncountable in English but might be countable in other languages
Examples:
1.“I want information” (not “I want an information”)
“Do you have experience with Frame 9?” (but “did you have a good experience on that training course?”)2.“rice”, “bread”, “water”, “paper” …3.“information”, “work”, “advice”, “experience”, “rating”, “billing” … (some may be countable in other languages)4.“shopping”, “weather”, “furniture”, “hair” … (may be countable in other languages)
[bookmark: scroll-bookmark-351]References
Grammatical rules taken from A Practical English Grammar, 4th ed.
Useful websites for grammar guides/checkers:•http://grammar.ccc.commnet.edu/grammar/ (includes quizzes!)•http://www.yourdictionary.com/grammar-rules/guide-for-grammar.html (includes links to online grammar guides)•http://freelancehomewriter.blogspot.com/2009/11/free-spell-checkers-and-grammar.html
Web articles on Indian English:•http://www.languageinindia.com/junjul2002/baldridgeindianenglish.html•http://www.experiencefestival.com/a/Indian_English_-_An_Indian_English_iGrammari/id/1500965•http://bigpedia.com/encyclopedia/Indian_English#.22An_Indian_English_Grammar.22
[bookmark: scroll-bookmark-352]Latin Abbreviations
[bookmark: scroll-bookmark-353]In notes and parentheses

	Guideline 1
Common Latin abbreviations (etc., i.e., e.g.) may be used in parenthetical expressions and in notes. Use periods in these abbreviations.


Correct
Web browsers (e.g. Firefox) can be used ...
Incorrect
Web browsers e.g. Firefox can be used ...
Web browsers, e.g. Firefox, can be used ...
Web browsers, (eg: Firefox) can be used ...
[bookmark: scroll-bookmark-354]In running text

	Guideline 2
In regular text (i.e. text outside of notes or parentheses), use the English equivalent of the abbreviation.


Correct
... web browsers, and so on.
Incorrect
... web browsers, etc.
Correct
Web browsers such as Firefox can be used ...
Incorrect
Web browsers e.g. Firefox can be used ...
[bookmark: scroll-bookmark-355]Meanings and English equivalents of Latin abbreviations
	Abbrev
	Latin
	English

	cf.
	confer
	compare

	e.g.
	exempli gratia
	for example

	et al.
	et alii
	and others

	etc.
	et cetera
	and so forth, and so on

	i.e.
	id est
	that is, in other words

	N.B.
	nota bene
	note well

	P.S.
	post scriptum
	postscript



	Note
Always consider whether it is truly beneficial to use a Latin abbreviation. Some of these are used so rarely that many readers will not understand the meaning, and others are often confused with one another. And be sure that you use them correctly, if you choose to do so. For example, be careful not to confuse "e.g." with "i.e.", which is a common error.


[bookmark: scroll-bookmark-356]Conditionals
Use "can" to describe actions or conditions that are possible. Use "may" only to describe situations where permission is being given. If either "can," "could," or "may" can be applied, use "can" because it’s less tentative.
Example:
· You can submit the form upon completion. (Correct.)
· You may submit the form upon completion. (Implies that you have permission to submit the report.)
Use "may" as a conditional verb only when you really need to be tentative.
Example:
· If you submit the form within two weeks, you may receive approval faster.
[bookmark: scroll-bookmark-357]Date, Time, and Measurement Formats
The following rules should be applied when entering dates, times, and measurements:
· Dates should be stated as: <Month Day, Year>, for example, May 3, 2007, with a nonbreaking space between the month and the number, as in May 3.
Where dates have to be expressed as numbers separated by slashes, the month should appear first, with both month and day using leading zeros where appropriate. In such cases the standard format of the date (as shown in the previous paragraph) should always be shown in parentheses after the date in its number form. The date May 3, 2009 should, therefore, be represented as 05/03/2009 (May 3, 2009).
	
	

	Note:
	Be aware that date formats may cause confusion, as the format 05/03/2009 would be interpreted as May 3, 2009 in the U.S., and as March 5, 2009 in the U.K.

	
	


Where abbreviated date formats must be referenced in regular text, use all capitals:
MM/DD/YYYY (or DD/MM/YYYY, as needed)
	
	

	Note:
	Although both formats are acceptable as required (for localization or to match source code), the U.S. style should be considered the standard unless special circumstances apply.

	
	


· Times should be given in 12-hour clock display. The format should be hh:mm:ss A.M. or hh:mm:ss P.M. Single-digit hours should have a leading zero added, as in 03:33:56 A.M. Use a nonbreaking space between the last number and A.M. or P.M.
· Note the use of capitals and periods for A.M. and P.M. However, if you are referring to a time-based field, match the system treatment of A.M. and P.M. (am, pm, AM, PM, and so on).
· As a general rule, units of measurement should be avoided where possible.
If you must refer to units of measurement:
· Quantities (other than money amounts) that include units should have a nonbreaking space between the amount and the unit (for example, 123 KB).
· No symbols should be used in the following cases:
· For degrees, do not use the (°) symbol. If you must mention degrees, use the word degrees, not the symbol.
· For percentages, do not use the % symbol in regular text. The symbol is acceptable in tables, however, where space is limited. In regular text, percent should be written as one word, as in 50 percent. Include a nonbreaking space between the numeral and percent.
[bookmark: scroll-bookmark-358]Gender-Neutral Language

	Guideline
Use gender-neutral language in any kind of writing where gender is irrelevant to the subject matter, to make the text as inclusive as possible. If the subject is a person of either gender, he/his is not appropriate. Try to avoid using he and his as generic third-person pronouns, using they and their instead. For example, If a customer owns Product A, he is able to … should be replaced with If customers own Product A, they are able to ….


Incorrect
A confirmation dialog appears, asking the user if he allows the web page to use his Web cam.
A confirmation dialog appears, asking the user if she allows the web page to use her Web cam.
Correct
(The best solution is to rewrite and eliminate the pronouns completely.)
A confirmation dialog appears, requesting the user's permission for Web cam access.
A confirmation dialog box appears that asks the user for permission to use the Web cam.
[bookmark: scroll-bookmark-359]Internationalization and Localization
Internationalization is the process of generalizing a product so that it can handle multiple languages and cultural conventions without the need for redesign. It takes place at the level of program design and document development.

Localization is the process of adapting, translating, and customizing a product for a specific market (or locale). It includes translating the user interface, Help, and documentation and ensuring that the entire document (including images and concepts) is linguistically and culturally appropriate and sensitive to the target locale. There may be subtle cross-cultural considerations, such as whether icons make sense in other parts of the world.

Localization can sometimes be required for documentation. With this in mind, authors should observe the following guidelines to assist in the localization process:
· Where possible, sentences should be short and concise (the average sentence length should be 15 to 20 words).
· Words with multiple or ambiguous meanings should be avoided.
For example:
· Press ANY key to continue...Since keyboards do not have an "ANY" key, use instead Press any key on the keyboard to continue….
· Hit ENTER when ready.The use of hit is ambiguous. Standards state that you press a key. Also, what is meant by is ready? Use instead Press the ENTER key when the program indicates to do so.
· Avoid using may or might. Aim for a more positive, clearer meaning. Use can or must, if appropriate, as in "You need the following before you proceed" not "You may need the following before you can proceed."
· Culturally specific language or slang should not be used. Some examples:
thumbs up – use OK, correct, right signal, affirmation
hang or lock up – Freeze/is frozen is the preferred term for localization purposes.
chain reaction or knock-on effect – series of related events
fallout – consequences, results, outcome, effect
I guess – I think
bonafide – genuine; authentic; real
ad hoc or off the cuff – unplanned; informal, impromptu; unprepared; improvised
one-off – non-recurring
fortnightly – biweekly
whilst – while
· For ease of translation, chapter names, book, chapter, and image file names should be short and concise – fewer than 40 characters since they present problems if the guide undergoes localization. See the Naming Conventions topic for information on naming conventions for files.
· Phrasal verbs, such as set up, should be avoided whenever possible, in favor of verbs such as assemble, configure. Some examples:
set up - configure
close down - close
rule out - eliminate
carry on - continue
turn into - become
go back - return
[bookmark: scroll-bookmark-360]Keystrokes
When referring to keys on a keyboard, the key name should appear in uppercase, for example, CTRL. The key name should not be in bold. In FrameMaker, the character style keys should be used to achieve this formatting. Square brackets are not used to denote keys.
Where more than one key is referred to in a sequence, key names should appear in uppercase, linked by a + symbol, for example, CTRL+SHIFT (with no space before or after the +).
Key names should always be written out, even though some keyboards use symbols instead, for example, an up arrow for SHIFT, a bent arrow for ENTER. (Note also that ENTER should be used, not RETURN.)
[bookmark: scroll-bookmark-361]Macro vs. Macros

	Guideline
Use the word macro correctly.
	Singular
	Plural

	macro
	macros


Note: Unlike Russian, in English, "macro" is written without an "s" when it is singular.


Correct
The %attribute% macro is used to append the parameter value to the name of the cable.
The %parent% and %child% macros are used to retrieve the IDs of the parent and child object, respectively.
Incorrect
The %username% macros produces name of the currently logged on user.

[bookmark: scroll-bookmark-362]Tree vs. Hierarchy
Use the word "tree" only when describing a tree of object types. Use the word "hierarchy" only when describing a hierarchy of objects that represent customer sites, devices, and so on in the Netcracker database.
Never use "tree" to refer to an object hierarchy, except when objects are displayed in the user interface as a tree. Never use "hierarchy" to refer to the object type tree.
Examples:
…in the object type tree. (not "the object types tree")
In the object hierarchy… (not "the objects hierarchy")
Clicking this button expands the tree of objects to show objects on the lower level of the hierarchy. (exception)
[bookmark: scroll-bookmark-363]Assigned vs. Associated

	Guideline 1
The word assigned cannot be applied to lifeless objects. For more knowledge about usage of assigned, refer to http://sentence.yourdictionary.com/assigned.



	Guideline 2
Attribute schema must always be associated with project. For more knowledge about usage of associated, refer to http://sentence.yourdictionary.com/associated.


[bookmark: scroll-bookmark-364]Parameters vs. Attributes
Attributes belong to object types. You can also write, for example, "attribute of the Device object type." Never write "attribute" when you refer to a parameter of an instantiated object. Use word "parameter" when you refer to parameters of a specific object.
Parameters are implemented by attributes. This means they are instantiated from attributes similar to how objects are instantiated from the object types. In other words, an object is a representation of an object type, and a parameter is a representation of an attribute.
Note: An attribute can belong to several object types in the object type tree, regardless of the relative positions in the hierarchy of object types. Basically, this means that a user can create an attribute inside an object type and then bind it to any object type in the system. Thus, an attribute is an entirely independent entity.
Correct
The Status attribute of the Device object types stores the status of the object.
To activate the Cisco 1534 device, change the value of its Status parameter to "Active." From the Status drop-down list box, select "Active."
[bookmark: scroll-bookmark-365]Using of Available To and For
When writing about availability, segregate the prepositions "to" and "for".
Check with the following rule:
1. Available FOR a purpose
2. Available TO a person
Examples:
· The software is available to a user on the Downloads page.
· The software is available for downloading on the Downloads page.

[bookmark: scroll-bookmark-366]Using of Below

	Guideline 
Never end sentences containing the word "below" with a colon. If a sentence ends with a colon, it cannot contain the word "below."


[bookmark: scroll-bookmark-367]Using of That, and Which, and Who
· Following are guidelines for correct use of "that" and "which" and "who" in restrictive and nonrestrictive causes.
[bookmark: scroll-bookmark-368]Identifying Restrictive and Nonrestrictive Clauses
· A modifier is any word, phrase, or clause that describes a noun, noun phrase, verb, verb phrase, or sometimes another modifier. For a discussion of restrictive and non-restrictive modifiers, only modifying phrases and clauses are at issue. (In the following sentence, the single word existing is an adjective, a modifier, but no one would consider putting commas before or after it: You open an existing customer when you select the customer from the results of a customer search.)
· A modifier is restrictive when the information in the modifier is necessary to the meaning of the sentence. In this case, necessary is not the same as important; by “necessary,” we mean that the sentence will lose essential meaning if the modifier is removed from the sentence. Restrictive modifiers are not set off with commas.
· A modifier is non-restrictive when it can be dropped from the sentence without the loss of essential meaning. That is, if the modifier is removed, the reader can still identify the thing being modified. Non-restrictive modifiers are set off with commas.
[bookmark: scroll-bookmark-369] Examples of Restrictive Clauses
· “This describes actions that can be started on the opening page.”
The clause that can be started on the opening page is restrictive. If you removed it, the actions could not be identified. For that reason, it is not set off with a comma.
· “The navigation bar menus will update to display the actions available for that entity.”
The phrase available for that entity is restrictive. If you removed it, the actions could not be identified. For that reason, it is not set off with a comma.
· Another way to help determine whether a modifying phrase or clause is restrictive or non-restrictive is to say the sentence aloud. If you do not naturally and comfortably pause between the modifier and the thing being modified, then the modifier is probably restrictive. Try the last example above:
“The navigation bar menus will update to display the actions available for that entity.”
It is not likely that you paused after actions. The modifier is restrictive, and a comma should not be placed before it.
[bookmark: scroll-bookmark-370]Examples of Non-restrictive Clauses 
· The sentence below contains a non-restrictive clause:
“This describes the Customer Hierarchy, which uses icons to represent existing customers, contacts, accounts, and products.”
The which clause provides useful information, but the reader would be able to identify the Customer Hierarchy without it. Therefore, the sentence has a comma before which.
· Think of a non-restrictive clause as a parenthetical clause introducing additional information about the subject. Sentences with nonrestrictive clauses could be split into two separate sentences.

· Now consider this sentence:
“Select the node for the customer that you want to modify.”
In this sentence, "that you want to modify" is a restrictive modifier. It is not set off by commas. The restrictive clause is necessary information because it tells the reader which customer is being discussed.
[bookmark: scroll-bookmark-371]Correct Use of "That" and "Which" and "Who"
· A distinction is typically made between the relative pronouns that and which.

· That is typically used to introduce a restrictive clause, with no preceding comma.
Example: “The system process that handles billing is the Billing Engine.”
· Which is typically used to introduce a nonrestrictive clause, with a comma preceding and one following the clause to set it off. (Preceding comma only if the clause ends the sentence.)
Example: “The Billing Engine, which handles billing, is a key Rating and Billing system process.”
· The relative pronoun Who is an exception in clauses. It may be used in both restrictive and nonrestrictive clauses.
Examples: The person who handles security administration has access to this user interface.
The CAAF Security Administrator, who defines user roles and permissions, has access to this user interface.


	Guideline
"Which" should not be used for restrictive clauses.


Incorrect
Navigate to the page which contains the report you want to run. Should have '"hat" instead of "which" because the second part of the sentence is a restrictive clause.
Correct
Navigate to the page that contains the report you want to run.
Also correct
Navigate to the Reports page, which contains reports you can run. For non-restrictive clauses, the use of "which" is fine.
[bookmark: scroll-bookmark-372]Comment
"That" introduces a restrictive clause—a clause that must be there for the sentence to make sense. A restrictive clause often defines the noun or phrase preceding it.
Example:
The form that is used for the final submission should be completed in ink.
A that-clause is not separated by commas. "Which" introduces a nonrestrictive, parenthetical clause—a clause that can be omitted without affecting the meaning of the sentence.
Example:
The green form, which is used for the final submission, should be completed in ink.
A which-clause is separated by commas. Use "who" or "whom," rather than "that" or "which," when referring to a person.
[bookmark: scroll-bookmark-373]References
The Chicago Manual of Style, 14th edition – Section 5.42
The Elements of Style – Section on “Elementary Rules of Usage”: http://www.bartleby.com/141/strunk.html
An English Grammar – Section on “Restrictive and Unrestrictive Relatives”: http://www.gutenberg.org/files/14006/14006-h/14006-h.htm
Grammar Girl – “Which Versus” That section: http://grammar.quickanddirtytips.com/which-versus-that.aspx
[bookmark: scroll-bookmark-374]Using of Both

	Guideline
When "both" is used with "and" to link parallel elements in a sentence, the words or phrases that follow them should correspond grammatically.


Correct
In both India and China…
Both in India and in China…
Incorrect
Both in India and China…
[bookmark: scroll-bookmark-375]Using of Following

	Guideline
If a sentence contains the word following, it must end with colon.
The only exclusion is the case when the meaning is following something, like in example below.
The number following the name indicates the ID of the object.


[bookmark: scroll-bookmark-376]Human Characteristics (Anthropomorphism)
The phenomenon of attributing human characteristics to non-human things is a type of metaphor called anthropomorphism that can cause readability problems in technical writing.

	Guideline
Avoid using words or phrases that attribute human characteristics or behavior to things that are not human.
For example, a function of a software application cannot know a piece of information or be responsible for performing a task because knowledge and responsibility are human characteristics.


In some cases, established conventions or terminology can make anthropomorphism unavoidable. For example, the relationship between a parent and child is often used to describe hierarchical relationships between objects and provide a framework for the concept of inheritance in technical content. Likewise, the term behavior is often used when describing the functioning of software. Anthropomorphic terms such as these are widely understood and are acceptable in the right context. However, take care when using the following words and phrases to ensure that you are not using anthropomorphism inappropriately.
· allow
· answer
· assume
· aware
· behave
· decide
· demand

· know
· let
· like
· own
· permit
· realize
· recognize

· refuse
· remember
· responsible
· see
· think
· understand
· want
Example
INCORRECT
The button is responsible for..., the screen control is responsible for..., the component is responsible...
CORRECT
The user is responsible for..., the administrator is responsible for..., the sales agent is responsible for..., the technician is responsible for...

[bookmark: scroll-bookmark-377]Netcracker References
If references need to be made to the company, you should use the name Netcracker in regular text.
In sentences, Netcracker should be regarded as a singular item. Use "Netcracker recommends…" in preference to "Netcracker recommend…"
[bookmark: scroll-bookmark-378]Using of Logs

	Guideline
Do not use the noun logs. Instead, use log files.
	The following cases are exclusions which allow using the term logs without files:
· When using the term in couple with a determiner word, e.g., event log, messages in log, Windows logs, DataFlow logs, system log, etc...
· When begining of the sentence makes clear that a protocol is meant, e.g., These events are forwarded to this log by other computers








[bookmark: scroll-bookmark-379]Numbers and Currency Amounts
When including numbers within text:
· Numbers from zero to nine should be written in full (except when they form part of a measure) and those from 10 onward as digits.
· Treat numbers within a category consistently. That is, if one "type" of number must be written in digits, another number of the same type must also be written in digits. If two numbers of different types appear together, one must be spelled out.
For example: One manual has 17 pages, one has 6 pages, and the third has only 3 pages. We had ten 12-page manuals.
In this example, because 17 is not less than 10, it is written as a numeral; so the other references to numbers of pages are also written as numerals. The first word in the first sentence is the beginning of a sentence and is less than 10, so it is written as a word. Therefore, in the second sentence, ten is written as a word, because it also indicates the number of manuals.
· The number zero should be written as a word and not as a figure 0. Using 0 (zero) is acceptable. Use a nonbreaking space between 0 and (zero).
· Round numbers of a million or more should be written as a numeral plus the word, with a nonbreaking space between numeral and word, as in 1 million, 5 million.
· Numbers of a thousand or more should use a comma. For example, write 20,000, rather than 20000. As an exception, where computer text values as expected by the system are shown, commas should be omitted.
· Try to avoid beginning a sentence with a number or an amount.
· Multiplication should be indicated by x, not *. For example: 20 calls cost $1.60 (20 x $0.08).
Currency amounts should be presented as follows:
· Major currencies should use the format $2.66 (U.S.), with no space between the symbol and amount, and with the country denoted as appropriate.
If all dollar amounts in a series are even (that is, do not include cents), the .00 values may be eliminated, as in $25, $50, $75; but $25.00, $50.00, $75.48.
· Minor currencies should use the format 15 cents (U.S.), with a nonbreaking space between the symbol and amount, and with the country denoted as appropriate.
	
	

	Note:
	In the first instance of a monetary amount, include the country identifier. In subsequent references, the country identifier can be omitted (if it is clearly understood), unless the reference is to a different country.
Note that in both of the preceding cases, the text (U.S.) can be omitted unless the context is specifically U.S. Additionally, in lists of monetary amounts where (U.S.) is required, it should only be included on the first member of the list.

	
	


· The currency name, for example, dollar or euro, should always be in lowercase.
· Do not use the abbreviation EUR for euro. Note that euros is the plural form of euro.
For information on using dashes when writing a range of numbers, see the Dashes topic.
[bookmark: scroll-bookmark-380]Person (Second and Third Person)
In general, the second person (you) should be used throughout the product documentation. The term operator should generally be avoided.

The following construction:

The process count parameter allows an operator to specify the number of processes to run.

should, therefore, be expressed as:

The process count parameter allows you to specify the number of processes to run.
[bookmark: scroll-bookmark-381]Positive vs. Negative Language
Use positive wording whenever possible, and avoid negative phrasing. Positive language is more direct and concise.
Example: The window opens only if the system accepts the customer record, instead of: The window does not open if the system does not accept the customer record.
[bookmark: scroll-bookmark-382]Rating and Billing Manager Specific Guidelines
[bookmark: scroll-bookmark-383]Bold
Use bold font only for the acceptable template styles, such as certain UI items, section headings, and bulleted list stubs.
[bookmark: scroll-bookmark-384]Italics
Use italics sparingly. Too much italics can make normal text on the page seem less important. Italics should be used for words that you want to emphasize and for terms that are defined in regular body text.
Do not use quotation marks or underlining to emphasize words or phrases.
Examples of acceptable use of italics:
Do not delete the customer until....(for emphasizing words)
A child product is a.... (defining the term)
Examples of inappropriate use of italics (not significant to the meaning of the sentence):
If the previous tasks have sent data to external systems, that data is not resent.
Each customer within the hierarchy can have one or more accounts.
[bookmark: scroll-bookmark-385]Schemas
Where a reference to the Rating and Billing Manager schema is made, it should appear with the release number (for example, 5.3) and the schema version as a trailing alphabetical character in capitals with no space between the number and the letter, for example, 5.3F.
Schemas for certain other TOMS components may additionally include version designations.
[bookmark: scroll-bookmark-386]Terms Specific to Rating and Billing Manager
When dealing with terms specific to Rating and Billing Manager (Collections Manager), the following guidelines should be used:
· Use user interface in preference to user application. Use system process in preference to volume processing application or batch application.
· Whenever a user interface or a system process is referred to, it should be called by its full name. For example:
When the Bill Data Writer processes the data…

Rather than:

When the Data Writer processes the data…
· References to some user interfaces do not need to be identified as user interfaces, as in the case of component user interfaces. For example, refer to Customer Account Maintenance instead of the Customer Account Maintenance user interface.
· Do not use acronyms or abbreviations for the names of Rating and Billing Manager, Collections Manager, and other component names, user interfaces, or system processes in text. For example, you should use Rating and Billing Manager in preference to RBM. If, however, the component name is used in a diagram or a table where space is limited, the component name can be abbreviated. Where this is the case, use the official abbreviation, for example RBM for Rating and Billing Manager.
[bookmark: scroll-bookmark-387]Sentence Fragments
[bookmark: scroll-bookmark-388]Definition
· Grammatical: Sentence fragments occur when a sentence is missing a subject, verb, or main clause. (A main clause is a clause that can stand alone, i.e. not subordinate.)
· Logical: A fragment is an incomplete idea, i.e. there is missing information so that the full meaning can’t be grasped.
[bookmark: scroll-bookmark-389]Words to Watch Out For
A phrase starting with any of these words is a subordinate clause, not a complete sentence:
· when
· while
· since
· as
· because
· if
· although
· unless
· before
· after
· during
· whereas
[bookmark: scroll-bookmark-390]Grammatical Rule
Every sentence consists of a subject and a predicate:
· The subject is what the sentence is about.
· The predicate is what you’re going to say about the subject.
Examples:
· The Active Rating Engine processes events.
· The Billing Engine’s attempt to process the wholesale accounts failed because of errors in the discount configuration.
At a minimum, a sentence requires a subject and a verb. Most sentences are usually more complex than this, but they always contain a subject and main verb.
[bookmark: scroll-bookmark-391]Examples of Subordinate Clause Fragments
· “The underlying code for the Event Unloader has been amended so that when the Event Unloader is run to unload fragmented events.”
· “Since the validation applied for the DAILY mode was inconsistent between the INITIALISE and WORK phases.”
· “However, because Event Sort/Merge is run for all the three phases (that is, INITIALISE, WORK, and COMPLETE) for each domain group in isolation.”
· “If you start up the process without providing the full set of command line arguments.”
· “Unless you link the rating catalog to the billing catalog.”
· “Before the main processing of the Active Rating Engine begins, which allows you to make modifications using a rating extension plug-in.”
These are all subordinate clauses – there is no main subject or verb.
In all cases, the reader will ask: “so what happens?”
[bookmark: scroll-bookmark-392]Examples where the Subject or Main Verb is Missing
· “Rating and Billing Manager provides flexible discounting. To increase customer loyalty.”
· “The event loading process was too slow. And resulted in duplicate events.”
· “An unpublished rating catalog, in which supplementary rate plans exist.”
[bookmark: scroll-bookmark-393]Correcting Sentence Fragments 
If you’re not sure it’s a complete sentence:
· Look for the main subject and/or verb.
· Ask yourself what information is missing. What is the “punchline”?
Examples:
· “The underlying code for the Event Unloader has been amended so that when the Event Unloader is run to unload fragmented events.”
Problem: The phrase in red does not have a main verb telling us what happens in this situation.
· “An unpublished rating catalog, in which supplementary rate plans exist.”
Problem: The whole sentence is noun phrase. There is no predicate telling us anything about the unpublished rating catalog.
Correcting Fragments:
· In some cases, the information exists but needs to be included in the same sentence (e.g. join up with next sentence).
· If not, supply the missing information – provide the subject and/or verb.
Examples:
· “However, because Event Sort/Merge is run for all the three phases ... for each domain group in isolation. It was difficult to recover from a systematic error such as partitions not being aligned when one domain group had the COMPLETE phase.”
Here, the real subject and verb are “it was difficult”. The solution is to change the period to a comma here.
· “Since the validation applied for the DAILY mode was inconsistent between the INITIALISE and WORK phases.”
Here, there is missing information. We need to state the outcome of this situation (e.g. did a process fail because of inconsistent validation? Were error messages generated? and so on).
[bookmark: scroll-bookmark-394]References
Sentence fragments:•http://www.ucalgary.ca/uofc/eduweb/grammar/marking/sentmark.htm#se1 and http://www.ucalgary.ca/uofc/eduweb/grammar/course/sentence/2_6a.htm for definition and tutorial•http://en.wiktionary.org/wiki/sentence_fragment
Other useful websites:•http://www.scientificpsychic.com/grammar/enggram2.html (English sentence types)•nicholsenglish.edublogs.org/files/2008/01/sentence-structure-glossary.ppt (glossary of sentence structure elements – useful short definitions)
[bookmark: scroll-bookmark-395]Tense
Always use the simple present tense by default. Only use other tenses when you are describing events specifically in terms of the past and the future. For example, use The workflow restarts at the point of error. Do not use: The workflow will restart at the point of error.
Occasionally, however, the use of future tense is needed, for example: If the customer purchases a service that will begin at a later date....
[bookmark: scroll-bookmark-396]Trademarks
Trademark symbols should not be used on covers or in the text for Netcracker or any other third-party trademarks unless expressly stated.
When referring to a Microsoft product, the product name should always be preceded by the word Microsoft, as in Microsoft Excel.
	
	


[bookmark: scroll-bookmark-397]U.S. Terminology and Spelling
All documents should use U.S. spelling, terminology, and grammar rules.
[bookmark: scroll-bookmark-347]User Interfaces and System Processes
When referring to user interfaces, the title should not be preceded by the word the or followed by the term user interface. For example:
Use the form:

	
	…Billing Catalog Maintenance is used to…... Customer Service Management consists of...



When referring to system processes, the title should be preceded by the word the. For example:

Use the form:

	
	The Task Master is designed to be a continually running background process.


Further to this, there are exceptions in Rating and Billing Manager:
· The Bill Renderer is a user interface but is treated as a system process, so it retains the word the.

Where user interfaces and system processes are referred to in documentation, the full name of the process must be used. Abbreviations are not acceptable. For example: Rating and Billing Manager, not RBM.
[bookmark: scroll-bookmark-398]Voice (Active vs. Passive)

	Guideline
Use the active voice, which tells who or what is performing the action of the sentence.
Use the active voice for column headings in tables that list user actions.


Passive voice is more often used and acceptable in programmer documentation. Sentences in the passive voice focus on the person or thing that receives the action, that is, the object of the action.
For example:

Active: This guide presents an overview of the Customer Service Management architecture. Passive: An overview of the Customer Service Management architecture is presented by this guide.

The first sentence is stronger, clearer, and shorter. It conveys more clearly who is the agent of the action. There is no reason to use the passive voice to make the point.

The following is an example of acceptable use of the passive voice:

Customer Service Management pages are grouped into functions. This sentence properly emphasizes the receiver of the action, the Customer Service Management pages. In this case, the agent that does the grouping is not indicated or required.
Avoid the passive voice except for the following cases where it is allowed:
· When necessary to avoid a wordy or awkward construction
· When the subject is unknown or not the focus of the sentence
· In error messages and troubleshooters, when the user is the subject and might feel blamed for the error if the active voice were used
[bookmark: scroll-bookmark-399]Examples
Preferred
Divide the documents into as many sections as necessary. Data hiding provides a number of benefits. Netcracker includes many useful features.
Acceptable Use of Passive Voice
The Include directive (#include) should appear in the header file for the fastest execution. It is recommended to choose the typical installation option.
Avoid Passive Voice
The document can be divided into as many sections as necessary. A number of benefits are provided by data hiding. Many useful features are included in Netcracker.


	Guideline
Do not mix active and passive constructions in the same sentence.


[bookmark: scroll-bookmark-400]Example
Preferred
The executive committee approved the new policy and revised the calendar for next year's meetings.
Avoid
The executive committee approved the new policy, and the calendar for next year's meetings was revised.

[bookmark: scroll-bookmark-401]Comma Splices
Avoid run-on sentences and comma splices.
A run-on sentence (sometimes called a "fused sentence") has at least two parts, either one of which can stand by itself (in other words, two independent clauses), but the two parts have been combined improperly. The length of a sentence has nothing to do with whether a sentence is a run-on. Being being a run-on is a structural flaw that can plague even a very short sentence:
	The sun is high, put on some sunblock.


An extremely long sentence, on the other hand, might be a "run-off-at-the-mouth" sentence, but it can be otherwise sound, structurally.
[bookmark: scroll-bookmark-402]When two independent clauses are connected by only a comma, they constitute a run-on sentence that is called a comma splice. The above example is a comma splice. When you use a comma to connect two independent clauses, it must be accompanied by a conjunction (and, but, for, nor, yet, or, so).
	The sun is high, so put on some sunscreen.


Run-on sentences happen typically under the following circumstances*:
1. When an independent clause gives an order or directive based on what was said in the prior independent clause:
	This next chapter has a lot of difficult information in it, you should start studying right away.


(We could put a period where that comma is and start a new sentence.)
2. When two independent clauses are connected by a transitional expression (conjunctive adverb), such as however, moreover, nevertheless.
	Mr. Nguyen has sent his four children to ivy-league colleges, however, he has sacrificed his health working day and night in that dusty bakery.


(Again, where that first comma appears, we could have used a period and started a new sentence.)
3. When the second of two independent clauses contains a pronoun that connects it to the first independent clause.
	This computer doesn't make sense to me, it came without a manual.


Although these two clauses are quite brief, and the ideas are closely related, this is a run-on sentence. We need a period where that comma now stands.
	Most of those computers in the Learning Assistance Center are broken already, this proves my point about American computer manufacturers.


Again, two nicely related clauses, incorrectly connected — a run-on. Use a period to fix this sentence.
[bookmark: scroll-bookmark-403]Using of You

	Guideline 1
Say “You can make report data."
Do not say “It is possible to make report data."



	Guideline 2
Try not to use "you" in plain text formatted with the Body Text style. Use object names or other nouns to designate a third person, and avoid passive voice as it is described in Voice (Active vs. Passive). But, use passive voice if nothing else is appropriate.



	Guideline 3
In Administrator Guides, use "you" for the administrator and "the user" for the application end user. Differentiate between "you" (the administrator) and the program and actions it can perform.



	Guideline 4
Do not use "one" as the third person. In this case, always use "you" or passive voice.


[bookmark: scroll-bookmark-404]Comments
· It is better to say “You can make report data”. After all, the reader of the guide is the one who will do these operations most of the time. It is simpler, clearer, more concise, and active. It also makes the documentation sound a little more user-friendly.

· In general, use the second person (you) in most product documentation to refer to the user. Using the second person focuses the discussion on the user and makes it easier to avoid the passive voice.
[bookmark: scroll-bookmark-405]Product Component

	Guideline 1
Use "product component" (or "component") only when you are talking about system troubleshooting or maintenance tasks.
Limit the usage of it to administrator's and developer's documentation.


For example:
If the list of rules is empty, check that the "Correlation Engine. Basic Inventory Rules" product component is installed.


	Guideline 2
Spell a product component name exactly as shown on the http://server_address:server_port/tools/components_versions.jsp Netcracker page.
Apply standard quotation rules as detailed in Quotation Marks.




[bookmark: scroll-bookmark-52]U.S. Terminology and U.K. Terminology Reference
This list shows U.S. English terms and their U.K. English equivalents. The U.S. terms must be used in all documentation unless it is decided to use English teminology due to the project specifics.
	U.K. English Term
	U.S. English Term

	-isation
	-ization (as in realization)

	-ise
	-ize (as in realize)

	account has debt
	account is in collections

	account's debt
	account's collection amount

	accruals
	earned but unbilled accruals

	analyse
	analyze

	anonymise
	anonymize

	backwards
	backward

	billing tariff
	price plan

	cancelled
cancelling
	canceled
canceling

	cancellation
	cancellation (two "l"s)

	catalogue
	catalog

	central exchange
	Centrex

	centre
	center

	chasable
	collectible

	chasable debt
	net receivables

	current debt
	current receivables

	debt
	receivable

	debt action
	collection action

	debt age
	age of receivable(s)
-- singular for one account/customer
-- plural for multiple

	debt analysis
	receivables analysis

	debt escalation
	collection process

	debt escalation action
	collection action

	debt escalation request
	collection request

	debt escalation schedule
	collection schedule

	debt escalation system
	collection system

	debt management
	receivables management

	debt start date
	collections start date

	debt system
	receivables

	debt with age
	collection with age

	dialogue box
	dialog box

	direct debit mandate
	direct debit authorization

	driving debt
	collection trigger

	dunning letter
	dunning notice

	enquire/enquiry
	inquire/inquiry

	fortnight
	two weeks

	fortnightly
	bi-weekly
every two weeks

	forwards
	forward

	fulfilment
	fulfillment

	grey
	gray

	legal debt
	total receivables

	licence
	license

	mandate
	automatic payment authorization

	mandate information request
	payment authorization request

	mandate reference
	payment authorization reference

	National Insurance number
	Social Security number (initial capitals as shown)

	nett
	net

	oldest debt
	oldest receivable(s)
-- singular for one account/customer
-- plural for multiple

	one-off charge
	non-recurring charge

	organisation
organise
	organization
organize

	package tariff
	package price plan

	payment request mandate
	payment request authorization

	post-termination bill
	post-final bill

	practise (verb)
	practice

	prepayment
	billed but unearned accruals

	programme
	program

	rating tariff
	rate plan

	tariff
	rate plan or price plan depending on context

	tariffing currency
	pricing currency

	termination bill
	final bill

	termination price
	final price

	termination surcharge / record / event / reason
	stay as is

	through
	through (never thru)

	total debt
	total receivables

	towards
	toward

	value of debt
	receivables value

	whilst
	while



	


[bookmark: scroll-bookmark-53]Internal and External Cross-References
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· General Guidelines
· Formatting Internal Cross-References
· Referencing Pages within the Current Guide
· Referencing Subsections of a Page within the Current Guide
· Formatting External Cross-References
· Referencing Other Netcracker Guides
· Referencing External Web Content
[bookmark: scroll-bookmark-408]General Guidelines

	Guideline 1
Avoid using cross-references for information that is essential to performing the task at hand, for example, completing a step-by-step procedure.



	Guideline 2
Do not use blind cross-references. Make sure you are explaining why the referenced information is useful so the user can make a decision about whether to break away from the current topic to follow the cross-reference.



	Guideline 3
Use the phrase "For more information about," and not "For more information on." The latter phrase can cause confusion for non-native English speakers.



	Important!
· Do not use cross-references to Administrator Guides from User Guides. Otherwise, users may be prompted to view documents they cannot access. For example, do not refer to the Netcracker Framework, "Search Profiles" document from the Netcracker User's Guide, "Search Function" chapter.
· Do not use cross-references to Developer Guides, whatever document you are working with. Netcracker Framework is an Administrator Guide.



[bookmark: scroll-bookmark-409]Formatting Internal Cross-References
Internal cross-references refer to other sections within the current guide.
When referencing a page within the current guide, use hyperlinks. When referencing a subsection of a page within the current guide, use plain text references.
[bookmark: scroll-bookmark-410]Referencing Pages within the Current Guide

	Guideline 4
Use hyperlinks to reference a page within the current guide. The link text must match the title of the linked page.
Hint: The easiest way to insert a hyperlink is to open the referred page of a product component, copy the URL from the browser, and paste it directly into the body text. Confluence will automatically convert the URL into a page title link.
For more information about hyperlinks, see Working with Links.



	Guideline 5
Provide links only for particular pages within the current guide. Do not link to subsections of pages, entire guides, or pages of other guides.



	Guideline 6
Hyperlinks in the Confluence documentation must not:
· Contain the document name, for example, "Netcracker Framework User's Guide."
· Contain quotation marks.
· Contain any words in italic.
· Use the phrase "refer to."




	Guideline 7
Cross-reference "For more information" to a particular article must not be inserted in the source article more than once.



	Guideline 8
Use only the following syntax for hyperlinks in Confluence documentation:

For more information about X, see Page Title.
Do not mention the name of the product components, modules, etc. in the link text.


[bookmark: scroll-bookmark-411]Referencing Subsections of a Page within the Current Guide

	Guideline 9
To reference a preceding section on the same Confluence page, for example, to focus on important information or to avoid duplication of content within one page, do not insert a hyperlink. Do not use the words "For more information" either. Use plain instructional text, possibly with the word "above", instead. For example:
This procedure invokes the same approach as described in the section "Setting Recalculation Delay" above.
Avoid using forward references.


[bookmark: scroll-bookmark-412]Formatting External Cross-References

	Guideline 10
Use the phrase "refer to" when referencing external Netcracker or non-Netcracker content.


[bookmark: scroll-bookmark-413]Referencing Other Netcracker Guides

	Guideline 11
When referencing other Netcracker guides, use the following format:
For more information about X, refer to Netcracker [Document Name], "[Page Title]."
Example:
For more information about creating attributes, refer to Netcracker Attributes and Types Configurator Administrator Guide, "Creating Attributes."



	Guideline 12
Do not use hyperlinks for external cross-references to Netcracker content. Any hyperlinks to content outside of the current guide are automatically removed when the guide is exported to PDF.



	Guideline 13
Cross-references in Confluence documentation should point to entire articles only, not to subsections.



	Guideline 14
When referring to a document from another space, make sure you refer to a page from the latest product version of a component.


[bookmark: scroll-bookmark-414]Referencing External Web Content

	Guideline 15
References to Web resources must be links to the relevant web pages. A hyperlink must be displayed as readable text, not as a URL.
All cross-references to external resources should have the following syntax:
For more information, refer to Oracle Database Installation Guide.


[bookmark: scroll-bookmark-415]Punctuation

	Guideline 1
Do NOT use any punctuation for names of controls, including <, >, [, ].



	Guideline 2
In general, do not use the ampersand sign (&), angle brackets (< >), quotes, em dash, or minus sign in headings. Do not use the ampersand sign (&) in text or headings to mean "and" unless you are specifically referring to the symbol on the user interface, code, or the symbol is part of a name of a brand, company, trademark, and so on. Refer to the Products drop-down menu of the Netcracker corporate Web site (http://www.Netcracker.com/) to determine whether an ampersand is part of a marketed name.



	Guideline 3
Use the greater than sign (>) ONLY when you are writing about the navigation path string. In all other cases avoid this character by writing in detail about each item.
Examples:
· Select "DS1" from the list …
· In the edit box, type Site C
· On the navigation path string, click "My Project."
· … click "Devices" on the navigation path string …




	Guideline 4
Use parenthesis ("()") ONLY for abbreviations preceeded by the abbreviated term. Do not use parenthesis to explain or illustrate what you mean.
	The Guideline 4 concerns to all the documentation except for the ICOMS, RBM, and CM documentation.


Examples:
INCORRECT
You can launch operations over objects (add, edit, import, and delete) by clicking the buttons on the toolbar.
CORRECT
You can launch operations over objects, such as add, edit, import, and delete, by clicking the buttons on the toolbar.



	Guideline 5
Never type ellipsis as one symbol in technical documentation. To insert ellipsis, type three symbols "dot."



	Guideline 6
Never end the sentences containing the word "below" with colon. If a sentence is ended with colon, it cannot contain the word "below."



	Guideline 7
A sentence can be ended only with period in case the sentence is followed by a regular paragraph, table, or figure.
A sentence can be ended with colon only in case the sentence is followed by a list, either bulleted, or numbered.
INCORRECT
When a Resource Group or a Position does not have the "To" parameter specified, they are considered to be never-ending. But in reality, they are just rescheduled in a fixed period of time. It is possible to configure the parameters of auto-prolongation in order to ensure better performance.
Editable parameters are:
The Auto-Prolongation Period, w parameter specifies the number of weeks that are automatically assigned to a Resource Group or Position. if the don't have the "To" parameter specified.
The Auto-Prolongation Job Interval parameter specifies the time period, in which the "Auto-Prolongation Period, w" parameter is refreshed to its value providing, that the specified amount of weeks will never be exceeded.
CORRECT
When a Resource Group or a Position does not have the "To" parameter specified, they are considered to be never-ending. But in reality, they are just rescheduled in a fixed period of time. It is possible to configure the parameters of auto-prolongation in order to ensure better performance.
Editable parameters are:
The Auto-Prolongation Period, w parameter specifies the number of weeks that are automatically assigned to a Resource Group or Position. if the don't have the "To" parameter specified.
The Auto-Prolongation Job Interval parameter specifies the time period, in which the "Auto-Prolongation Period, w" parameter is refreshed to its value providing, that the specified amount of weeks will never be exceeded. T


[bookmark: scroll-bookmark-416]Apostrophes
Apostrophes should always be "smart" (curved) quotes. See the note in the Quotation Marks topic.
Apostrophes are used for the following main purposes:
· To denote a missing letter in a contraction. However, contractions should be avoided, in general. If you do use a contraction, be sure to use it correctly. Examples of correct use:
it's for it is or it has.
A common error is to use it's to indicate possession. The correct possessive form is its:
Netcracker refers to Netcracker Corporation or any of its wholly owned subsidiaries.
· To denote possession for nouns:
· Denoting possession for a singular noun:
The computer's program – 1 computer, 1 program
Netcracker's database
· Denoting possession for a plural noun:
The computers' keyboards were all broken – lots of computers with lots of keyboards.
An apostrophe is never used to denote a plural. If you refer to a large quantity of CDs, do not add an apostrophe to say CD's.
[bookmark: scroll-bookmark-417]Bullets
Bullets are graphic devices that substitute for alpha-numeric designation of items in a list. In a bulleted list, the graphic device obviates normal grammatical punctuation.
1. In bulleted lists within text passages, the bullet is the punctuation. No other punctuation is required to separate listed items. Do not use commas or semicolons at the end of each item.
2. Capitalize the first word of a bulleted (or numbered list) and put a period at the end of the sentence.
3. Avoid mixing sentences and sentence fragments in a bulleted list.
4. All list items should have the same punctuation. That is, either all items have points at their ends, or none.
5. You should also use the bulleted list to emphasize the description for a separated procedure that contains only one step.
[bookmark: scroll-bookmark-418]Colon

	Guideline 1
Always put a colon (":") after a lead-in phrase followed by a numbered or bulleted list.



	Guideline 2
If the list is included in the sentence, do not use a colon



	Guideline 3
A colon should be followed by a single space, except when it precedes a bulleted or numbered list.



	Guideline 4
A sentence ending with colon can be followed only by list. Such sentence cannot be followed by paragraph, image, code block, figure, table, etc...
Exclusions are cases when a console text styled Preformatted follows the sentence, as well as syntax and code samples.


INCORRECT
[image: ]
CORRECT
[image: ]
CORRECT
All possible values of the Driven By parameter are listed in the table below.
	Value
	Description

	Value 1
	Description 1

	…
	…



	Guideline 5
If a colon precedes a bulleted or numbered list, each item in the list should begin with a capital letter, unless the native format of the first word is to have an initial lower-case letter, such as a file name or a parameter name. A colon can sometimes be used to introduce any series of three or more items in a sentence. In this case the colon is not followed by a capital letter.


CORRECT:
The most commonly used values of the Driven By parameter are:
· Value 1
· Value 2
· …
The most commonly used values of the Driven By parameter are "Value 1", "Value 2", and "Value 3".

[bookmark: scroll-bookmark-419]Commas and Periods
In all cross-references put commas and periods inside the quotation marks, as shown in this example:
… as described in "Exporting objects."
End each numbered action or step with a period if it is a complete sentence. Do not mix complete and incomplete sentences in a series of actions formatted as a numbered list.
[bookmark: scroll-bookmark-420]Commas in Enumerations
If there are more than two items in a list, they should be separated by commas. The last item is usually preceded with "and," "or," or "but" (these are called "conjunctions"). Always put a comma before the conjunction.
Examples:
1. The news will be shown after Dangermouse, and Rug Rats. (Without the comma, readers could think that "Dangermouse and Rug Rats" is one program.)
2. The emblem is an amalgamation of the British and Irish flags, the Stars and Stripes, and the Hammer and Sickle. (The word "and" appears multiple times in this example. The comma before the "and" makes it easier for the reader.)
3. I need to see DC Jones, PC Pinner, and PC Hoyles in my office immediately.
4. She went to the shops for eggs, milk, and butter.
[bookmark: scroll-bookmark-421]Commas in Introductions
It is common for a sentence to start with an introduction. An introduction can be anything from just one word to a long clause. In general, an introduction is used to state a time, place, condition, frequency or fact before the main part of the sentence. (Introductions vary greatly)
Examples:
1. In the center of London, the number of people who fell victim to pickpockets rose by 30 per cent in a month. (sets a place)
2. As soon as the cake is golden-brown, take it out of the oven. (sets a time)
3. Yesterday, the manager visited the stables. (sets a time)
4. On Tuesday, July 4th, a band played carols in the park for 8 hours. ("On Tuesday, July 4th" sets a time. It is an introduction and should be followed by a comma.)
5. Having spoken to John, I can confirm that the meeting is definitely off. (states a fact)
6. As you are well aware, the latest figures do not look promising. (states a fact)
7. After the secretary had read the minutes of the meeting, the chairman asked for the financial report.
Commas in Clauses
When two independent clauses are joined by a coordinate conjunction, (such as and, but, yet, or, and nor) separate the independent clauses by a comma.
Examples:
1. The public is eager for some legislation, but the congress is too timid to enact any effective measures.
2. Jack brought the food, and Jill brought the camping supplies.
A comma is not necessary if the introductory clause is short:
Example:
Select Yes and click OK.
When an independent clause or main clause is followed by a dependent clause, no comma is needed; however, if the independent clause follows the dependent clause, a comma is used to separate the two.
Examples:
1. I knew we would succeed although there were numerous hurdles in our path. (Independent clause is followed by a dependent clause.)
2. If it rains, we shall not be able to go to the movies. (Dependent clause is followed by an independent clause.)
When there is a nonrestrictive clause, commas are needed to set off the clause.
Example:
This option, which is the default, must be chosen.
When there is a restrictive clause, commas are not needed.
Example:
The option that is the default must be chosen.
Separate two independent clauses that are linked by a coordinating conjunction such as or, and, or but.
Commas to Separate Coordinate Adjectives
To determine whether the adjectives in a sentence are coordinate, two rules can be applied:
· Place the coordinate conjunction "and" or "but" between the adjectives.
· Reverse the order of the adjectives.
If the sentence still reads right, the adjectives are coordinate and take a comma between them.
Examples:
1. To get to the little old house, they had to travel over several narrow, winding, treacherous roads. (little old are non-coordinate adjectives; narrow, winding, treacherous are coordinate adjectives)
2. She often wore a grey wool shawl over a tattered blue dress. (Both sets of adjectives are non-coordinate)
3. The judges placed the trophy in the hands of the nervous, excited players. (coordinate adjectives)
Commas to Set off Parenthetical Elements
A parenthetical phrase is non-essential information in a sentence, which does not change the meaning of the sentence when removed. Be it an absolute phrase or an appositive, a parenthetical detracts from the flow of the main idea and distracts the reader. All parenthetical elements must be set off by commas.
Examples:
1. Robert Frost, perhaps America's most beloved poet, died at the age of 88.
2. Jane stayed up late, writing her report.
3. Frankly, what you choose to do with your life should not matter to anyone.
4. Margaret, his wife of thirty years, suddenly decided to open her own business.
Commas in Dates and Times
Use a comma to separate the date of the month from the year. Treating the year as a parenthetical, set it off by a pair of commas.
Examples:
1. July 4, 1776, is regarded as the birth date of American independence.
2. August 2013 was one of the most wet months in the history of the Indian monsoon. (month and year only; comma not required)
3. The conference is scheduled for 5 November 2014. (inverted date; comma not required)
4. It was on Monday, October 3, 2011, that we joined Netcracker.

More on Grammar and Commas

For a full understanding of how to use commas, it is helpful to be able to identify restrictive and non-restrictive modifiers. A modifier is any word, phrase, or clause that describes a noun, noun phrase, verb, verb phrase, or sometimes another modifier. For a discussion of restrictive and non-restrictive modifiers, only modifying phrases and clauses are at issue. (In the following sentence, the single word existing is an adjective, a modifier, but no one would consider putting commas before or after it:
You open an existing customer when you select the customer from the results of a customer search.

A modifier is restrictive when the information in the modifier is necessary to the meaning of the sentence. In this case, necessary is not the same as important; by "necessary," we mean that the sentence will lose essential meaning if the modifier is removed from the sentence. Restrictive modifiers are not set off with commas.

A modifier is non-restrictive when it can be dropped from the sentence without the loss of essential meaning. That is, if the modifier is removed, the reader can still identify the thing being modified. Non-restrictive modifiers are set off with commas.

The sentences below contain restrictive clauses or phrases. Example sentences are in regular font, with the relevant words in italic:

· This describes actions that can be started on the opening page.

The clause that can be started on the opening page is restrictive. If you removed it, the actions could not be identified. For that reason, it is not set off with a comma.

· The navigation bar menus will update to display the actions available for that entity.

The phrase available for that entity is restrictive. If you removed it, the actions could not be identified. For that reason, it is not set off with a comma.
Another way to help determine whether a modifying phrase or clause is restrictive or non-restrictive is to say the sentence aloud. If you do not naturally and comfortably pause between the modifier and the thing being modified, then the modifier is probably restrictive. Try the last example above:

· The navigation bar menus will update to display the actions available for that entity.

It is not likely that you paused after actions. The modifier is restrictive, and a comma should not be placed before it.

The sentence below contains a non-restrictive clause:

· This describes the Customer Hierarchy, which uses icons to represent existing customers, contacts, accounts, and products.

The which clause provides useful information, but the reader would be able to identify the Customer Hierarchy without it. The sentence therefore has a comma before which.
Now consider this sentence:

· Select the node for the customer that you want to modify.

In this sentence, "that you want to modify" is a restrictive modifier. It is not set off by commas. The restrictive clause is necessary information because it tells the reader which customer is being discussed.


[bookmark: scroll-bookmark-422]Dashes
The use of dashes in documentation should be kept to a minimum. Where a dash is required between words, use an en dash character (–) instead of a hyphen or an em dash character (—).
1. Use an en dash with no extra space before or after:

· To indicate continuing (or inclusive) numbers, dates, times, or reference numbers.
	1968–82
	but
	from 1968 to 1982 (never from 1968–82)

	May–June 1967
	
	from May to June 1967

	10 a.m.–5 p.m.
	
	between 10 a.m. and 5 p.m.

	pp. 38–45
	
	from pages 38 to 45



· In a compound adjective one element of which consists of two words or of a hyphenated word.
Examples:
New York–London flight
post–Civil War period
quasi-public–quasi-private judicial body
2. Use an em dash with no extra space before or after:
· To denote a sudden break in thought that causes an abrupt change in sentence structure.
Example: Consistency—that hobgoblin of little minds.
· In defining or enumerating complementary elements.
Example: The influence of three musicians—Mozart, Bach, and Beethoven—was of great importance in his development as a musician.
· In sentences having several elements as referents of a pronoun that is the subject of a final, summarizing clause.
Example: Smith, Jones, and McCoy—all felt groggy on humid days.


Do not use en dashes in number ranges and date ranges in regular text. Use the word through instead, for example, In lines 55 through 67…
Remember, however, that through, in the preceding sense, means "inclusive"; therefore, it may not be accurate in some references to number ranges, or when referring to percentages. In cases in which the number range is not intended to be inclusive, use between/and, as in:

Values between 1,000 and 2,000 are reserved exclusively for…. (meaning the values 1,001 through 1,999 only)

In cases in which a range of percentages is referred to, use the following form:

10 to 30 percent

For additional information on representing numbers in documentation, see the Numbers and Currency Amounts topic.

[bookmark: scroll-bookmark-423]Ellipses
The presence of ellipses (…) in FrameMaker documents poses problems when rendering a guide in an HTML format. Where an ellipsis is required within a sentence, three periods with no spaces between should be used. At the end of a sentence, four periods should be used, with no space following the last letter before the periods. When you use four periods, three are used as the ellipsis and the fourth functions as a period to indicate the end of the sentence. However, avoid this construction whenever possible.

Examples:
· Customer Service Management enables a short timeframe … resulting in a cost savings for your business.
· Click Details....
Note: Be careful when cutting and pasting text into a guide from a Microsoft Word document, since Microsoft Word can automatically translate three sequential periods into an ellipsis character. The ellipsis character may not copy properly into FrameMaker. In addition, if you add a fourth period, the spacing may not be correct. Use the Find/Change facility in FrameMaker to perform a Text search for \e and replace the imported periods with manually inserted periods.
[bookmark: scroll-bookmark-424]Hyphens

	Guideline 1
Do not split words and hyphenate across lines.



	Guideline 2
Capitalize the letter following the hyphen In titles and captions that include hyphenated (compound) words . For example, refer to Use of Plug-Ins in a heading but use of plug-ins in text.



	Guideline 3
Do not use hyphens for words like "IP address," "IP range," and similar phrases.



	Guideline 4
Say "drop-down list box," not "dropdown."


For general guidelines on hyphenation and capitalization of terminology, refer to the Preferred Terms and Treatments topic. You may also want to refer to the Microsoft Manual of Style for Technical Publications, "Hyphens, Hyphenation," page 177, or an English language dictionary.
For information about using hypens in common tems, see Hyphens and Spaces in Terms.

[bookmark: scroll-bookmark-426]Nonbreaking Hyphens and Spaces
Nonbreaking hyphens and nonbreaking spaces should not be used in the headings or titles of documents, because they can affect the formatting of the PDF bookmarks. See the Date, Time, and Measurement Formats topic and the Preferred Terms and Treatments topic for more information on when you can use a nonbreaking space.
[bookmark: scroll-bookmark-425]Hyphens and Spaces in Terms
This list provides standards for the way that hyphenation and spacing between words should be implemented in commonly-used terms. In cases where a term is not listed, your judgment should be based on the treatment of similar terms in the list.
	Acceptable
	Unacceptable
	Comments

	account-specific
	account specific
	Adjective, as in an account-specific discount, or as in The discount is account-specific.

	back-end back end
	-
	Back-end is the adjective form that precedes a noun, as in a back-end database. Otherwise, use back end, as in the back end or at the back end.

	back-office back office
	-
	Back-office is the adjective form, used immediately preceding a noun, as in back-office functions. Otherwise, use back office, as in The functions are managed in the back office.

	back up backup
	-
	Back up is the verb form. Backup is the noun or adjective form.

	bidirectional
	bi-directional
	-

	break out breakout
	-
	Break out is the verb form. Breakout is the noun or adjective form.

	build up buildup
	-
	Build up is the verb form. Buildup is the noun or adjective form.

	carryover
	carry over carry-over
	Carry over can be used as a verb.

	chargeback
	charge back
	-

	check box
	checkbox check-box
	-

	class loader
	classloader class-loader
	Adjective, as in class loader architecture.

	class name
	classname
	-

	class path
	classpath
	-

	clearinghouse
	clearing house
	-

	color-coded
	color coded
	Adjectival use.

	comma-delimited comma delimited
	comma-separated comma separated
	Comma-delimited is the adjective form that precedes a noun, as in a comma-delimited file. Otherwise, use comma delimited, as in The file is comma delimited.

	cross-reference cross-refer
	cross reference cross refer
	-

	cutouts
	cut outs
	Noun form

	data field data file data store data source
	datafield datafile datastore datasource
	But database and datatype.

	database datatype
	data base data type
	-

	dial-up
	dial up
	Adjective form

	direct-dialed direct dialed
	-
	Direct-dialed is the adjective form that precedes a noun, as in a direct-dialed call. Otherwise, use direct dialed, as in The call is direct dialed.

	double-click
	double click
	-

	drop-down list
	drop down list
	Must include list. Wording such as select from a drop-down is unacceptable.

	e-mail
	email
	Use lowercase e, except where conventional grammatical rules apply.

	end user
	end-user
	-

	event-generating event generating
	-
	Event-generating is the adjective form that precedes a noun, as in an event-generating product. Otherwise, use event generating, as in The product is event generating.

	fail over
	failover
	Fail over is the verb form. Failover is the noun form.

	field name
	fieldname
	-

	file-based
	file based
	Adjective form.

	file name
	filename
	-

	firewall
	fire wall
	-

	first-in, first-out
	first in, first out FIFO
	Do not use the acronym FIFO.

	follow up follow-up
	-
	Follow-up is the adjective form that precedes a noun, as in a follow-up review. Otherwise, use follow up as the noun or verb form.

	front-end front end
	-
	Front-end is the adjective form that precedes a noun, as in a front-end interface. Otherwise, use front end, as in the front end of the interface or at the front end.

	high-availability high availability
	-
	High-availability is the adjective form that precedes a noun, as in a high-availability system. Otherwise, use high availability, as in a system that offers high availability.

	host name
	hostname
	-

	in advance in-advance in arrears in-arrears
	-
	In-advance and in-arrears are the adjective forms that precede a noun, for example, an in-advance payment. However, avoid this construction whenever possible; that is, use a payment made in advance. In advance and in arrears should normally be used.

	interprocess
	interprocess inter process
	-

	interoperable
	inter-operable
	-

	left
	left-hand left hand
	Refer to the left column, rather than the left-hand column.

	lifecycle
	life cycle life-cycle
	-

	lockbox
	lock box
	-

	login log in
	-
	Login is the noun or adjective form as in your login ID or enter your login. Log in is the verb, as in Log in to a user application.

	logoff log off logon log on
	-
	Log off/log on is the verb form. Logoff/logon is the noun or adjective form.

	look up lookup
	-
	Look up is the verb form. Lookup is the noun form, as in an address validation lookup.

	lowercase
	lower case lower-case
	-

	menu bar
	menubar menu-bar
	-

	metadata
	meta data meta-data
	-

	middle-tier middle tier
	-
	Middle-tier is the adjective form that precedes a noun, as in a middle-tier plug-in. Otherwise, use middle tier, as in The system has a middle tier.

	multixxxx
	multi-xxxx
	As in multiparty, multibyte.

	namespace
	name space
	-

	nonxxxxx non-xxxxx
	-
	Non should generally be used as a closed prefix (that is, nonxxxxx). A hyphen should be included only if it is needed to avoid confusion, if it is followed by a proper noun (as in non-Euclidean), or if the second element is more than one word (as in non-file-based).

	off-net
	off net
	Lowercase unless referring to a window element, as in the Off-Net check box.

	off-peak
	off peak
	Adjective, as in off-peak call,or The call is off-peak.

	off-site
	off site
	Adjective, as in an off-site meeting,or The meeting is off-site.

	offline
	off line off-line
	As in working offline.

	one-time
	one time
	As in one-time charges. Note that the hyphen is absent in UIs ("one time").

	on-net
	on net
	Lowercase unless referring to a window element, as in the On-Net check box.

	on-screen on screen
	-
	On-screen is the adjective form that precedes a noun, as in an on-screen event. Otherwise, use on screen, as in The event is on screen.

	on-site
	on site
	Adjective, as in an on-site meeting, or The meeting is on-site.

	online
	on line on-line
	As in working online.

	operator-connected
	operator connected
	Adjective form.

	outcollects
	out collects out-collects
	-

	parent/child
	parent-child
	Adjective, as in parent/child relationship.

	path
	pathname path name
	-

	pay-per-view
	pay per view
	-

	pay TV
	pay-TV
	-

	percent
	per cent % per-cent
	Use the % symbol only in tables or where space is an issue. Always use a nonbreaking space before percent.

	plug in plug-in
	plugin
	Plug in is the verb form. Plug-in is the noun or adjective form, as in plug-in interface (formerly plug point).

	pop-up
	popup pop up
	Adjective, as in pop-up menu, or pop-up window.

	port in/out ported-in/out
	port-in/out
	Port in/out is the verb form. Ported-in/out is the adjective form.

	post-installation
	post installation
	-

	post-itemization
	post itemization
	-

	postpaid
	post-paid post-pay
	As in a postpaid account.

	pre-xxxxx prexxxxx
	-
	This prefix does not follow a standard rule for hyphenation. When in doubt, consult a dictionary or the editor. As in Oracle pre-compiler, convergent pre-pay, pre-installation. Note the specific instances that follow.

	preconfiguration
	pre-configuration
	As in preconfiguration data. Preferably, use a more specific alternative as appropriate (such as implementation, installation, configuration).

	predefined
	pre-defined
	-

	prepaid
	pre-paid pre-pay
	As in a prepaid account. But note convergent pre-pay.

	preprocess
	pre-process
	-

	prequalify prequalification
	pre-qualify pre-qualification
	-

	prerelease
	pre-release
	-

	prerequisite
	pre-requisite
	-

	prework
	pre-work
	-

	pro rata
	prorata pro-rata
	-

	prorated
	pro-rated pro rated
	-

	rexxxxxx
	re-xxxxxx
	As in rerate, reassignment. Note the following exceptions: re-create, re-processed, re-transmission.

	read-only
	read only view only view-only
	-

	real-time
	real time
	Use real-time as an adjective (for example, real-time environment). Use real time as an adverb.(for example, processed in real time)

	right-click
	right click
	-

	right
	right-hand right hand
	Refer to the right column, rather than the right-hand column.

	roll back rollback
	-
	Roll back is the verb form. Rollback is the noun or adjective form.

	run-time run time
	runtime
	Run-time is the adjective form. Run time is the noun form, as in at run time.

	script-based
	script based
	Adjective form, as in a script-based command, or The command is script-based.

	service provider billing
	service-provider billing
	-

	set up setup
	set-up
	Set up is the verb form. Setup is the noun or adjective form. However, phrasal verbs should be avoided, so use configure or assemble rather than the verb form, set up.

	shut down shut-down
	shutdown
	

	stack trace
	stacktrace
	-

	standalone
	stand alone stand-alone
	-

	standby
	stand by stand-by
	-

	start up start-up startup
	-
	Start up is the verb form, as in start up the system. Start-up is the adjectival form, as in an Internet start-up company. Startup is the the noun form, as in system startup.

	style sheet
	stylesheet
	-

	subxxxxxx
	sub-xxxxxxx sub xxxxxx
	As in subdivide, subdivision, subtab. Exceptions: Include a hyphen if the second part is a proper noun (as in sub-Saharan), or begins with a capital letter (as in sub-ID).

	subject matter expert
	subject-matter expert
	-

	system-generated
	system generated
	Adjective, as in a system-generated value, or The value is system-generated.

	tablespace
	table space
	-

	tax-exempt tax-exclusive tax-inclusive tax exempt tax exclusive tax inclusive
	-
	Tax-exempt (etc.) is the adjective form, used immediately preceding a noun, as in a tax-exempt product. Otherwise, use tax exempt (etc.), as in The product is tax exempt.

	third-party third party
	-
	Third-party is the adjective form, used immediately preceding a noun, as in a third-party agreement. Otherwise, use third party, as in the customer is the third party.

	time frame
	timeframe
	-

	time out timeout
	time-out
	Time out is the verb form. Timeout is the noun or adjective form.

	toolbar
	tool bar tool-bar
	-

	top level top-level
	-
	Top-level is the adjective form, used immediately preceding a noun, as in top-level architecture. Otherwise, use top level, as in at the top level.

	troubleshoot
	trouble shoot trouble-shoot
	-

	two-phase-commit protocol
	-
	Also referred to as 2PC.

	UNIX-based
	UNIX based
	-

	uppercase
	upper case upper-case
	-

	user-configurable user configurable
	-
	User-configurable is the adjective form, used immediately preceding a noun, as in a user-configurable product. Otherwise, use user configurable, as in The product is user configurable.

	user name username
	-
	User name is preferable, but use username if it matches system use.

	voicemail
	voice mail voice-mail
	-

	voiceover
	voice over voice-over
	-

	Web page/site
	Webpage/site Web-page/site
	Note the uppercase W.

	Windows-based
	Windows based
	-

	workflow
	work flow work-flow
	-

	workforce
	work force work-force
	-

	workgroup
	work group work-group
	-

	worldwide
	world wide world-wide
	-

	write off write-off
	-
	Write off is the verb form. Write-off is the noun or adjective form.

	ZIP code
	zipcode zip code
	-



	


[bookmark: scroll-bookmark-427]Parentheses and Brackets
The following rules relate to parentheses and brackets:
Use parentheses with numbers or characters to clarify meaning where appropriate. For example:
· 0 (zero)
· T (true)
Use a nonbreaking space between the numeral or letter and the parenthesis.
Parentheses are acceptable if needed to enclose letters, as in this example:
This determines the charge segment(s) into which the event falls.
	
	

	Note:
	The use of (s) should be avoided where possible. However, if you must use (s) to indicate one or more, use a plural verb, for example, The window(s) open.

	
	


In addition, in lengthier sentences that cannot be shortened and already contain commas, parentheses can be used to set off an interruption. Using parentheses in such cases helps to break the sentence into more manageable phrases, or "chunks," for example:
The missing discount revenue results in a difference between the revenue total (reported in the BILLDETAILS table) and the invoice total (reported in the BILLSUMMARY table).
Use square brackets inside parentheses to set off a further parenthetical item. For example:
(This should be set to T [true].)
Unless what is contained within parentheses is a complete sentence, a period should typically be placed outside the ending parenthesis. For example:
Please ensure that you understand these figures (from the recent survey).
Please ensure that you understand these figures. (They are from a recent survey.)
The latter form, with a complete sentence contained within parentheses, should be avoided.
[bookmark: scroll-bookmark-428]Periods in Abbreviations and Acronyms
The following rules relate to periods in abbreviations:
· Where abbreviations are used, a period is required after all abbreviations, regardless of whether the final letter of the abbreviation is the same as the final letter of the abbreviated word. For example:
St. for Street, Rd. for Road, Co. for Company, and Inc. for Incorporated all require periods.
· Avoid the abbreviation etc. in favor of "and so on."
· The abbreviations e.g. and i.e. should not be used, except in tables or diagrams, where space is at a premium. Otherwise the terms for example and that is, respectively, should be used. If used, the abbreviations e.g. and i.e. should both contain two periods and should be followed by a comma.
· Periods should not be included in acronyms, with the following exceptions:
· Abbreviations for countries (for example, U.S. and U.K.)
· A.M. and P.M.
Acronyms of industry standard terms do not require periods, however. For example:
· HTTP
· WWW
For more examples of industry standard acronyms, see the Preferred Terms and Treatments topic. For more guidelines about periods, see the Commas and Periods topic.
[bookmark: scroll-bookmark-406]Quotation Marks

	Common Rule for Quotes
Limit quotation marks to the traditional usage:
· Quoted speech
· Numbers, letters, or words referred to as such
· Section titles
Quotation marks are often mistakenly used as emphasis techniques in technical text. Quotation marks, like capital letters, tend to create a busy, distracting text and therefore should be avoided.



	Guideline 1
Use double quotes for drop-down list values.


Correct
From the Bandwidth drop-down list box, select "100 Megabit."
Incorrect
From the Bandwidth drop-down list box, select 100 Megabit.


	Guideline 2
Use double quotes when the object is displayed as link and you use the word "click" to ask the user to click it.


Correct
Click "DHL Inventory Project."
Click CLLI "site A". (note that CLLI is a variable here)
On the navigation path string, click "Circuits."
Incorrect
Click DHL Inventory Project. Click the DHL Inventory project.
Click CLLI site A.
On the navigation path string click Circuits.



	Guideline 3 - Exceptions
1. Use double quotes when you refer to an object name and it has lowercase words in it.
Do not capitalize the lowercase word.
2. Use double quotes when you refer to an object name and it has a period (.) in it.



Correct
The "Users: Named users" report produces a snapshot of all current users of the system.
Navigate to Inventory > DHL Inventory Project > CLLI "My site" and review the site racks configuration. (note that CLLI is a variable here)
Incorrect
The Users: Named users report produces snapshot of all current users of the system. The Users: Named Users report produces snapshot of all current users of the system.
Navigate to Inventory > DHL Inventory Project > CLLI My site and review site racks configuration.
Correct
If the list of rules is empty, check that you have the "Correlation Engine. Basic Inventory Rules" product component installed.
Incorrect
If the list of rules is empty, check that you have Correlation Engine. Basic Inventory Rules product component installed.



	Guideline 4
Do not use quotes for:
· Text entered in edit boxes. Use code style.
· Parameter field
· Navigation path string
· Statuses, for example ...a Deleted status...
· Report names
· Task names or activity names. Initial caps suffice.
· Business operations
· Database tables. Use the TABLE_NAME approach, all caps.
· Database table columns or fields. Use the TABLE_NAME.COLUMN approach.
· Templates, for example ...and SDH Multiplex Section template...
· Technological template types. Just use normal capitalization for the technology, for example ...an Hybrid-Fiber Coaxial circuit template... or ...POP site template...
· Document titles. Just italicize them.
· Role name. Use initial caps.
· Page names, except when the last word is not capitilized. Use capitalization exactly as it is on the screen.
· Product component names
· Section (in widgets) names
· Configuration names, as in ...Main Synchronization Flow configuration...
· Folder names, as in ...Start Configurations folder...
Use the cap style on the screen for all of the above, where applicable.


If a parameter name is a system name, like acctCustomerNum, then it should appear exactly as it appears in the system and without quotes. If it is displayed on a screen as Customer Account Number, then that takes precedence over the system table name.
	Correct
	Incorrect

	Fill in the Customer Account parameter value.
	Fill in the "Customer Account" parameter value.


	You cannot delete a device in Installed status.
	You cannot delete a device in the "Installed" status.

	Device status changes to Planned.
	Device status changes to "Planned."

	The acctCustomerName parameter is filled out automatically.
	The "acctCustomerName" parameter is filled in automatically.

	In Netcracker Sales Force Automation User Guide you will find ...
	In the "Netcracker Sales Force Automation User Guide" you will find...

	Adding the SetProcessRelation business operation.
	Adding the "SetProcessRelation" business operation.

	The system applies the XPath expression specified in the workflow.event_start.template.xpath key of the NC_DIRECTORY table.
	The system applies the XPath expression specified in the workflow.event_start.template.xpath key of the “nc_directory” table.

	The value of this parameter is compared with the values in the NC_WFRELATIONS.TYPE table column to identify the processes for which the received event is meant.
	The value of this parameter is compared with the values in the "TYPE" column of the NC_WFRELATIONS table to identify the processes for which the received event is meant.

	If this command is unavailable, vefiry that you are logged on under the Sales Engineer role.
	If this command is unavailable, vefiry that you are logged on under the "Sales Engineer" role.



	Guideline 5
Do not use quotes when you use the words open, navigate, or select the check box to the left of.


Correct
Open the DHL Inventory project. (note lowercase project)
Navigate to Inventory > DHL Inventory Project > CLLI "My site" and review the site racks configuration.
Select the check box to the left of DHL Inventory Project and click Edit on the toolbar.
Incorrect
Open the "DHL Inventory Project."
Navigate to "Inventory > DHL Inventory Project > CLLI My site" and review site racks configuration.
Select the check box to the left of "DHL Inventory Project" and click Edit on the toolbar.



	Guideline 6
Do not use quotation marks for Java properties, classes, beans, and so on. It is obvious they are not normal words, so there is no chance of confusion to the reader.


Correct
To activate this functionality, the Netcracker.workflow.event_dispatchers property in the NC_DIRECTORY table should provide classes (separated by a semicolon) that are used to dispatch incoming events.
By default, the com.Netcracker.ejb.wf.engine.framework.DefaultEventDispatcher class is specified.
Incorrect
For activating this functionality, the “Netcracker.workflow.event_dispatchers” property in the NC_DIRECTORY table should provide classes (separated by a semicolon) that are used to dispatch incoming events.
By default, the "com.Netcracker.ejb.wf.engine.framework.DefaultEventDispatcher" class is specified.


	Guideline 7
In TOMS documentation, use only straight quotation marks ("). In Rating and Billing Manager and ICOMS documentation, quotation marks should be double, "smart" (curved) quotes in all cases.


	
	

	Note:
	FrameMaker templates automatically use smart quotes. A good practice is to double-check any information imported into FrameMaker to determine whether the smart quotes in the imported content have been retained. (You can see smart quotes in FrameMaker by increasing the zoom to 140 percent.)

	
	



	Guideline 8
Do not use single quotation marks ('), except when they are used inside double quotation marks.



	Guideline 9
Always put the following comma or period inside the quotation marks, except when the quotes delimit an exact value or a value that is to be entered manually. in the latter case, the punctuation inside the quotation marks can confuse the user. Semicolons and colons should always be placed outside the ending quotation mark. Placement of quotation marks with question marks and exclamation marks depends on the sentence structure. Place the question mark or exclamation mark inside the quotation mark if the question or exclamation is part of the quotation, and place them outside if the question or exclamation is not part of the quotation.


Incorrect
See also "Capitalization".

Follow these steps, as referenced in Chapter 2, "Languages:"

Correct
See also "Capitalization."
Follow these steps, as referenced in Chapter 2, "Languages":

	
	

	Note:
	For chapter and section titles, using quotation marks is necessary. However, for word emphasis and titles of documents, use italics.

	
	







[bookmark: scroll-bookmark-429]Semicolons
Use a semicolon, not a comma, to separate independent clauses that are linked by a conjunctive adverb, such as however, therefore, otherwise, besides, or consequently.
Example:
Normally you should reconfigure before beginning this process; however, in the following example it is essential to wait before reconfiguring.
However, consider splitting these types of sentences into two or more sentences whenever possible.
Example:
Normally you should reconfigure before beginning this process. However, in the following example it is essential to wait before reconfiguring.
[bookmark: scroll-bookmark-430]Slashes
Avoid using slashes in sentences or headings as much as possible.
Do not use slashes to express the conjunctions “or” or “and/or”.
Do not use spaces on either side of a slash.
Examples:
· Billing Engine/Dunning Letter Engine
· Customer bill/statement
[bookmark: scroll-bookmark-431]Symbols
Instead of using a checkmark (a tick) or an X (a cross) in a table to indicate compatibility, use Y for yes or N for no. Use Y and N because the tick and cross symbols ( [image: ] and [image: ] ) increase the size of files a great deal. When you use Y and N in table cells, you should populate all cells with either a Y or an N. No cells should be left blank.
[bookmark: scroll-bookmark-47]Table Punctuation

	Guideline 1
All entries in one column should have the same punctuation.
If the text inside a cell is a complete sentence (has a subject and a predicate), or contains commas or other punctuation marks, it should be followed by a period.
If there are several sentences in one cell, then definitely use periods for each of them, including the last.


Correct
	Period or no period
	This is a complete sentence, and it has a comma inside, so put the period.

	No question
	This cell has two sentences inside. Put the period.

	Short phrase
	Short phrase.

	Note above
	In the cell above there is only a short phrase, but it is necessary to put a period, as there are cells with periods in this column.

	No sentences here
	Note the left column. It contains only short phrases and no sentences. Therefore, there are no periods.


Incorrect
	Period or no period
	Note the left column. It contains different punctuation, which is incorrect. And this cell contains three sentences, so it should end with a period, but it doesn't

	No question.
	In the left cell, the period is unnecessary.



	Guideline 2
Instead of using a checkmark (a tick) or an X (a cross) in a table to indicate compatibility, use Y for yes or N for no. Use Y and N because the tick and cross symbols ( [image: ] and [image: ] ) increase the size of files a great deal. When you use Y and N in table cells, you should populate all cells with either a Y or an N. No cells should be left blank.


[bookmark: scroll-bookmark-432]Interactive HTML Documents
[bookmark: scroll-bookmark-433]Color Standards
Many of the Netcracker interactives use the same colors.

The correct RGB color code for producing the Netcracker blue is: 0, 121, 194. The hexadecimal number for the Netcracker blue is: #0079C2.
[bookmark: scroll-bookmark-434]Online Help: RBM and CM
The guidelines contained herein are specific to the Rating and Billing Manager and Collections Manager Help formats but should be applied alongside the style guidelines set out for user documentation.
These guidelines should be used by:
· Information developers
· Information editors
· Anyone else involved in creating or updating Help versions of product documentation
Note: The TOMS documentation uses the same raw content to generate both PDF and HTML versions of the user documentation. Therefore, there are no separate style guidelines for the online version.
Product Documentation Help Style Guide
Document Version 10
QMS-ST-0401DRAFT
[bookmark: scroll-bookmark-435]Change Control
Some method of marking changes in the Help files is required, both for review purposes and for localization. RoboHelp does not provide any automated method to do this. Therefore, new and changed text must be rendered in red.

To indicate changes in text:
1. Do one of the following:

· Click where you want to begin typing.
· Highlight the text you have just changed or added.

1. Click the down arrow next to the Font Color icon in the toolbar, and select Red from the color palette.
2. Once you have finished updating the Help file, add the enhancement number to the htm topic file name (for example, XXXX_new_topic.htm), save the file, and check it in to SVN. It is now ready to be sent for technical review or editor check, with all changed text marked in red.
	
	

	Note:
	You do not need to mark text in a completely new Help file in red. Since the file is new, it is accepted that the contents of the Help file will be too.

	
	


3. After any changes from the technical review and editor check have been entered (and the red text has been applied if necessary), zip the files up and check them in to the source directory in SVN. Ensure that a version of the compiled Help file, with red text displayed, is included for localization.
4. Prior to release, change all red back to the default style (black) and remove the enhancement number from the topic name.
	
	

	Note:
	Help must note be released with any red change text visible.

	
	


[bookmark: scroll-bookmark-436]Cross-References and Other Links
References within a Help file can take one of three forms:
· An external cross-reference, when referring to other guides or Help files within the Netcracker documentation set
· A see also link, when referring to other related topics within a Help file
· A hyperlink, when referring to procedural topics within a Help file
This section details the guidelines that should be followed when using any of these links.
[bookmark: scroll-bookmark-437]External Cross-References
If you want to refer to a different document, give its full title, including the type of document, and apply the externalXref character style.
For example:

For more information, refer to Rating and Billing Manager Tax Concepts.
[bookmark: scroll-bookmark-438]Other Hyperlinks
You can create internal links using the text itself (hyperlinks) to other Help topics. The most common scenario is to create a hyperlink that links to a page containing details of the fields in a dialog. For example:
The Attributes for Product dialog is displayed, containing details about the selected product.
	
	

	Note:
	The word dialog should also be included in the hypertext link.

	
	


You can also use text links to open topics for more information. For example:

See Changing the General Batch Information for details on how to proceed if you do not want to use this checking mechanism.
See Use of See Also Links for instructions on creating internal links.
[bookmark: scroll-bookmark-439]General Rules for Hyperlinks
Note the following rules regarding hyperlinks:
· Links should not be used within secondary topics, except under exceptional and justifiable circumstances.
· A-links should not be used.
[bookmark: scroll-bookmark-440]See-Also Links
Where appropriate, a See Also heading (in 10-point Arial bold) may appear at the foot of topics. This should provide one or more links to any other relevant topics in the Help project.
	
	

	Note:
	There should be one paragraph return (<p> in the HTML code) between:



· The last line of text and the See Also heading.
· The last See Also link and the copyright statement.
	
	


[bookmark: scroll-bookmark-441]General Rules for See-Also Lists
Note the following rules regarding See Also lists:
· The See Also link should be used to provide links to relevant topics. They may be used to link topics in the same section, but only where relevant. The browse sequence is there to link all topics within a section.
· Related Topics buttons should not be used.
· A-links should not be used.
[bookmark: scroll-bookmark-442]General Guidelines
The guidelines and rules regarding spelling, punctuation, case, hyphens, and other usage are as described elsewhere in this style guide under User Documentation..
[bookmark: scroll-bookmark-443]Copyright Statements in Help Files
All Rating and Billing Manager and Collections Manager Help files are required to display an abbreviated copyright statement in three separate locations:
· A visible abbreviated statement at the bottom of every topic in the Help file
· An abbreviated copyright statement in the meta tags at the top of the HTML source code
· An abbreviated copyright statement in a comment at the bottom of the HTML source code
Furthermore, every Help file should include a Legal Statement topic detailing complete Netcracker copyright information.
[bookmark: scroll-bookmark-444]Copyright Comment in HTML Code
To fulfill the legal requirement to place a copyright statement at the foot of the HTML source code, each Rating and Billing Manager and Collections Manager Help file should include a copyright statement in a comment below the final </HTML> tag in the HTML source code.
The following format must be used to insert the Netcracker copyright message at the bottom of the HTML source code:
<!-- Copyright © 1999-<year of release> Netcracker. All rights reserved. Confidential and Proprietary -->
[bookmark: scroll-bookmark-445]Meta Tag Copyright for HTML Code
To fulfill the requirement to place a copyright statement at the top of the HTML source code, each Rating and Billing Manager and Collections Manager Help file should use a meta tag.
The following meta tag must be used to insert the Netcracker copyright message at the top of the HTML source document:
<meta name=copyright value="Copyright © 1999-<current year> Netcracker. All rights reserved. Confidential and Proprietary">
[bookmark: scroll-bookmark-446]Visible Copyright Statements
An abbreviated on-screen copyright statement should appear once in each topic, as the final wording on the page. The text should be aligned to the right and should use the character style Copyright to set the font face (Arial) and font size (8 point).
The abbreviated Netcracker copyright information should use the following format:
Copyright © -<year of release> Netcracker. All rights reserved.Confidential and Proprietary
For Rating and Billing Manager, the date range must always be 1999 through to the year of the Help file's release, and the statement is aligned to the right, using the Copyright style. One line space should separate the copyright statement from the preceding text.
The following example illustrates the on-screen appearance of the abbreviated Netcracker copyright statement:
[image: ]
	
	

	Note:
	A soft return is inserted after reserved in the first line of the copyright, and not a paragraph return. Therefore, the HTML tag <br> must be used in preference to <p>.

	
	


[bookmark: scroll-bookmark-447]Identifying Tax-Specific Fields
The appearance of certain tabs, dialogs, and fields may depend on the tax model that the operator is using. Note that this is specific to Rating and Billing Manager. To avoid confusion, these fields must be clearly identified in text, with each field name labeled according to the tax model in which it will appear.
Where this is the case, the name of the tax-specific field should be followed by an abbreviation in parentheses that identifies the relevant taxation model or models, and provides a link to the Geographical Differences topic. This topic must be included in the Overview book of a Help file only if it accompanies a user interface in which tax-specific fields appear.
Rating and Billing Manager currently provides support for the following taxation models:
· Value Added Tax and Goods and Service Tax (VAT/GST)
· U.S. tax (UST)
· Brazil tax (BRT)
The abbreviation VAT/GST, UST, or BRT should appear in Bold and as a hypertext link after each field that it applies to. For example, to highlight a field that appears only in a system configured for the VAT/GST taxation model, the following format would be used:
Contracted point of supply (VAT/GST)
The customer's contracted point of supply. Select an item from the drop-down list.
If a field is relevant to more than one taxation model, the following format should be used:

Invoice (UST and BRT)

The invoice to which the dispute relates. This field is mandatory.

Fields that are visible in all taxation models do not need to be identified.
[bookmark: scroll-bookmark-448]Splash Page
Each Rating and Billing Manager and Collections Manager Help project should include a splash page, which will be the first page displayed when the Help file is opened. This page includes two graphics, the component name, a copyright statement, and the Help file's release and issue numbers.
[bookmark: scroll-bookmark-449]Help Styles

The styles used in Rating and Billing Manager and Collections Manager Help files should be consistent with the styles used in the main documentation. For more information regarding these styles, refer to the style guidelines in User Documentation.
All the styles that you should ever need are in the relevant cascading style sheet file. For all Rating and Billing Manager and Collections Manager Help files, this is the infinys_41h.css file.
[bookmark: scroll-bookmark-450]Character Styles in Help Files
Character styles should be used to highlight particular words or phrases in the text. The character styles available are as follows:
	Component
	General style to be used when referring to the names of system elements such as tabs, buttons, drop-down lists, menus, option buttons, and so on.

	Bold
	General style used when referring to file names, directory names, and so on.


[bookmark: scroll-bookmark-451]General Text in Help Files
The Body style should be used as the default style. This is 10-point Arial.
[bookmark: scroll-bookmark-452]Bold in Help Files
The Bold style should be used when referring to directory names, file names, file suffixes, and parameters.
[bookmark: scroll-bookmark-453]Emphasis in Help Files
The Emphasis style should be used where terms or phrases in text require additional emphasis. It should also be used to identify a cross-reference to a document that is not part of the Netcracker documentation set.
[bookmark: scroll-bookmark-454]External Cross-References in Help Files
The externalXRef style should be used when referring to other documents that are part of the Netcracker documentation set. Where external references appear in a Help file, note that the references themselves do not form links to the relevant documentation, and, consequently, are not in blue text. However, you should use the externalXRef style in preference to the emphasis style when formatting external cross-references.
[bookmark: scroll-bookmark-455]Hanging Text in Help Files
When describing features such as dialog fields and columns in tabs, the Hanging style can be used for the name of the label, and the Indent style for the body of the text, for example:
Label
Description of the label, description of the label, description of the label…
[bookmark: scroll-bookmark-456]Headings in Help Files
Headings should have the following styles:
	Heading 1
	
	The topic title. This is 14-point, dark blue, Arial bold.
	

	Heading 2
	
	For subheadings within topics. This is 12-point, black, Arial bold.
Note: Topics should be kept as concise and relevant as possible. The use of subheadings should be kept to a minimum.
	

	
	
	
	

	
	
	
	

	
	
	
	


[bookmark: scroll-bookmark-457]Lists in Help Files
The StepIntro style should be used to introduce a series of instructions. For example:
To create an <item>:
[bookmark: scroll-bookmark-458]Numbered and Bulleted List Styles
For first-level indents, use the following:
	List
	Used for two or more numbered instructions. Also used for lists where ordering is implied (for example, if items further down a list occur later or are in order of importance).

	Bullet
	Used as a general bulleted list style and for procedures having only one step.
Note: Bullet points do not imply any logical progression between the points listed but should be used to allow relevant points to be grouped (for example, when breaking up points in a paragraph into a list).

	List-Continue
	Used wherever additional explanation is required for a list entry or bullet entry or an example needs to be provided.
List-Continue is indented correctly for use with both numbered and bulleted lists.


For listing additional points within a list, use the following:
	Bullet-Indented
	Bulleted list indented one step, using hollow bullet points. This style should be used to create a bulleted list within a bulleted list.

	Bullet-Normal-Indented
	Standard bulleted list indented one step. This style should be used to create a bulleted list within a section of indented text.


[bookmark: scroll-bookmark-459]Example
1. List
List-Continue
· Bullet
List-Continue
· Bullet-Indented
· Bullet-Normal-Indented
The Netcracker Product Documentation SharePoint (https://sps3.netcracker.com/sites/proddoc/default.aspx) includes template topics with fully formatted lists that you can import into your project and base new topics on.
[bookmark: scroll-bookmark-460]On-Screen Text and Structures in Help
In some places, examples of text that can either be input to the system or output from it must be provided (these examples should be kept as brief as possible). Two styles can be used:
	computer-text-p
	A paragraph style, used to highlight an entire line of text.

	computer-text-c
	A character style, used to highlight individual words or phrases.


Both styles appear in the Andale Mono font.
[bookmark: scroll-bookmark-461]Notes in Help Files
Additional information may be presented in a topic in the form of a note. Where notes are added, the information should be kept concise and relevant. Notes should be included only as a last resort, since too many notes could undermine confidence in the interface and confuse the operator. Two consecutive notes must not appear in the same topic.

To create a note in a Help topic in RoboHelp:
1. Open the topic in RoboHelp.
2. Click the WYSIWYG tab, and highlight the location where the note will appear.
3. Click the TrueCode tab, and paste the following code into the HTML:
<table class=noteTable width=100%> <tr> <td class=noteTableHeader>Note:</td> <td class=noteTableText>
Note Text Here
</td></tr> </table>
1. Click the WYSIWIG tab. The new Note table appears in the correct location in the topic.
2. Insert the text of the note over the Note Text Here label.
	
	

	Note:
	Unlike standard core documentation, only one note type is available in Help. An information, warning, or critical graphic does not appear alongside a Help note.
Also, notes should not appear in the middle of a numbered or bulleted list. If a note is required, you should insert it above or below the list, revising your note text as necessary.

	
	


[bookmark: scroll-bookmark-462]Tables in Help Files
Provision is made for the use of tables in Help. However, tables should be used sparingly. Tables are useful if you are aligning text into columns, for example, and where that is the case, the infoTableHeader and infoTableText styles should be employed as follows::
	infoTableHeader
	For the table heading and, if a matrix is being used, for the initial column.

	infoTableText
	The main style to be used within the body of a table.


To create a standard table in a Help topic in RoboHelp:
1. Open the topic in RoboHelp.
2. Click the WYSIWYG tab, and highlight the location where the table is to appear.
3. Click the TrueCode tab, and paste the following code into the HTML:
<table class=infoTablewidth=80%><tr>
<td class=infoTableHeader>Heading Column 1</td><td class=infoTableHeader>Heading Column 2</td></tr>
<tr>
<td class=infoTableText>Text Here</td><td class=infoTableText>Text Here</td>
</tr></table>
1. Click the WYSIWIG tab. The new information table should appear in the correct location in the topic.
To resize a column/table width:
· Both table and column widths can be set in the WYSIWYG tab. Drag and drop the cell or table border to the required width.

	
	

	Note:
	The left margin cannot be moved.

	
	


To add rows to tables:
· Insert the following code for each new row:
<tr>
<td class=infoTableText>New row text</td><td class=infoTableText>New row text</td>
</tr>

To add columns to tables:
· Insert the following code for each new column:
<tr>
<td class=infoTableText>Existing column<td><td class=infoTableText>Existing column</td><td class=infoTableText>New column text here</td>
</tr>
	
	

	Note:
	The <tr> and </tr> tags control the number of rows in a table. The <td> and </td> tags control the number of columns. If you change the number of columns or rows, you must ensure that those changes are made throughout the table's code. Otherwise, the table's formatting will be affected.

	
	


[bookmark: scroll-bookmark-463]Indexing
Each Help file should include an index.
[bookmark: scroll-bookmark-464]Layout
The following guidelines regarding the layout of Help files should be observed.
[bookmark: scroll-bookmark-465]Length of Help Pages
Individual topics should ideally fit within a single window (assuming a typical viewing area of 1024 x 768 pixels) so that the user is not required to scroll down to read all the information. If a topic becomes larger than this, you should consider whether to break it up into multiple, smaller topics. It is preferred that a Help user not scroll more than twice to view all the information in a topic.
[bookmark: scroll-bookmark-466]Single-Window Display
As a rule, message boxes (pop-ups) should not be used.

Where message boxes are used, it is essential that they are kept succinct and to the point. Scroll bars should not appear in a message box. For this reason, all dialog fields should always be described in the body of the Help topic and not in a message box.
[bookmark: scroll-bookmark-467]Naming Conventions for Dynamic Dialogs
Where Netcracker uses a dialog, the title of which is dynamically generated according to how the Netcracker operator has accessed it, only the generic title, and not the verb, should appear in text or headings. For example, if the user clicks Add, opens the Add Account for Customer dialog, and then returns to the previous window and clicks Modify to open exactly the same window, which is now entitled Modify Account for Customer, the Help topic should read:
1. Click Add to open the Account for Customer dialog. Make any necessary changes, and click OK to return to the main window.
2. Click Modify to open the Account for Customer dialog.
Maintaining two separate (but largely identical) topics in the Help file may introduce inconsistencies. Therefore, both the links in the preceding example connect to the same topic, which is titled Account for Customer Dialog. Note the use of capitalization. Refer to the User Documentation style guidelines for more information regarding the use of capitals in headings.
	
	

	Note:
	This approach should only be used where an Add and a Modify dialog are identical in every respect apart from the name. Separate topics should be used for any dialog that does display the same fields or follow the same procedure for adding or modifying information.

	
	


[bookmark: scroll-bookmark-468]Screen Snapshots
Screen snapshots should be used judiciously, and only where they help to clarify text, for example, the fields in a complex or key window.
Screen snapshots may be used to explain tabs or button bars. Where this is the case, the PC used to capture the screen snapshots must have been configured according to the guidelines detailed in the User Documentation guidelines before any screen captures are made.
[bookmark: scroll-bookmark-469]RBM/CM Naming Conventions
This section outlines the conventions that should be used when saving Rating and Billing Manager and Collections Manager product documentation materials and any associated graphics or screen snapshots.
[bookmark: scroll-bookmark-470]Product Documentation
The naming of FrameMaker and PDF files relating to product documentation should be as described in this section.
[bookmark: scroll-bookmark-471]FrameMaker File Names
Each FrameMaker document has the following files:
	<doc code>.book
	Generated automatically.

	<doc code>_title.fm
	Title page and inside cover.

	<doc code>_toc.fm
	Table of contents.

	<doc code>_tof.fm
	Table of figures.

	<doc code>_tot.fm
	Table of tables.

	<doc code> <chapter name>.fm<doc code> <appendix name>.fm
	One file for each chapter or appendix.
Any spaces in the name should be replaced by an underscore.
Each appendix should be treated as an individual chapter, rather than grouping appendixes together in an appendixes section.


In these file names, <doc code> is an agreed code for the document in question.
FrameMaker auto-generates Tables of Figures with a .lof extension and Tables of Tables with a .lot extension. You need to change these to the file names indicated above.
	
	

	Note:
	When creating books and chapter names, long titles should be avoided since they present problems when the guide undergoes localization.
Book and chapter titles should be limited to 40 characters.

	
	


Release numbers and chapter numbers must not be included in file names.
As an example, the following list shows the FrameMaker files that compose Rating and Billing Manager Finance Concepts.
· fnc.book
· fnc_title.fm
· fnc_toc.fm
· fnc_tot.fm
· fnc_about.fm
· fnc_overview.fm
· fnc_revenue_codes.fm
· fnc_revenue_assurance.fm
· fnc_contracts.fm
· fnc_disputes_and_adjustments.fm
· fnc_financial_reporting.fm
[bookmark: scroll-bookmark-472]RBM/CM Illustrations
Always use lowercase for illustration file names. The naming convention for illustrations should be as follows:
<doc code><type>[ex]_<name>.<extension>
	
	

	Note:
	In the naming convention defined here, <doc code> is the code for the document, <type> is the object type being illustrated, and [ex] is included only if the screen snapshot is part of a worked example.

	
	


An example of a file name for an illustration is ear_diag_install_process_flow.gif. In this example, diag stands for diagram. For a more complete list of object types, see the Object Types topic.
All images and graphics used in a document should be stored with that document, even if the image is common to other documents. For example, all images in Rating and Billing Manager Event and Rating Concepts should begin with ear.
[bookmark: scroll-bookmark-473]Graphic Title
In the naming conventions, <name> is the title of the dialog, and so on. For dialogs, the name does not include the initial "Add/Modify". For images without obvious titles, try to keep the first word significant to make searching for an image easier, for example, "account_creation" rather than "creating_accounts."

Example:
	rep_win_date_selection
	The Date Selection window for reports.

	dis_diag_ex_products_events
	An example of a product-event source relationship in Rating and Billing Manager Discount Concepts.


[bookmark: scroll-bookmark-474]Object Types
In the naming conventions, <type> is the type of object being illustrated.

Possible values are:
· db – Dialog
· mb – Message box
· win – Window
· pg – Page
· tab – Tab
· frm – Frame or group box
· btn – Button
· flow – Flow diagram
· diag – General illustration
[bookmark: scroll-bookmark-475]Training Documentation
This section outlays the rules for developing training documentation.
[bookmark: scroll-bookmark-476]Training Guide Template Use
This section addresses guidelines for work with the Training Guide Template when developing the courses.
Note: Before you start developing a new course, allways download the latest version of the Training Guide Template located in the Templates folder of the documentation storage:
http://sps3/corporate/NetCrackerProductReleaseTrainings/default.aspx
On the left, in the Library menu, click Course Templates.

One-Part Training Guide
If a Training Guide contains only one part, do not segregate it as part. Such Guide must incorporate contents only.
One-Step Procedures
If a procedure contains only one step, do not insert numbered item “Step 1”. Just outlay the instructions.
Course Objectives
1. The Course Objectives section of a Training Template must be always typed on a page with odd number.
2. An Introduction must contain no more than ten lines of text and the Course Objectives must be placed right after the Introduction text.
Styles use
1. Use only embedded styles. It is allowed to apply to the text only the styles that were designed for corporate Training Guide Template.
2. Do not format lists by placing dash in front of the items’ names.


[bookmark: scroll-bookmark-477]Word Processing Software
[bookmark: scroll-bookmark-478]Adobe FrameMaker
This software is used to create the pdf documents for Rating and Billing Manager and Collections Manager. The software is located on the virtual machines on a server located in Cambridge.
[bookmark: scroll-bookmark-479]MS Word Quick Hints
This section is designed to describe briefly the MS Word featuers that are most commonly used in the product documentation.
The subsections describing the features will help the documentation authors to avoid issues when working with an MS Word document.
[bookmark: scroll-bookmark-480]File Properties and Fields
Such parts of any document as the project name, document type, component version and other, are set as the file properties and inserted in the document as fields.
This section provides information on hwo to work with the document properties and to use them in fields in a document.
You will know how to :
· set summary document properties
· set custom document properties
· add a new document property
· update all the fields
· view a field code
· edit a field
The first thing to be done when starting a new document is to set the file properties and to make sure that the fields that reference to the properties are correct.
	[bookmark: scroll-bookmark-481]To set summary document properties


· In MS Word, on the ribbon, click the File tab.
[image: ]
· On the right pane, expand the Properties options by clicking the down arrow and select Advanced Properties.
· On the Summary tab, enter the document title that is to be displayed on the front matter of a document.
[image: ]
· On the Custom tab of the Properties dialog, specify the document type that will also be displayed on the front matter, the component version if required and the other custom properties.
	[bookmark: scroll-bookmark-482]To set custom document properties



· Click the Custom tab.
· Click the property name in the Properties list, and type the new value in the Value box.
[image: ]
· Press the ENTER key and select the next property to change.
· After you completed working with the properties, click OK.
	[bookmark: scroll-bookmark-483]To add a new document property


· On the Custom tab of the Properties dialog, in the Name field either type a new property name or select from the predefined values in the list below the Name box.
· Select the type of the property if necessary. The default value is "Text".
· Enter the value of the new property in the Value text box.
· The button Add is activated.
· Click Add.
[image: ]
· After completing configuring the document properties, click OK.
· When the properties are configured, update the fields through the document to make sure the properties are set correctly.
	[bookmark: scroll-bookmark-484]To update all the fields


· select all the document by clicking CTRL+A and then press F9.
The table of contents, which is a field as well, must be updated entirely.
	The fields inserted in headers and footers, are not updated with the whole document. To update the fields in the headers and footers, double click the header or footer area, select the contents and click F9.


Usually, the corporate templates contain the preconfigured fields which refer to the document properties, thus it is enough to set the properties values and update the fields.
If something goes wrong, you can check with the field code.
	[bookmark: scroll-bookmark-485]To view a field code


· Point your cursor to the field.
· Right-click the field
· From the contextual menu, select Toggle Field Codes.
[image: ]
The field code is displayed, which provides understanding of what document property value goes in this field (if document property used).
For example, on the picture below it is visualized that the field type is DOCPROPERTY, and the property which value is displayed, is DocType.
[image: ]
	[bookmark: scroll-bookmark-486]To edit a field


· Right clicki the field.
· From the contextual menu,select Edit Field option
· If you need to refer to another document property, select it from the Field dialog.
[image: ]

If something is incorrect with the property value, you can correct the issue in the document properties, see To set summary document properties and To set custom document properties
	[bookmark: scroll-bookmark-488]To insert a new field with a document property


· In MS Word, on the ribbon, click the Insert tab.
· In the Text panel, expand the Quick Parts menu and select Field.
[image: ]
· From the categories drop-down list, select "Document Information."
· From the Field names list, select "DocProperty."
· From the Property list, select the property which value you need to insert.
[image: ]
· Click OK
[bookmark: scroll-bookmark-489]
[bookmark: scroll-bookmark-490]Table of Contents (TOC)
Table of Contents (TOC) is required for all the product and project documents providing structured information. TOC enables seeing parts of documents in the order they appear. This section addresses creating, modifying, and updating (re-building)TOC.
You will know how to:
· Create TOC from the Reference tab
· Create TOC as field from Insert tab
· Edit TOC (re-configure, not update) including:
· Editing TOC Options
· Editing formatting of TOC levels
· Update TOC
In MS Word Toc is inserted as a field containing links to the headings' positions. Commonly, the product documents provide TOC configured in accordance with the corporate design guidelines, but the documentation authors are able to reconfigure TOC if needed or if it is damaged by some reasons.
TOC configuration enables to manage:
· Styles which instances build the table of contents
· Appearance of the table of contents
· The level of headings hierarchy
· others
Table of Contents in inserted in the beginning of a document after the standard parts as the front matter, confidentiality data, and so on, before the Introduction section.
[image: ]
MS Word template Normal.dotm provides a number of built-in styles which instances go in TOC. These are Headings Heading 1, Heading 2, etc…
When configuring TOC, it is possible to add other styles in TOC. For example, if you need to include Appendices titles be included, you can create a special style for these titles and add it to the list of styles for building TOC.
Each time before saving document you have to update TOC to re-build the links to the document sections that is updating the renamed sections' names and numbers of the pages the sections start on, as well as adding links to new sections and removing links to deleted sections.
	[bookmark: scroll-bookmark-497]Create TOC


[bookmark: scroll-bookmark-491][bookmark: scroll-bookmark-498]Create TOC from the Reference tab
To create TOC in an MS Word 2010 document:
· Click on the position in the document the TOC will start with.
· On the Ribbon, click the Reference tab.
· In the Table of Contents group, expand the TOC options list by clicking the down arrow on the Table of Contents button.
[image: ]
You can select the TOC appearance from the list of different TOC views, otherwise click Insert Table of Contents.
	Only one table of contents can be inserted in a document. If a document contains TOC, the Insert Table of Contents button is disabled.


The configure Table of Contents dialog is displayed. The default TOC settings are displayed in the dialog.
[image: ]
· Configure TOC if needed and click OK. The TOC parameters are described below, see Editing TOC Options and Editing formatting of TOC levels.
[bookmark: scroll-bookmark-492][bookmark: scroll-bookmark-499]Create TOC as field from Insert tab
Another way to create TOC is to insert it as a field. When editing TOC it is also updated as a field.
To insert TOC as field:
· Click on the position in the document the TOC will start with
· On the Ribbon, click the Insert tab,
In the Text group, expand the Quick Parts options list by clicking the down arrow on the Quick Parts button.
[image: ]
The Field dialog is displayed. Field dialog enables inserting any kind of fields in a document. Some kinds of the fields can be pre-formatted in the same dialog before being inserted.
[image: ]
· Scroll down the Filed names list to the "TOC" item and click it.
	If table of contents already exists in the document, the TOC item in the list of fields is not available.


· Click OK.
The table of contents with default view is inserted in the text.
	[bookmark: scroll-bookmark-500]Edit TOC (re-configure, not update)


Editing TOC lets you change its appearance, the number of levels, styles which instances go in TOC, whilst TOC update implies rebuilding references to the headings in TOC.
	Do not confuse editing that means reconfiguring of TOC with update TOC that means update field.


To edit TOC:
· Right-click the mouse on any area of TOC and select Edit Field from contextual menu.
[image: ]
The Field dialog is displayed.
· Do one of the folllowing:
Either
· scroll the list of Field names to TOC,
or
· select Index and Tables in Categories list to shorten the Fields Names list and then select TOC from it.
[image: ]

· Click Table of Contents.
The Table of Contents dialog is displayed.
[image: ]
The parameters' names are intuitive.
The Print Preview and Web Preview panes let you see how the parameters' updates affect the appearance of TOC if applied.
[bookmark: scroll-bookmark-494][bookmark: scroll-bookmark-501]Editing TOC Options
Clicking the Options button opens the Table of Contents Options dialog.
The Table of Contents Options dialog enables you specifying the styles that go in TOC and the level at which they appear.
[image: ]
To add a style to TOC, find it in the Available styles: list and type the level of it in the TOC level: cell on the right.
For example, if you need to include the Appendices titles in TOC, you need to:
· Create and apply a particular style to all of the Appendices titles, for example, "Appendix"
· Open the Table of Contents dialog
· Open the Table of Contents Options dialog
· Find the "Appendix" style among the available styles
· Set "1" in TOC level cell
· Save the settings.
The confirmation dialog is displayed prompting to replace the TOC.
[image: ]
If you click OK, the table of contents will be replaced with Appendices titles.
[bookmark: scroll-bookmark-495][bookmark: scroll-bookmark-502]Editing formatting of TOC levels
Clicking the Modify button in the Table of Contents dialog opens the Style dialog.
In the Style dialog the formatting of each level of TOC is performed .
The TOC 1, TOC 2, … correspond to the levels of tabel of contents.

[image: ]
	[bookmark: scroll-bookmark-503]Update TOC


Updating TOC is performed as a standard field update operation.
To update TOC:
· Point the cursor to any area of TOC and right-click the mouse.
· From contextual menu, select Update Field
The Update Table of Contents dialog is displayed.
[image: ]
· Select the necessary option and click Ok.

[bookmark: scroll-bookmark-504]Table of Figures (TOF) and Table of Tables (TOT)
This section addresses how to work with the Table of Figures (TOF) and the Table of Tables (TOT).
You will know how to:
· insert caption for a table or for a figure
· insert TOF or TOT
Table of tables (TOT) and Table of Figures (TOF) may be needed, for example, if you want to see all the tables' and figures' names together in one place.
You can also insert TOT or TOF temporarily, to validate that the tables' and figures' names are consistent and correctly capitalized.
Table of Figures and Table of Tables are build as sets of references to the captions of figures or tables in a document.For information about working with captions, see Inserting Captions.
	Only tables that have captions with the "Table " lead-in are included in the Table of tables.



	Only figures that have captions with the "Figure " lead-in are included in the Table of tables.


	[bookmark: scroll-bookmark-505]To insert caption for a table or for a figure


· Click in the table or the figure.
· On the MS Word ribbon, click References tab.
· On the References tab, in the Captions group, click Insert Caption.
· In the Caption dialog, from the Label drop-down list, select Table for a table, or Figure for a figure.
[image: ]
· Click OK.
Once all the tables in the document have the "Table" captions, you can build the table of tables.
	[bookmark: scroll-bookmark-506]To insert TOT or TOF


· Click where you want the Table of Tables to go.
· On the MS Word ribbon, click References tab.
· On the References tab, in the Captions group, click Insert Table of Figures.
The Table of Figures dialog is opened.
[image: ]
· From the Caption label drop-down list, select "Table" for TOT or "Figure" for TOF.
· Click OK.
[bookmark: scroll-bookmark-97]Inserting Captions
Captions are used for inserting inscriptions to the tables and figures. This section addresses using captions in documentation.
You will know how to:
· insert caption
· update caption
· refer to caption
A caption consists of the label and number. You can use the predefined labels like Figure, Table, and Equation, otherwise you can create your own label if you need.
The advantages of using captions are the following:
· Caption can be referred to from any place of the document as many times as it is required.
· Captions' numbers are generated automatically thus providing consistent numbering through the document.
· The "Caption" style provides consistent formatting of the inscriptions to the tables and figures.
	[bookmark: scroll-bookmark-507]To insert caption


· Point the mouse to a position you need a caption to be inserted (e.g., below the picture).
· On the ribbon (MS Word top panel), click the References tab.
[image: ]
· On the References tab, in the Captions group, click Insert Caption.
[image: ]
· In the Caption dialog, select the name of the caption and click OK.
The caption label and number are inserted.
[image: ]
· Type manually the text of the caption.
	[bookmark: scroll-bookmark-508]To update caption


· Point the mouse to a caption to be updated.
· Right-click the mouse.
· From a contextual menu, select Update Field.
· The number of the caption is updated in accordance with the caption order in the document.
	[bookmark: scroll-bookmark-509]To refer to caption


· Point the mouse to a position you need to insert the reference to.
· On the References tab, in the Captions group, click Cross-reference.
[image: ]
The Cross-reference dialog is opened.
· From the Reference type drop-down list, select the type of caption you need to refer to.
· In the For which caption list, select the necessary caption.
[image: ]
· From the Insert reference to drop-down list, select the appearance you need for the reference.
[image: ]
· Click Insert.
[bookmark: scroll-bookmark-510]Inserting Cross-References
Cross-references enable quick navigating between parts of a document. this section addresses how to work with cross-references.
You will know how to:
· insert cross-reference
· update cross-reference
Cross references can be inserted in any place of a document and you can refer to the same item as many times as you need.
When you make changes to the document, the cross-reference must be updated. If some pert of a document you refer to is deleted, the error message will replace the reference, like:
[image: ]
You can create cross-references to the following objects:
· Numbered item
· Heading
· Bookmarked text
· Footnote
· Endnote
· Figure / Table / Equation – items having the appropriate captions.
	[bookmark: scroll-bookmark-511]To insert cross-reference


· On the MS Word ribbon, click the References tab.
[image: ]
· In the Captions group, click Cross-reference.
· The cross-reference dialog is opened.
[image: ]
· From the Reference type drop-down list, select the type of the item you need to refer to.
The reference type can be as follows:
· 
· Heading
· Bookmark
· 
· Footnote
· Endnote
· 
· Equation
· Figure
· 
· Table

· Insert Reference to drop- down list is contextual. It depends on the Reference type value and defines the appearance of the cross-reference.
[image: ]
· In the "For which " list, select the item you want to refer to.
· Click Insert.
	[bookmark: scroll-bookmark-512]To update cross-reference


The references are updated like the other fields.
· To update a single field, point the cursor to the field and press F9
· To update all fields in a document, click CTRL + A to select all text and then press F9 .
[bookmark: scroll-bookmark-513]Keep with Next
Keep with next option is used to prevent splitting to different pages the paragraphs that must go together.
This section addresses working with the "Keep with next" option.
You will know how to:
· set the "Keep with next" option for paragraph
· apply the "Keep with next" option to style
The situations when paragraphs must be "sticked together" can be the following:
· The table name and the table
· An image and the image caption
· etc…
Setting "Keep with next" option is recommended in the following cases:
· Headings
· Image – to keep image always together with the caption
· Table captions – to keep table names with tables
· Introduction to procedure
Example:
To run the report:
1. Navigate to Reports folder
2. From the Reports table, select…
3. Introduction to a list
Example:
The Status parameter can have the following values:
· New
· Activated
· Suspended
…
It is also recommended to apply the "Keep with next" option to paragraphs preceding images and tables.
	[bookmark: scroll-bookmark-514]To set the "Keep with next" option for paragraph


· Point the cursor to the paragraph that must always be together with the next one, and right-click the mouse.
· From the contextual menu, select Paragraph
· Click the Line and Page Breaks tab.
· Select the Keep with next check box.
[image: ]
· Click OK.
You can apply the "Keep with next" option to a style. For example, all the heading styles have this option toggled, or the style used for graphics is also set as "keep with next" to be never torn apart with the caption below.
	[bookmark: scroll-bookmark-515]To apply the "Keep with next" option to style


· In MS Word, on the ribbon, click the Home tab.
· In the Styles group, click the left-down arrow button to open the Styles pane.
[image: ]
· In the Styles pane, select the necessary style and right-click on it.
· From the contextual menu, select Modify.
· The Modify Style dialog is opened.
· Click the Paragraph button to expand the menu.
[image: ]
· The Paragraph dialog is displayed.
· On the Line and Page Breaks tab, select Keep with next check box.
· Save the updates.


[bookmark: scroll-bookmark-516]Connecting Word Templates
A template is a file used as a basis for the new files created in MS Word. Corporate templates design is created by Brand Management Group and is part of Netcracker Brand Book.
Netcracker templates have standard parts, like front matter, confidentiality information part, headers and footers, TOC, etc... The templates also specify the colors, margins, and other parameters of a document.
All the corporate documents must be consistent with the corporate templates of proper document type.
This section addresses fixing the situation when a template applied to a document is disconnected accidently.
You will now how to re-connect the template backl to a document.
	To link a template to the opened document


· In MS Word, on the ribbon, click the File tab.
· On the left pane, click Options.
[image: ]
· In the Word Options dialog, in the left vertical pane, click Add-Ins.
[image: ]
· In the Manage drop-down list, select "Templates" and click Go.
The Templates and Add-ins dialog is opened.
· To select a template, click Attach.
[image: ]
· Navigate to the required template using your file browser and select it.
After you located and selected the necessary template, click OK to save the settings.
[bookmark: scroll-bookmark-517]MS Word Troubleshooting
[bookmark: scroll-bookmark-518]Troubleshooting Cross-references in MS Word

When editing documents in MS Word you may encounter broken cross-references like the one on the screenshot below.
As you can see, the bookmark includes a whole topic along with a screenshot instead of just the name of the required heading.
[image: ]
This page describes the root cause of the problem, how to fix it and how to avoid it in the future.
[bookmark: scroll-bookmark-519]Root Cause
The problem is caused by adding new topics directly from the heading of a subsequent topic. By doing so, you extend the bookmark range and insert the whole content of the newly added topic to it.
Lets consider the following example. We have a heading and a reference to it below the heading (in grey):
[image: ]
Suppose you need to add a new chapter just above Connector specifications. The most intuitive (but ultimately wrong) way to do this is to position you cursor before the beginning of the heading text like this:
[image: ]
And then press ENTER. This would create a new heading where you can add a title and content like this:
[image: ]
So far so good. But the problem is, there was a hidden bookmark set on the heading Connector specifications. When you expanded the heading to create the new chapter, you expanded the bookmark as well. Now it will include New heading, Connector specifications and everything in between including screenshots and tables. For now, it is not visible because the field with the cross-reference is not yet updated. But when you update it, the result will be following:
[image: ]
Due to Word's insidious nature, the problem may remain undetected and will manifest only when pdf or online help versions of the document are generated. Make sure to always update all fields and check the document content before you finalize the document and upload it to SVN! Setting Field shafing to "Always" also really helps. (File > Options > Advanced category > Show document content group > Field shading)
[bookmark: scroll-bookmark-520]Avoiding the Problem
	Never add a new paragraph by placing the cursor before the beginning of the text and pressing ENTER. That is, never add a new paragraph before the current paragraph, only add new paragraphs after the current paragraph.
Never use New Heading Before feature on MS Word Navigation pane. Use only New Heading After. (Yes, New Heading Before also causes this problem, Word is such a Word [image: ]).



[bookmark: scroll-bookmark-521]Fixing the Problem
You can fix the problem using one of the two ways:
· Delete the field with the cross-reference, and then insert a new one with the reference to the same heading. This will create a new, correct hidden bookmark. The previous hidden bookmark will remain in the document. But since it is not referenced anywhere, it will not cause problems. Note that you would need to replace all references to this heading in the document!
· Select all the newly added text that should not be included in the bookmark and cut it. Add a new paragraph in a proper way, and then paste the text. This would remove the unwanted text from the bookmark and it will be fixed. You do not need to fix the fields with cross-references this way.


[bookmark: scroll-bookmark-522]Single Source
[bookmark: scroll-bookmark-523]Figure References

	Guideline 1
The word "figure" must not be used in document plain text.


This guideline applies only to the Netcracker TOMS documentation (not RBM, CM, and ICOMS). The reason for this is that screen captures are removed from the online help version of Netcracker user guides.


	Guideline 2
Cross-references to figures must always comply with the following format:
… (see CrossRef).


This guideline applies only to the NetCracker TOMS documentation (not RBM, CM, and ICOMS). The reason for this is that screen captures are removed from the online version (diagrams stay). Therefore, remaining references like “figure below” make no sense.
"(see CrossRef)" is also automatically removed from the online version, but only when it is structured like that.
[bookmark: scroll-bookmark-524]Example
Incorrect
The figure below shows the Netcracker login page.
The following figure shows the Netcracker home page.
Correct
Upon opening a Netcracker URL, you see the Netcracker login screen (see CrossRef).
[bookmark: scroll-bookmark-525]Topic Context

	Guideline
Each topic in a user guide or Unit, administrator guide or unit, or configuration guide or unit must have a context string.
To insert a context for a topic, click the "tree dots" menu > Page Context and specify the context string in the popup dialog.


[bookmark: scroll-bookmark-526]Definition
A Confluence page context string is a Confluence page property called PAGE_CONTEXT. This property can only be set or changed through the Page Context command on the page's "three dots" menu.
Example:
ComplexObjectEditorDialog$Circuit
[bookmark: scroll-bookmark-527]More than One Context String for Page
Confluence page, that is the article or the topic, may have two or more context strings.To put more than one context string in a context string, separate them with a line break.
[bookmark: scroll-bookmark-528]Context String Syntax

	Important!
Replace all spaces in the context string with %20
Do not replace other special characters, such as "/", "&", and so on.


[bookmark: scroll-bookmark-529]Read More: 
· Context Linking Guidelines
· Browser Page Context String
· Java Applet Context Strings
· Browser Mode Context Precedence
[bookmark: scroll-bookmark-530]Context Linking Guidelines
https://bass.netcracker.com/pages/viewpage.action?pageId=250546284


	Guideline 1
For all topics of the Task type, the full context should be specified with three parts: jspName$objectTypeID$Tab



	Guideline 2
For topics of the Concept type, use a wildcard (*) to provide the covering of many relevant UI pages in Netcracker by this topic. In other words, one topic will be invoked from different locations in Netcracker.
If there is a large amount of conceptual information, and it is structured in several topics from the point of view of readibility, you can use the context only in the root topic, provided that the root topic and its subtopics refer to one topic that corresponds to one page in the Netcracker interface.



	Guideline 3
A context string can be used only once in Confluence.
In other words, the same context cannot be used in two different pages in Confluence.


[bookmark: scroll-bookmark-531]Browser Page Context String Syntax
For browser mode pages, the context string syntax is the following:
{.pathToJSP.jspFileName.jsp | * } $ [ {objectTypeID | * } ] [ $ {tabName | * } ]
Where:
pathToJSP is a full path to the JSP file with all folder names divided by periods ".", not slashes "/".
jspFileName is the name of the JSP file.
objectTypeID is the ID of the type of object displayed in Netcracker UI. If no object type ID can be defined for the current screen or tab, the objectTypeID part can be skipped, but the preceding dollar sign ($) must be put in the string.
tabName is the name of the tab from where the user clicks Help. If there is no tab name in the status string, it can be omitted.

	Important
Do not use a plus sign "+" to replace a space in a tab name. Do not remove spaces from a tab name. Always substitute spaces with %20.


[bookmark: scroll-bookmark-534]Retrieving a JSP Path and Name

	Important
Always put a period "." before a jsp path.


[bookmark: scroll-bookmark-535]Example
Assume your browser page address is http://<host>/inventory/xcircuits/xpelement.jsp
Then pathToJSP is .inventory.xcircuits. and jspFileName is xpelement.jsp
Altogether:
.inventory.xcircuits.xpelement.jsp
[bookmark: scroll-bookmark-536]Retrieving an Object Type ID and Tab Name
To obtain the exact object type ID and the tab name:
1. From the View menu of Internet Explorer, select Source.
2. In the HTML code, find the <a> element whose title attribute is set to "Display help for the current page".
This is the Help button's hyperlink.
The onclick attribute of the element shows what object type ID and tab name will be passed to the online help system to search for the help topic.
[bookmark: scroll-bookmark-537]Example
The <a> hyperlink is: <a title="Display help for the current page" class="path" href="#" onclick="javascript:popupHelp( '2122666122013690792','_Sites + Devices' );">Help</a>
After replacing each space in the tab name with "%20", the object type ID and tab name parts of the context string will be:
$2122666122013690792$_Sites%20+%20Devices
[bookmark: scroll-bookmark-538]Bookmarklet
You can use the bookmarklet below to capture context strings automatically from Netcracker UI pages. Please note that this bookmarklet supports only Google Chrome browser.
To set up bookmarklet:
1. Copy the bookmarklet code below.
2. Add a bookmark to your browser and in URL field, paste the copied code.
Now you can just navigate to the required page in Netcracker UI and click this bookmark; the context string appears in a dialog box.
Context Bookmarklet
Code Block 1 Context string retrieval bookmarklet code
	javascript:{var tab = PageDescriptor.tabName.replace(/\s/,escape(" "));
  var cur_url = window.location.href.replace(/http:\/\/.+?\//,"");
    var found_jsp= cur_url.match(/.+?\.jsp/)[0]; var jsp_name = found_jsp.replace(/\//g,".");
    var html_body = document.body.innerHTML; var object_type = html_body.match(/javascript\:popupHelp\(\s\W(\d*)/)[1];
    var res = "."+jsp_name+"$"+object_type+"$"+tab;
    var response = prompt("The context string is: ", res); }



	Sometime bookmarklet does not work. In this case retrieve the context string parts manually.


[bookmark: scroll-bookmark-539]Asterisk "*" Wildcard
You use an asterisk (*) as a wildcard to indicate any JSP file, object type ID, or tab to replace .pathToJSP.jspFileName.jsp, objectTypeID, or tabName.
This wildcard is a powerful tool to cover many Netcracker screens with fewer topics. That is, when a topic is missing for aparticular page, the closest relevant topic is shown to the user, not the Help home page.

	Guideline
Use of the * wildcards is a strongly recommended.


	Instead of using the wildcard *, you can skip parts of the context string. Examples are shown in Browser Mode Context Precedence.


	Replaced Part
	Meaning
	Usage

	Tab name
	The topic will be shown from all tabs of an object of the type objectTypeID, regardless of the active tab.
	Use for concept topics describing objects of a specific type, and when you do not care which tab is currently active.

	Object type ID
	The topic will be shown for all pages called by this path:.filename.jsp.
	Use when you do not care about the type of object but do care about the tab name and/or JSP file.

	JSP path and name
	The topic will be shown for all pages displaying objects of the objectTypeID.
	Use when you care only about the type of object and/or tab name.


[bookmark: scroll-bookmark-532]Netcracker Java Applet Context String Syntax
In the Network Configurator, the following context blocks can be specified:
· Context for a window that is named as window path
· Context for an object type related to an element within the Device stencil or the Site stencil, or an object in the workspace
· Context for a tab of the Properties dialog that is generated by the attribute group with given ID
The context string syntax is following:
[Window_path][[$]obj_object_type_ID][[$]attr_attribute_group_ID]
where:
Window_path is a string displayed in the Java console between the "path=" keyword and the first "&" sign.
attribute_group_ID is the ID of an attribute group generating the same-named tab in the Property dialog.
object_type_ID is the ID of the object type for which the context is being defined.
Therefore, the syntax implies a fixed sequence for the context blocks. But any block can be omitted along with the corresponding separator.
Note The "$" sign must be used as separator between context blocks.
The same rules are good for the Workflow Configurator and the Device Configurator.
To obtain context string in the Network Configurator (version 6.5 and above):
1. Make sure that the Java console is turned on and not hidden.
To turn on the Sun Java console, select "Sun Java Console: from the Tools menu of the Internet Explorer browser.
2. Make sure the "-DNCG.LogSeverity=debug" option is defined for the Java VM.
This option is displayed in the Java Runtime Parameters column of the Java Runtime Settings dialog. To call this dialog, select Start>Settings>Control Panel>Java. In the Java Applet Runtime Settings section of the Java tab, click View.
3. Start Netcracker.
4. Navigate to a location and start the Network Configurator.
Make sure the Java Console window is displayed.
[image: ]
Java Console window
5. In the Java Console window, click 5.
The trace level is set to 5.
6. In the Network Configurator, select the necessary element (object), or open a dialog and a tab with the context to be determined, and press F1.
In the Java Console, a lot of information is displayed.
7. In this information, look for the line containing the word "path=".
You can find something like this:
####<20.11.2007 19:21:33 MSK> <Debug> <NC Graphics> <show document with url = http://train:6201/help/applethelp.jsp?path=PropertiesDialog$NCGTabbedPanel&attrGroupID=10&objectTypeID=2111346142013240436&admin=true>
In this string, the important part is between "path=" and "&admin":
PropertiesDialog$NCGTabbedPanel&attrGroupID=10&objectTypeID=2111346142013240436

Here, the window path is "PropertiesDialog$NCGTabbedPanel", the attribute group ID is "10", and the object type ID is "2111346142013240436". The resulting context that you must insert into the context tag is:
PropertiesDialog$NCGTabbedPanel$obj_2111346142013240436$attr_10
[bookmark: scroll-bookmark-533]Browser Mode Context Precedence
Important! The rules below apply to Netcracker Help version 6.5 and above.
Please see the lines below to understand which context strings can be used in the topics and what their precedence is.
The priority of help properties file search is as follows (from high to low):
 .inventory.xsite.jsp$300$_Sites%20+%20Devices 
 .inventory.xsite.jsp$300 
 .inventory.xsite.jsp$300$* 
 *$300$_Sites%20+%20Devices 
 *$300$* 
 .inventory.xsite.jsp$173$_Sites%20+%20Devices 
 .inventory.xsite.jsp$173 
 .inventory.xsite.jsp$173$* 
 *$173$_Sites%20+%20Devices 
 *$173$* 
 .inventory.xsite.jsp$0$_Sites%20+%20Devices 
 .inventory.xsite.jsp$0 
 .inventory.xsite.jsp$0$* 
 *$0$_Sites%20+%20Devices 
 *$0$* 
 .inventory.xsite.jsp$$_Sites%20+%20Devices 
 .inventory.xsite.jsp$*$_Sites%20+%20Devices 
 *$$_Sites%20+%20Devices 
 *$*$_Sites%20+%20Devices 
 .inventory.xsite.jsp$$* 
 .inventory.xsite.jsp$* 
 .inventory.xsite.jsp$*$* 
 .inventory.xsite.jsp$ 
 *$$* 
 *$*$* 


In the above list, "300" is object type ID and "_Sites%20+%20Devices" is the tab name.
The logic behind the context string is that the strongest match is when all three components—JSP name, object type ID and tab name—match. If object type is not "*" or empty, then the next strongest match (a weaker match) first goes by tab name, then by JSP name, and then by object type ID. If object type ID is * or empty, the next strongest match first goes by JSP name, and then by tab name.
The next strongest match by object type ID is: a precise match > parent object type ID match > parent’s parent object type ID match > … > 0.
The next strongest match by tab name is: a precise match > empty > *.
The next strongest match by JSP name is: a precise match > *.
If object type ID is empty or *, then * is a weaker match than empty.
[bookmark: scroll-bookmark-540]WebWorks-Style Conditions
[bookmark: scroll-bookmark-541]Condition Overview
In DOCX source documents that are related to product documentation, the following conditions can be used:
	Condition
	Description

	Online
	Text to be displayed in the online help and not to be displayed in the printed documentation (PDF).

This condition is opposite of the Print condition.

	Print
	Text to be displayed in the printed documentation (PDF) and not to be displayed in the online help.

This condition is opposite of the Online condition.

	Hide
	Text not to be displayed in printed documentation (PDF) and online help.
For instance, this can be used to mark up some internal information like document history, which should not appear in the documents delivered to customers.

This condition is applied for any documentation generation session performed via PDGS.

	WebLogic
	Text that describes using the Oracle WebLogic Server as a separate third-party (Oracle's) product that the Netcracker TOMS Suite depends upon.

	WLEM
	Text that describes using the Application Server Embedded (ASE) functionality. ASE is a set of Oracle WebLogic Server libraries that are licensed to Netcracker for useas part of the Netcracker TOMS Suite application, which saves our customers from acquiring separate WebLogic Server licenses. These libraries are "embedded" within the Netcracker application. That's why internally this functionality is also known as WebLogic Embedded (WLEM).


These conditions are supported both in DOCX->WebHelp and DOCX->PDF WebWorks templates.
When starting a documentation generation session, certain PDGS command-line keys can be used. Among them are keys that are related to these conditions. Namely, these keys specify whether to apply a particular condition:
· {-p|-print}—Generates PDF documents only.
· {-o|-online}—Generates the online help only.
Note: If neither of these two keys mentioned above is specified for the session, both PDF documents and online help are generated.
· {-WebLogic=visible|hidden}—In the resulting document format, displays or hides the text marked with the WebLogic condition.
· {-WLEM=visible|hidden}—In the resulting document format, displays or hides the text marked with the WebLogic condition.
[bookmark: scroll-bookmark-542]Marking Up Text with Conditions
To mark up a piece of text in a DOCX document with a condition:
1. Add the transit.dot template, which will add the WebWorks menu, to your document.
a. In Microsoft Word, open the document and then open the Templates and Add-ins dialog.
b. Click Add and choose the T:\Netcracker\transit.dot file.
As a result, the WebWorks panel in the Add-Ins menu is displayed.
2. Create the condition (if necessary), and apply it to the text.
To learn how to do this, refer to http://www.webworks.com/Documentation/Reverb/index.html#page/03.Preparing%2520and%2520Publishing%2520Content/Preparing%2520Word%2520Files.2.33.htm

[bookmark: scroll-bookmark-543]What's New Articles
[bookmark: scroll-bookmark-544]Creating What's New
https://bass.netcracker.com/pages/viewpage.action?pageId=385849132
This section describes the process of creating a What's New article from a template and filling out the mandatory fields of the template.
To create and compose correctly a What's New article:
1. Navigate to https://doc.netcracker.com/, to the What's New in Releases page https://doc.netcracker.com/display/ALLDOC/What's+New+in+Releases.
2. Navigate to the section Unsorted https://doc.netcracker.com/display/ALLDOC/Unsorted and open one of the following subsections:
a. Projects https://doc.netcracker.com/display/ALLDOC/Projects in case you are documenting a product project updates;
b. PDCRs https://doc.netcracker.com/display/ALLDOC/PDCRs in case you are documenting updates against a particular CR.
3. To create a new page from a template, click the button [image: ]Create from Template on the horizontal pane at the top of the screen.
[image: ]

4. In the template selection dialog, select the What's New template, and click Create.
[image: ]

5. In the What's New template, fill out the fields as follows:
a. Page title
i. for a product project, enter the project code, e.g., NC.PROD.BSS_UP_NS
ii. for a particular CR, enter the key of the root CR, i.e. the functionality change request, e.g., PDCR-8398, NOT of the key of a subtask for documenting.
b. Ticket Key – this field should contain a link (links) to the PDCR(s). Any product project incorporates a number of PDCR tickets; functionality updates for each of tickets should be described in a section under the appropriate Ticket Key field.
c. Product Component – the name of the component impacted by the change.
6. Describe the functionality updates using the approach given in the What's New Content article.
[bookmark: scroll-bookmark-545]What's New Content
https://bass.netcracker.com/pages/viewpage.action?pageId=382113224
The procedure of developing a What's New article text is described in the section What's New Information for Product Projects and Product Change Requests.

	Guideline 1
The What's New text should be developed on a mandatory basis.



	Guideline 2
What's New text must start with the name of the Product Component.
You should not delete parts in the What's New note template. All parts of the template, that is, ticket key, product component name, and text, must be kept.



	Guideline 3
In most cases, a What's New text consists of three parts:
· introduction mentioning what exactly has changed in the system
· middle part providing some important details about the change
· conclusion stating the benefits provided by the updates.




	Guideline 4
Each What’s New note, both PDCR and PROD project, must also contain:
· Business value. One business value paragraph per PDCR. Several business value paragraphs, per each feature of a PROD project.
· Screenshots. One screenshot per PDCR. Several screenshots, per PROD project features. Anything you consider relevant – UI, visio diagram, flowchart, piece of programming code, XML, etc.




Example 1:
The ability to use panning in the Splicing Dialog window is provided.
Now the user can move the workspace along with all the objects displayed in it in various directions. This can be done with the help of the Pan button available on the toolbar of the Splicing Dialog window or by clicking and holding the middle button of the mouse.
The new feature significantly facilitates the process of viewing objects in the Splicing Dialog window, making the view more convenient and easy to comprehend, especially when it contains a large number of objects.
Example 2:
A list of time zones available in the Time Zone parameter of a user profile has been changed to display time zones in the Coordinated Universal Time format (that is, "UTC ±[hh]:[mm] [time zone name]").
The zones on the list are displayed in the ascending order, starting from UTC−12 and going to UTC+12.
This format is more familiar to users, convenient and easy to use. Now they can quickly and easily locate the necessary value.

	Introduction writing helpful tips
[image: ] Stick to the present tense.
[image: ] Use helpful phrases:
· Now the system provides/supports/enables smth
· The system/ ... component has been enhanced with the ... feature
· The ability to do smth is provided
· Smth is now available
· Smth is introduced
· The list of smth has been extended to include smth



Example 1:
The ability to use mouseless navigation to navigate to and to use different page elements (for example, menus, nodes of the Navigation Tree, tabs and tables, and so on) is provided. ...
Example 2:
The ability to use the drag-and-drop feature when editing reference parameters of objects in the in-place editing mode is introduced. ...

	Middle part writing helpful tips
[image: ]The text may be of arbitrary size, but do your best to write briefly and in essence.
[image: ] Use helpful phrases:
· This can be done with the help of ...
· Now the user can do smth
· Now it is possible to do smth
· To enable/disable the new feature, ...
· By default, ... . However, the administrator can ...
· If ... is enabled, the system ...



Example 1:
... Now the user can use the CTRL + ARROW key combination to navigate up and down, left and right on the page and the ENTER key to select a particular element (equals the click of a mouse). ...
Example 2:
... Now the user can edit reference parameters of tables, populating them with values from other reference cells by simply dragging the relevant value. In the same way, they can populate table cells with references to objects that make nodes of the Navigation Tree. ...

	Conclusion helpful tips
[image: ] If the benefits of innovation are not evident, then the information on the benefits for businesses can be requested from the business analyst.
[image: ]Use helpful phrases:
· The new feature/functionality
· significantly accelerates/facilitates the process of doing smth
· makes the system more flexible/user-friendly/informative
· adds more flexibility to the system
· expands capabilities of the system
· makes smth more convenient and easy to comprehend
· reduces/eliminates the possibility of errors
· helps to avoid ... errors
· allows eliminating data inconsistency
· helps to maintain data integrity
· saves the user time and effort
· allows the user to quickly do smth/avoid unnecessary steps when doing smth
· improves/increases usability of the system, especially for visually impaired/inexperienced users.



Example 1:
... The new feature significantly accelerates the process of navigation, saving the user time and effort and allowing them to use the keyboard more effectively. Besides, it makes the system more compliant with the Web accessibility standards.
Example 2:
... The new feature significantly facilitates the process of editing objects' parameters in tables, reduces the possibility of errors, and saves the user time and effort.

	Guideline 4
If the details are unimportant or become clear from the text of the introduction, the middle part can be omitted.


Example 1:
The Cambridge Bordered user interface theme is introduced.
The new theme makes the interface more convenient and user-friendly, allowing the user to quickly locate the necessary information.
Example 2:
The ability to use filters and navigation along the tree of object types to pinpoint the necessary types when configuring reference type definitions is provided.
The new feature is a good alternative to the use of the reference selector, especially for inexperienced users. Thus the new functionality saves the user time and effort and significantly reduces the possibility of errors.

	Guideline 5
The information should be stated clearly, distinctly, and very concisely, so that even after being taken out of the CR context, it is still intelligible. Vague wording, which makes impossible to understand the meaning, are unacceptable. For example, such wording like New form of the parameter provides more comfortable and easy usage of the system clarifies only that we are talking about a certain parameter and that its form has changed. What kind of setting, and how it has changed, is unclear.


Example:
Now the Channelization Type parameter displayed in the New Circuit dialog is a reference selector field.
To populate it, the user can either expand the list of interfaces and look for the necessary value on the list or start typing its name in the field, and the system will show the values that match their entry.
Besides, now the values of the lists displayed in the Channelization Type parameter of the New Circuit dialog and the Interface parameter of the Create Circuits dialog (used for circuits bulk creation) can be sorted in two ways.
By default, they are sorted in the lexicographical order, however, if necessary, they can be ordered differently.
The new feature significantly facilitates the process of circuits creation, allowing the user to quickly locate the necessary value on the list of interfaces.

	Guideline 6
If for some reason the requirements of a CR were implemented not in itself, but in another CR or project, you must provide links to the CR or to the project. If a What's New text contains a message like Since this ticket is outdated, the features described in it were already implemented in other newer tickets. What's New section was updated in those tickets, it is a reference to nowhere. The objective of a technical writer is to record the results of their research. In the above case, the ticket should contain the references to those tickets with What's New articles, and projects in order to present the changes and documentation developed by the specialists of our department.


Example:
The changes are implemented in scope of PDCR-NNNN / PSUPTW-NNNN (links to the tickets).
What’s New details and links to updated documents are provided in PDCR-NNNN / PSUPTW-NNNN (links to the “Documenting” subtasks).

	Recommendations on writing What's New for CRs that correct the system behavior (bug fixes))
[image: ] It is not necessary to focus on the deficiencies or adverse effects of the legacy system behavior or to mention the very mistake.
[image: ] Provide clear description of the current behavior of the system.
[image: ] Specify the problems that are solved due to the new behavior of the system.


Example 1:
The objects filtering functionality is improved.
Now the list of parameter values which can be used as filtering criteria for a particular table column includes only the values that are listed in this column. Thus, if the user filters the table by several columns, each time they do it, the list of parameter values available for filtering is updated to take into consideration the filtering performed.
The improvement allows eliminating data misinterpretation and user confusion.
Example 2:
Representation of link labels in the Geographical View is improved.
Now they are displayed next to the middle point of the link, so users can easily understand what link a particular label belongs to.
Example 3:
Now export of graphs from graph views to files of SVG and PDF format is more accurate - the system exports all the objects displayed in the view, including curves.
The improvement allows eliminating data inconsistency.

	Recommendations on writing What's New for new components and documents
[image: ] Specify which module the component belongs to.
[image: ] Specify the main purpose of the new component and the features it provides.
[image: ] Specify the name of the new document that you created.


Example 1:
The UI Components product component is created. The component belongs to the Netcracker Framework module and is basically a library of visual components for client interfaces development. The components are developed with the help of the GWT development toolkit. The library includes the following components:
· a set of panels and layouts for distributing components on the page
· a set of components for editing text, integer values and currency values
· table
· tree, and so on.
When used out-of-the-box, the product component supports localization and UI themes.
Example 2:
Now the NC OSS/J Service Inventory component of the Netcracker Framework module provides the ability to access and manage (that is, create, update and remove) service instances via OSS/J which makes the system compliant with the OSS/J Inventory API (JSR-142) specification.
The NC.CG.OSSJ.Service_Inventory configuration guide describing the new functionality is created.
[bookmark: scroll-bookmark-546]Dictionary

	Guideline 1
Use the Merriam-Webster online dictionary for spellings.
https://www.merriam-webster.com/



	Guideline 2
Use American English rather than British English.



	Guideline 3
Use the first listed spelling in the case of equal variants.


For a list of frequently confused or misspelled words, refer to Quick Word Reference.
[bookmark: scroll-bookmark-547]Confluence Markup Guidelines
[bookmark: scroll-bookmark-548]Headings in Confluence

	Guideline 1
In Confluence, the first heading on a page must always be formatted with "Heading 1" style.
This rule is applied to all cases, including instances when such formatting looks too big and inappropriate.

	Note
A page title is not a heading. It is possible to have no headings at all on a page.






	Guideline 2
Use more than one Heading 1 on a page where appropriate.

	Note
A page is not limited to only one Heading 1.






	Guideline 3
Use heading levels in sequence. In other words, use only the next heading level down to indicate a change to a lower level in the hierarchy to keep the overall document structure consistent and predictable.


[bookmark: scroll-bookmark-549]Article Body

	Guideline 1
Do not forget to remove empty paragraphs, even after tables. Empty paragraphs result in empty spaces while generating PDF documents, like shown in the picture below.

[image: ]



	Guideline 2
Each document section in Confluence must describe a particular functional area. A section's content is limited by a particular screen form providing the user interface for working in a particular mode. It is not permitted to describe several features associated with different screens in the same article. If the content is too big, it must be split into subsections.


[bookmark: scroll-bookmark-550]Code Inside Lists
	A list item can contain one line of code (not language syntax), two-three lines maximum, as an illustrative example, formatted with the Preformatted markup (CTRL+7).
No list can contain a Code Block inside of it, either numbered or bulleted.
Correct
http://doc.netcracker.com/display/NTTDoCoMo15B/Setup+VNF+Plugin0
Incorrect
http://doc.netcracker.com/pages/viewpage.action?pageId=15962379



	Language syntax is always placed outside lists.


[bookmark: scroll-bookmark-122]Syntax, Code Samples, Console Text

	Guideline
Differentiate language syntax, code sample, and terminal input/output on screen.
Language syntax is a programming language or command construction rule, not a real code sample. Whereas, the code sample or code example is code with real or mock-up data values. If you cannot distinguish where there is code itself and where there are data values, ask the person who provided the code sample.
Terminal input/output is not code. It is a sequence of commands that user enters in the UNIX shell or Windows OS command line, and system on screen (not to file) output.
Rules:
· Language syntax is never formatted with either 'Preformatted' or 'Monospace'. Paragraph (CTRL+0) style is applied, bold and italic formatting is allowed. See Code Syntax for details.
· Any system response which is not displayed on the screen, that is when it writes the output to a file, or response to an API call – is always a code sample.
· Code sample never hasbold oritalic formatting.
· Terminal input/output is never formatted as a Code Block. 'Preformatted' style only.
· Keyboard shortcut for Preformatted is CTRL+7. Put your cursor anywhere inside a paragraph and press CTRL+7. Same works for multiple highlighted paragraphs.



	Never use images to represent code in Confluence!
The existing figures demonstrating code are to be converted to text by any online OSR (Optical Character Recognition) site, like, e.g. http://www.onlineocr.net/


EXAMPLES
[bookmark: scroll-bookmark-551]Language syntax examples:
The mobile app URL has the following common syntax:
http://server[:port]#common?object=objectID

The change directory Unix command has the following syntax:
cd [{/|target_folder|.|..|~username|-}]
[bookmark: scroll-bookmark-552]Code Sample example 1 – illustrating parameter value in NC UI:
Specify the value of the Endpoint URL parameter for Orchestrator. Endpoint URL should specify protocol, IP address, and port of the external system. See the example below.
	http://192.168.50.183:6340


[bookmark: scroll-bookmark-553]Code Sample example 2 – piece of text in some file:
Sample broker is shown in the example below.
	<broker brokerName="broker" persistent="true" ... >
    ...
    <persistenceAdapter>
        <kahaDB directory="${YOUR DIRECTORY}" />
    </persistenceAdapter>
    ...
</broker>


[bookmark: scroll-bookmark-554]Terminal input example:
Enter the following commands:
 cd $RTF_HOME/bin
 ./status.sh
[bookmark: scroll-bookmark-555]Terminal output example (use soft line breaks [CTRL+ENTER] within one block of terminal text!):
Remote system responds with the following data:
ntcrk@example123 bin]$ ./status.sh
==================================================
JAVA_HOME              : /ub01/rtf/jdk1.7.0_51
RTF_HOME               : /ub01/rtf/manual_test/newScrits
RTF server config      : solutions/rtf-messaging-smoke-tests/rtf-messaging-smoke-tests-server-config.xml
Debug                  : OFF, debug port: 5005
Last start time        : Fri Aug  8 16:02:42 MSK 2014
OS process status     : RUNNING, pid=28315
RTF status file        : RUNNING
RTF apps status        : OK, 0 successfully, 0 with failures,
JVM OutOfMemory check  : OK
Summary status: OK
==================================================

[bookmark: scroll-bookmark-556]Auto Indentation

	Guideline
Use this on-line code formatter to auto-indent code http://www.freeformatter.com. Enter text, format it online, and copy and paste it in the Confluence's code block.
Example for JSON: http://www.freeformatter.com/json-formatter.html


[bookmark: scroll-bookmark-557]Code as Picture - Optical Recongnition

	Guideline
Never use images to present code in Confluence!
The existing figures demonstrating code are to be converted to text by any online OSR (Optical Character Recognition) site, like, e.g. http://www.onlineocr.net/


[bookmark: scroll-bookmark-558]Line Break in Preformatted
	To break the line of text in a Preformatted block use only the SHIFT+ENTER keyboard combination, as the plain ENTER will create a new Preformatted block of text instead of a new line in the current block.
Confluence in this case does not insert the <br/>, as is does in case of a usual Paragraph, but inserts a real natural line break.


[bookmark: scroll-bookmark-559]Context Strings
	Important! Do not delete strings like «!<!Context!.common.uobject.jsp$6000000010002$_Report!>!»
These are important strings that will be automatically moved into inside pages' persistence with a special script.


[bookmark: scroll-bookmark-560]Working with Images

	Guideline 1 - Inserting images
If you are copying and pasting from a browser window, including another Confluence page, right click the picture and select "Copy picture to clipboard". Then paste it onto a new page as usual with CTRL-V. Confluence will flash with an upload window, which indicates that the image file was successfully uploaded anew.



	Guideline 2 - Font size in image
Normal text font size on the screenshot should be the same as Confluence's superscript font size. If the font size is different, adjust the explicit size of the screenshot in Confluence.
This is the superscript font size:
Some text



	Guideline 3 - Changing image size
Important! To adjust the picture size use the the preset size buttons Small, Medium, Large.
If you setting picture size explicitly, e.g. to flexibly adjust the size, make sure the size does not exceed 580px! Otherwise the image would become bigger than page in PDF.



	Guideline 4 - Using dashes in captions is deprecated
Never use dashes in captions.



	Guideline 5
To observe how an inserted image looks in printed document, it is enough to export the page with image to MS Word and view the result. This is the only way to provide correct image size and make sure it is not too small. When exporting a page to Word, use the Netcracker Book or Netcracker Manual schemes,



	Guideline 6
Apply correct technique when capturing screenshots demonstrating screen areas. There must be no pieces of screen background visible behind the image rounded corners, borders, etc... Replacing screenshots is a labour-consuming work, thus screenshots must be initially taken correctly. The method for capturimg screenshots is described at Screen Snapshot Capture Techniques.



	Guideline 7
Never insert figures in procedures' steps. Add a figure below a procedure to illustrate it if necessary.



	Guideline 8
Dialogs' background must not be transparent or partially transparent.
INCORRECT
[image: ]


[bookmark: scroll-bookmark-249]Working with Links
[bookmark: scroll-bookmark-561]/*<![CDATA[*/ div.rbtoc1511515741875 {padding: 0px;} div.rbtoc1511515741875 ul {list-style: disc;margin-left: 0px;padding-left: ;} div.rbtoc1511515741875 li {margin-left: 0px;padding-left: 0px;} /*]]>*/
· General Guidelines
· Formatting Internal Cross-References
· Referencing Pages within the Current Guide
· Referencing Subsections of a Page within the Current Guide
· Formatting External Cross-References
· Referencing Other Netcracker Guides
· Referencing External Web Content
[bookmark: scroll-bookmark-569]General Guidelines

	Guideline 1
Avoid using cross-references for information that is essential to performing the task at hand, for example, completing a step-by-step procedure.



	Guideline 2
Do not use blind cross-references. Make sure you are explaining why the referenced information is useful so the user can make a decision about whether to break away from the current topic to follow the cross-reference.



	Guideline 3
Use the phrase "For more information about," and not "For more information on." The latter phrase can cause confusion for non-native English speakers.



	Important!
· Do not use cross-references to Administrator Guides from User Guides. Otherwise, users may be prompted to view documents they cannot access. For example, do not refer to the Netcracker Framework, "Search Profiles" document from the Netcracker User's Guide, "Search Function" chapter.
· Do not use cross-references to Developer Guides, whatever document you are working with. Netcracker Framework is an Administrator Guide.



[bookmark: scroll-bookmark-570]Formatting Internal Cross-References
Internal cross-references refer to other sections within the current guide.
When referencing a page within the current guide, use hyperlinks. When referencing a subsection of a page within the current guide, use plain text references.
[bookmark: scroll-bookmark-571]Referencing Pages within the Current Guide

	Guideline 4
Use hyperlinks to reference a page within the current guide. The link text must match the title of the linked page.
Hint: The easiest way to insert a hyperlink is to open the referred page of a product component, copy the URL from the browser, and paste it directly into the body text. Confluence will automatically convert the URL into a page title link.
For more information about hyperlinks, see Working with Links.



	Guideline 5
Provide links only for particular pages within the current guide. Do not link to subsections of pages, entire guides, or pages of other guides.



	Guideline 6
Hyperlinks in the Confluence documentation must not:
· Contain the document name, for example, "Netcracker Framework User's Guide."
· Contain quotation marks.
· Contain any words in italic.
· Use the phrase "refer to."




	Guideline 7
Cross-reference "For more information" to a particular article must not be inserted in the source article more than once.



	Guideline 8
Use only the following syntax for hyperlinks in Confluence documentation:

For more information about X, see Page Title.
Do not mention the name of the product components, modules, etc. in the link text.


[bookmark: scroll-bookmark-572]Referencing Subsections of a Page within the Current Guide

	Guideline 9
To reference a preceding section on the same Confluence page, for example, to focus on important information or to avoid duplication of content within one page, do not insert a hyperlink. Do not use the words "For more information" either. Use plain instructional text, possibly with the word "above", instead. For example:
This procedure invokes the same approach as described in the section "Setting Recalculation Delay" above.
Avoid using forward references.


[bookmark: scroll-bookmark-573]Formatting External Cross-References

	Guideline 10
Use the phrase "refer to" when referencing external Netcracker or non-Netcracker content.


[bookmark: scroll-bookmark-574]Referencing Other Netcracker Guides

	Guideline 11
When referencing other Netcracker guides, use the following format:
For more information about X, refer to Netcracker [Document Name], "[Page Title]."
Example:
For more information about creating attributes, refer to Netcracker Attributes and Types Configurator Administrator Guide, "Creating Attributes."



	Guideline 12
Do not use hyperlinks for external cross-references to Netcracker content. Any hyperlinks to content outside of the current guide are automatically removed when the guide is exported to PDF.



	Guideline 13
Cross-references in Confluence documentation should point to entire articles only, not to subsections.



	Guideline 14
When referring to a document from another space, make sure you refer to a page from the latest product version of a component.


[bookmark: scroll-bookmark-575]Referencing External Web Content

	Guideline 15
References to Web resources must be links to the relevant web pages. A hyperlink must be displayed as readable text, not as a URL.
All cross-references to external resources should have the following syntax:
For more information, refer to Oracle Database Installation Guide.


[bookmark: scroll-bookmark-576]Indenting Text and Lists

	Guideline 1
You can not use spaces to indent text or list items.


[bookmark: scroll-bookmark-577]Content Matrix
https://bass.netcracker.com/pages/viewpage.action?pageId=446900097
This section addresses the description and regulations for the API guides and other types of documentation. These include the classification, lifecycle, design guidelines, and other data.

	Official R&D guideline
Please note, that official R&D guideline can be downloaded by the link
https://sps3.Netcracker.com/corporate/ProductDocumentation/Product%20Documentation/NC.RD.Product_Deliverables_Structure_and_Specification.doc.
Where and if there is conflict with information above, R&D guideline takes precedence.



	DG (Internal) vs. CG
Please note, that we do not produce Configuration Guides (CG) any more. Instead, we produce Developers Guides (Internal) that are never delivered to customers.


[bookmark: scroll-bookmark-578]Content Matrix
	

Information type

	

Auditory

	Permitted contents


	
	
	Public UI

	Hidden UI2
	JSP, Java coding, API

	Hacks, workarounds, end-to-end3

	Standard. Delivered out of the box.
UG, AG, release level documentation
	Customer. Users.
(business departments' employees)
	[image: ] Yes
	[image: ] No
	[image: ] No
	[image: ] No

	Developer. Delivered on request.
IG, DG
	Customer. Engineers and develpers.
(IT departments' specialists)
	[image: ] Yes
	[image: ] No
	[image: ] Yes
	[image: ] No

	Developer (Internal). Internal only.1
DG (Internal)

	Netcracker. Solution delivery engineers.
	[image: ] Yes
	[image: ] Yes
	[image: ] Yes
	[image: ] Yes


_________________________________________________________________________________________________________________
1 Attention! No part of DG (Internal) contents is ever made available to the customers!
2 JSP pages non-referred from UI. Accessed only by full path on the server to a particular JSP file.
3 Purely internal hints for delivery: workarounds, "strange" hacks, "non-documented" features (i.e. the features that exist and can be accessed via Netcracker interface, but not delivered in external documentation). Product internal recommendations to the project implementation engineers: end-to-end solutions, Netcracker know-how.
[bookmark: scroll-bookmark-579]Integration Guide

	Definitions
The Integration Guide is a document specifying integration with external systems.



	Abbreviation and Template
Abbreviation: IG
Link to the template:



	Target Audience
The engineers involved in integration of Netcracker with external systems of different classes, both the customer spacialists and the Netcracker engineers.



	Purpose
· IG must cover the externally facing functions that arу needed for the integration purposes, i.e. data exchange with the customers' external systems, legacy systems and others.
· A deliverable shall be a customer-facing document.




	Occurence
· For component delivery IG is optional and is delivered if applicable.
· For module delivery IG is is not applicable.




	Output of Process, Activity, Project Stage
· Design stage of product development project
· Final stage of product development project




	Input to Process, Activity, Project Stage
· Build stage of Product Development stage
· Product (next version) Development




	Related Deliverables
· Requirements Specification (SRS)
· Use Cases (UC)
· Functional Design Specification (FDS)




	Stakeholders
	Author
	Approver/ Reviewer
	Owner/Customer

	· Business Analysts
· Senior Software Engineers (Architects)
???
· Technical Writers

	· Component/Module Owner
· Business Analyst

	· Technical Writers







	Contents
What should be specified
A deliverable contains specification of public API:
· request syntax, parameters, and description.
· response syntax and description.
A deliverable shall specify the methods and applying use cases for them.
What should not be included

Optional




	Conventions
Likewise the JavaDocs, API IG shall specify methods and classes but only for the externally facing functions that are necessary for integration purposes..



	Additional
References to JavaDocs are insufficient because of the following reasons:
1. The JavaDocs are not delivered obligatorily.
2. The JavaDocs scope is wider than it is requireded for the document.
3. The JavaDocs can contradict with the other guides, since JavaDocs are generated automatically and can include non-described updates.



[bookmark: scroll-bookmark-580]Developer Guide

	Definitions
Developer Guide is a document describing cases of using API for product evolution and delivery.
Developer Guide describes component extension points available for developers and recomendations for developing custom functions over product ones.



	Abbreviation and Template
· Abbreviation: DG
· Link to the template:




	Target Audience
Java developers and developers of Netcracker application pages not available in the OOB product.



	Purpose
· DG must cover...
· The DG audience upon studuing the document must be able to ...




	Occurence

· For component delivery DG is ....
· For module delivery DG is ...




	Output of Process, Activity, Project Stage




	Input to Process, Activity, Project Stage




	Related Deliverables




	Stakeholders
	Author
	Approver/ Reviewer
	Owner/Customer

	
	
	






	Document Contents


Structure
View the Developer Guide Structure on the Developer Guide Reference Structure page.

What should be specified
The best practice is to provide the API description as references generated by request.
· Product API application use cases
· Variety of solutions for the most frequently emerging tasks and the examples of the most common cases.
· All the "documented" Flex View functions that are the methods and classes.


What should not be included
· usage of some public API
· references to Javadoc output
· references to "non-documented" functions' options

Optional




	Conventions
For the moment Javadoc outputs are used extensively for Java API.
Usage of other tools related to automatically generated practices is in research.


[bookmark: scroll-bookmark-581]Developer Guide Reference Structure
1. Описание продуктового компонента
2. Назначение продуктового компонента (ПК)
3. Техническая архитектура компонента. (Иллюстрации и описание составных частей, а также их функций)
4. Место продуктового компонента в TOMS-модуле
5. Значение ПК в томс-модуле
6. Interaction ПК с остальными ПК
7. Примеры кода в виде листингов.

	Иллюстрация примерами
Описания решения проблем, рассматриваемых в мануале, должны сопровождаться примерами и листингами кода.


8. Справочная информация
a. Методы
b. Функции
c. Передаваемые параметры
d. Атрибуты
e. Таблицы
9. Extension\Customization points. (Описание точек, где можно решить конкретные девелоперские задачи)

	Важно!
Информация об установке скомпилированного кода в систему в гайд не входит. Гайд ориентирован на читательскую аудиторию, которая, как предполагается, умеет выполнять deployment java-программ.



1. Product Component Overview
2. Product Component Purpose
3. Product Component Technical Architecture (illustrations and description of the subcomponents and their functions)
4. Product Component Placement in the TOMS Module
5. Product Component Role in the TOMS Module
6. Product Component Interaction with the Other Product Components
7. Code samples listings.

	Code samples
Resolution of issues addressed in the guide should be illustrated with the code samples listings.


8. Reference Data
a. Methods
b. Functions
c. Passed Parameters
d. Attributes
e. Tables
9. Extension/Customization points. Description of the points applicable for solving particular developers' tasks.

	Important!
Information on installation of compiled code on the system is not included in Developer's Guide. Developer's Guide is intended for the readers that are supposed to be able to deploy Java programs.


[bookmark: scroll-bookmark-582]Detailed Design Specification

	Definitions
Detailed Design Specification is a document providing data on design and implementation, the data types, API, packaging and deployment information, unit testing information.



	Abbreviation
Abbreaviation: DDS
Link to the template: https://sps3.netcracker.com/corporate/ProductDocumentation/Product%20Documentation/Templates/NC.DDS.Module_Code.Full_Component_Name_x.x.x.x.Template.doc



	Target Audience
Product developers.



	Purpose
DDS shall provide implementation data in terms and at the detail level required for a developer to implement product CRs, projects, and for fixing bugs..




	Occurence
· For component delivery DDS is recommended.
· For module delivery DDS is not applicable.




	Output of Process, Activity, Project Stage
· Design stage of product development project
· Final stage of product development project




	Input to Process, Activity, Project Stage
· Build stage of Product Development stage
· Product (next version) Development




	Related Deliverables
· Glossary
· Functional Design Specification




	Stakeholders
	Author
	Approver/ Reviewer
	Owner/Customer

	· Software Engineer (Developer)

	· Component/Module Owner

	· Business Practice







	Contents
What should be specified
DDS shall contain implementation description, including the data types, API, packaging and deployment, unit testing. The detail level must be sufficient for developers to implement product CRs, projects, and for fixing bugs.

What should not be included
-
Optional
-



	Conventions





	Additional
-




[bookmark: scroll-bookmark-583]Configuration Guide

	Definitions
Configuration Guide is a document describing product settings and confgurations necessary for an engineer. Configuration Guide is also a document that tells the reader of the "undocumented" features of the Netcracker products, that is JSPs and functions existing in the product, but not described in the standard user documentation.
db150.jsp is an example of such "undocumented" tool.



	Abbreviation and Template
· Abbreviation: CG
· Link to the template:




	Target Audience
The target audience of CG are the system engineers of the Netcracker internal Research & Development projects and of the Solution Delivery projects, including:
· Implementation engineers (developers)
· Business analysts (BAs)
· Solution architects




	Purpose
Configuration Guide deliverable shall provide a user the ability:
· to identify limitations on configuration/customization of a given component’s functionality,
· to identify list of the most typical cases when the component’s functionality is to be extended,
· to understand step-by-step instructions on component configuration/customization for covering these cases of customization.




	Occurence
· The CG development is recommended for the complex components delivery with a big number of extesion points.
· The CG development is mandatory for module delivery if CG for component doesn’t exist
· The CG development is recommended for module delivery for customization/configuration cases which provided by means of coordinated configuring of several components.




	Output of Process, Activity, Project Stage
The Configuration Guides are developed on the final stage of a project.



	Input to Process, Activity, Project Stage
· Product Implementation
· Requirement Gathering stage of Implementation Project
· Solution Architecture Development stage of Implementation Project




	Related Deliverables
· Glossary
· Business Use Casess (BUC)
· System Requirements (SRS)
· Functional Design Specification (FDS)
· Detailed Design Specification (DDS)




	Stakeholders
	Author
	Approver/ Reviewer
	Owner/Customer

	· Business Analysts
· Senior Software Engineers (Architects)

	· Component/Module Owner,
· RND BA Lead

	· Business Practice







	Approver/ Reviewer
· Component/Module Owner,
· RND BA Lead




	Contents
What should be specified
Description of data model extensions, product settings configuration, that can be performed by teh Netcracker engineers.
What should not be included
Codes.
Optional




	Conventions
-



	Additional
-




[bookmark: scroll-bookmark-584]Administrator Guide
https://bass.netcracker.com/pages/viewpage.action?pageId=446900104

	Guideline
Administrator Guide – a guide containing functions and features of the interface available to the user logged in as Administrator of Netcracker system. Example – functions of Navigation > Administrative Tools.



	Guideline 2
The following information is always placed only in the administrator guide:
· UI localization issues
· work on WFM Configuration Project




	Note
· If function or feature is available not only to the Netcracker administrator, the description of this function is always placed in the User Guide.
· It is not allowed to mix in the User Guide features that are available only to an administrator and functions that are available to everybody.
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[bookmark: scroll-bookmark-590]Best Practices
[bookmark: scroll-bookmark-591]Active Voice vs. Passive Voice
	Voice refers to the relationship between the grammatical subject of a sentence and the verb. In active voice, the person or thing performing the action of the verb is the grammatical subject. In passive voice, the receiver of the action is the grammatical subject.
Active voice emphasizes the person or thing preforming the action. It is more direct than passive voice and is generally easier for users to follow. However, there are a few situations in which passive voice constructions are preferable. Use passive voice only in the following situations:
· To avoid a wordy or awkward construction.
· When the subject is unknown or the emphasis is on the receiver of the action.
· If casting the user as the subject might sound blaming or condescending, especially in error messages and troubleshooting content.




I did this presentation.
· Active Voice.
· Active voice is used in writing to denote the subject directly performing the action described by the verb.
This presentation was done by me.
· Passive Voice
· Passive voice is used in writing when the subject in the sentence receives the action of the verb.
Active Voice
Active Voice is used in cases when:
· The statement to be made is direct. E.g.: You must learn to be polite.
· The statement made conveys a strong meaning. E.g.: She will have to wash the clothes.
· The statement gives responsibility to the reader in the form of a work to do. E.g.: Click the Start button.
Passive Voice
Passive Voice is used in cases when:
· The subject performing the action is not known. E.g. The mystery needs to be solved by the any one in the police department.
· The subject performing the action is not important. E.g. The breakfast I ate was made by the cook.
Passive Voice -> Active Voice
Steps to convert passive voice to active voice
Let us take into consideration the statement
The Presentation was done by me
· Move the subject in the passive sentence to direct slot in the active sentence.
· Remove the auxiliary verb be from the main verb and change the verb form if needed.
· Place the object of preposition by into the subject slot.
Transitive and Intransitive Verbs
Transitive verbs takes an object and can be converted into passive voice, while intransitive verbs do not take an object and cannot be converted into passive voice.
Example for transitive verb: She offered me a cup of tea -> I was offered a cup of tea
Example for intransitive verb: He laughs loudly. This sentence cannot be converted into passive voice.
Imperatives
Imperative or command sentences are mostly converted to passive voice using the word “Let.”
E.g. Shut the door -> Let the door be shut.

Time for some workouts.
Active or Passive?
· The user guide was edited by Carmeline. Passive
· Vijetha made this cake. Active
· The movie tickets were booked by Vivek. Passive
Passive -> Active
· The cat was adopted by Nishita.
· Nishita adopted the cat.
· This car was bought by Ranganath.
· Ranganath bought this car.
Active ->Passive
· Ankush ate this biryani.
· This biryani was eaten by Ankush.
· Subatree surprised his wife with a gift.
· His wife was surprised by Subatree’s gift.
· Preeti clicked the “I agree to terms and conditions” check box.
· The “I agree to terms and conditions” check box was clicked by Preeti.
Significance in Tech Writing
It is recommended to use active voice in tech writing as it help keep documents:
· Directed towards the user

· Simpler to read and process

· More concise and lucid
Bottom Line
Active voice makes the reader more attentive and helps them grasp concepts faster.
Be Active, Use Active Voice.
[bookmark: scroll-bookmark-592]Adverbs
[bookmark: scroll-bookmark-593]Adverb Definition
An adverb is a word that modifies a verb, adjective, another adverb, noun phrase, clause, or a sentence.
The most common question that adverbs answer is how. An adverb also answers when, where, and why.
Modifying verbs
She sang beautifully.
The pianist played carelessly.
Adverbs also modify adjectives
That woman is extremely nice.
It was a terribly hot afternoon.
Modifying adverbs
He teaches quite creatively.
He writes too slowly.
[bookmark: scroll-bookmark-594]Identifying an adverb
· You can tell whether or not a word is an adverb by considering its function in the sentence. If it is describing one of those three parts of speech- a verb, adjective or other adverb- it is an adverb.
· Many frequency words are adverbs as well. For example, very, much, more and many can all be adverbs.
· Adverbs also answer the questions when, where, and why.
· Adverbs are intensifiers.
[bookmark: scroll-bookmark-595]Exercises 
Identify the adverbs in the following sentences:
1. Jim will miss the many wonderful people at work.
2. Joe walked slowly and steadily up the hill.
3. The cat crept near.
4. Clark wanted to build a great big house.
5. The very pretty girl was in the car.
6. I am certain of the facts, for sure.
7. Although she speaks five languages, she did not do well on the translation exam.
8. They all went there for the party.
9. The much smarter boy won the race.
Identify the modified words in the following sentences:
Jayne happily accepted her award for Best Actress. {the actress (Sub, accepted (V), the award (Obj)}
Verb -The adverb "happily" tells us the manner in which she accepted.
She went completely crazy on stage. {She (Sub), went (V), crazy (Adj)}
Adj -The adverb "completely" tells us "how crazy".
She spoke extremely fast. {She (Sub), spoke (V), fast (Adv)}
Adv - The adverb "extremely" tells us "how fast".
The actress stood exactly in the middle of the stage. {stood (V), in the middle of the stage (PP)}
PP -The adverb "exactly" tells us "where in the middle" she stood.
Suddenly, the music started to play because she had talked too long. {the music (sub), started to play (V), the music started to play (the clause)}
V - The adverb "suddenly" tells "how" the action happened/When the adverb "suddenly" is placed in front of a clause, it modifies the whole clause.
She left the stage dramatically blowing kisses to the audience. {She (Sub), left the stage (verb phrase), blowing kisses to the audience (participial clause)}
It may tell "how" she left the stage, or more probably "how" she was blowing kisses / It tells "how" she was blowing kisses. — in a dramatic, hollywood way.
She was allowed to speak for only three minutes. {allowed to speak (V), three (Adj)}
The adverb "only" tells us "how much" — (just) three minutes.

[bookmark: scroll-bookmark-596]Articles
Articles are words which may or may not be used before a noun to demonstrate if the noun is new to the listener or reader (the indefinite article) or if the listener or reader already knows exactly what we are talking about (the definite article). Articles are part of a group of words called 'determiners'.Articles modify nouns.
The three articles in English are 'a', 'an' and 'the'.
The word a (which becomes an when the next word begins with a vowel) is called indefinite article because the noun it goes with is indefinite or general.
Many nouns, especially singular forms of countable nouns must have an article.
Ex: I sat on a chair
[bookmark: scroll-bookmark-597]Definite Article – ‘The’
The definite article is used before singular and plural nouns when the noun is specific or particular. The signals that the noun is definite, that it refers to a particular member of a group.
For example:
The dog that bit me ran away.
Here, we're talking about a specific dog, the dog that bit me.
I was happy to see the policeman who saved my cat!
Here, we're talking about a particular policeman. Even if we don't know the policeman's name, it's still a particular policeman because it is the one who saved the cat.
I saw the elephant at the zoo.
Here, we're talking about a specific noun. Probably there is only one elephant at the zoo.
[bookmark: scroll-bookmark-598]‘The’ is used
When the same thing or person mentioned again, that is, a particular thing or person
Example: I bought an orange. The orange is sweet.
When there is only one such thing
Example: the earth, the sun, the moon
Before the names of famous buildings, etc.
Example: The Eiffel Tower, The Taj Mahal
When a singular noun is used to point out a whole class, race, group, etc.
Example: The bear is a strong animal.
Before the names of holy or important books
Example: The Bible
Before an adjective when the noun is understood
Example: The poor need help
We use "the" when we are talking about a specific person or thing, or if there is only one, or if it is clear which one we are talking about.
Example: I loved the apple pie after the meal.
In this example, the audience knows which apple pie is being praised.
[bookmark: scroll-bookmark-599]Use 'The' with
Nouns where there is only oneThe President The sun
Ordinal numbersThe first The fifth time
SuperlativesThe best The most beautiful place in the world.
Geographical areasThe Middle East The Midwest
Nationality and geopolitical adjectives when followed by a noun or defining the peopleThe Federal University The International Airport
Seas & oceansThe Atlantic The Mediterranean
Rivers & desertsThe Nile The Sahara
Most hotelsThe Hilton The Copacabana Palace Hotel
PubsThe Red Lion The Queen's Legs
Theatres and cinemasThe Odeon The Municipal Theatre
MuseumsThe Museum of Modern Art The Carmen Miranda Museum
NewspapersThe New York Times The Guardian
Mountain rangesThe Himalayas The Alps
Groups of countries, islands or statesThe Bahamas The EEC
Musical instrumentsPlay the piano Good on the violin
Public buildingsWhen I was in Oxford I saw the university. She works at the hospital on Fridays.
Radio and computerI heard it on the radio. It's on the computer at work.
[bookmark: scroll-bookmark-600]Exercise
1. I will visit ___ friend of mine in ___ United States

a) I will visit a friend of mine in the United States.
2. Listening to ______ music is quite ______ useful form of relaxation.
a) Listening to music is quite a useful form of relaxation
3. Her daughter was so lovely ______ little girl that everybody in the street would smile at her at ______ first sight
a) Her daughter was so lovely a little girl that everybody in the street would smile at her at _×_ first sight.
4. Money plays ______ important role in the material world, but you can't expect it to give you ______ real happiness

a) Money plays an important role in the material world, but you can't expect it to give you _×_ real happiness
5. I think it is right to buy him ______ MP3 as ______ birthday present

a) I think it is right to buy him an MP3 as a birthday present.
6. I don’t watch __ TV. I get __ information and __ news, etc., from __ Internet. I don’t often go to __ cinema, either. I’m interested in __ finance. I heard __ Euro is losing value, compared to __ US dollar.
a) I don’t watch TV. I get information and news, etc., from the Internet. I don’t often go to the cinema, either. I’m interested in finance. I heard the Euro is losing value, compared to the US dollar.
7. I have __ uncle who lives in __ home for __ elderly. He is __ honest man. He used to be __ FBI agent. He once saved ___ one-year-old boy from __ fire. He has many interesting stories.
a) I have an uncle who lives in a home for the elderly. He is an honest man. He used to be an FBI agent. He once saved a one-year-old boy from a fire. He has many interesting stories.

8. He told me that he once met __ alien from __ space. This alien didn’t need __ oxygen to live; it didn’t have __ nose. That’s _ hard story to believe. I’m not sure he was telling me __ truth. Maybe he isn’t so honest, after all

a) He told me that he once met an alien from space. This alien didn’t need oxygen to live; it didn’t have a nose. That’s a hard story to believe. I’m not sure he was telling me the truth. Maybe he isn’t so honest, after all.
9. When I drive to __ work, usually __ highways are really busy. If there’s __ accident during __ rush hour, it can be __ chaos on the roads

a) When I drive to work, usually the highways are really busy. If there’s an accident during rush hour, it can be chaos on the roads.
10. Today, I have __ job interview at _ financial company. Company has ___ offices all over __ world. I’m not sure that I have __ skills to get hired. I hope so. Company‘s office is on ___ Main Street. That’s ___ same street my friend works on.
a) Today, I have a job interview at a financial company. The company has offices all over the world. I’m not sure that I have the skills to get hired. I hope so. The company‘s office is on Main Street. That’s thesamestreet my friend works on.

[bookmark: scroll-bookmark-601]Don't use 'The' or 'A/An' with
Places where the focus is on the activity which takes place there
I went to X university to take an exam.
The kids were at X school all day.
Continents He travelled across X Asia. Monaco is in X Europe.
Countries X Brazil is the fifth largest country in the world. X Russia is the biggest.
Towns X London is the capital of the UK.
Streets I live in X Oxford street.
Lakes X Lake Titicaca is between Bolivia and Peru.
Mountains I wanted to climb X Mount Everest.
Possessive 's'It's X John's book. X Brazil's economic situation.
All + time expression
I've been waiting all X day. We spent all X week there
TV and most recording mediaI saw it on X TV. I've saved it on X cd-rom
AirportsI arrived at X JFK at 6am. What time do you get in to X Heathrow?
With most countable clothes and parts of the body we use a possessive adjective, not 'the'
He put on his coat and shoes. I hurt my arm playing rugby.(after prepositions we often use 'the') He patted me on the back.



[bookmark: scroll-bookmark-602]Use this flow chart to help you use articles correctly
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[bookmark: scroll-bookmark-603]Indefinite Article – ‘A’ or ‘An’
We use A/An with singular, countable nouns when mentioning them for the first time.They have two children, a boy and a girl.There's a new hospital in the city centre.

We use 'A' before a noun or adjective which begins with a consonant sound.
I'd like a cup of tea. She's got a blue bag.

We use "a or an" to define what kind of person or thing someone or something is.
We use "a or an" with an adjective, or to indicate that it belongs to a particular group.
We use "a or an" to indicate something general/unspecific.
[bookmark: scroll-bookmark-604]‘A’ is used
Before a word (noun or adjective) which begins with a consonant
Example: A woman
Before a singular, countable noun
Example: A banana
When we mention something for the first time
Example: I saw a dog
Before a word with a long sound of ‘u’
Example: A university, a uniform, a useful book, a European
Before the word one
Example: a one-way street, a one-eyed man, a one-year course, a one-day holiday, etc.
[bookmark: scroll-bookmark-605]‘An’ is used
Before a noun which begins with a vowel
Example: an apple
Before a word which begins with a vowel sound or a silent ‘h’
Example: an hour, an honest man, an heir, an honour
Before a singular, countable noun which begins with a vowel or silent ‘h’
Example: an orange
[bookmark: scroll-bookmark-606]Use 'A' or 'An' with
Professions
I'm a teacher. She's an architect.
Some expressions of quantity
A lot of A little A thousand
A few Three times a day
A pair of shoes. Forty miles an hour
Exclamations with What + countable noun
What a lovely day! What a terrible hat!
Don't use A or An with:
Plural nouns Meals
X Children usually go to school. I had X breakfast at 8.30.
Uncountable nouns
Buy X bread and X milk, please.


[bookmark: scroll-bookmark-607]Chunking Content
Break up dense and lengthy text by arranging related content into small chunks. A chunk is a manageable piece of information that can be quickly and easily understood. Chunking helps users navigate the information hierarchy and understand the underlying relationships between elements.

	Guideline 1
Use short sentences that make one or two points and aim for no more than 50–75 characters where possible.



	Guideline 2
Use short paragraphs and ensure that each paragraph makes one main argument where possible.



	Guideline 3
Avoid overly long paragraphs or "walls of text", which can appear intimidating or time-consuming.



	Guideline 4
Use headings, subheadings, and lists to group related items together and reinforce visual hierarchies.



	Guideline 5
Preface large sections with a short summary paragraph to guide users where appropriate.



	Guideline 6
Use information chunks to layer the level of detail provided. Give overview information at a higher level and introduce more detailed content at a deeper level.


[bookmark: scroll-bookmark-608]Commas
Rule 1
Adjectives in a series
•Use a comma with two or more adjectives that are together (coordinate adjectives) without any conjunction and can only if they can be reversed or joined by the conjunction “and”.••Example
The gray, darkening sky caused me to hurry home.

Little Red Riding Hood’s grandmother lived in a little white house.
Rule 2
Compound Sentence
F.A.N.B.O.Y.S
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•Use a comma before FANBOYS when they join two independent clauses.•Example:
John pressed the button, and the engine started.

Rule 3
Introductory Phrase/Words•Use a comma after an introductory phrase.•Example:
When exercising, you need to be aware of your limitations.

Yes, I do like creative writing.

To get to the park, turn right at the corner.

Rule 4
Interrupters•Use a comma when words or phrases interrupt the sentence, and they could be removed and the sentence still makes sense.•Example:
What the minister promised, in fact, is impossible to achieve.

Now then, let’s go back to work.

She wanted to drive the car, too.
Rule 5
Appositives
Use commas to set off an appositive.
Example:
Mr. Walton, my favorite teacher, is retiring this year.

That ladybug, an insect, just landed on the rose bush.

Apposition is a grammatical construction in which two elements, normally noun phrases, are placed side by side, with one element serving to identify the other in a different way.
Rule 6
Direct Address•Use a comma for direct address.•Example:
Mr. Ram, would you please explain the procedure again?
Letter Examples
•Use commas at the end of greetings and closures while writing letters.
Rule 7
Non-Essential Clauses•Use commas to set off non-essential which, who, whom, or that clauses. (clauses that you do not really need)•Example:
The old woman, who lives down the street, drives a red car.

Bananas, which grow in the tropics, do not need refrigeration.
Rule 8
Quoted Elements•Use commas to set off quoted elements.•Example:
She said, “Can I go home?”

“Can I borrow your car,” he said, “mine is in the shop.”•Do not add a comma if the quote ends in a question mark or an exclamation point.•Example:
“What is that?” he asked.

“Watch out!” she screamed.
Summary•Use a comma with two or more adjectives that are together without any conjunction and can only if they can be reversed or “and” put between them.
•Use a comma before FANBOYS when they join two independent clauses.
•Use a comma after an introductory phrase.
•Use a comma when words or phrases interrupt the sentence, and they could be removed and the sentence still makes sense.•Use commas to set off an appositive.••Use a comma for direct address.
•Use commas at the end of greetings and closures while writing letters.••Use commas to set off non-essential clauses.••Use commas to set off quoted elements.
Test Your Understanding

1.Which sentence is correctly written?
A. After the storm ended we went outside to survey the damage.
B. After the storm ended, we went outside, to survey the damage.
C. After the storm ended we went outside, to survey the damage.
D. After the storm ended, we went outside to survey the damage.

2. Which sentence is correctly written?
A. The fire destroyed the garage. The house however was saved.
B. The fire destroyed the garage. The house, however was saved.
C. The fire destroyed the garage. The house however, was saved.
D. The fire destroyed the garage. The house, however, was saved.

3. Which sentence is correctly written?
A.Our new car, is a fast, fuel-efficient vehicle.
B. Our new car is a fast, fuel-efficient vehicle.
C. Our new car, is a fast fuel-efficient vehicle.
D. Our new car is a fast fuel-efficient vehicle.

4. Which sentence is correctly written?
A. The anaconda the biggest snake in the world can weigh up to 250 kilograms.
B. The anaconda, the biggest snake in the world, can weigh up to 250 kilograms.
C. The anaconda, the biggest snake in the world can weigh up to 250 kilograms.
D. The anaconda the biggest snake in the world, can weigh up to 250 kilograms.

5. Which sentence is correctly written?
A. The busy servers took orders, and delivered meals to hungry customers.
B. The busy servers, took orders and delivered meals to hungry customers.
C. The busy servers took orders and delivered meals to hungry customers.
D. The busy servers, took orders and delivered meals, to hungry customers.

Answers to test your understanding

1. Option D is correct.
After the storm ended, we went outside to survey the damage.
Use a comma after an introductory phrase.

2. Option D is correct!
The fire destroyed the garage. The house, however, was saved.
The word, ‘however’, is not essential to the sentence.
Use commas to set off non-essential which, who, whom, or that clauses. (clauses that you do not really need)

3. Option B is correct!
Our new car is a fast, fuel-efficient vehicle.
Use a comma with two or more adjectives that are together without any conjunction.

4. Option B is correct!
The anaconda, the biggest snake in the world, can weigh up to 250 kilograms.
Use commas to set off non-essential which, who, whom, or that clauses. (clauses that you do not really need)

5.Option C is correct!
The busy servers took orders and delivered meals to hungry customers.
No commas required in this sentence.
[bookmark: scroll-bookmark-609]Commas (,)
[bookmark: scroll-bookmark-610]Overview
Of all the punctuation marks in English, the comma is perhaps the most abused and misused one. There are lots of rules about comma usage, and often the factors that determine whether you should use one are quite subtle. Let us learn a few things about the comma today.
[bookmark: scroll-bookmark-611]What is a comma?
· The comma is generally used to separate words or groups of words so that the meaning of the sentence is clear. While a period ends a sentence, a comma indicates a smaller break.
· Some writers think of a comma as a soft pause - a punctuation mark that separates words, clauses, or ideas within a sentence.
· The presence or absence of a comma can change the meaning of a sentence - sometimes dramatically. In extreme cases, an erroneous comma can make a sentence mean the exact opposite of what the writer intended. A careful writer must be a careful user of commas.
[bookmark: scroll-bookmark-612]Lets us see some rules on how, when and where we can use the comma in a right way.
[bookmark: scroll-bookmark-613]1. Comma with Subjects and Verbs

· With few exceptions, a comma should not separate a subject from its verb.
My friend Cleo, is a wonderful singer.

· Writers are often tempted to insert a comma between a subject and verb this way because speakers sometimes pause at that point in a sentence. But in writing, the comma only makes the sentence seem stilted.
My friend Cleo is a wonderful singer.
[bookmark: scroll-bookmark-614]2. Comma Separating a Verb and Its Object


· Don’t separate a transitive verb from its direct object with a comma.
I’m glad I trained, Charlie not to beg for scraps.
I’m glad I trained Charlie not to beg for scraps.
[bookmark: scroll-bookmark-615]3. Comma Between Two Verbs in a Compound Predicate


· You get a compound predicate when the subject of a sentence is doing more than one thing. In a compound predicate that contains two verbs, don’t separate them with a comma.
Cleo will sing, and play the banjo.
Cleo will sing and play the banjo.

· This mistake is most common when the predicate is made up of long verb phrases.

· Don’t use a comma in compound predicates unless there is a chance of misreading.
Cleo spotted the man who entered the diner, and waved.

· 
· In the sentence above, you need the comma to make clear that it was Cleo who waved, not the man.

[bookmark: scroll-bookmark-616]4. Comma Splices


· When you want to join two independent clauses, you need a conjunction or a semicolon. A comma alone isn’t strong enough to join them. This kind of mistake is called a comma splice.
We were out of milk, I went to the store.

· You can fix a comma splice by adding a conjunction or changing the comma to a semicolon.
We were out of milk, so I went to the store.
We were out of milk; I went to the store.

· Or, you can simply write the two independent clauses as separate sentences.
We were out of milk. I went to the store.
[bookmark: scroll-bookmark-617] 5. Comma After Introductory Phrase

· A comma normally follows participial phrases that introduce a sentence.
· When an adverbial phrase begins a sentence, it’s often followed by a comma but it doesn’t have to be, especially if it’s short. As a rule of thumb, if the phrase is longer than about four words, use the comma.
· You can also use a comma with a shorter phrase when you want to emphasize it or add a pause for literary effect.
After the show, Cleo will be signing autographs.
Without knowing why, I crossed the room and looked out the window.


· But, if there is a chance of misreading the sentence, use the comma.
Before eating the family said grace.
Before eating, the family said grace.
[bookmark: scroll-bookmark-618] 6. Comma Within a Comparison

· Don’t use a comma before “than” when you’re making a comparison.
This box is lighter, than that box.
This box is lighter than that box.
[bookmark: scroll-bookmark-619] 7. Comma with a Question Tag

· A question tag is a short phrase or even a single word that is added to the end of a statement to turn it into a question. Writers often use question tags to encourage readers to agree with them. A question tag should be preceded by a comma.
These willow trees are beautiful, aren’t they? You didn’t actually write a 600-page vampire romance novel, did you? I know, right?
[bookmark: scroll-bookmark-620]8. Comma with Direct Address

· When addressing another person by name, set off the name with commas.
Mom, I can’t find my shoes!
Cleo, there’s someone on the phone for you.
Hello, Chester.
[bookmark: scroll-bookmark-621]9. Commas in Dates

· When writing a date in month-day-year format, set off the year with commas.
July 4, 1776, was an important day in American history.I was born on Sunday, May 12, 1968.

· When the month and date are written in the British format, the need for commas is eliminated.
Her arrival on 10 April 1988 was considered a turning point for the company.
Applications are due by 31 December 2016.


· If you are referencing a day of the week and a date, use a comma:
On Tuesday, April 13, at three o’clock, there will be a meeting for all staff.
Please join us on Saturday, June 14, 2010, for the marriage of Annie and Michael.


· When you are referencing only a month and year, you don’t need a comma.
The region experienced record rainfall in March 1999.
[bookmark: scroll-bookmark-622]10. Comma Before And

· When you have a list that contains only two items, don’t use a comma before the and.
My dog Charlie is cute, and smart.
My dog Charlie is cute and smart.
[bookmark: scroll-bookmark-623]11. Comma Before But

· Use a comma before the word but if it is joining two independent clauses:
Cleo is a good singer but she’s an even better dancer.
Cleo is a good singer, but she’s an even better dancer.


· If but is not joining two independent clauses, leave the comma out.
My teacher is tough, but fair.
My teacher is tough but fair.
[bookmark: scroll-bookmark-624]12. Commas with Lists

· When you have a list that contains only two items, don’t use a comma before the and.
Cleo’s favorite activities are singing on stage, and relaxing in the sunshine.
Cleo’s favorite activities are singing on stage and relaxing in the sunshine.
[bookmark: scroll-bookmark-625] Exercises

· The things that cause me joy, may also cause me pain.
The things that cause me joy may also cause me pain.

· Navigating through snow, sleet, wind, and darkness is a miserable way to travel.
Navigating through snow, sleet, wind, and darkness is a miserable way to travel.

· Mary said, she likes chocolate.
Mary said she likes chocolate.

· I meant to buy tickets for Cleo’s show, but ran out of time.
I meant to buy tickets for Cleo’s show but ran out of time.

· We were out of food, I went to the restaurant.
We were out of food, so I went to the restaurant.We were out of food; I went to the restaurant.We were out of food. I went to the restaurant.

· In 1816 life was very different. Suddenly an angry black cat sprang from the shadows.
In 1816 life was very different. Suddenly, an angry black cat sprang from the shadows.

· Hardcover books are more expensive, than paperback books.
Hardcover books are more expensive than paperback books.

· Jill who is my sister shut the door.
Jill, who is my sister, shut the door.

· The July10, 2011, meeting was canceled due to a hurricane watch.
The meeting scheduled for July 10, 2011, was canceled due to a hurricane watch.

· The store closed its doors for good in October 1958.
The store closed its doors for good inOctober,1958.

· My teacher is tough, but fair.
My teacher is tough but fair.

· Cleo’s favorite activities are dancing on stage, and walking in the park.
Cleo’s favorite activities are dancing on stage and walking in the park.

· Life is but a dream.
Life is, but a dream.

· Grabbing her umbrella Kate raced out of the house. Confused by her sister’s sudden change in mood Jill stayed quiet.
Grabbing her umbrella, Kate raced out of the house. Confused by her sister’s sudden change in mood, Jill stayed quiet.

[bookmark: scroll-bookmark-626]An Example of how a misplaced comma can cause huge loss to a company.
[image: ]

Please find the below links to know more about commas.
https://www.grammarly.com/blog/comma/http://www.thepunctuationguide.com/comma.html

http://www.thepunctuationguide.com/comma.html#dates

http://www.grammarbook.com/punctuation/commas.asp








[bookmark: scroll-bookmark-627]Where not to use commas?
[bookmark: scroll-bookmark-628]Overview
Commas as a whole are useful; they are grammatical tools that allow you to keep your intended meaning clear. When you use them correctly, you guide your readers to understand your words in the right way, preserving your ideas with the right separations, or pauses.
When commas are misused, whether it is overuse or under use, you run the risk of confusing, irritating and frustrating your readers because your sentences are chopped into too many pieces. In some cases, you are unintentionally misinforming readers as well.

Let us see some rules on where not to use commas.
[bookmark: scroll-bookmark-629]1. In front of “that”
· In most cases, a comma preceding a clause including “that” is incorrect. Avoid making this common mistake because “that” is usually used to introduce an essential clause, making the clause necessary for the sentence to retain its meaning.
The dress, that she wore to the wedding was beautiful.
The dress that she wore to the wedding was beautiful.
[bookmark: scroll-bookmark-630]2. Compound Subject
· Do not use a comma to separate two subjects doing the same thing.
John, and Peter wanted to play football.
John and Peter wanted to play football.
[bookmark: scroll-bookmark-631]3. To separate the predicate
· Do not use a comma to separate the subject from the predicate.
Richard, was happy to win the award.
Richard was happy to win the award.
[bookmark: scroll-bookmark-632]4. To separate adjectives
· Do not use commas to separate adjectives from the words they modify.
Michael loved his squishy, teddy bear.
Michael loved his squishy teddy bear.
[bookmark: scroll-bookmark-633]5. Separating correlated pairs
· Do not use a comma when the second part of the sentence pairs with the information in the first part through correlation.
Her new car is sporty looking, and creates a distinguished look.
Her new car is sporty looking and creates a distinguished look.
[bookmark: scroll-bookmark-634]6. To introduce restrictive modifiers
· Do not use commas to introduce restrictive (i.e., necessary) modifiers.
The fingers, on the left hand, are bigger than those on the right.
The fingers on the left hand are bigger than those on the right.
[bookmark: scroll-bookmark-635]7. Before the first or after the last item in a series
· Do not use commas before the first or after the last item in a series.
They ate, steak, lobster, chicken, and candy bars, for breakfast.
They ate steak, lobster, chicken, and candy bars for breakfast.
[bookmark: scroll-bookmark-636]8. Separating a verb from its subject
· Never separate a subject from its verb; this creates a disjointed sentence with an unnecessary pause and is grammatically incorrect as well.
One of the smartest things a writer can do, is learn how to use commas correctly.
One of the smartest things a writer can do is learn how to use commas correctly.
[bookmark: scroll-bookmark-637]9. Separating verbs
· Sometimes verbs are used in multiple locations in a sentence. When this occurs, you should not separate them with a comma.
She jogged for 30 minutes, and walked for 20 minutes.
She jogged for 30 minutes and walked for 20 minutes.
[bookmark: scroll-bookmark-638]10. After a coordinating conjunction
· Do not misuse a comma after a coordinating conjunction.
Sleet fell heavily on the tin roof but, the family was used to the noise and paid it no attention.
Sleet fell heavily on the tin roof, but the family was used to the noise and paid it no attention.
[bookmark: scroll-bookmark-639]11. After a short introductory prepositional phrase
· Do not use a comma after a short introductory prepositional phrase unless you mean to add extra emphasis.
Before the parade, I want to eat pizza.
Before the parade I want to eat pizza.
[bookmark: scroll-bookmark-640]12. To set off quotations that occupy a subordinate position in a sentence
· Do not use a comma to set off quotations that occupy a subordinate position in a sentence, often signalled by the words "that," "which," or "because."
Participating in a democracy takes a strong stomach because, "it requires a certain relish for confusion," writes Molly Ivins.
Participating in a democracy takes a strong stomach because "it requires a certain relish for confusion," writes Molly Ivins.
[bookmark: scroll-bookmark-641]13. When subordinate clause follows the independent clause
· Do not use a comma if the subordinate clause follows the independent clause in a sentence.
The traffic was held up, because the minister’s cavalcade was on its way to the airport to receive the President.
The traffic was held up because the minister’s cavalcade was on its way to the airport to receive the President.
[bookmark: scroll-bookmark-642]14. To separate two independent clauses
· Do not use a comma to separate two independent clauses. That would result in a comma splice.
The stakes were high in the political game, she played to win.
The stakes were high in the political game; she played to win.
The stakes were high in the political game. She played to win.
[bookmark: scroll-bookmark-643]15. When the date and year are not written next to each other
· Do not use a comma if the date and year are not written next to each other.
The Indian Constitution came into effect on 26 January, 1950.
The Indian Constitution came into effect on 26 January 1950.
[bookmark: scroll-bookmark-644]Exercises
· The colors, that were used to decorate the reception hall, were well-matched.
The colors that were used to decorate the reception hall were well-matched.
· Hoping to become famous, Liza, and Burt ran to the newspaper office.
Hoping to become famous, Liza and Burt ran to the newspaper office.
· What Belle wanted to do, was save the beast.
What Belle wanted to do was save the beast.
· The bright, beautiful, star drew everyone’s attention when night fell.
The bright, beautiful star drew everyone’s attention when night fell.
· The article is not only a masterpiece of the written word but also grammatically sound.
The article is not only a masterpiece of the written word but also grammatically sound.
· The future of print newspapers appears uncertain due to rising production costs and the increasing popularity of online news sources.
The future of print newspapers appears uncertain due to rising production costs and the increasing popularity of online news sources.
· Morgan, Pat, and John, ran for their cars at the news.
Morgan, Pat, and John ran for their cars at the news.
· Write to the program advisor at 5th Street, Minerton, Indiana 55555.
Write to the program advisor at 5th Street, Minerton, Indiana 55555.
· Every day, millions of children go to day-care with millions of other kids, there is no guarantee that none of them are harbouring infectious conditions.
Every day, millions of children go to day-care with millions of other kids. There is no guarantee that none of them are harbouring infectious conditions.

Please find the below links to know more about commas.
http://theeditorsblog.net/2011/01/13/finding-commas-in-all-the-wrong-places/


http://www.write.com/writing-guides/general-writing/punctuation/mastering-the-art-of-comma-usage/commas-misuse-of-commas/


https://www.boundless.com/writing/textbooks/boundless-writing-textbook/overview-of-english-grammar-punctuation-and-mechanics-251/commas-31/common-comma-mistakes-139-10368/

[bookmark: scroll-bookmark-645]Common Mistakes
Actual Fact / Actually
Actual fact is an unnecessary extension of actually. Avoid.
Example: In actual fact, I do not much care for brownies.
Actually is the recommended usage.
Example: Actually, I do not much care for brownies.
Advise / Advice
Advice is a noun.
Example: It is up to you to take your doctor’s advice.
Advise is a verb.
Example: The doctor advised him to exercise regularly.
Affect /Effect
Affect means to have an impact upon. It is a verb.
Example: These changes to the application do not affect online help.
Effect means a phenomenon that is caused by something. It is a noun.
Example: The effect of these changes is far reaching.
Alot / A lot
Despite being used widely, "alot" is not a word. A lot is the correct spelling.
Exercise:
Ram likes you alot.
Ram likes you a lot.
Answer:
Ram likes you a lot.
All Ready /Already
All ready means to be completely prepared.
Example: I am all ready to take the test.
Already refers to something that has happened some time ago.
Example: She has already finished her assignment.
Alright / All Right
Alright is a nonstandard variant of all right. The word has never been accepted as standard. Avoid.
All right is the accepted spelling.
Example: I guess I am feeling all right now.
Alternate /Alternative
Alternate means every other.
Example: Our club meets on alternate Sundays.
Alternate rows on the screen are in blue.
Alternative means substitute.
Example: We need to have an alternative plan.
Of the three alternatives, I vote for the second.
Anyway / Anyways / Any way
Anyway is an adverb, and it means "regardless" or "in any event": Penelope never completes her homework assignments, but she expects to go to college anyway. Any way is a phrase meaning "any particular course, direction, or manner“. "Anyways" is a nonstandard form to be avoided by careful speakers and writers.
Exercise:
Who reads my paper anyways?
Who reads my paper anyway?
Our dog tries to get out of his pen any way he can.
Our dog tries to get out of his pen anyway he can.
Answers:
Who reads my paper anyway?
Our dog tries to get out of his pen any way he can.
Awhile / A while
Awhile is an adverb that means "for a while." Because awhile means "for a while," to say for awhile is like saying "for for a while.” A while is a noun phrase that means “a period of time” and takes a preposition, such as for or in before it; for example, I will call you in a while, I will be home for a while.
Exercise:
I'll be staying in Paris for awhile.
I'll be staying in Paris for a while.
I'll be staying in Paris awhile.
I will call you in a while.
I will call you in awhile
Answers:
I'll be staying in Paris for a while.
I'll be staying in Paris awhile.
I will call you in a while.
Beside / Besides
Beside means next to, or by the side of.
Example: I was happy to sit beside my friend in class.
Besides means apart from, or other than.
Example: Besides cricket, I like to play tennis and golf.
Between / Among
Between is used for two people or objects.
Example: My brother and I shared the expenses between us.
Among is used for more than two people or objects.
Example: Expenses were shared among all the friends.
Complement / Compliment
Complement, most frequently used as a verb, means "to complete." Compliment, used as a verb, means "to make a courteous remark." As a noun, it means "a courteous remark."
For example: She complimented his singing. Sallie has difficulty accepting compliments.
Exercise:
I want to complement you on your writing style.
I want to compliment you on your writing style.
The illustrations complement the text.
The illustrations compliment the text.
The drums were a perfect compliment to their dancing style.
The drums were a perfect complement to their dancing style.
The jade and silver cuff-links complement the green tie.
The jade and silver cuff-links compliment the green tie.
Answers:
I want to compliment you on your writing style.
The illustrations complement the text.
The drums were a perfect complement to their dancing style.
The jade and silver cuff-links complement the green tie.
Compose / Comprise
Comprise does not take an ‘of’ after it.
Example: The new feature comprises the following functions.
Compose takes an ‘of’ after it.
Example: Alloys are composed of two or more materials in varying proportions.
Fewer / Less
Fewer means not so many and is used with countable plural nouns.
Example: I have fewer responsibilities in the present job.
Less means not so much and is used with uncountable nouns.
Example: The crowd is less enthusiastic today.
Imply / Infer
The verb imply means to suggest a meaning. The person who implies something hints at it without saying it directly. The verb infer means to take meaning from. The person who infers draws a conclusion by interpreting words or actions. For example: Because you are always late, I infer that you don't want to work here.
Exercise:
His use of that word infers that he doesn't trust you.
His use of that word implies that he doesn't trust you.
You can infer the meaning.
You can imply the meaning.
Answers:
His use of that word implies that he doesn't trust you.
You can infer the meaning.
Its / It's
It’s is the short form of ‘it is’.
Example: It’s a cold day.
Its is the possessive pronoun form of ‘it’.
Example: The dog buried its bone.
Lose / Loose
Lose means to fail to win or not to be able to find something.
Example: With this attitude, you are sure to lose the game.
I do not want to lose my honor.
Loose means ill-fitting.
Example: These trousers are loose for me.
Tie the noose loosely around the animal’s neck.
Me / I
Me is the object form of the pronoun I. It should never be used as the subject of a verb. The same applies to the other object pronoun forms him, her, us, and them.
Exercise:
Me and Jamie are going to Mexico.
Jamie and I are going to Mexico.
Jamie and me are going to Mexico.
Answer:
Jamie and I are going to Mexico.
Myself / I
Myself is a pronoun whose function is to restate the subject I: I cut myself shaving. Sometimes I talk to myself as I work. I couldn't have believed it myself. It is never correct to use myself as the subject of a verb, or anywhere in a sentence in which I is not the subject.
Exercise:
Sophie and myself volunteer three days a month at the homeless shelter.
Sophie and I volunteer three days a month at the homeless shelter.
Answer:
Sophie and I volunteer three days a month at the homeless shelter.
Only
Only John eats fish on Friday. This sentence implies that only John eats fish on Fridays and no one else.
John only eats fish on Friday. This sentence implies that John only eats fish on Fridays and does nothing else.
John eats only fish on Friday. This sentence implies that John eats only fish and nothing else on Fridays.
John eats fish only on Friday. This sentence implies that John eats fish only on Fridays and on no other day of the week.
John eats fish on Friday only. This sentence implies that John eats fish only on Fridays and on no other day of the week.
That / Which
That – Restrictive clause (One which is essential to the meaning of a sentence-if it is removed, the meaning of the sentence will change).
Which – Non-restrictive or parenthetical clause (Can be left out without changing the meaning of a sentence. These are either in brackets or have a comma before and after them, or only before them if they come at the end of a sentence.)
Some tricks:
If removing the words that follow would change the meaning of the sentence use that otherwise which is fine.
If the sentence does not need the clause that the word in question(that or which) is connecting, use which.
Exercise:
Chairs that do not have cushions are uncomfortable to sit on.
Chairs which do not have cushions are uncomfortable to sit on.
Chairs, that are found in many places of work, are often uncomfortable to sit on.
Chairs, which are found in many places of work, are often uncomfortable to sit on.
I sat on an uncomfortable chair, which was in my office.
I sat on an uncomfortable chair, that was in my office.
My car that is red goes very fast.
My car, which is red, goes very fast.
Who ate the cake that I bought this morning?
Who ate the cake which I bought this morning?
Answers:
Chairs that do not have cushions are uncomfortable to sit on.
Chairs, which are found in many places of work, are often uncomfortable to sit on.
I sat on an uncomfortable chair, which was in my office.
My car, which is red, goes very fast.
Who ate the cake that I bought this morning?
[bookmark: scroll-bookmark-646]Compound Words
Compound words are made up of two or more smaller words that are combined to make a new word with its own meaning.
Examples:
work + station = workstation
style + sheet = style sheet
two + dimensional = two-dimensional
[bookmark: scroll-bookmark-647]Types of compound words
· Closed compound words
· Open compound words
· Hyphenated compound words
[bookmark: scroll-bookmark-648]Closed compound words
Closed compound words are made up of two words without a space between them.
Examples:
Progress is monitored daily and stored in a data base.
Progress is monitored daily and stored in a database.

His family still holds the copyright to his songs.

She went on-line and found some listings, but none were close enough to commute.
She went online and found some listings, but none were close enough to commute.

flowchart viewpoint shutdown cutouts
keyboard rollout proofread headset
metadata offline postpaid preprocess
[bookmark: scroll-bookmark-649]Open compound words
Open compound words have a space between the words that make them up. Even though the words seem separate, when you read them together they have a new meaning.
Examples:
check box
Web page
class name
help desk
end user
[bookmark: scroll-bookmark-650]Hyphenated compound words
Hyphenated compound words are formed by using a hyphen in between the words.
Examples:
self-discipline right-click real-time
editor-in-chief voice-over account-specific
add-ons on-site e-mail
dial-up drop-down pop-up

Sometimes knowing when to write compounds as closed, or open, or hyphenated compound is difficult. That is because compounds can function as different parts of speech.
For example, when used as a verb, backup is written as open compound.
Did you back up your computer files?
When used as a noun, backup is written as a closed compound.
The police officer called for backup.
When used as an adjective, backup is a closed compound.
What is your backup plan for tomorrow evening?

Whether a compound word is closed, open or hyphenated may depend on whether it is used as a noun, adjective or verb.
· Verbs are usually open.
break out build up fail over

· Adjectives and nouns are usually closed or hyphenated.
breakout buildup front-end
login off-site failover
[bookmark: scroll-bookmark-651]When to Hyphenate 

· When compounded modifiers precede a noun, they are often hyphenated.

· Examples:
fifty-yard-wide field
fire-resistant curtains
part-time teacher

· When modifying a person with his or her age, the compounded phrase is hyphenated.
· Examples:
My six-year-old son.
A twenty-two-year-old cyclist won the race.

· When words are difficult to recognize as compounds and could be confusing.

· Example:
The Government promise to reform the health system. (improve)
The band has decided to re-form. (form again)

· When the pre-head item in a compound is a single capital letter.
· Examples:
U-turn
X-ray
D-day
T-shirt

· When writing compound numbers and fractions.

· Examples:
forty-six
sixty-three
One-third
two-fifths

· When compounds consist of more than one word.
· Examples:
non-English-speaking
pre-Civil War
grant-in-aid
state-of-the-art

· Use a hyphen:
–with the prefixes ex- (meaning former), self-, all-–with the suffix -elect–between a prefix and a capitalized word or a number.
· Examples:
ex-husband self-assured all-inclusive
mayor-elect anti-American mid-September
mid-1980s

· Comparative and superlative forms of adjectives are hyphenated when compounded with other modifiers.

· Examples:
the shorter-term loanthe highest-priced car
· The following kinds of compound adjectives almost always need to be hyphenated.
–Noun + adjective (tax-exempt)–Noun + participle ( government-owned)–Adjective + participle (friendly-looking)–Adjective + noun + ed (high-priced)
[bookmark: scroll-bookmark-652]When not to Hyphenate 

· When compound words come after the noun, they are not hyphenated.

· Examples:
a field fifty yards wide
curtains that are fire resistant
a teacher who works part time

· Never hyphenate -ly adverbs.
· Examples:
a partially refunded ticket
publicly held securities
largely irrelevant
newly formed

· Some compounds created by the addition of a prefix are not hyphenated.
· Examples:
antisocial coordinate extraordinary
infrastructure interrelated multicultural
nonviolent preconference socioeconomic
transatlantic unnatural underdeveloped

Other tricky compounds:
· Never mind – correct
Nevermind – not a word
· A lot – correct
Alot – incorrect
Allot – to give or apportion
· All together – as a group
Altogether – entirely
· Every day – duration or time
Everyday – noun or adjective
· All right – use this
Alright – non-standard and therefor not entirely proper
The rules for compound words can be a bit ambiguous at times. When in doubt about a compound word, look it up in a dictionary or style manual. If the answer is still unclear, use your own judgment. However, be consistent throughout the document.
[bookmark: scroll-bookmark-653]Test Your Understanding
Identify the compound words and correct them if necessary.
1. We sent in heavily-fortified troops.
We sent in heavily fortified troops.

2. The committee centers all of its recommendations in performance based standards.The committee centers all of its recommendations in performance-based standards.
3. Long term planning must be an essential goal of this company.Long-term planning must be an essential goal of this company.
4. The upside down poster announced a free concert in the park.The upside-down poster announced a free concert in the park.
5. The South-American rain forest is home to hundreds of species of hummingbirds.The South American rain forest is home to hundreds of species of hummingbirds.
6. That man is well-respected.That man is well respected.
7. The money from that line item will carryover to next year's budget.The money from that line item will carry over to next year's budget.
8. The bluish grey was slowly disappearing from the bluish grey sky.The bluish grey was slowly disappearing from the bluish-grey sky.
9. Follow up activities have been scheduled for June and July.Follow-up activities have been scheduled for June and July.
10. Does anyone have a telephone I can use?Does anyone have a telephone I can use?
11. My favorite football player scored a touchdown in the fourth quarter.My favorite football player scored a touchdown in the fourth quarter.

[bookmark: scroll-bookmark-654]Reference: 

· https://www.merriam-webster.com/dictionary/

· http://grammar.ccc.commnet.edu/grammar/compounds.htm

· http://www.grammarbook.com/punctuation/hyphens.asp

· https://www.grammarly.com/blog/open-and-closed-compound-words/












[bookmark: scroll-bookmark-655]Conjunctions
In English grammar, a conjunction is used to connect words, phrases, or clauses. A conjunction is also called a conjunct or a joiner.
[bookmark: scroll-bookmark-656]Types of Conjunctions
Conjunctions are broadly classified into three categories:
1. Coordinating conjunctions
2. Subordinating conjunctions
3. Correlative conjunctions.
[bookmark: scroll-bookmark-657]Coordinating Conjunctions
Among the three types of conjunctions, coordinating conjunctions are commonly used to connect words, phrases, or clauses. There are seven coordinating conjunctions.
You can use the mnemonic FANBOYS to remember them.
· For
· And
· Nor
· But
· Or
· Yet
· So
Examples:
· They do not gamble or smoke, for they are ascetics.
· They gamble, and they smoke.
· They do not gamble, nor do they smoke.
· They gamble, but they do not smoke.
· Every day they gamble, or they smoke.
· They gamble, yet they do not smoke.
· He gambled well last night, so he smoked a cigar to celebrate.
[bookmark: scroll-bookmark-658]Subordinating Conjunctions
Subordinating conjunctions are used to join an independent clause (main clause) with a dependent clause.
A dependent clause relies on the main clause for meaning and relevance. It cannot exist on its own, and often does not make sense without the main clause.
Frequently used subordinating conjunctions are: while, as soon as, although, before, even if, because, whether, wherever, when, until, after, as if, how, if, provided, once, while, unless, in case, as far as, as, so that, though, since, etc.
The subordinating conjunction must always be placed before the dependent clause.
Examples:
· Because they had misbehaved, the boys were suspended from school.
· If you leave me now, you will take away the biggest part of me.
· We are never going to survive unless we get a little crazy.
· You do not know what you have until it is gone.
[bookmark: scroll-bookmark-659]Correlative Conjunctions
Correlative conjunctions are pairs of conjunctions that are used to join sentence elements together.
Frequently used correlative conjunctions are: either… or, neither… nor, not only… but also, both… and, Whether… or, etc.
Examples:
· Both my brother and my father are lawyers.
· Clara not only wants money but also wants fame.
· Jerry is neither rich nor famous.
[bookmark: scroll-bookmark-660]Comma Rules in Conjunctions
1. Use commas to separate independent clauses when they are joined by any of the seven coordinating conjunctions: and, but, for, or, nor, so, yet.
2. Use commas to separate three or more words, phrases, or clauses written in a series.
3. Do not use a comma after the main clause when an dependent clause follows it (except for cases of extreme contrast).
4. Use a comma between clauses when a dependent clause is placed first in a sentence.
5. Do not use a comma to separate clauses when an independent clause is placed first in a sentence, and it is followed by a dependent clause.
[bookmark: scroll-bookmark-661]Effective Emails
To make emailing, the ubiquitous mode of communication in the corporate world, effective, some guidelines in the form of dos and don'ts should be followed.
[bookmark: scroll-bookmark-662]Dos and Don'ts of Writing Emails
[bookmark: scroll-bookmark-663]Dos
· Provide an intuitive and clear subject line, such as Weekly Status Report – 6th to 10th Feb 2017, Vacation Leave Application – 24th Feb 2017, New Document Version for Reports Engine, [Project Name]
· Tag the email with its level of importance if necessary, especially when seeking a quick response.
· Know your audience/readers.
· Use inline comments/responses. Distinguish between the excerpt and your response by using another color, your name, or any other inoffensive and easily understandable style.
· Keep your information to-the-point and cut out the flab.
· Place your action items at the start.
· If the request is urgent and there's a deadline to be met, say so explicitly.
· Make your questions specific.
· Mention a date by when you would be able to respond to an email if you are unable to do right then.
· Maintain the continuity of a single topic thread; for any new discussion, start a fresh email chain.
· Keep the spellcheck option turned on in Outlook.
· Keep the tone of the email formal or casual depending on your relationship with the receiver and the purpose of the email.
· Use complete and grammatically correct sentences.
· Read your email all over again from the receiver’s perspective before clicking Send.
· End the email with the normal courtesies. Unless the email thread becomes more like a chat, end it with your name.
· Use OOO responses if you are going to be out of office and unable to respond to emails.
[bookmark: scroll-bookmark-664]Don'ts
· Don’t assume that your email will be read immediately or responded to promptly. Give the receiver adequate time to respond. To do so, don’t send last-minute emails.
· Do not use capital letters or bold font.
· Do not click Reply All unless everyone really needs to be on the email thread.
· Do not send emails in anger or in haste. Both can land you in trouble causing you to regret your action.
[bookmark: scroll-bookmark-665]Dos and Don'ts of Presenting Work Status via Emails
When presenting work status, it would help to keep a few things in mind.
[bookmark: scroll-bookmark-666]Dos
· Be consistent in presenting the status. Leave no room for ambiguity.
· Use parallelism.
· Provide additional information about your project, the project manager, the components affected, etc. only if you are sending the status to a person who is unfamiliar with your work/assignments. Such information would be irrelevant when sending a status report to your line manager or project manager.
· For status emails, it is best to use a tabular format providing clear information on the tasks at hand and their status along with essential dates.
· For a weekly report, provide the subject line as Weekly Status Report along with the From and To dates.
· Enter details of the tasks as suggested in the shared table at the end of this presentation.
· Use an introductory sentence before a table that is crisp but not vague.
· When adding ticket numbers, use hyperlinks.
· Avoid unnecessary words that do not add value to the sentences. At the same time, leave no room for ambiguity. If you think the reader will have difficulty in understanding what you are referring to, use more precise words.
· Add a line or two for planned activities for the next week, if necessary.
· Ensure correctness of language and spelling in a status email. There are no excuses for missed words, spelling errors, or grammatical errors.

[bookmark: scroll-bookmark-667]Don'ts
· Do not write a status email in haste at the end of the day. Start the email early in the week, and add the status daily. Send the email only once a week.
· Do not end the introductory sentence before a table with a colon. End it with a period.
· Do not use non-standard terms, such as “works”. Use “tasks” or “assignments” instead.
· Do not change the tone and format of the email midway.
· Do not add too many details to the status report. Keep it crisp.
Figure 7 Weekly Status Report
[image: ]
[bookmark: scroll-bookmark-668]Homographs/Homophones/ Homonyms
[bookmark: scroll-bookmark-669]Homograph
· A homograph is a word that has the same spelling as another word but has a different sound and a different meaning

· It comes from Greek words, ‘homo’ meaning ‘same’ and ‘graph’ meaning ‘writing’.

· lead (to go in front of)/lead (a metal)
· wind (to follow a course that is not straight)/wind (a gust of air)
· Tear( tears in the eye)/ tear( tear into two)
[bookmark: scroll-bookmark-670]Homophone
· A homophone is a word that has the same sound as another word but a different meaning.
· It comes from Greek words, ‘homo’ meaning ‘same’ and ‘phone’ meaning ‘voice’.
· They may be spelled same or different.

· Eight/ate
· Its/It's
· Pray/Prey
· Stationary/Stationery
[bookmark: scroll-bookmark-671]Homonyms
· Homonyms are words that have the same spellings and same sound but different meanings.
· It comes from Greek words, ‘homo’ meaning ‘same’ and ‘nym’ meaning ‘name’.
· Pen(the writing instrument)/ Pen(enclosure for an animal)
· bark (a tree’s out layer)/bark (the sound a dog makes)
· lie (to recline)/lie (to tell a falsehood)
· spring (a season)/spring (coiled metal)
· match (to pair like items)/match (a stick for making a flame)
[bookmark: scroll-bookmark-672]Parallelism
[bookmark: scroll-bookmark-673]What is Parallelism?
· Parallelism refers to matching grammatical structures in sentences.
· Parallelism = Balance. For example, balance a noun with a noun, a phrase with a phrase, a clause with a clause.
· Elements in a sentence that have the same function or express similar ideas should be grammatically parallel or grammatically matched.
Example: Tobacco should be outlawed because it endangers everyone’s health, pollutes the environment, and drains us of valuable energy.
[bookmark: scroll-bookmark-674]Parallelism is used to:
· Coordinate elements in a series.
· Connect ideas.
· Enhance coherence.
· Organize lists.
[bookmark: scroll-bookmark-675]Parallelism with Words
· Not parallel: Good writing requires you to plan outlines, write several drafts, and revision.
· Parallel: Good writing requires you to plan outlines, write several drafts, and revise your work.
· Not parallel: This proposal is profitable, timely, and it helps us.
· Parallel: This proposal is profitable, timely, and helpful.
[bookmark: scroll-bookmark-676]Parallelism in Lists
· Not parallel: I left my job for several reasons:
· The pay was poor
· Long hours
· I found the work tedious
· Equipment was dangerous
· Parallel: I left my job for the following reasons:
· Poor pay
· Long hours
· Tedious work
· Dangerous equipment
[bookmark: scroll-bookmark-677]Parallelism in Series
· Not parallel: We need a plumber, plasterer, and someone to paint.
· Parallel: We need a plumber, plasterer, and painter.
· Not parallel: Our vacation included camping, canoeing, and to watch birds.
· Parallel: Our vacation included camping, canoeing, and bird-watching.
[bookmark: scroll-bookmark-678]Important Rules
1. When the prepositions used for the different ideas presented in the sentence are different, do not skip them.
· The train leaves the station in the morning and noon. (Incorrect)
· The train leaves the station in the morning and at noon. (Correct)
2. If the preposition or article is same for all the items in the list, either repeat it for all items or use it only once.
· We went to the market, to a restaurant, and to the movies.
· We went to the market, a restaurant, and the movies.
· The document deliverables for version 6.0 include the Administration Guide, the User Guide, and the Release Notes.
· The document deliverables for version 6.0 include the Administration Guide, User Guide, and Release Notes.
3. When using a correlative expression.
· Both… and…
· Sales have risen both in India and China. (Incorrect)
· Sales have risen both in India and in China. (Correct)
· Sales have risen in both India and China. (Advisable)
· Neither… nor…
· Neither can you write correctly nor legibly. (Incorrect)
· Neither can you write correctly nor can you write legibly. (Correct but repetitive)
· You can write neither correctly nor legibly. (Advisable)
· Either… or…
· Either you must grant his request or incur his ill will. (Incorrect)
· Either you must grant his request or you must incur his ill will. (Correct but repetitive)
· You must either grant his request or incur his ill will. (Advisable)
4. When making comparisons, the compared items must have parallel structure.

· My income is more than my husband. (Incorrect)
· My income is more than my husband’s. (Correct)
· The photos in our brochure must look as good as their brochure. (Incorrect)
· The photos in our brochure must look as good as those in their brochure. (Correct)
· The condition of the new building is not any better than the old one. (Incorrect)
· The condition of the new building is not any better than that of the old one. (Correct)
[bookmark: scroll-bookmark-679]Quiz
1. Choose the right sentence.
a. The teacher came into the room, he paused before the class, and began the lesson.
b. The teacher came into the room, paused before the class, and began the lesson.
c. The teacher came into the room, he paused before the class, and decided to begin the lesson.
d. The teacher came into the room, he paused before the class, and beginning the lesson.
2. Choose the right sentence.
a. Her choices were one, to begin college, or two, to find a job.
b. Her choices were one, begin college, or two, be an employee.
c. Her choices were one, begin college, or two, that she find a job.
d. Her choices were one, beginning college, or two, find a job.
3. Correct the following sentences.
a. The car needs to be tuned up, air in the tires, and the oil needs to be changed.
b. The contamination of air continues, and it threatens not only the comfort but the existence of the earth’s inhabitants.
c. The cancer researcher is interested and excited about the new advancements in medical technology.
d. A big car is not necessarily better than one that is small.
e. Either ask Ben or Marianne to prepare the agenda for tonight's meeting.
4. Fill in the blank.
Pasta boiling in water, __________, and garlic bread baking in the oven welcomed Francisco as he opened the door.
a.simmered tomato sauce in the panb.tomato sauce simmering in the panc.tomato sauce that simmered in the pand.saucy tomatoes that were simmering in the pan
Answer 1. b. The teacher came into the room, paused before the class, and began the lesson.
Answer 2. a. Her choices were one, to begin college, or two, to find a job.Answers 3.a.The car needs a tune-up, air in the tires, and an oil change.b.The contamination of air continues, and it threatens not only the comfort but also the existence of the earth’s inhabitants.c. The cancer researcher is interested in and excited about the new advancements in medical technology.d. A big car is not necessarily better than a small one.e. Ask either Ben or Marianne to prepare the agenda for tonight's meeting.e. Either ask Ben or ask Marianne to prepare the agenda for tonight's meeting.Answer 4. b. tomato sauce simmering in the pan
[bookmark: scroll-bookmark-680]Prepositions
Prepositions are words that show the relationship between a noun or a pronoun and some other word in the sentence. There are about 150 prepositions in English. They are often called the “biggest little words” in English, because they are generally small words but they serve very important functions.
Prepositions of Comparison

Prepositions of comparison help us to separate, or distinguish, between two or more ideas, people, things, and so on.
AFTER = similar or comparable to

This artist’s work is after the style of the cubists' movement.

AGAINST = A. contrasting with B. compared with

A. That picture would look better against a dark background.
B. Look at this schedule against last year’s; it was so much better last year.
BELOW = less, or fewer, than

That shop is going out of business; they are selling things below cost.

BESIDE = compared with

Beside her sister, she's not the least bit talented.

BETWEEN = differentiating

He can't tell the difference between blue and green because he's color-blind.
LIKE = similar to

You've gotten so tanned, you look like an Egyptian.

NEAR = approaching / similar to

No one can come near him when it comes to Math.

OVER = more than, a greater number or amount, than

He's got over ten thousand coins in his collection.
UNDER = less, or fewer, than

The Communist Party got under a thousand votes in the election.

UNLIKE = not similar to

That puppy looks unlike either of its parents.
[bookmark: scroll-bookmark-681]Exercise:
1. This artist's work is after the great masters of the Renaissance.
2. We feed over three thousand pupils every day at lunchtime.
3. Unlike you, I did my homework for all of our classes.
4. You were fooled again? No one comes near your naivety.
5. Beside great poets, your work is not that bad.
6. Some children have difficulties learning the difference between right and left.
7. You won't pass if you get under 65% on your exam.
8. Against last year's numbers, we are doing much better this year.
9. He won the race easily: no one was even near him.
10. With that long hair, he looked like a woman.
[bookmark: scroll-bookmark-682]Pronouns
A pronoun takes the place of a noun in a sentence. They avoid the repeat of nouns being used.
Example:Thomas Jefferson was the third President of the United States. He said, “I’m a great believer in luck, and I find that the harder I work, the more I have of it.”
[bookmark: scroll-bookmark-683]Types of Pronouns
The different types of pronouns with a few of their examples are listed in the table below:
	Type of Pronoun
	ExamplesExamples

	Personal
	I/ you/ they

	Possessive
	mine/ yours/ theirs

	Demonstrative
	this/that/those

	Interrogative
	whose/ what/ where

	Reciprocal
	each other/ one another

	Relative
	who/ which/ that

	Indefinite
	everybody/ anybody/ somebody

	Intensive
	myself/ themselves


[bookmark: scroll-bookmark-684]Personal Pronouns
A different pronoun is required depending on two elements: the noun being replaced and the function that noun has in the sentence. Subject pronouns replace nouns that are the subject of their clause. Object pronouns are used to replace nouns that are the direct or indirect object of a clause.
Personal pronouns can be classified into three classes: firstperson, second person and third person. If the first person is someone telling you his or her story, and second person is you being told how you should do something, then the third person is more like a camera recording events.
[bookmark: scroll-bookmark-685]First person point of view:
First person refers to the speaker. It uses the subject pronoun “I” (singular) or “We” (plural).
Examples:
· I/we (subject, singular/plural)
I prefer coffee to hot cocoa. (First person singular)
We prefer burgers to pasta. (First person plural)
· me/us (object, singular/plural)
Jacob embarrassed me.
Jacob embarrassed us.
· mine/ours (possessive, singular/plural)
The hat is mine.
The hat is ours.
· my/our (possessive, modifying a noun, singular/plural)
That is my hat.
That is our hat.
The first-person point of view is used primarily for autobiographical writing, such as a personal essay or a memoir. Academics and journalists usually avoid first person in their writing because doing so is believed to make the writing sound more objective; however, using an occasional “I” or “we” can be appropriate in formal papers and articles if a publication’s style allows it.
Literature in the first person point of view is written from the speaker’s perspective. This point of view uses first person pronouns to identify the speaker/narrator. First person point of view is generally limited in that the audience only experiences what the speaker/narrator himself experiences.
For additional clarification, here’s another table:
Question 1: What is the total number of pronouns in the below example?
I asked Sam to help me with my Happy New Year mailing, and we somehow got the project done early during the last week of December in spite of our packed schedules. I’m quite proud of us and ended up calling the project ours instead of mine.
[bookmark: scroll-bookmark-686]Second person point of view:
Second person refers to the addressee. It uses the subject pronoun “you.”
Examples:
· you (subject, singular/plural)
You prefer coffee to hot cocoa.
· you (object, singular/plural)
Jacob embarrassed you.
· yours (possessive, singular/plural)
The hat is yours.
· your (possessive, modifying a noun, singular/plural)
That is your hat.
The second person uses the pronouns “you,” “your,” and “yours.” We use these three pronouns when addressing one, or more than one, person. Second person is often appropriate for e-mail messages, presentations, and business and technical writing.
In non-fiction writing, a speaker will often switch between pronouns. Writers do this only for effect. For example, if a speaker wants to be clear and “get through” to the audience, he might say “you” (second person) throughout the text even if the text is mostly in third person. Again, this is strictly for rhetorical effect. Experienced writers use this as a literary tool.
Question 2: What is the total number of pronouns in the below example?
Class, you need to be in your seats when the principal arrives. Tom and Jerry, I’m speaking to you as well. By the way, are these comic books yours?
[bookmark: scroll-bookmark-687]Third person point of view:
Third person refers to a third party individual. It uses the subject pronouns “he,” “she,” “it,” “they.”
Examples:
· he, she, it / they (subject, singular/plural)
He prefers coffee to hot cocoa. (Third person singular)
They prefer tea to coffee. (Third person plural)
· him, her, it / them (object, singular/plural)
Jacob embarrassed her.
· his, hers, its / theirs (possessive, singular/plural)
The hat is theirs.
· his, her, its / their (possessive, modifying a noun, singular/plural)
That is their hat.
The third person is the most common point of view used in fiction writing and is the traditional form for academic writing. Authors of novels and composers of papers use “he,” “she,” or “it” when referring to a person, place, thing, or idea.
Literature in third person point of view is written from an “outside” perspective. This point of view uses third person pronouns to identify characters. In third person writing, the narrator is not a character in the text. Because of this, he can usually “see” what happens to all of the characters.
Question 3: What is the total number of pronouns in the below example?
He met her at a conference where she was the keynote speaker, and it was odd to him that her laptop had a fountain pen sticker on it, because that was his favorite kind of pen. He had his with him and wondered about hers. “A laptop has its place on a desk or on a lap,” he thought, “but in the pocket near the heart and in the hand a fountain pen has its.”

For additional clarification, here is a table listing the three different types of personal pronouns.
	


First Person
(singular, plural)
	Subjective Case
	Objective Case
	Possessive Case

	
	I, we
	me, us
	my/mine, our/ours

	Second Person
(singular & plural)
	you
	you
	your/yours

	Third Person
(singular)



(plural)
	he (masculine)
she (feminine)
it (neuter)
	him (masculine)
her (feminine)
it (neuter)
	his/his (masculine)
her/hers (feminine)
its/its (neuter)

	
	they
	them
	their/theirs



Answers to the Questions
1. I asked Sam to help me with my Happy New Year mailing, and we somehow got the project done early during the last week of December in spite of our packed schedules. I’m quite proud of us and ended up calling the project ours instead of mine.
2. Class, you need to be in your seats when the principal arrives. Tom and Jerry, I’m speaking to you as well. By the way, are these comic books yours?
3. He met her at a conference where she was the keynote speaker, and it was odd to him that her laptop had a fountain pen sticker on it, because that was his favorite kind of pen. He had his with him and wondered about hers. “A laptop has its place on a desk or on a lap,” he thought, “but in the pocket near the heart and in the hand a fountain pen has its.”

[bookmark: scroll-bookmark-688]Possessive Pronouns
Possessive pronouns are used in English to avoid repeating information that is already clear. In general it makes the sentence less confusing because the same information is not being repeated.
	Remember that with possessive pronouns there are no apostrophes (').
It's a cold night. (Verb)
The dog bit its tail. (Possessive pronoun)


Possessive pronouns refer to something which belongs to someone or something. They can take the place of both the pronoun and the noun which is possessed, and they’re generally found at the end of the clause or sentence.
We use possessive pronouns depending on:
· number: singular (eg: mine) or plural (eg: ours)
· person: 1st person (eg: mine), 2nd person (eg: yours) or 3rd person (eg: his)
· gender: male (his), female (hers)
Below are the possessive pronouns, followed by some example sentences. Notice that each possessive pronoun can:
· be subject or object
· refer to a singular or plural antecedent
The table below lists the different possessive pronouns:
	Number
	Person
	Gender (of "owner")
	Possessive pronouns

	singular


	1st
	male/ female
	mine

	
	2nd
	male/ female
	yours

	
	3rd
	male
	his

	
	
	female
	hers

	
	
	neuter
	its

	plural
	1st
	male/ female
	ours

	
	2nd
	male/ female
	yours

	
	3rd
	male/ female/ neuter
	theirs


Examples:
· Please don’t take Veronica’s book. The book is hers.
· The cat is theirs.
[bookmark: scroll-bookmark-689]Of yours
It is also very common to say a friend/some friends + of + possessive pronouns.
Example: I saw one of your friends last night. (or) I saw a friend of yours last night.
[bookmark: scroll-bookmark-690]Yours faithfully - Yours sincerely
Yours is also used in English with faithfully or sincerely at the end of a formal letter or e-mail. The two common expressions are:
· Yours faithfully (If it is someone that you don't know)
· Yours sincerely (If it is someone that you know)

[bookmark: scroll-bookmark-691]Demonstrative Pronoun
A demonstrative pronoun is a pronoun that is used to point to something specific within a sentence. These pronouns can indicate items in space or time, and they can be either singular or plural.
When used to represent a thing or things, demonstrative pronouns can be either near or far in distance or time:
· Near in time or distance: this, these
· Far in time or distance: that, those
[bookmark: scroll-bookmark-692]List of Pronouns
Such
This
That
These
Those
None
Neither
[bookmark: scroll-bookmark-693]Rules
Because there are only a few demonstrative pronouns in the English language, there are just three simple rules for using them correctly.
· Demonstrative pronouns always identify nouns, whether those nouns are named specifically or not. For example: “I can’t believe this.” We have no idea what “this” is, but it’s definitely something the writer cannot believe. It exists, even though we don’t know what it is.
· Demonstrative pronouns are usually used to describe animals, places, or things, however they can be used to describe people when the person is identified, i.e., This sounds like Mary singing.
· Do not confuse demonstrative adjectives with demonstrative pronouns. The words are identical, but demonstrative adjectives qualify nouns, whereas demonstrative pronouns stand alone.
[bookmark: scroll-bookmark-694]Examples
A few examples of demonstrative pronouns are discussed below.
This was my mother’s ring.That looks like the car I used to drive.These are nice shoes, but they look uncomfortable.Such was her command over the English language.None of these answers are correct.Neither of the horses can be ridden.
[bookmark: scroll-bookmark-695]Relative Pronoun
A relative pronoun is one which is used to refer to nouns mentioned previously, whether they are people, places, things, animals, or ideas. Relative pronouns can be used to join two sentences.
[bookmark: scroll-bookmark-696]List of Relative Pronouns
Who
Whom
That
Which
Whoever
Whomever
Whichever
[bookmark: scroll-bookmark-697]Rules
There are only a few relative pronouns in the English language. Because there are only a few of them, there are also just a few rules for using relative pronouns.
· Relative clauses are typically introduced by relative pronouns, and that the relative pronoun can function as a possessive pronoun, an object, or a subject.
· When relative pronouns introduce restrictive relative clauses, no comma is used to separate the restrictive clause from the main clause.
· In American English, the relative pronoun whom is used rarely. You may notice this in conversations, but it is best to use the term when writing to ensure that your work is grammatically correct.
The below table explains the use of the relative pronouns with examples.
	Relative Pronoun
	Use
	Example

	who
	subject or object pronoun for people
	I told you about the woman who lives next door.

	which
	subject or object pronoun for animals and things
	Do you see the cat which is lying on the roof?

	which
	referring to a whole sentence
	He couldn’t read which surprised me.

	whose
	possession for people, animals, and things
	Do you know the boy whose mother is a nurse?

	whom
	object pronoun for people, especially in non-defining relative clauses (in defining relative clauses we colloquially prefer who)
	I was invited by the professor whom I met at the conference.

	that
	subject or object pronoun for people, animals and things in defining relative clauses (who or which are also possible)
	I don’t like the table that stands in the kitchen.


[bookmark: scroll-bookmark-698]Examples
The cyclist who won the race trained hard.
The four team leaders, whomever the committee selects, will be at tomorrow's meeting.
The book, when it was finally returned, was torn and stained.
The store on the corner, where we usually buy all of our art supplies, burned to the ground.
[bookmark: scroll-bookmark-699]Interrogative Pronoun
An interrogative pronoun is a pronoun which is used to make asking questions easy. There are just five interrogative pronouns. Each one is used to ask a very specific question or indirect question. Some, such as “who” and “whom,” refer only to people. Others can be used to refer to objects or people.
Interrogative pronouns can also be used as relative pronouns, which may be found in questions or indirect questions. A pronoun is classified as an interrogative when it’s used in an inquiring way, because interrogative pronouns are found only in question and indirect questions.
The five interrogative pronouns are what, which, who, whom, and whose.
In some cases, interrogative pronouns take on the suffix –ever. A few can also take on the old-fashioned suffix –soever, which is rarely seen in writing these days. For example:
· Whatever
· Whatsoever
· Whichever
· Whoever
· Whosoever
· Whomever
· Whomsoever
· Whosever
[bookmark: scroll-bookmark-700]Rules
· What – Used to ask questions about people or objects.
- What do you want for dinner?- I wonder what we’re doing tomorrow.
· Which – Used to ask questions about people or objects.- She asked which train to take.- Which seat would you like?
· Who – Used to ask questions about people.- I’m wondering who will be at the party.- Who is going to take out the trash?
· Whom – This interrogative pronoun is rarely seen these days, but when it shows up, it is used to ask questions about people.- Whom do you prefer to vote for?- You should ask whom to call.
· Whose – Used to ask questions about people or objects, always related to possession.- I wonder whose dog knocked our garbage can over. - Whose phone is that?
[bookmark: scroll-bookmark-701]More Examples of Interrogative Pronouns

1. What do you want for your birthday?
2. Which shirt do you think looks better on me?
3. Who do you think will win the game?
4. To whom are you speaking?
5. Whose socks are those?

[bookmark: scroll-bookmark-702]Reciprocal Pronoun
A reciprocal pronoun is a pronoun which is used to indicate that two or more people are carrying out or have carried out an action of some type, with both receiving the benefits or consequences of that action simultaneously. Any time something is done or given in return, reciprocal pronouns are used. The same is true any time mutual action is expressed. Simply put, reciprocal pronouns help prevent repetition within sentences.
There are only two reciprocal pronouns. Both of them allow you to make sentences simpler. They are especially useful when the same general idea is expressed more than once.
· Each other
· One another
[bookmark: scroll-bookmark-703]Rules
Reciprocal pronouns are easy to use.
· When you want to refer to two people, you will normally use “each other.”
· When referring to more than two people, for example the students in a lecture hall, you will normally use “one another.”
[bookmark: scroll-bookmark-704]Examples of Reciprocal Pronouns
1. We give each other gifts during the holidays.
2. The kids spent the afternoon kicking the ball to one another.
3. The students congratulated one another after giving practice speeches.
4. Terry and Jack were talking to each other in the hallway.
[bookmark: scroll-bookmark-705]Reflexive Pronoun
A reflexive pronoun is a type of pronoun that is preceded by the adverb, adjective, pronoun, or noun to which it refers, so long as that antecedent is located within the same clause. It refers to a subject of a sentence.
[bookmark: scroll-bookmark-706]List of Reflexive Pronouns
MyselfYourselfHerselfHimselfItselfOneselfOurselvesYourselvesThemselves
[bookmark: scroll-bookmark-707]Rules
· Using a reflexive pronoun means you do not have to repeat the subject.
· He blames himself for what happened.
· Reflexive pronouns may be used as the object of a preposition.
· He made a cup of coffee for himself.
[bookmark: scroll-bookmark-708]Examples of Reflexive Pronouns 
1. I was in a hurry, so I washed the car myself.
2. You’re going to have to drive yourself to school today.
3. He wanted to impress her, so he baked a cake himself.
4. The dog bit itself.
5. You are too young to go out by yourselves.
6. The actors saved the local theatre money by making costumes themselves.
7. We forfeit three-fourths of ourselves in order to be like other people. (Arthur Schopenhauer, 1788-1860)
[bookmark: scroll-bookmark-709]Intensive Pronoun
An intensive pronoun is almost identical to a reflexive pronoun. It is defined as a pronoun that ends in self or selves and places emphasis on its antecedent by referring back to another noun or pronoun used earlier in the sentence. For this reason, intensive pronouns are sometimes called emphatic pronouns.
[bookmark: scroll-bookmark-710]Reflexive versus Intensive Pronouns
The difference between a reflexive pronoun and an intensive pronoun can be identified easily: Intensive pronouns aren’t essential to a sentence’s basic meaning. Both intensive and reflexive pronouns end in the suffix –self or –selves, however reflexive pronouns are always objects that refer to a sentence’s subject.
The following example shows a reflexive pronoun in action:
Jim made himself coffee.
Without the reflexive pronoun himself, it would be impossible for the reader to know who Jim made coffee for.
In the next example, himself is used as an intensive pronoun. The reader would be able to understand the sentence’s complete meaning without this pronoun, but it serves to add emphasis:
Jim made coffee for the king himself.
Here, himself refers to the king rather than to Jim. The reader is meant to be impressed that Jim made coffee for the king.
[bookmark: scroll-bookmark-711]Common Intensive Pronouns
The following list contains the most commonly used examples of intensive pronouns.
· Himself
· Herself
· Yourself
· Themselves
· Ourselves
[bookmark: scroll-bookmark-712]Examples of Intensive Pronouns
1. The Queen herself attended the party.
2. Maria knew that she herself could make a positive impact on the world, if only she put her mind to it.
3. You yourself can easily transform your body: All it takes is a proper diet and plenty of exercise.
4. The team knew that they themselves were responsible for playing their best.
[bookmark: scroll-bookmark-713]Exercises
[bookmark: scroll-bookmark-714]Choose the correct pronoun to fill the blank in each sentence 
1. Jordan made _____________ a sandwich, complete with pickles. (ourselves, himself, yourself, themselves)
2. Is ____________ yours? (this, those, these, such)
3. Because of their bad behavior, ____________ of the children were given allowances. (such, that, none, which)
4. The twins are growing up fast; they’re already walking by _____________. (myself, ourselves, himself, themselves)
5. This is the place __________ we met. (when, where, who, that)
6. I am looking for someone __________ can watch my dog while I go on vacation. (which, who, whoever, that)
7. ______________ time do we need to be at the airport? (Which, What, Whose, Whom)
8. The baby, ________ nap had been interrupted, wailed loudly. (whomever, whose, whom, who)
[bookmark: scroll-bookmark-715]Identify the italicized word as either an intensive pronoun or a reflexive pronoun
1. Ben built a boat for himself.
2. My mother bakes our family’s bread herself.
3. The mayor herself appeared at the rally.

[bookmark: scroll-bookmark-716]Answers
Choose the correct pronoun to fill the blank in each sentence:
1. himself.
2. this.
3. none.
4. themselves.
5. where.
6. who.
7. What.
8. whose.
Identify the italicized word as either an intensive pronoun or a reflexive pronoun:
1. Reflexive.
2. Intensive.
3. Intensive.
[bookmark: scroll-bookmark-717]Redundant Words and Phrases
[bookmark: scroll-bookmark-718]Agenda
1. Meaning of “redundant”
2. Why should we avoid redundancy?
3. What is a phrase?
4. Redundant words Redundant phrases
5. Big words and wordy phrases
6. Exercises
7. Tips and recommendations
[bookmark: scroll-bookmark-719]Redundant -What does this mean?
Something that is not useful or no longer needed; superfluous.
Synonyms: unnecessary, not required, inessential, unessential, needless, unneeded, uncalled for, unwanted, useless, and so on.
[bookmark: scroll-bookmark-720]Why should we avoid redundancy?
A study by Harvard professor D.H. Menzel indicates that in technical papers, sentences become difficult to understand when they exceed 34 words in length. Industry recommendation, especially for technical writing that is being translated, is to limit sentences to 23 words or less. Some technical writing groups recommend lengths of 15-20 words.
[bookmark: scroll-bookmark-721]What is a phrase?
A phrase is a small group of words that adds meaning to a sentence.
A phrase is not a sentence because it is not a complete idea with a subject, verb, and a predicate.
Examples:
· Performed a core dump
· The underlying code of
· Has been modified
[bookmark: scroll-bookmark-722]Redundant Words
Words that do not add information to a sentence at times:
· Absolutely, actually
· Basically, began, begin, begun
· Certainly, completely
· Definitely
· Quite Rather
· somehow, somewhat, start
· That, then , totally
· Virtually
[bookmark: scroll-bookmark-723]Redundant Phrases 
· In terms of
· The fact that
· In order to
· All of the
· It is important to note that
· In as much
· In the process of
· Whether or not
[bookmark: scroll-bookmark-724] Big Words or Wordy phrases 
Let us try and replace with simple words:
· During the course of
· In the form of
· In many cases
· In the event of
· Exhibits the ability to
· Utilize
· Endeavor
· Necessitate
· Prior to this enhancement
[bookmark: scroll-bookmark-725]Exercises
1. It was observed that dynamic discounts could not handle the gaps in CUSTPRODRATINGDISCOUNT table. As a result, the Active Rating Engine failed and events could not be rated.
2. An internal library has been modified so that the Real-time Event Distributor creates and sends a termination request alongside a cancel authorization so that details in the COSTEDEVENT table can be populated.
3. The deletion of a product was possible when partial usage, authorizations and events were associated with the product. As a result, discount data was corrupted and there was a possibility that the Active Rating Engine could fail.
4. When percentage discount thresholds were used, rerating of discounts produced decimal values. As a result, incorrect actions and notifications were repeated and the functionality was impacted.
5. The Active Rating Engine applied discounts incorrectly if there were multiple charges associated with scalars.
6. A new optional system parameter, RATEoptimisticLockMessageMode, has been added to display INFORM messages when the optimistic lock fails, or is successful when authorizations and partial events are reprocessed.
[bookmark: scroll-bookmark-726]Tips and Recommendations
1. Ask yourself what you’re trying to say. Being clear in your thinking is a big step towards achieving clarity in your writing.
2. Read your writing aloud and see how easy you find it. If you find yourself stumbling over your words or having to start a sentence again, you may need to edit to make it more concise and easier to read.
3. Re-read the sentence and cross out any words that do not add anything to the meaning (such as “basically” or “actually”).
4. Use words instead of phrases where possible.
5. Remove unnecessary repetition (“9am in the morning”, for instance, should just be “9am”).
6. Use the Ctrl + F function and check words and phrases discussed today.


[bookmark: scroll-bookmark-727]Subject-Verb Agreement
The subject of the sentence must agree with the verb of the sentence. They must agree in two ways:
· In number: singular vs. plural
· In person: first, second, and third
The first basic rule: Singular subjects take singular verbs and plural subjects take plural verbs.
[bookmark: scroll-bookmark-728]Examples:
The girl is reading.
The girls are reading.

In the following situations, subject verb disagreement errors are difficult to spot.
[bookmark: scroll-bookmark-729]Rule 1: When subjects are joined by “and”, the verb is plural.
[bookmark: scroll-bookmark-730]Examples:
Ravi and I are working on this project.
Martin and his team are visiting tomorrow.
[bookmark: scroll-bookmark-731]Rule 2: When subjects are joined by “or” or “nor”, the verb must agree with the subject closest to it.
[bookmark: scroll-bookmark-732]Examples:
Neither Vivek nor I am interested in working on this project.
Either the manager or his colleagues were expected to inform us.
[bookmark: scroll-bookmark-733]Rule 3: Pronouns such as “either” and “neither” are considered singular; hence, they require singular verbs.
[bookmark: scroll-bookmark-734]Examples:
Neither of us wants to confront him.
Either message is correct.
Either of the messages is correct.
[bookmark: scroll-bookmark-735]Rule 4: Indefinite pronouns such as “each”, “everyone”, “someone”, “anyone”, “everybody”, “no one”, “somebody”, and “nobody” are singular and require singular verbs.
[bookmark: scroll-bookmark-736]Examples:
Everyone has left for the day.
No one is being held responsible for this chaos.
Anyone who does not want to attend the training is free to walk out.
[bookmark: scroll-bookmark-737]Rule 5: Some indefinite pronouns such as “all”, “some”, and “none” are singular or plural depending on whether the noun they are referring to is countable or uncountable.
[bookmark: scroll-bookmark-738]Examples:
Some of the bugs have been fixed.
Some of the training material is irrelevant.
All enhancements to the product are included in this release.
All development work has been completed.
None of the teams have begun work on the new requirements.
None of the food is fresh.

Note: For countable nouns, it is acceptable to use “none” with a singular or plural verb. “None of the boys have arrived” is as good as “None of the boys has arrived”. But one would not say “None of the food are fresh”.
[bookmark: scroll-bookmark-739]Rule 6: Expressions such as “together with”, “as well as”, “along with”, “accompanied by”, and “including” do not affect the choice of the verb.
[bookmark: scroll-bookmark-740]Examples:
The manager, as well as his subordinates, does not approve of the new company policy.
The players, along with the coach, have decided to question the change in rules.
[bookmark: scroll-bookmark-741]Rule 7: In expletive constructions, the subject comes after the verb. The number of the subject decides the use of the verb.
[bookmark: scroll-bookmark-742]Examples:
There are two reasons for our inability to support this product.
This is a decision we all have to stand by.
[bookmark: scroll-bookmark-743]Rule 8: In the present tense, subjects in the third person singular take verbs ending in “s”.
[bookmark: scroll-bookmark-744]Examples:
Chris does not work here any more.
She takes great pride in her work.
This function requires code documentation.
[bookmark: scroll-bookmark-745]Rule 9: Some plural nouns that appear singular use plural verbs.
[bookmark: scroll-bookmark-746]Examples:
My glasses were lying on this table.
These trousers are loose on me.
Be careful! The scissors are very sharp.
[bookmark: scroll-bookmark-747]Rule 10: Some plural nouns such as news, Civics, Politics, Measles, etc. require singular verbs.
[bookmark: scroll-bookmark-748]Examples:
The news is telecast at 6:00 pm every day.
Mathematics is my favorite subject.
Measles was a dreaded disease in the seventeenth century.
[bookmark: scroll-bookmark-749]Rule 11: Plural subjects that are considered singular take singular verbs.
[bookmark: scroll-bookmark-750]Examples:
The team is short of working hands.
The committee spends an hour a week on reviewing its policies.
The family that eats together stays together.
[bookmark: scroll-bookmark-751]Rule 12: Sometimes, the same plural subjects refer to each individual in the group. In that case, the verb they require is plural.
[bookmark: scroll-bookmark-752]Examples:
The jury were having an argument.
The committee have been asked to send in their votes.
The family have never been able to agree on where to go for a holiday.
[bookmark: scroll-bookmark-753]Rule 13: Fractional expressions such as “half of’, “a percentage of”, “a majority of”, and “a part of” are sometimes singular and sometimes plural depending on the following:
[bookmark: scroll-bookmark-754]If the object/noun/noun clause is singular, is a collective noun, or is an uncountable noun, the verb is singular.
[bookmark: scroll-bookmark-755]Examples:
A large percentage of the older population is not exercising its vote.
Two-thirds of the crop was destroyed by fire.
Thirty percent of the company is in favor of working on Saturday.
Only a fifth of the class has done the assignment.
The information is correct.
[bookmark: scroll-bookmark-756]If the object/noun/noun clause is plural, the verb is plural.
[bookmark: scroll-bookmark-757]Examples:
Only a small percentage of children are interested in sports nowadays.
Two-fifths of the troops were lost in the battle.
Twenty percent of the employees are in favor of working on Saturday.
A number of candidates were applying for the job.
A third of the attendees have decided to leave early.
A majority of the voters are unhappy with the results.
When the article “the” is used to introduce a definite number, percentage, or majority, the verb is always singular.
[bookmark: scroll-bookmark-758]Examples:
The percentage of women interested in Science is increasing slowly.
The number of candidates for the position was large.
The majority approves of the plan.

References:
http://www.writing.utoronto.ca/advice/english-as-a-second-language/expressions-of-quantity
http://data.grammarbook.com/blog/singular-vs-plural/subject-and-verb-agreement-with-collective-nouns/
http://grammar.ccc.commnet.edu/grammar/sv_agr.htm
https://owl.english.purdue.edu/owl/resource/599/01/

[bookmark: scroll-bookmark-759]The Semicolon (;)
and the Colon (:)
[bookmark: scroll-bookmark-760]Uses of a Semicolon (;)
1. The first appropriate use of the semicolon is to connect two related sentences.
The pattern looks like this:
Complete sentence + ; + complete sentence.
2. You can also team up a semicolon with a transition to connect two complete sentences that are close in meaning.
The pattern looks like this:
Complete sentence + ; + transition + , + complete sentence.
3. Finally, use the semicolon to avoid confusion when you have complicated lists of items.
The pattern looks like this:
Item + , + More Information + ; + Item + , + More Information + ; + and + Item + , + More Information.
[bookmark: scroll-bookmark-761]Examples
1. My eighty-one-year-old grandmother still rides her Harley motorcycle her toy poodle balances in a basket between the handlebars.
My eighty-one-year-old grandmother still rides her Harley motorcycle; her toy poodle balances in a basket between the handlebars.
2. Spring brings gentle rains and warmer weather in addition to thunderstorms and hail.
Spring brings gentle rains and warmer weather; in addition to thunderstorms and hail.
3. My father does not approve of his mother cruising around town on a Harley motorcycle however, Grandma has never cared what anyone thinks.
My father does not approve of his mother cruising around town on a Harley motorcycle; however, Grandma has never cared what anyone thinks.
4. I really like beef, with mushroom sauce pasta, with Alfredo sauce and salad, with French dressing.
I really like beef, with mushroom sauce; pasta, with Alfredo sauce; and salad, with French dressing.
5. On a Harley motorcycle, my grandmother and her poodle have traveled to Anchorage, Alaska, San Francisco, California and Tijuana, Mexico.
On a Harley motorcycle, my grandmother and her poodle have traveled to Anchorage, Alaska; San Francisco, California; and Tijuana, Mexico.
6. The Christmas ornaments are finally packed away small, shiny ones big, bright ones and the homemade ones.
The Christmas ornaments are finally packed away: small, shiny ones; big, bright ones; and the homemade ones.
[bookmark: scroll-bookmark-762]Points to remember about Semicolon
[bookmark: scroll-bookmark-763]Keep these three things in mind when you use a semicolon:
1. The two main clauses that the semicolon joins should be closely related in meaning.
2. Don't capitalize the word that follows the semicolon unless that word is a proper noun, one that is always capitalized.
3. Limit your use of semicolons; you should not scatter them wantonly throughout your writing. Semicolons are like glasses of champagne; save them for special occasions.
Link to the Style Guide, for semicolons: https://bass.netcracker.com/display/SG/Semicolons.
[bookmark: scroll-bookmark-764]Uses of a Colon (:)
1. Use a colon after a complete statement in order to introduce one or more directly related ideas, such as a series of directions, a list, or a quotation or other comment illustrating or explaining the statement.
2. Space once between a colon and the next word, when the colon is used between words.
3. Do not space between numerals and a colon when a colon is used to mark time or ratios.
4. For a list of items which are part of a sentence followed by a verb, such as are, the colon should not be used.
5. A stem or introductory sentence used before a table, figure, or diagram should not end in a colon.
[bookmark: scroll-bookmark-765]Examples
1. The strategies of corporatist industrial unionism have proven ineffective compromises and concessions have left labor in a weakened position in the new "flexible" economy.
The strategies of corporatist industrial unionism have proven ineffective: compromises and concessions have left labor in a weakened position in the new "flexible" economy.
2. The daily newspaper contains four sections news, sports, entertainment, and classified ads.
The daily newspaper contains four sections: news, sports, entertainment, and classified ads.
3. He said he would be at home by 5 30 p.m.
He said he would be at home by 5:30 p.m.
4. The values this parameter can use are “A”, “B”, “C”, and “D.”
The values this parameter can use are “A”, “B”, “C”, and “D.”
5. He always liked to refer to Genesis 1 18 when starting a speech.
He always liked to refer to Genesis 1:18 when starting a speech.
6. Barry wanted to know why I didn’t respond to his text I hadn’t received it.
Barry wanted to know why I didn’t respond to his text: I hadn’t received it.
7. Penguin an aquatic, flightless bird found almost exclusively in the Antarctic.
Penguin: an aquatic, flightless bird found almost exclusively in the Antarctic.

[bookmark: scroll-bookmark-766] 
[bookmark: scroll-bookmark-767] 
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Inside Order Management Project the sales orders are

New Specification Parameters
The Business Order Entry Application can be launched by clicking the [Business
Order Entry] button on the toolbar of the <Sales Orders> table. The full path is the
following: “Navigation” menu > "Documents” > "Business Order Entry Customers® >
"some Business Customer Account” > "some Order Management Project” > "Sales
Orders” tab.

Test BCA 23 OM Project

=

Figure 67, Business Order Entry button

Before the application is launched, the system checks if the following enties and

‘connections exist:

« Configured Business Offering Catalog—for more information, see "Business
Offering Catalog™;

« Whether the cument Business Customers project is bound to the Business
Offering Catalog (the default "Business Order Entry Customers” project is already
bound to default Business Offering Catalog)]

Business Order Entry Application”).
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Creating New Retention Case Value

A retention type is specified by the retention Case Type atribute. The Case Type attribute is an atirbute of the list type: to
create a new retention type In a system, you need o add a new value to the Case Type atiibute of the Retention object ype.

o create a ew retention case type:
1. Navigate to any retention
For more information, see “Navigating to Customer Retention Invertory”
2. Onthe retention page, rom the Others menu, select Goto Object Type.
The Administrative Tool page is opened.

Figure1, Administrative Tool Page
3. Inthe Atributes section, scroll down o Retention case Information (Parameters) attributes’ group,
4. Clickthe Case Type afribute, to select it

The Case Type atribute’s parameters are displayed in the Attibutes Parameters pane

Figure2, Attribute Parameters Pane.
5. Onthe right of the Type Definition Parameter, cick Case Type.
The Attribute Type Definition Form is opened

6. Toaddanew case type value, on the List Values toolbar, click ©.
Anew row for a new list value is added o the List Values table.

7. Enterthe new value of the Case Type attribute and click Update.
The new value is added to the List Values table.

8. Click Close,

The new Case Type value is addedto the fist atiribute values andthis value is available for selecting when creating new
etentions
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Adding New Retention Case Types

The type of retention defines the flow that is launched after a retention is created. To compose a fully new flow of processing
the retentions, add a new type of retentions. A retention type is specified by the Case Type attribute associated with the
Retention Object type. This attribute is an attribute of the st type: to create a new retention type in the system. add a new
value to the attribute.

To add a new case type value:

1. Open the Retention object type. To navigate, use the Go to Object Type system function, which enables accessing
object's type from the object itself

For more information about the Go T, Object Type command, refer to NetCracker Administrator Guide, "Object Types,
Attributes and Schemas.”

2. Oncein the object type, locate the Case Type attribute in the Attributes section.
3. Make sure that the located attribute is of the List type.
4. Add a new value to the list of the attribute values.

Immediately after the value is added, it becomes available for selecting in the Case Type drop-down list box when creating
retentions.
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The sysfem enables generating and apening a report n Excel by using only one button. The Open I Excel 2003 buton on he foolbr of the Reporttable is
intended to save time and reduce the number of steps. e

% schedule [ Opennxel 2003 ExporTocsv [] [ parerm
Singl Report s
Figure 11, Report table—Open In Excel 2003 button
To open a reportin Excel
1. Onthe Navigation menu, click Inventory.
2. Onthe Others menu, click Reports
3. Navigate to the page containing the required report
4. Inthe Reporttable, selectthe check box to the leftof the appropriate report,
Note In case more than one check box is selected, the system displays the “Please check only one object” notification message and denies the operation
5. Onthe toolbar of the Reporttable, click Open In Excel 2003

Note The system generates the selected report before opening itin Excel. The generating time is configured by the administrator and displayed as a pop-up
message after the button is clicked. In case the report is not opened within the configured time, the system displays an error message. For more information.
see "Appendix A Reports Engine Error Messages.”

6. Choose one of the options, proposed by a web-browser.
ho0se o of e OO proposed b el vowsen
‘The Teportis opened in Excel
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2.1VNF Descriptor StructureQ

VNF Descriptor has the following entities:

NG

VNF Component Descriptor -logical container of the function. One function can have one
‘or more components: active and stand-by components. An active VNF componentis re-
sponsible forthe operation of the function. A stand-by VNF component insures the work
of function, in case the active VNF componentis disabled.

VNF Deployment Flavor - description of the VNF configuration.

Virtual Deployment Unit- requirements for the virtual machines, where the functionsare
configured.
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same VNF.

Connection Point Descriptor- element describingan interface exposed by this VNF.

2.2 VNF Descriptor Archive
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